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The intended audience for the Introduction to OTCnet includes:
Administration Users
Deposit Processing and Reporting Users
Check Capture, Check Processing and Reporting Users
Card Processing Users
Viewers
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Welcome to Introduction to OTCnet Overview and OTCnet Course Content. In this chapter, you will learn:
The introduction to OTCnet

[bookmark: _Toc467486126][bookmark: _Toc43803290]Topics
The topics of this chapter are:
OTCnet Background and Organization
OTCnet User Roles

[bookmark: _Toc43803291]Topic 1. Introduction to OTCnet
[bookmark: _Toc270774793][bookmark: _Toc43803292][bookmark: _Hlk10669802][bookmark: _Toc251088641][bookmark: OLE_LINK9]Overview
The Bureau of the Fiscal Service (BFS) Over the Counter Division (OTCD) provides the Over the Counter Channel Application (OTCnet) to facilitate the prompt electronic processing, reporting of deposits and transaction activities. OTCnet financial services include retail transactions made at agency offices, face-to-face collection points, and point of sale (POS) locations throughout the US and abroad.

OTCD oversees the systems, networks and program infrastructure which enable world-class OTCnet financial services including the collection of checks, cash, coins and credit, debit and gift card transactions at agency POS locations around the globe. The OTCD is responsible for implementing a coordinated government-wide strategy for the collection of over the counter transaction and deposit activities (cash, card, check, foreign checks/currency, seized currency), and the transition from paper checks to electronic mechanisms.

OTCnet is a secure web-based system that enables federal agencies to integrate check conversion, deposit reporting, and card processing, so that all check, cash, coin, and card deposits to the TGA are handled by one web-based application. 

OTCnet offers agencies superior customer service and high-quality e-commerce solutions for collections and reporting needs.

OTCnet Financial Services includes the following.
1. Electronically process US checks presented for cashing, payment or deposit
2. Process US currency, foreign currency cash and foreign check item deposits
3. Accepts credit, debit and gift cards (Visa, MasterCard, American Express and Discover)
4. Supports the self-service kiosk
5. Automate the collection and settlement process
6. Provide online reporting and research capability for reconciliation and inquiries
7. Improve deposit history record keeping
[bookmark: _Toc43803293] 
OTCnet Elements 
OTCnet is comprised of five elements: 1) Administration, 2) Check Capture, Check Processing and Reporting, 3) Deposit Processing and Reporting, 4) Card Processing, and 5) Self-Service Kiosk: Web Service. Administration functions support Check Capture, Check Processing and Reporting, Deposit Processing and Reporting, Card Processing, and Self-service Kiosk (see Figure 1 below). 

[bookmark: _Toc59444334]Figure 1. OTCnet Elements
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The functions of the five elements of are:
Administration: allows for those with administrative permissions to install, setup users, and manage OTCnet
Deposit Processing: permits Federal agencies the ability to create and submit deposits for confirmation. This platform also allows for Financial Institutions (FIs) to confirm those deposits and create adjustments electronically. Deposits can be created for US currency, foreign cash and foreign check items
Check Capturing, Check Processing: converts personal and business checks into electronic fund transfers. Transactions can be consumer, consumer accounts receivable, and business transactions.
· Card Processing: allows agencies to provide their customers an option to make their payments via credit/debit cards and gift cards. 
· Self-service Kiosk: Third party vendor standalone kiosk supported by OTCnet.
[bookmark: _Toc43803294]OTCnet Process Flow: Check Capture, Check Processing and Reporting
Check Capture and Check Processing involve converting paper checks received over the counter or through the mail into electronic debits to the check writer’s account. The process is highly automated and greatly improves the collection, reconciliation, research, and reporting processes associated with Federal Agency check collections. 

In OTCnet, your Agency scans a check and the check scanner captures an image of the front and back of each check. In OTCnet Online, the image is available immediately; in OTCnet Offline, the image is stored locally. You can also access Collections Information Repository (CIR) to retrieve deposit information.

The captured image of the check is stored for seven years in OTCnet. You can search the check images as well as the check capture and transaction date throughout the Check Image and Research Archive (CIRA) Query feature within OTCnet.

OTCnet sends summary as well as detailed information to CIR for those agencies that are not processing tax transactions.

CIR sends accounting entries with Treasury Account Symbol/Business Event Type Code (TAS/BETC) or Classification Keys (C-Keys) to Central Accounting Reporting System/Government Wide Accounting (CARS). CARS invokes Shared Account Module (SAM) to either validate, translate, or default the TAS/BETC based on the accounting information received on the transaction

OTCnet sends the captured check data to Debit Gateway at the Federal Reserve Bank Cleveland (FRB-C). FRB-C/Debit Gateway sends the data and settles to the appropriate Financial Institutions (FIs) either through FedACH (personal check) or Check 21 (non-personal check) where the check was written.

The FI where the check was written shows the account was debited (see complete Check Capture and Check Processing and Reporting Process flow in Figure 2 below). 
If your Agency uses the Master Verification Database (MVD) (which provides downloads of prior negative check information and blocked items) and is working offline, the information is passed to the agency's Local Verification Database (LVD) when each batch is closed. The LVD is then used to determine the check writer's status and implement your Agency's bad check policy if applicable.

[bookmark: _Toc59444335]Figure 2. Check Capture, Check Processing, and Reporting Process Flow
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[bookmark: _Toc43803295]What is ACH?
The ACH Network is a nationwide batch-oriented electronic funds transfer system governed by the NACHA (National Automated Clearing House Association) operating rules which provide for the interbank clearing of electronic payments for participating depository financial institutions. The Federal Reserve and Electronic Payments Network act as ACH Operators, central clearing facilities through which financial institutions transmit or receive ACH entries. ACH payments include:
Direct Deposit of payroll, Social Security and other government benefits, and tax refunds;
Direct Payment of consumer bills such as mortgages, loans, utility bills and insurance premiums;
Business-to-business payments;
E checks;
E commerce payments;
Federal, state and local tax payments.

[bookmark: _Toc43803296]What is Check 21?
Check 21, also known as ‘Check Clearing for the 21st Century’ Act, was signed into law on October 28, 2003. Provisions of the law took effect on October 28, 2004. It is important to understand the effects of Check 21 on OTCnet. Check 21 provides the legal framework for the creation of substitute checks, which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. 
To meet legal requirements, a substitute check must:
Contain an image of the front and back of the original check.
Bear a legend that states, “This is a legal copy of your check. You can use it the same way you would use the original check.”
Display a MICR line containing all information appearing on the MICR line of the original check.
Conform in paper stock, dimension, and otherwise, with generally applicable industry standards for substitute checks.
Be suitable for automated processing in the same manner as the original check.

Note: All non-personal items are processed via Check 21.

Overall, this legislation has modernized the nation’s check payments system. Check 21 is designed to foster innovation in the payments system and to enhance its efficiency by reducing some of the legal impediments to check truncation. ALL payment instruments are eligible for processing under OTCnet, including Business Checks, Money orders, Treasury checks, Credit card checks, Traveler’s checks, Cashier’s checks, Official checks, Third-party checks, Payroll checks and checks drawn on state or local government. Check 21 requires financial institutions to accept a substitute check from a presenting institute and grant it equivalent status as the original check, if the substitute check meets prescribed requirements. It also requires a reconverting bank to meet the warranties and indemnities enacted through the legislation and subsequent regulations. Check 21 requires financial institutions to provide education to individual consumers on substitute checks and consumer re-credit rights. 
For more information on Check 21, visit: http://www.frbservices.org/Retail/Check21.html

Table 1 below identifies acceptable forms of FedACH and Check 21 payment types.
[bookmark: _Ref486242781][bookmark: _Toc13076373]Table 1. FedACH and Check 21 Payment Types
	FedACH
	Check 21

	Direct Deposit of payroll, Social Security and other government benefits, and tax refunds
Direct Payment of consumer bills such 
as mortgages, loans, utility bills and insurance premiums
Business-to-business payments
E checks
E commerce payments
Federal, state and local tax payments
	Business Checks
Money Orders
Treasury Checks
Credit Card Checks
Traveler’s Checks
Cashier’s Checks
Official Checks
Third-party Checks
Payroll Checks
Checks drawn on state or local government
Personal Check (No Notice)
Personal Check (Opt Out)


[bookmark: _Toc43803297]
OTCnet Process Flow: Deposit Reporting
Deposit Processing electronically collects and automates US and Foreign funds which facilitates the classification of Treasury collections on a daily basis.

[bookmark: _Hlk10123813][bookmark: OLE_LINK10]As shown in Figure 3 below, the Deposit Preparer, or Agency, electronically reports the deposit to Treasury using OTCnet and prints out the OTCnet deposit ticket. The bank deposit ticket, OTCnet deposit ticket, cash, and checks (US and foreign) are taken to your Treasury General Account (TGA) Bank. At the TGA Back, the Deposit Confirmer confirms the deposit, rejects the deposit or creates an adjustment to the deposit using OTCnet. 

OTCnet sends commercial deposit voucher information to CIR. CIR receives commercial deposit information from OTCnet for reconciliation and transmits to Treasury Cash Management System (TCMS) for cash concentration purposes. TCMS receives the commercial deposit data from CIR and initiates the cash concentration activity.

The Deposit Preparer and Deposit Viewer can access OTCnet to view their deposit ticket information, as well as access reports, receive rejections, and view adjustments.

[bookmark: _Toc59444336]Figure 3: Deposit Processing Workflow
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[bookmark: _Toc43803298]OTCnet Process Flow: Card Processing
Card processing is a web-based functionality that provides agency customers with an option to make payments with a credit, debit, or gift card. Card transactions are sent directly to WorldPay.

As shown in Figure 4 below, The Agency initiates the Card Processing payment. Currently, OTCnet does not store any card transaction details. The Agency can access Collections Information Repository (CIR) to retrieve deposit and card payment information. 
Note: Agencies are responsible for reconciling all transaction data. For card transactions, data reconciliation can be conducted using the source system, merchant card processor, and the Department of Treasury’s reporting repository. Card transactions processed via OTCnet can be viewed within the OTCnet application, Worldpay from FIS iQ portal, and CIR. CIR provides the summary and detailed transaction data for settled transactions. When reconciling, CIR has Card Reports that provide the user with all reporting information associated with the selected card transaction(s). These transactions auto pull from the Card Acquiring Service (CAS) and Pay.gov.
The customer pays with a credit/debit card or gift card at an agency terminal station. The customer authorizes the amount to be charged to their account. The Verifone/OTCnet terminal sends the transaction data to Worldpay for authorization. 
Worldpay processes the payment in four steps:
Step 1 - Authorization (Real Time)
Worldpay sends the transaction data to the card issuer through the card networks (e.g., Visa, Discover, Amex and Mastercard). The card issuer determines whether funding is available and returns authorization through the card networks to Worldpay.

Step 2 - Clearing
Funds in the daily transaction batch are cleared from Worldpay to Comerica Bank. The processing cut off for credit card payments is 4:30 AM and 2:00 AM for debit card payments.

Step 3 - Settlement
The card issuer sends the settlement money back to Worldpay via the card networks once the payments have been authorized and cleared. The timing varies by credit/debit network for when the settlement money is sent back to Worldpay.

Step 4 - Deposit Reporting
If the payment is approved, Worldpay sends deposit voucher transaction data to CIR via the Worldpay flat file the following morning between 4:00 AM - 6:00 AM. 
CIR sends the voucher information to Treasury Cash Management System (TCMS). TCMS uses National Settlement Service (NSS) to draw funds. NSS transfers funds to the TGA Bank NY/FRB and reconciles them with Worldpay/Comerica Bank.

[bookmark: _Toc59444337]Figure 4. Card Processing Workflow
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[bookmark: _Toc43803299]OTCnet Process Flow: Self-Service Kiosk: Check Payment
Self-Service Kiosk: Check Processing is a web-based functionality that provides agency customers with an option to make payments with a check at kiosk. 
As shown in Figure 5 below, the kiosk captures the image of the front and back of each check. Kiosk: Image stored on the kiosk server. The images will be uploaded to the OTCnet server on a scheduled basis. The Agency accesses OTCnet for Check Processing reports. The agency can also access Collections Information Repository (CIR) to retrieve deposit information.
The captured image of the check is stored for seven years in OTCnet. An agency can search for check images as well as the check capture and transaction date throughout the CIRA (Check Image and Research Archive) Query feature within OTCnet. OTCnet sends the captured check data to Debit Gateway at the Federal Reserve Bank Cleveland (FRB-C). FRB-C/Debit Gateway sends the data and settles to the appropriate Financial Institutions (FIs) either through FedACH (personal check) or Check 21 (non-personal check) where the check was written. The FI where the check was written shows the account was debited.
OTCnet sends summary as well as detailed information to CIR for those agencies. CIR sends accounting entries with Treasury Account Symbol/Business Event Type Code (TAS/BETC) or Classification Keys (C-Keys) to Central Accounting Reporting System (CARS). CARS invokes Shared Account Module (SAM) to either validate, translate, or default the TAS/BETC based on the accounting information received on the transaction.
Note: The Kiosk Operator sets up the workstation and Kiosk Tablet daily by logging in to and locking down the Kiosk Tablet.
[bookmark: _Toc59444338]Figure 5. Self-Service Kiosk: Check Payment
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[bookmark: _Toc43803300]OTCnet Process Flow: Self-Service Kiosk: Deposit Processing 
Self-Service Kiosk: Deposit Processing is a web-based functionality that provides agency customers with an option to make US cash payments at a kiosk. 
As shown in Figure 6 below, The customer (kiosk user) makes US cash payments using the kiosk. The kiosk sends the deposit information to OTCnet with draft status. OTCnet creates deposit voucher for kiosk’s cash payment transactions with accounting code information. The Agency logs in to OTCnet to classify, approve and submit the voucher to the agency’s Financial Institution (FI) and can view the Deposit Process report. The cash goes to the bank.
The Agency can also access Collections Information Repository (CIR) to retrieve deposit information. The FI verifies and confirms the deposit in OTCnet. OTCnet sends vouchers information to Collections Information Repository (CIR). CIR sends the voucher information to Treasury Cash Management System (TCMS). TCMS uses National Settlement Service (NSS) to draw funds.
Note: The Kiosk Operator sets up the workstation and Kiosk Tablet daily by logging in to and locking down the Kiosk Tablet.
[bookmark: _Toc59444339]Figure 6. Self-Service Kiosk: Deposit Processing Workflow
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[bookmark: _Toc43803301]OTCnet Process Flow: Self-Service Kiosk: Card Processing 
Self-Service Kiosk: Card Processing is a web-based functionality that provides agency customers with an option to make payments with a credit, debit, or Visa/Mastercard gift card at an agency terminal station. Card transactions are sent directly to WorldPay.

As shown in Figure 7 below, pays with a credit/debit card or Visa/Mastercard gift card at the kiosk. Customer authorizes the amount to be charged to their account. The kiosk sends transaction data to Worldpay for authorization. 
Worldpay processes the payment in four steps:
Step 1 - Authorization (Real Time)
Worldpay sends the transaction data over to the card issuer through the card networks (Visa, Discover, Amex and Mastercard). The card issuer determines if funding is available or not and returns authorization back through the card networks to Worldpay.

Step 2 - Clearing
Funds in the daily transaction batch are cleared from Worldpay to Comerica Bank. Processing cut off for credit card payments is 4:30 AM and 2:00 AM for debit card payments.

Step 3 - Settlement
The card issuer sends the settlement money back to Worldpay via the card networks once the payments have been authorized and cleared. The timing varies by credit/debit network for when the settlement money is sent back to Worldpay.
Step 4 - Deposit Reporting
If the payment is approved, Worldpay sends deposit voucher transaction data to CIR via the Worldpay flat file the following morning between 4:00 AM - 6:00 AM.
CIR sends the voucher information to Treasury Cash Management System (TCMS). TCMS uses National Settlement Service (NSS) to draw funds. The kiosk sends the card transaction data to OTCnet via the card webservice. NSS transfers funds to the TGA Bank NY/FRB and reconcile with Worldpay/Comerica Bank. The Agency accesses OTCnet for Card Processing report. The Agency can also access Collections Information Repository (CIR) to retrieve deposit information.
Note: The Kiosk Operator sets up the workstation and Kiosk Tablet daily by logging in to and locking down the Kiosk Tablet.


[bookmark: _Toc59444340]Figure 7. Self-Service Kiosk: Card Processing Workflow
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[bookmark: _Toc43803302]OTCnet End Users
There are three functional areas of the OTCnet application: 1) Administration, 2) Check Capture, Processing and Reporting and 3) Deposit Processing and Reporting. The user role you will hold is based on the types of tasks you will perform.

Administration user roles, with varying degrees of permission, can perform administrative duties such as user management and system installation. Check Capture/Check Processing and Reporting user roles can perform functions to capture checks, process checks, access reports and edit or view the Master Verification Database (MVD). Deposit Processing and Reporting user roles can create deposits, approve, confirm (reject or adjust), and/or view information. (see Table 2 below).
[bookmark: _Ref486240980][bookmark: _Toc13076374]Table 2. End User Roles
	Administration
	Check Capture/ Check Processing and Reporting
	Deposit Processing and Reporting
	Card
Processing 

	Agency
Check Capture Supervisor
Check Capture Administrator
Accounting Specialist/ Local
Accounting Specialist
Card Administrator

Financial Institution/ Federal Reserve
Primary Security Administrator
Local Security Administrator
	Agency
Check Capture Operator
Check Capture Lead Operator
Check Capture Supervisor
Batch Approver*
Batch Uploader*
Master Verification Database (MVD) Editor
Master Verification Database (MVD) Viewer
	Agency
Deposit Preparer
Deposit Approver
Viewer


Financial Institution/ Federal Reserve
Deposit Confirmer
Viewer
	Agency
Card Operator




*Batch Approver and Batch Uploader are sub-roles assigned to users with existing roles.
[bookmark: _Toc43803303]Topic 2. OTCnet User Roles
Individuals can be granted user access based on their job roles. Agency and financial institution/federal reserve bank (FI/FRB) user roles are listed in Table 3 below with corresponding descriptions of job roles, the user roles that may assign the access, and if the user can access Check Capture, Deposit Processing, or Card Processing functions.
[bookmark: _Ref486241010][bookmark: _Toc13076375]Table 3. OTCnet Agency and FI/FRB User Roles
	User
Role
	Role 
Description
	Assignable By
	Check Capture
	Deposit Processing
	
Card Processing

	Accounting Specialist
	The agency user in this role is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet. 

	Agency PLSA
Agency LSA
	BLANK
	•
	

	Agency Local Security Administrator (LSA)
	The agency user in this role will maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. LSAs can also view security reports. 

	Agency PLSA
	•
	•
	

	Agency Primary Local Security Administrator (PLSA)
	The agency user in this role has the same capabilities as an LSA with the additional capability of creating and modifying LSAs for their organization. There can only be one PLSA per agency.
	OTCnet Customer Support Team
	•
	•
	

	Agency Manager
	The agency user in this role can view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports. The agency user can view if an endpoint is designated for summary-level classification, and the agency comments associated to an endpoint. 
	Agency PLSA
Agency LSA 
	•
	BLANK
	

	Batch Approver
	The user assigned this role will have the ability to approve a batch either prior to batch upload (from Offline) or when a batch is uploaded/submitted to OTCnet but not yet approved. This permission is granted especially when, in offline mode, a user has configured the terminal to upload a batch upon Batch Close. An example of this permission applies to a Check Capture Operator: though a terminal may be configured to upload upon close, an Operator is able to close a batch but does not inherently have Upload permissions, therefore the user's permissions will override the terminal configuration, and the batch will not be automatically uploaded. Providing this permission along with Batch Uploader allows for the Check Capture Operator to auto-upload the batch upon close. This role should be granted in limited cases at sites where there is a need for the Operator to perform this function without a Supervisor present.

Note: This role only applies to the Offline version of OTCnet.
	Agency PLSA
Agency LSA
	•
	BLANK
	

	Batch Uploader
	The user assigned this role will have the ability to upload a batch from Offline OTCnet to the online database; this user has no other permissions, and therefore should typically be granted to a Check Capture Operator and Lead Operator. This permission is granted especially when, in offline mode, a user has configured the terminal to upload a batch upon Batch Close. An example of this permission applies to a Check Capture Operator: though a terminal may be configured to upload upon close, an Operator is able to close a batch but does not inherently have Upload permissions, therefore the user's permissions will override the terminal configuration, and the batch will not be automatically uploaded. Providing this permission along with Batch Approver allows for the Check Capture Operator to auto-upload the batch upon close. This role should be granted in limited cases at sites where there is a need for the Operator to perform this function without a Supervisor present.

Note: This role only applies to the Offline version of OTCnet.
	Agency PLSA
Agency LSA
	•
	BLANK
	

	Card Administrator
	The agency user in this role has the capability to manage endpoints for card processing. The user can view and modify terminal configuration. The user can also modify, delete, view, and search organization hierarchy. Lastly, this user has the capability to download releases and read/view audit card modules.
	Agency PLSA
Agency LSA
	
	
	•

	Card Operator
	This user views organizational hierarchy and searches within the organization. This user can process credit card payments, query card transactions, and view terminal configuration. Finally, this user can read/view the audit log and has partial access to the user’s own activities.
	Agency PLSA
Agency LSA
	
	
	•

	Check Capture Administrator
	The agency user in this role has the capability to define and modify the check capture sites as well as manage accounting codes and modify endpoint mappings. For example, this user is able to setup the location policy and location group. Additionally, this user is able to view, modify, and import accounting codes and modify endpoint mappings. This user can also configure the Check Capture functions and perform upgrades of the application as well as has the permission to download user profiles for the site. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. This user has the permission to download software or firmware to the terminal using the Download Check Capture application permission. Lastly, this user is authorized to download the OTCnet Local Bridge (OLB) application, install the OLB certificate, install the OLB application, create the OLB profile, and start and stop the OLB application.
	Agency PLSA
Agency LSA 
	•
	Check Capture Administrator
	

	Check Capture Administrator
	The agency user in this role has the capability to define and modify the check capture sites as well as manage accounting codes and modify endpoint mappings. For example, this user is able to setup the location policy and location group. Additionally, this user is able to view, modify, and import accounting codes and modify endpoint mappings. This user can also configure the Check Capture functions and perform upgrades of the application as well as has the permission to download user profiles for the site. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. This user has the permission to download software or firmware to the terminal using the Download Check Capture application permission. Lastly, this user is authorized to download the OTCnet Local Bridge (OLB) application, install the OLB certificate, install the OLB application, create the OLB profile, and start and stop the OLB application.
	Agency PLSA
Agency LSA 
	•
	BLANK
	

	Check Capture Lead Operator
	The agency user in this role will have the ability to scan checks into a batch, view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. This user is authorized to install the OTCnet Local Bridge (OLB) certificate, install the OLB application, create the OLB profile, and start and stop the OLB application. Additionally, this user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicates. This user is not authorized, however, to use out-of-date LVD. This role can establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 
	Agency PLSA
Agency LSA 
	•
	BLANK
	

	Check Capture Operator
	The agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. This user is authorized to install the OTCnet Local Bridge (OLB) certificate, install the OLB application, create the OLB profile, and start and stop the OLB application. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. However, the user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality.
	Agency PLSA
Agency LSA 
	•
	BLANK
	

	Check Capture Supervisor
	The agency user in this role is the most powerful user on the Check Capture site. The user can perform almost all the functions in Check Capture including view and classify checks at the item level or a batch at the summary level, accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, accept checks with poor quality, as well as view, modify, and import accounting codes, and modify endpoint mappings. However, this user does not have any permissions associated with scanning checks. To ensure “checks and balances,” scanning checks is reserved for a Check Capture Operator or Lead Operator only. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet. This user is authorized to install the OTCnet Local Bridge (OLB) certificate, install the OLB application, create the OLB profile, and start and stop the OLB application.
	Agency PLSA
Agency LSA 
	•
	BLANK
	

	CIRA Viewer
	The agency user in this role can only view organization endpoints and CIRA records. This is the check processing role with the lowest level of access. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.
	Agency PLSA
Agency LSA
	•
	BLANK
	

	Deposit Approver
	The agency user in this role will approve the deposit report and submit the information to the TGA financial institution. 
	Agency PLSA
Agency LSA
	BLANK
	•
	

	Deposit Preparer
	The agency user in this role prepares the deposit ticket and supporting information for transmission to the TGA financial institution.
	Agency PLSA
Agency LSA
	BLANK
	•
	

	FPA Viewer
	The agency user in this role will only be able to search / view deposit and adjustments and produce reports from it. 
	Agency PLSA
Agency LSA
	BLANK
	•
	

	Local Accounting 
Specialist
	The agency user in this role is an expert on the organizational structure, reporting needs and accounting rules for its depositing and lower level endpoints. This role will establish, maintain and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level endpoints will use in OTCnet.
	Agency PLSA
Agency LSA
	BLANK
	•
	

	MVD Editor
	The agency user in this role can create, update and read verification records. This role can also download CSV formatted reports, view other general reports such as the 215 Deposit Ticket, 5515 Debit Voucher reports and the ACR Activity report. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated with an endpoint.
	Agency PLSA
Agency LSA
	•
	BLANK
	

	MVD Viewer
	The agency user in this role can read CIRA records in addition to read verification records and read block records containing only AB permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket, 5515 Debit Voucher reports and the ACR Activity report. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.
	Agency PLSA
Agency LSA 
	•
	BLANK
	

	View Report
	The agency user in this role will have access to agency reports with the exception of the CIRA CSV report. 
	Agency PLSA
Agency LSA
	•
	•
	

	Deposit Confirmer
	The financial institution user in this role will verify the submitted deposit ticket, reject the deposit ticket if necessary, forward the information to the Treasury, and create adjustments, as necessary. 
	FI PLSA
FI LSA
	BLANK
	•
	

	FI Viewer
	The financial institution user in this role will only be able to search and view deposits and adjustments, view Financial Institution information and produce reports from it.
	FI PLSA
FI LSA 
	BLANK
	•
	

	FI/FRB Local Security Administrator (LSA)
	The financial institution/federal reserve bank user in this role will maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access.
	FI PLSA

	BLANK
	•
	

	FI/FRB Primary Local Security Administrator (PLSA)
	The financial institution/federal reserve bank user in this role has the same capabilities as an LSA, with the additional capability of creating and modifying LSAs for their organization. There can only be one PLSA per financial institution.
	OTCnet Customer Support Team
	BLANK
	•
	

	FI/FRB Confirmer
	The FI/FRB user in this role will verify the submitted deposit ticket, reject the deposit ticket if necessary, forward the information to the Treasury, and create adjustments, as necessary.
	FI PLSA
FI LSA
	BLANK
	•
	

	FRB Viewer
	The FRB user in this role will only be able to search and view deposits and adjustments, view FRB information and produce reports from it
	FI PLSA
FI LSA 
	BLANK
	•
	


[bookmark: _Toc43803304]
Agency User Role Combinations
The two tables below show Agency Deposit Processing, Check Capture and Card Processing user roles that can be combined and assigned to an individual user. “•” indicates that the role in the column heading can be combined with the role to the far left of it.
[bookmark: _Toc13076376]Table 4. Combinable Agency Deposit Processing User Roles
	Agency User Roles
	Agency PLSA
	Agency LSA
	Accounting Specialist
	Local Accounting Specialist
	Deposit Preparer
	Deposit Approver
	FPA Viewer

	Agency PLSA
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•

	Agency LSA
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•

	Accounting Specialist
	BLANK
	BLANK
	BLANK
	•
	•
	•
	•

	Local Accounting Specialist
	BLANK
	BLANK
	•
	BLANK
	•
	•
	•

	Deposit Preparer
	BLANK
	BLANK
	•
	•
	BLANK
	•
	•

	Deposit Approver
	BLANK
	BLANK
	•
	•
	•
	BLANK
	•

	FPA Viewer
	•
	•
	•
	•
	•
	•
	BLANK

	CIRA Viewer
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	View Report
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	MVD Editor
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	MVD Viewer
	•
	•
	•
	•
	•
	•
	BLANK

	Card Administrator
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	Card Operator
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	Check Capture Operator
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	Check Capture Lead Operator
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	Check Capture Administrator
	BLANK
	•
	•
	•
	•
	•
	BLANK

	Check Capture Supervisor
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK


[bookmark: _Toc13076377]Table 5. Combinable Agency Check Capture User Roles
	
Deposit Reporting. Check Capture and Card Processing User Roles
	Agency Manager
	CIRA Viewer
	View Report
	MVD Editor
	MVD Viewer
	Check Capture Operator
	Check Capture Lead Operator
	Check Capture Admin.
	Check Capture Supvr.
	Batch Approver
	Batch Uploader

	Agency PLSA
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Agency LSA
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK

	Accounting Specialist
	BLANK
	•
	•
	•
	•
	•
	•
	•
	•
	BLANK
	BLANK

	Local Accounting Specialist
	BLANK
	•
	•
	•
	•
	•
	•
	•
	•
	BLANK
	BLANK

	Deposit Preparer
	BLANK
	•
	•
	•
	•
	•
	•
	•
	•
	BLANK
	BLANK

	Deposit Approver
	BLANK
	•
	•
	•
	•
	•
	•
	•
	•
	BLANK
	BLANK

	Agency Manager
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK

	CIRA Viewer
	BLANK
	BLANK
	•
	•
	•
	•
	•
	•
	•
	BLANK
	BLANK

	View Report
	BLANK
	•
	BLANK
	•
	•
	•
	•
	•
	•
	BLANK
	BLANK

	MVD Editor
	•
	•
	•
	BLANK
	•
	•
	•
	•
	•
	BLANK
	BLANK

	MVD Viewer
	
	•
	•
	•
	BLANK
	•
	•
	•
	•
	BLANK
	BLANK

	Card Administrator
	blank
	blank
	blank
	blank
	blank
	•
	•
	•
	•
	blank
	blank

	Card Operator
	blank
	blank
	blank
	blank
	blank
	•
	•
	
	•
	blank
	blank

	Check Capture Operator
	BLANK
	•
	•
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•

	Check Capture Lead Operator
	BLANK
	•
	•
	•
	•
	BLANK
	BLANK
	•
	•
	•
	•

	Check Capture Administrator
	•
	•
	•
	•
	•
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK

	Check Capture Supervisor
	•
	•
	•
	•
	•
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK

	Batch Approver
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK

	Batch Uploader
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK




[bookmark: _Toc43803305]Financial Institution (FI) User Role Combinations
Table 6 below shows financial institution user roles that can be combined and assigned to an individual user. “•” indicates that the role in the column heading can be combined with the role to the far left of it.
[bookmark: _Ref486242923][bookmark: _Toc13076378]Table 6. Combinable Financial Institution User Roles
	Financial Institution (FI)
User Roles
	FI PLSA
	FI LSA
	FI Confirmer
	FI Viewer

	FI PLSA
	BLANK
	BLANK
	BLANK
	•

	FI LSA
	BLANK
	BLANK
	BLANK
	•

	FI Confirmer
	BLANK
	BLANK
	BLANK
	•

	FI Viewer
	•
	•
	•
	BLANK


[bookmark: _Toc43803306]System Tasks by Agency and Financial Institution (FI) Roles
The two tables below show the system tasks that can be performed by Agency and Financial Institution/Federal Reserve Bank (FI/FRB) user roles. “•” indicates that the user role shown in the column heading can perform the task listed to the far left of it.
[bookmark: _Toc13076379]Table 7. Deposit Processing and Reporting Roles
	Deposit Processing & Reporting Task
	Agency PLSA
	Agency LSA
	Agency Acc Spec
	Agency Local Acc Spec
	Agency Dep. Prep.
	Agency Dep. Appr.
	FI/
FRB Viewer
	FI/
FRB PLSA
	FI/
FRB LSA
	FI/
FRB Dep. Confirmer
	FI/
FRB Viewer

	Add/Update/
Delete a User
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK

	Reset Password
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK

	Manage Own Account
	•
	•
	•
	•
	•
	•
	•
	•
	•
	•
	•

	OTCnet Logon and Homepage
	•
	•
	•
	•
	•
	•
	•
	•
	•
	•
	•

	Create/Modify Deposit
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Submit Deposit
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Confirm/Reject Deposit
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK

	View Deposit/
Adjustment Detail
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	•
	BLANK
	BLANK
	•
	•

	Search Deposit/ Adjustment
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	•
	BLANK
	BLANK
	•
	•

	Create Deposit/ Adjustment
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK

	Create Return Item Adjustment
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK

	Modify Organization Hierarchy
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Delete Organization Hierarchy
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Organization Hierarchy
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Search Organization Hierarchy
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Modify Accounting Codes*
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Import Accounting Codes*
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Accounting Codes*
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Modify Endpoint Mappings*
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Modify Custom Labels
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Custom Labels
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Modify Processing Options
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Processing Options
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Modify User Defined Fields
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View user Defined Fields
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Financial Institutions
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•

	View Business Reports
	BLANK
	BLANK
	•
	•
	•
	•
	•
	BLANK
	BLANK
	•
	•

	View Security Reports
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK

	View Administrative Reports
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	•
	BLANK
	BLANK
	•
	•

	Read/View Audit Log
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Reporters Flag
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK



This next table specifies OTCnet Check Capture roles and corresponding permissions at the Agency level.
[bookmark: _Toc13076380]Table 8. Check Capture Roles
	Check Capture Task
	Check Capture Operator
	Check Capture Lead Operator
	Check 
Capture 
Admin.
	Check Capture Supervisor
	Batch Approver*
	Batch Uploader*
	Online/
Offline

	Authorize Duplicates
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Authorize MICR Correction
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Authorize Poor Image Quality
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	Online/
Offline

	Balance Check Amounts
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Change Batch Control Values
	•
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Change Batch Status
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Close Batch
	•
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Edit Batch
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Change Mode
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	Online/
Offline

	Configure Check Capture System (settings)
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	Online/
Offline

	View Check Capture System Configuration
	•
	•
	•
	•
	BLANK
	BLANK
	Online/
Offline

	Configure Batch Manager
	•
	•
	•
	•
	BLANK
	BLANK
	Online/
Offline

	Override Verification
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	Process Transactions (Scan Checks)
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	Online/
Offline

	Approve/
Submit Batch
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	Online/
Offline

	View 
Batch List
	•
	•
	•
	•
	BLANK
	BLANK
	Online/
Offline

	Void Item During Balancing
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	Online/
Offline

	Void Transaction
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	Online/
Offline

	Check Capture System Maintenance (Upgrade Scanner Firmware)
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	Online/
Offline

	Check Capture System Maintenance (Upgrade Application from Online)
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	Offline

	Check Capture System Maintenance (Upgrade Form from Online)
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	Offline

	Upload 
Batch
	BLANK
	BLANK
	BLANK
	•
	BLANK
	•
	Offline

	Acknowledge Batch
	BLANK
	BLANK
	BLANK
	•
	BLANK
	•
	Offline

	Recover From Secondary Storage
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	Offline

	Reset LVD
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	Offline

	Update LVD
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	Offline

	Authorize Old Verification
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	Offline

	Create and Download Local Bridge Credential File
	•
	•
	•
	•
	BLANK
	BLANK
	Online

	Create and Download Initialization File
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	Offline

	Startup of OTCnet Local Bridge (OLB) Application
	•
	•
	•
	•
	
	
	

	Startup of OTCnet Offline Application Server
	•
	•
	•
	•
	•
	•
	Offline

	Upgrade Offline OTCnet Version
	•
	•
	BLANK
	•
	BLANK
	BLANK
	Offline

	Modify Classify Batch
	•
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	View Classify Batch
	•
	•
	•
	•
	BLANK
	BLANK
	Online/
Offline

	Modify Classify Item
	•
	•
	BLANK
	•
	BLANK
	BLANK
	Online/
Offline

	View 
Classify Item
	•
	•
	•
	•
	BLANK
	BLANK
	Online/
Offline

	Download Check Capture Application
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	Offline

	View 
Activity Log
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	Offline

	Read/View Audit Check Capture Module (Partial – Access User’s Own Activities Only)
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	Offline

	Manage Users
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	Offline

	Download User Profiles
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	Offline

	Update User Profiles
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	Offline

	Download OTC Endpoints
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	Offline

	Update OTC Endpoints (Offline)
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	Offline


*Batch Approver and Batch Uploader are sub-roles assigned to users with existing roles.

Table 9 below shows the OTCnet Agency Check Processing user roles and their associated permissions.
[bookmark: _Ref486242960][bookmark: _Toc13076381]Table 9. Check Processing
	Check Processing Task
	Agency Manager
	Check Capture Operator
	Check Capture Lead Operator
	Check Capture Admin.
	Check Capture Supervisor
	CIRA Viewer* 
	View Reports* 
	MVD Editor
	MVD Viewer
	Batch Approver*

	Manage Own Account
	•
	•
	•
	•
	•
	••
	BLANK
	•
	•
	BLANK

	OTCnet Logon and Homepage
	•
	•
	•
	•
	•
	•
	BLANK
	•
	•
	BLANK

	Modify Organization Hierarchy
	BLANK
	BLANK
	•
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Delete Organization Hierarchy
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View organization Hierarchy
	•
	•
	•
	•
	•
	•
	BLANK
	•
	•
	BLANK

	Search Organization
	•
	•
	•
	•
	•
	•
	BLANK
	•
	•
	BLANK

	Create/
Modify Verification Records
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	
	BLANK

	View Verification Records
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK

	Read Block Record Containing Only an ABA
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK

	Create/
Modify Check Capture Site
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Download Release**
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View CIRA
	•
	BLANK
	BLANK
	BLANK
	BLANK
	•
	•
	•
	•
	BLANK

	Read/View Audit Admin (Partial)
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Read/
View Audit Check Capture (All)
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Read/View Audit Check Capture Module (Partial)
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Read/View Audit Check Capture Module (Partial – User’s Own Activity)
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Read/View Audit Check Processing (All)
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK
	•
	BLANK
	BLANK

	Read CIRA Check Image Report
	•
	BLANK
	BLANK
	•
	BLANK
	BLANK
	•
	•
	•
	BLANK

	Read CIRA CSV Report
	•
	BLANK
	BLANK
	•
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK

	Download CIRA CSV Historical Report
	•
	BLANK
	BLANK
	•
	BLANK
	BLANK
	•
	•
	•
	BLANK

	Read Deposit Ticket Report
	•
	BLANK
	BLANK
	•
	BLANK
	BLANK
	•
	•
	•
	BLANK

	Read Debit Voucher Report
	•
	BLANK
	BLANK
	•
	BLANK
	BLANK
	•
	•
	•
	BLANK

	Modify Accounting Codes
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Import Accounting Codes
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Accounting Codes
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	•
	BLANK
	BLANK
	BLANK

	Modify Endpoint Mappings
	BLANK
	BLANK
	BLANK
	•
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	Modify Summary level Classification Flag
	BLANK
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Summary Level Classification Flag
	•
	•
	•
	•
	•
	•
	BLANK
	•
	•
	BLANK

	Edit Agency Comments
	BLANK
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Agency Comments
	•
	•
	•
	•
	•
	•
	BLANK
	•
	•
	BLANK

	Modify Processing Options
	BLANK
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	View Processing Options
	BLANK
	BLANK
	•
	BLANK
	•
	BLANK
	BLANK
	BLANK
	BLANK
	BLANK

	ACR Activity Report
	•
	BLANK
	BLANK
	•
	BLANK
	BLANK
	•
	•
	•
	BLANK


*CIRA Viewer, View Reports, and Batch Approver are sub-roles assigned to users with existing roles.
**Download Release – includes downloading firmware, OTCnet Offline software, the OTCnet Local Bridge (OLB) application, and Security Updates.


	[bookmark: _Toc13076382]Card Processing Task
	Card Operator
	Card Administrator
	Card Uploader*

	Manage Own Account
	•
	•
	BLANK

	OTCnet Logon and Homepage
	•
	•
	BLANK

	Modify Organization Hierarchy
	BLANK
	•
	BLANK

	Delete Organization Hierarchy
	BLANK
	•
	BLANK

	View Organization Hierarchy
	•
	•
	BLANK

	Search Organization
	•
	•
	BLANK

	Process Card Payments
	•
	BLANK
	BLANK

	Print Receipts
	•
	
	

	Card Transaction Query
	•
	BLANK
	BLANK

	Modify User Defined Fields (UDF)
	
	•
	

	View User Defined Fields (UDF)
	
	•
	

	Manage Card Process – Modify Terminal Configuration
	
	•
	BLANK

	Manage Card Process – View Terminal Configuration 
	B•LANK
	•
	BLANK

	Download OTCnet Local Bridge
	BLANK
	•
	BLANK

	Create OTCnet Local Bridge OLB Credentials
	•
	•
	

	Import OTCnet Local Bridge OLB Credentials
	•
	•
	

	Read/View Audit Admin – (Partial)
	BLANK
	•
	BLANK

	Read/View Audit Card Module – (All)
	BLANK
	•
	BLANK

	Read/View Audit Card Module – (Partial – Access User's Own Activities Only)
	•
	BLANK
	BLANK

	Card Web Service
	BLANK
	BLANK
	•


Table 10. Card Processing


*The Card Uploader is a self-service kiosk-server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions.
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Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one or many agency defined accounting codes or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations, and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so), or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

[bookmark: _Hlk9339520][bookmark: _Hlk9521334]Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

[bookmark: _Hlk18600587]Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

[bookmark: _Hlk9590158]Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

[bookmark: _Hlk18600759][bookmark: _Hlk9496512]Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System. 

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

[bookmark: _Hlk18600831]Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU, and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.

D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. User Defined Field 1 is usually the SSN number of an individual.

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

[bookmark: _Hlk18603143]Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file, and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

[bookmark: _Hlk18603253][bookmark: _Hlk18603235]Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines if the check is handled through Check 21 (non-personal) or FedACH (personal).

K
Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

 Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, deposit processing, scanning checks, processing card payments and printing receipts. 
L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

[bookmark: _Hlk59390538]Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

[bookmark: _Hlk18603470]Merchant Identification Number (MID) – A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

[bookmark: _Hlk18604005]OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

[bookmark: _Hlk18604024]OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity, and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 

Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.

R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.

S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 

SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

[bookmark: _Hlk18604228]SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.

T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 
Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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[bookmark: _Toc426719674][bookmark: _Toc490834160]Audience, Overview, and Topics
[bookmark: _Toc270283779][bookmark: _Toc270289676][bookmark: _Toc270335618][bookmark: _Toc317687309][bookmark: _Toc362603769][bookmark: _Toc362604036][bookmark: _Toc363682819][bookmark: _Toc467493537][bookmark: _Toc490834161]Audience
The intended audience for the Accessing and Navigating OTCnet Participant User Guide includes:
1. [bookmark: _Toc270283780][bookmark: _Toc270289677][bookmark: _Toc270335619]All OTCnet Users

[bookmark: _Toc317687310][bookmark: _Toc362603770][bookmark: _Toc362604037][bookmark: _Toc363682820][bookmark: _Toc467493538][bookmark: _Toc490834162]Overview
Welcome to Accessing and Navigating OTCnet. In this chapter, you will learn:
2. How to start and stop the OTCnet Local Bridge (OLB) application
3. How to log in to OTCnet Online/Offline
4. How to access your User ID and reset your Password
5. How to navigate the OTCnet Online/Offline home page

[bookmark: _Toc270283781][bookmark: _Toc270289678][bookmark: _Toc270335620][bookmark: _Toc317687311][bookmark: _Toc362603771][bookmark: _Toc362604038][bookmark: _Toc363682821][bookmark: _Toc467493539][bookmark: _Toc490834163]Topics
The topics of this chapter are:
6. Logging in to OTCnet Online/Offline 
7. Accessing a User ID and Resetting Passwords
8. Navigating the OTCnet Online/Offline Home Page


[bookmark: _Toc490834164]Topic 1. Starting and Stopping the OTCnet Local Bridge (OLB) Application
[bookmark: _Hlk16140206]The OTCnet Local Bridge (OLB) application is required for terminal detection and performing check capture, check processing and card processing tasks. The OLB application is also required if you are using the Deployable Disbursing System (DDS) Interface (DoD only). If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, the OLB application must be started on the workstation in order to perform terminal configuration, check capture, check processing, and card processing tasks.

Note: For newer versions of the OLB (1.3.0 and higher) the OLB certificate is included in the OLB installer file. You do not have to separately install the OLB certificate. For OLB versions 1.2.0 and below, however, for the OLB application to function properly with OTCnet, users are required to separately install the OLB Certificate on the terminal. Review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) for additional information.

Before starting the OLB application, ensure the following steps have been completed in this order:
1. The Check Capture Administrator and Card Administrator downloaded the OLB application
2. The OLB certificate is installed on the terminal (for OLB versions 1.2.0 and below)
3. The OLB application is installed on the terminal
4. Each user has created their OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated) 
5. Each user has imported their OLB credentials to the terminal
[bookmark: _Hlk536195158]For step-by-step instructions, refer to the Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, Create the OTCnet Local Bridge (OLB) Profile, and Import OTCnet Local Bridge (OLB) Credentials printable job aids.

There is no “timeout” with the OLB application (i.e., a suspension or break in OTCnet activity). Therefore, the OLB application will stay connected unless one of the following occurs:
6. The user logs out of the workstation (Windows session)
7. The terminal is restarted or rebooted
8. The user stops the OLB application on the terminal

If a user logs in to perform one of these operations and the OLB application has not been started, the user will receive the following message: Terminal detection failed. Please ensure that the OLB application is running.


[bookmark: _Toc490834165]How to Start and Stop the OTCnet Local Bridge (OLB) Application
To start the OTCnet Local Bridge (OLB) application, complete the following steps:

1. Double-click the Start OTCnet Local Bridge icon located on the terminal’s desktop (see Figure 1).
[bookmark: _Ref486179882][bookmark: _Toc40079838]Figure 1. Start OTCnet Local Bridge Icon
[image: ]

Or

Click Start>Programs>Start OTCnet Local Bridge.

If the icon does not reside in either location, contact your Card Administrator or Check Capture Administrator. They can help complete the steps required to install the OLB application on the card terminal and install the OLB Application and the OLB certificate (for OLB versions 1.2.0 and below) for the check capture terminal, create your OLB profile, and import your OLB credentials.

If the OLB application has already been started on the terminal, you will receive an OTCnet Local Bridge Application is already running message.

2. The OTCnet Local Bridge Startup page appears (see Figure 2). Enter your User ID and Password in the appropriate text boxes.

Password Criteria:
9. Must be at least 12 characters long
10. Must contain at least one uppercase letter
11. Must contain at least one lowercase letter
12. Must contain at least one numeric character
13. Must not have more than two repeating characters
14. Must not repeat any of your last ten passwords
15. Must not have been your password during the last ten days
16. Must not be a word in a language, slang, dialect, or jargon
17. Must not be related to personal identity, history, environment, or other personal associations
18. Must not be shared or displayed in plain view


3. Click Log In (see Figure 2). 
[bookmark: _Ref486180351][bookmark: _Toc40079839]Figure 2. OTCnet Local Bridge Startup
[image: ]

4. A Login Successful. OTCnet Local Bridge Application Started message appears (see Figure 3). Click OK.
[bookmark: _Ref486180845][bookmark: _Toc40079840]Figure 3. Login Successful. OTCnet Local Bridge Application Started.
[image: ]

Once you have successfully started the OLB application, you can proceed to log in to OTCnet Online. For details on logging in to OTCnet Online, refer to the Log In to OTCnet Online for the First Time and Log In to OTCnet Online printable job aids.

To stop the OLB application, double-click the Stop OTCnet Local Bridge icon located on the terminal’s desktop (see Figure 4).
[bookmark: _Ref486181194][bookmark: _Toc40079841]Figure 4. Stop OTCnet Local Bridge Icon
[image: ]
Or

Click Start>Programs>Stop OTCnet Local Bridge.

A Stop OTCnet Local Bridge window and an Are you sure you want to stop the OTCnet Local Bridge Application? message appear (see Figure 5). Click Yes.
[bookmark: _Ref486181344][bookmark: _Toc40079842]Figure 5. Stop OTCnet Local Bridge
[image: ]

If you click No, the Are you sure you want to stop the OTCnet Local Bridge Application? message closes, and the OLB application remains running. Stopping the OLB application ensures the application is completely closed and that your OTCnet session is terminated securely.

Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the terminal, ensure that it is stopped before uninstalling the application.


[bookmark: _Toc490834166][bookmark: _Hlk26256096][image: Description: MCj04420720000[1]]Start and Stop the OTCnet Local Bridge (OLB) Application
	[image: ]Application Tip
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users performing terminal configuration, check capture, check processing operations and card processing. If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, the OLB application must be started on the terminal to perform these operations.
Before starting the OLB application, ensure the following steps have been completed in this order:
9. The Check Capture Administrator and Card Administrator downloaded the OLB application
10. The OLB certificate is installed on the terminal (for OLB versions 1.2.0 and below)
11. The OLB application is installed on the terminal
12. Each user has created their OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated) 
13. Each user has imported their OLB credentials to the terminal
For step-by-step instructions, refer to the Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, Create the OTCnet Local Bridge (OLB) Profile, and Import OTCnet Local Bridge (OLB) Credentials printable job aids.





	[image: ]Application Tip
There is no “timeout” with the OLB application (i.e., a suspension or break in OTCnet activity). Therefore, the OLB application will stay connected unless one of the following occurs:
14. The user logs out of the workstation (Windows session)
15. The terminal is restarted or rebooted
16. The user stops the OLB application on the terminal



	[image: ]Application Tip
If a user logs in to perform terminal configuration, check processing, check capture operations, or card processing, and the OLB application has not been started, the user will receive the following message: “Terminal detection failed. Please ensure that the OLB application is running.”



To start the OTCnet Local Bridge (OLB) application, complete the following steps:

· Double-click the Start OTCnet Local Bridge icon located on the terminal’s desktop.

Or

Click Start>Programs>Start OTCnet Local Bridge.

	[image: ]Application Tip
If the icon does not reside in either location, contact your Card Administrator or Check Capture Administrator. They can help complete the steps required to install the OLB application on the card terminal and install the OLB Application and the OLB certificate (for OLB versions 1.2.0 and below) for the check capture terminal, create your OLB profile, and import your OLB credentials.



	[image: ]Application Tip
If the OLB application has already been started on the terminal, you will receive an OTCnet Local Bridge Application is already running message.



· The OTCnet Local Bridge Startup page appears. Enter your User ID and Password in the appropriate text boxes.


	[image: ]Application Tip
Note that this password is the same password entered when you created your OLB profile. The criteria for this password include the following:
· Must be at least 12 characters long 
· Must contain at least one upper case letter
· Must contain at least one lower case letter
· Must contain at least one numeric character
· Must not have more than two repeating characters
· Must not repeat any of your last ten passwords
· Must not have been your password during the last ten days
· Must not be a word in a language, slang, dialect, or jargon
· Must not be related to personal identity, history, environment, or other personal associations
· Must not be shared or displayed in plain view



· Click Log In. 

	[image: ]Application Tip
If you click Cancel, the Are you sure you want to exit message appears. Click Yes to cancel the OLB startup. Click No to return to the OTCnet Local Bridge Startup page.



· A Login Successful. OTCnet Local Bridge Application Started message appears. Click OK.

Once you have successfully started the OLB application, you can proceed to log in to OTCnet Online.

	[image: ]Application Tip
For details on logging in to OTCnet Online, refer to the Log In to OTCnet Online for the First Time and Log In to OTCnet Online printable job aids.





	[image: ]Application Tip
To stop the OLB application, double-click the Stop OTCnet Local Bridge icon located on the terminal’s desktop. 
Or
Click Start>Programs>Stop OTCnet Local Bridge.
A Stop OTCnet Local Bridge window and an Are you sure you want to stop the OTCnet Local Bridge Application? message appear. Click Yes.
If you click No, the Are you sure you want to stop the OTCnet Local Bridge Application? message closes, and the OLB application remains running.
Stopping the OLB application ensures the application is completely closed and that your OTCnet session is terminated securely.



	[image: ]Application Tip
Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the terminal, ensure that it is stopped before uninstalling the application. 
For information on installing and uninstalling the OLB application, refer to the Install the OTCnet Local Bridge (OLB) Application printable job aid.





[bookmark: _Toc426719675][bookmark: _Toc490834167]Topic 2. Logging In to OTCnet Online/Offline
[bookmark: _Hlk16156392]To access OTCnet Online you must have your Fiscal Service Single Sign On User ID and Password. To obtain your user ID, contact your Primary Local Security Administrator (PLSA) or your Local Security Administrator (LSA). After your User ID is created, you will receive an email with a temporary password. 

The first time you log in to OTCnet Online Single Sign On, you will be required to change your password, accept the Rules of Behavior, provide challenge and response questions used for secondary authentication, and enter a shared secret that is used when calling the Fiscal Service Help Desk. Before accessing OTCnet Online, you must first accept the Rules of Behavior, answer the challenge questions and shared secret. 

[bookmark: _Hlk535276876]To log in to OTCnet Offline, you must have your User ID and temporary password. Your User ID is the same User ID you use to log in to OTCnet Online; however, your initial temporary password is different from your password used to access OTCnet Online. To obtain your temporary password, contact your Check Capture Administrator. 

After you obtain your temporary password, you can log in to OTCnet Offline. To log in to OTCnet Offline, double-click the OTCnet Offline (Production or QA) icon on your terminal’s desktop or click Start >Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA). 

If the icon does not reside in either location, contact your Check Capture Administrator to configure the terminal. If a terminal has more than one version of the OTCnet Offline application (Production or QA), do not run both at the same time as running more than one version at a time will cause errors.

As an added layer of security, you will need to first start and log in to the OTCnet Offline server before accessing the OTCnet Offline application. To start the Offline server, enter your User ID and Offline password. If this is the first time you are accessing OTCnet Offline, enter your temporary password. Once you have successfully started up the Offline server, you will be prompted to log in to the OTCnet Offline application. 

If the Offline server has already been started, you will skip this step and log directly in to the OTCnet Offline application. The first time you log in to the OTCnet Offline application you will be required to change your password. After your permanent password is set you will use your permanent password to startup the Offline server and/or Offline application.

Note: To stop the OTCnet Offline application, access the Start Menu, then Programs and click Stop OTCnet Offline. Stopping the OTCnet Offline application ensures the application is completely closed and that your OTCnet session is terminated securely.
[bookmark: _Toc426719676][bookmark: _Toc490834168]

How to Log in to OTCnet Online for the First Time 
Once you have received your User ID and generic password, you will want to access the OTCnet application to create a permanent password.

The OTCnet Local Bridge (OLB) application is required for performing check processing, check capture, card processing and terminal configuration operations. If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, the OLB application must be started on the terminal in order to perform these operations. Refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid for more details.

To log in to Fiscal Service Single Sign On (OTCnet Online) for the first time, complete the following steps:

1. [bookmark: _Hlk495933956]Access https://otcnet.fms.treas.gov and enter your User ID and Password in the appropriate text boxes, and click Log In as shown in Figure 6.
[bookmark: _Ref455759457][bookmark: _Ref455759423][bookmark: _Toc40079843]Figure 6. Fiscal Service Single Sign On Page
[image: ]


2. The Password Change: Create New Password page appears. Enter your temporary Password, New Password, and Confirm New Password and click Change Password (see Figure 7).

Password Criteria:
19. Must be at least 12 characters long
20. Must contain at least one uppercase letter
21. Must contain at least one lowercase letter
22. Must contain at least one numeric character
23. Must not have more than two repeating characters
24. Must not repeat any of your last ten passwords
25. Must not have been your password during the last ten days
26. Must not be a word in a language, slang, dialect, or jargon
27. Must not be related to personal identity, history, environment, or other personal associations
28. Must not be shared or displayed in plain view
[bookmark: _Ref455759520][bookmark: _Toc40079844]Figure 7. Password Change Page
[image: ]


3. A confirmation page appears stating your new password has been set. Click Continue (see Figure 8).


[bookmark: _Ref455759821][bookmark: _Toc40079845]Figure 8. Password Change: Password Set
[image: ]

4. The Change Challenge/Response – Select and Provide Reponses to Questions page appears. Select any three challenge questions you want to response to by clicking the check boxes next to the questions. 

Provide your responses in the Response and Confirm Response fields. Each response must be at least three characters long and are case sensitive. Click Save My Questions and Responses (see Figure 9. Select and Provide Responses to Questions Page).
[bookmark: _Ref455759831][bookmark: _Toc40079846]Figure 9. Select and Provide Responses to Questions Page
[image: ]

5. A Change Shared Secret page appears. Enter a Shared Secret phrase, a Confirm Shared Secret phrase, and then click Save My Shared Secret (see Figure 10). The shared secret phrase must be at least three characters. 
You will not be able to proceed to OTCnet until the Challenge questions and Share Secret are set.


[bookmark: _Ref455759842][bookmark: _Toc40079847]Figure 10. Challenge Shared Secret Page
[image: ]
6. The Change Challenge/Response-Completed page appears. Click Logout.

After your challenge questions and responses as well as your shared secret are successfully saved, wait 15 minutes prior to accessing OTCnet.

7. Click Logout (see Figure 11).
[bookmark: _Ref455759850][bookmark: _Toc40079848]Figure 11. Logout Browser Page
[image: ]

8. Access https://otcnet.fms.treas.gov and enter your User ID and Password in the appropriate text boxes, and click Log In (see in Figure 6).

By logging in with your PIV, SecurID, or User ID and Password, you acknowledge and agree that you have read, understand, and agreed to abide by the Rule of Behavior. 


[bookmark: _Toc467493542][bookmark: _Toc490834169][image: MCj04420720000[1]]Log in to OTCnet Online For the First Time
To log in to Fiscal Service Single Sign On (OTCnet Online) for the first time, complete the following steps:

	[image: ]Application Tip
The OTCnet Local Bridge (OLB) application is required for performing check processing, check capture, card processing and terminal configuration operations. If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, the OLB application must be started on the terminal in order to perform these operations. Refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid for more details.



To log in to Fiscal Service Single Sign On (OTCnet Online) for the first time, complete the following steps:

1. Access https://otcnet.fms.treas.gov.

2. Enter your User ID and Password in the appropriate text boxes, and click Log In. The Password Change: Create New Password page appears.

Enter your temporary Password, New Password, and Confirm New Password.

Password Criteria:
29. Must be at least 12 characters long
30. Must contain at least one uppercase letter
31. Must contain at least one lowercase letter
32. Must contain at least one numeric character
33. Must not have more than two repeating characters
34. Must not repeat any of your last ten passwords
35. Must not have been your password during the last ten days
36. Must not be a word in a language, slang, dialect, or jargon
37. Must not be related to personal identity, history, environment, or other personal associations
38. Must not be shared or displayed in plain view

3. Click Change Password. A confirmation page appears stating your new password has been set.

4. Click Continue. The Change Challenge/Response – Select and Provide Reponses to Questions page appears.

· Select any three challenge questions you want to respond to by clicking the check boxes next to the questions and provide your responses in the Response and Confirm Response fields. 

	[image: ]Application Tip
Each response must be at least three characters long, and each response is case sensitive.


· Click Save My Questions and Responses. A Change Shared Secret page appears.

· Enter a Shared Secret phrase and Confirm Shared Secret phrase. 
	[image: ]Application Tip
The shared secret phrase must be at least three characters. You will not be able to proceed to OTCnet until the Challenge questions and Shared Secret are set.


· Click Save My Shared Secret. A confirmation page appears showing the challenge questions and responses and your new shared secret were successfully saved. 

· Click Logout.

	[image: ]Application Tip
After your challenge questions and responses as well as your shared secret are successfully saved, wait 15 minutes prior to accessing OTCnet.



· Access OTCnet (https://otcnet.treas.gov), enter your User ID and Password in the appropriate text boxes, and click Log In.

	[image: ]Application Tip
By logging in with your PIV, SecurID, or User ID and Password, you acknowledge and agree that you have read, understand, and agreed to abide by the Rule of Behavior.





[bookmark: _Toc490834170]How to Log In to OTCnet Online
Once you have changed your password, responded to the challenge questions, and established a shared secret, you can log in to OTCnet to access functionality for one or more of the following:

39. Administration
40. Deposit Processing and Reporting
41. Check Capture
42. Check Processing
43. Card Processing
44. Access User Identity (ID) and Reset Password

The OTCnet Local Bridge (OLB) application is required for performing check processing, check capture, card processing and terminal configuration operations. If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, the OLB application must be started on the terminal in order to perform these operations. Refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid for more details.

To log in to OTCnet Online, complete the following steps:
1. Access https://otcnet.fms.treas.gov and enter your User ID and Password in the appropriate text boxes, and click Log In as shown in Figure 12.
[bookmark: _Ref455759548][bookmark: _Toc40079849]Figure 12. Fiscal Service Single Sign On Page
	[image: ]	


2. The OTCnet Home Page appears. See Figure 13 below.
Figure 13. OTCnet Home Page
[image: ]
Once you have logged in to OTCnet, you can review the Privacy Statement link at the bottom of the page, as well as the Accessibility Statement link (see Figure 14).
[bookmark: _Ref455759576][bookmark: _Toc40079851]Figure 14. OTCnet Home Page Privacy Statement
[image: ]

[bookmark: _Hlk16138987]As a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, when logging into OTCnet Online and using Google Chrome, the OTCnet splash screen does not appear. The OTCnet splash screen does appear for Internet Explorer (IE) users: Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, when setting up OTCnet. 




[bookmark: _Toc467493544][bookmark: _Toc490834171][image: MCj04420720000[1]]Log In to OTCnet Online
	[image: ]Application Tip
The OTCnet Local Bridge (OLB) application is required for performing check processing, check capture, card processing and terminal configuration operations. If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, the OLB application must be started on the terminal in order to perform these operations. Refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid for more details.



To log in to Fiscal Service Single Sign On (OTCnet Online), complete the following steps:

1. Access https://otcnet.fms.treas.gov.

2. Enter your User ID and Password in the appropriate text boxes, and click Log In. The OTCnet Home Page appears. 

	[image: ]Application Tip

	As a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, when logging into OTCnet Online and using Google Chrome, the OTCnet splash screen does not appear. The OTCnet splash screen does appear for Internet Explorer (IE) users: Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, Check Capture Operator, Card Operator or Card Administrator, when setting up OTCnet. 







[bookmark: _Toc426719678][bookmark: _Toc490834172]


How to Start the OTCnet Offline Server
As an added layer of security, the Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, and Check Capture Operator must first start and log in to the OTCnet Offline server before accessing the OTCnet Offline application. If the OTCnet Offline server has already been started, you will skip this step and log directly in to the OTCnet Offline application. You can identify the Offline Server log in page, as it is smaller in size and the Retrieve Admin Profile link does not appear on the page. 

To log start the OTCnet Offline server, complete the following steps:

· Double-click the OTCnet Offline (Production or QA) icon located on your terminal’s desktop or click Start >Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA) (see Figure 15).

If the icon does not reside in either location, contact your Check Capture Administrator to configure the terminal.

If a terminal has more than one version of the OTCnet Offline application (Production or QA), do not run both at the same time as running more than one version at a time will cause errors.
[bookmark: _Ref455759694][bookmark: _Toc40079852]Figure 15. OTCnet Offline Icon
[image: ]
· The OTCnet Offline Server Startup page appears. Enter your User ID and Password in the appropriate text boxes and click Log In (see Figure 16).
[bookmark: _Toc40079853]Figure 16. OTCnet Offline Server Startup
[image: figure 12]



[bookmark: _Toc467493546][bookmark: _Toc490834173][image: Description: MCj04420720000[1]]Start the OTCnet Offline Server

To start the OTCnet Offline server, the Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, and Check Capture Operator must complete the following steps:

· Double-click the OTCnet Offline (Production or QA) icon located on your terminal’s desktop. 

Or 

Click Start>Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA).
	[image: ]Application Tip
If the icon does not reside in either location, contact your Check Capture Administrator to configure the offline terminal.



	[image: ]Application Tip
If a terminal has more than one OTCnet Offline application installed (Production or QA training environment), do not run both at the same time as running more than one offline client at a time will cause errors.


· Enter your User ID and Password in the appropriate text boxes, and click Log In. The OTCnet Login page appears.
	[image: ]Application Tip
The Offline Server Startup prompt appears as a standalone prompt, outside of the browser.



	[image: ]Application Tip 
If you are a Check Capture Administrator and this is your first time starting the OTCnet Offline server and logging in to OTCnet, enter the temporary password you created when you created your Check Capture Administrator Offline Logon Profile.



	[image: ]Application Tip
If you are a not a Check Capture Administrator and this is your first time starting the OTCnet Offline server and logging in to OTCnet, enter your temporary password.



	[image: ]Application Tip
If the Offline server was previously started, you will skip this step and log in to the OTCnet Offline application. Refer to the Log In to OTCnet Offline for the First Time and Log In to OTCnet Offline printable job aids for more details. If the Offline server was not been previously started, you will need to enter your credentials to start up the Offline server.



	[image: ]Application Tip
After your credentials are successfully authenticated, the Offline Check Capture application log in page is displayed.



	[image: ]Application Tip
If you have forgotten your Offline password or you are not authorized to start the OTCnet Offline application, contact your Check Capture Administrator to reset/create your offline password.


[bookmark: _Toc426719679][bookmark: _Toc490834174]
How to Log In to OTCnet Offline for the First Time
Once you have received your User ID and temporary password from your Check Capture Administrator, you will want to access the OTCnet Offline application to create a permanent password.

If you are a Check Capture Supervisor, Check Capture Lead Operator, or Check Capture Operator and are logging in to OTCnet Offline for the first time, complete the following steps:

· Double-click the OTCnet Offline (Production or QA) icon located on your terminal’s desktop or click Start >Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA) (see Figure 17).

If the icon does not reside in either location, contact your Check Capture Administrator to configure the terminal.

If a terminal has more than one version of the OTCnet Offline application (Production or QA), do not run both at the same time as running more than one version at a time will cause errors.
[bookmark: _Ref455759596][bookmark: _Toc40079854]Figure 17. OTCnet Offline Icon
[image: new offline icon]
· Enter your User ID and temporary Password in the appropriate text boxes and click Log In (see Figure 18).

If you are a Check Capture Administrator and this is the first-time logging into OTCnet Offline or need to download user profiles, click the Retrieve Admin Profile link.
[bookmark: _Ref455759605][bookmark: _Toc40079855]Figure 18. OTCnet Offline User Login Page
[image: ]

· The Set Permanent Password page appears. Enter your temporary Password, New Password, and Re-Enter New Password and click Save (see Figure 19).

Password Criteria:
· Must be at least 12 characters long
· Must contain at least one uppercase letter
· Must contain at least one lowercase letter
· Must contain at least one numeric character
· Must not have more than two repeating characters
· Must not repeat any of your last ten passwords
· Must not have been your password during the last ten days
· Must not be a word in a language, slang, dialect, or jargon
· Must not be related to personal identity, history, environment, or other personal associations
· Must not be shared or displayed in plain view
[bookmark: _Ref455759618][bookmark: _Toc40079856]Figure 19. Set Permanent Password
[image: ]



· A Confirmation page appears stating your new password has been set.

After the profile is successfully downloaded and the password is reset, you will be prompted to log in to the system with your new password. Click Return to Login Page to login to the OTCnet Offline (see Figure 20).
[bookmark: _Ref455759638][bookmark: _Toc40079857]Figure 20. Password Reset Confirmation
[image: ]
To stop the OTCnet Offline application, click Start Menu>Programs> OTCnet Offline (Production or QA)>Stop OTCnet Offline (Production or QA). Stopping the OTCnet Offline application ensures the application is completely closed and that your OTCnet session is terminated securely. It is recommended that after stopping OTCnet Offline, wait at least one to two minutes before restarting.

If more than one version of the OTCnet Offline application resides on a terminal, be sure to stop the correct version of the OTCnet Offline application (Stop OTCnet Offline Production or QA).


[bookmark: _Toc467493548][bookmark: _Toc490834175][image: Description: MCj04420720000[1]]Log in to OTCnet Offline for the First Time
Once you have received your User ID and temporary password from your Check Capture Administrator, you will want to access the OTCnet Offline application to create a permanent password.

If you are a Check Capture Supervisor, Check Capture Lead Operator, or Check Capture Operator and are logging in to OTCnet Offline for the first time:

1. Double-click the OTCnet Offline (Production or QA) icon located on your computer’s desktop. 

Or 

Click Start>Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA). 
	[image: ]Application Tip
If you cannot locate the icon in either of these locations, contact your Check Capture Administrator.



	[image: ]Application Tip
If a computer has more than one version of the OTCnet Offline application (Production or QA), do not run both at the same time. This will cause errors.


2. Enter your User ID and temporary Password in the appropriate text boxes, and click Log In. The Set Permanent Password page appears.
	[image: ]Application Tip
If you are a Check Capture Administrator and this is your first-time logging into OTCnet Offline or need to download user profiles, click the Retrieve Admin Profile link. 


3. 
Enter your temporary Password, New Password, and Re-Enter New Password.
	
[image: ]Application Tip
Password Criteria:
45. Must be at least 12 characters long
46. Must contain at least one uppercase letter
47. Must contain at least one lowercase letter
48. Must contain at least one numeric character
49. Must not have more than two repeating characters
50. Must not repeat any of your last ten passwords
51. Must not have been your password during the last ten days
52. Must not be a word in a language, slang, dialect, or jargon
53. Must not be related to personal identity, history, environment, or other personal associations
54. Must not be shared or displayed in plain view


4. Click Save. A Confirmation page appears stating your new password has been set.
	[image: ]Application Tip
After the profile is successfully downloaded and password was reset, you will be prompted to log in to the system with your new password.



	[image: ]Application Tip
To stop the OTCnet Offline application, click Start Menu>Programs> OTCnet Offline (Production or QA)>Stop OTCnet Offline (Production or QA). Stopping the OTCnet Offline application ensures the application is completely closed and that your OTCnet session is terminated securely. After stopping OTCnet Offline, wait at least two minutes before restarting to ensure that OTCnet Offline was shut down completely.




[bookmark: _Toc426719680][bookmark: _Toc490834176]How to Log in to OTCnet Offline
If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, or Check Capture Operator and you have reset your temporary password, you can log in to OTCnet Offline. You can click the Return to Login Page to be returned to the Login Page. If you choose not to immediately access OTCnet Offline after resetting your temporary password, you can double-click the OTCnet Offline icon or access your Start Menu under Programs. 

To log in to OTCnet Offline, complete the following steps:

1. Double-click the OTCnet Offline (Production or QA) icon located on your terminal’s desktop or click Start >Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA) (see Figure 21).

If the icon does not reside in either location, contact your Check Capture Administrator to configure the terminal.

If a terminal has more than one version of the OTCnet Offline application (Production or QA), do not run both at the same time as running more than one version at a time will cause errors.
[bookmark: _Ref455759721][bookmark: _Toc40079858]Figure 21. OTCnet Offline Icon
[image: ]
2. Enter your User ID and Password in the appropriate text boxes and click Log In (see Figure 22). The OTCnet Home Page appears.
[bookmark: _Ref455759706][bookmark: _Toc40079859]Figure 22. OTCnet Offline User Login Page
[image: ]

[bookmark: _Toc317687317]To stop the OTCnet Offline application, access the Start Menu, select Programs>OTCnet Offline and click Stop OTCnet Offline. 

Stopping the OTCnet Offline application ensures the application is completely closed and that your OTCnet session is terminated securely.


[bookmark: _Toc467493550][bookmark: _Toc490834177][image: Description: MCj04420720000[1]]Log in to OTCnet Offline 
If you are a Check Capture Administrator, Check Capture Supervisor, Check Capture Lead Operator, or Check Capture Operator and you have reset your temporary password, you can log in to OTCnet Offline. 

To log in to OTCnet Offline, complete the following steps:

1. Double-click the OTCnet Offline (Production or QA) icon located on your terminal’s desktop. 

Or 

Click Start>Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA). 
	[image: ]Application Tip
If the icon does not reside in either location, contact your Check Capture Administrator to configure the terminal.



	[image: ]Application Tip
If a terminal has more than one version of the OTCnet Offline application (Production or QA), do not run both at the same time as running more than one version at a time will cause errors.



	[image: ]Application Tip
If the Offline server was not been previously started, you will need to enter your User ID and password to start up the Offline server. Refer to the Start up the OTCnet Offline Server printable job aids for more details.



2. Enter your User ID and Password in the appropriate text boxes, and click Log In. The OTCnet Home Page appears.



	[image: ]Application Tip
To stop the OTCnet Offline application, click Start>Programs>OTCnet Offline (Production or QA)>Stop OTCnet Offline (Production or QA). Stopping the OTCnet Offline application ensures the application is completely closed and that your OTCnet session is terminated securely. It is recommended that after stopping OTCnet Offline, wait at least one to two minutes before restarting. 



	[image: ]Application Tip
If more than one version of the OTCnet Offline application resides on a terminal, be sure to stop the correct version of the OTCnet Offline application (Stop OTCnet Offline Production or QA).





[bookmark: _Toc490834178]Topic 3. Accessing a User ID and Resetting Passwords
To obtain your user ID or reset your password, contact your PLSA or LSA. You can also have your User ID, or a temporary password emailed to you. Once you sign in with your temporary password, you will need to reset it.

[bookmark: _Toc426719682][bookmark: _Toc490834179][bookmark: _Toc140379729]Access a User ID
To access a user ID, complete the following steps:

5. [bookmark: _Toc251088493][bookmark: _Toc251088809]From the Single Sign On page, click on the Forgot your User ID? link shown in
Figure 23 below. 
[bookmark: _Ref455760019][bookmark: _Toc40079860]Figure 23. Single Sign On Page (Forgot Your User ID? Link)
[image: ]

6. The Treasury Self Service page appears. Enter the words you seen in the image in the text box and click Next (see Figure 24).

If you want to receive a new image of the text, click on New Image. To hear the set of characters and enter them in the text box, click Audio Test. You can click on Help to receive detailed instructions.


[bookmark: _Ref455760032][bookmark: _Toc40079861]Figure 24. Treasury Self Service Page (Enter Text of Image)
[image: ]
7. Enter your email address and click Next (see Figure 25). A confirmation page appears showing your request for your User ID has been completed.
[bookmark: _Ref455760078][bookmark: _Toc40079862]Figure 25. Forgot User ID (Enter Email Address)
[image: ]
8. Click Finish.


[bookmark: _Toc467493553][bookmark: _Toc490834180][image: MCj04420720000[1]]Access User ID
To obtain your user ID or reset your password, contact your PLSA or LSA. You can also have your User ID, or a temporary password emailed to you. Once you sign in with your temporary password, you will need to reset it.

To access your user ID, complete the following steps:

1. From the Fiscal Service Single Sign On page, click Forgot your User ID? The Self-Service Account/Password Reset page appears.

2. Enter the characters that you see in the image in the text box and click Next. The Treasury Enterprise ID page appears.

3. Enter your email address and click Next. A confirmation page appears showing your request for your User ID has been completed. 

4. Click Finish.

[bookmark: _Toc426719683]

[bookmark: _Toc490834181]Resetting Passwords
To reset a password, complete the following steps:

1. From the Single Sign On page, click on the Forgot your Password? link as shown in Figure 26 below.
[bookmark: _Ref455760130][bookmark: _Toc40079863]Figure 26. Single Sign On Page (Forgot Your Password? Link)
[image: ]
2. The Treasury Self Service page appears. Enter the characters that you see in the image in the text box and click Next (see Figure 27). 
[bookmark: _Ref455760141][bookmark: _Toc40079864]Figure 27. Forgot Your Password Page
[image: ]
3. 
The Treasury Enterprise ID page appears. Enter your Treasury Login (User ID) and click Next (see Figure 28).
[bookmark: _Ref455760156][bookmark: _Toc40079865]Figure 28. Enter Treasury Enterprise ID (User ID)
[image: ]
4. A confirmation page appears. Click Finish (see Figure 29).

You will receive an email to your official email address with further instructions to complete the Self-Service Account/Password Reset process. 
[bookmark: _Ref455760166][bookmark: _Toc40079866]Figure 29. Password Request Confirmation
[image: ]

5. Check your email. After you received the email link to reset your password, copy and paste the entire link (including the equal sign “=”) in the web browser (see Figure 30). 

Each reset password web link is unique. The link shown below is for example purposes only.


[bookmark: _Ref486095124][bookmark: _Toc40079867]Figure 30. Resetting Your Forgotten Password Email
[image: ]

6. The Answer Challenge/Responses Questions Provide Responses page appears.
Enter your answers for the challenge questions and click Reset My Password (see Figure 31). 
[bookmark: _Ref455760179][bookmark: _Toc40079868]Figure 31. Answer Challenge/Response Questions - Provide Responses
[image: ]

7. The Answer Challenge/Response Questions – Change Password page appears. Enter your New Password and Confirm New Password and click Change My Password (see Figure 32).


[bookmark: _Ref455760190][bookmark: _Toc40079869]Figure 32. Answer Challenge/Response Questions - Change Password
[image: ]

8. The Challenge/Response Questions – Completed page appears. Click Close Browser (see Figure 33).
[bookmark: _Ref455760198][bookmark: _Toc40079870]Figure 33. Answer Challenge/Response Questions - Completed
[image: ]

[bookmark: _Toc467493555][bookmark: _Toc490834182]
[image: MCj04420720000[1]]Reset Password
To obtain your user ID or reset your password, contact your PLSA or LSA. You can also have your User ID, or a temporary password emailed to you. Once you sign in with your temporary password, you will need to reset it.

To reset your password, complete the following steps:

· From the Fiscal Service Single Sign On page, click Forgot your Password? The Self-Service Account/Password Reset page appears.

· Enter the characters that you see in the image in the text box and click Next. The Treasury Enterprise ID page appears.

· Enter your Treasury Login (User ID) and click Next. A confirmation page appears. 

· Click Finish.
	[image: ]Application Tip
You will receive an email (Resetting your Forgotten Password) to your official email address with further instructions to complete the Self-Service Account/Password Reset process.


· Check your email. After you received the email link to reset your password, copy and paste the entire link (including the equal sign “=”) in the web browser. The Answer Challenge/Responses Questions Provide Responses page appears.
	[image: ]Application Tip
Check your Junk E-mail folder if you do not receive an email with your password. It is recommended that you add donotreply@fiscal.treasury.gov  to your Safe Senders or Safe Recipients list. 



	[image: ]Application Tip
The email is generated by an automated notification system. The link expires 24 hours after creation after which the process needs to be reinitiated.



· Enter your answers for the challenge questions and click Reset My Password. The Answer Challenge/Response Questions – Change Password page appears. 

	[image: ]Application Tip
Three invalid attempts to answer your challenge questions will result in your account being locked. If your account is locked, call the Customer Support at 866-945-7920 or DSN 510-428-6824, Options 1, 2, 4 to re-activate your account.


· Enter your New Password and Confirm New Password and click Change My Password. The Challenge/Response Questions – Completed page appears.

· Click Close Browser.


[bookmark: _Toc426719684][bookmark: _Toc490834183]Topic 4. Navigating the OTCnet Online/Offline Home Page
The OTCnet Online home page allows Check Capture Supervisors, Check Capture Lead Operators, Check Capture Operators and Card Operators to process deposits, capture checks, process checks, process card transactions, view reports, and perform administrative and security functions. Additionally, a user can access information for training, help and to update a profile. The OTCnet Online home page is accessible for users to either view or perform any of the functionality above.
[bookmark: _Toc426719685]The OTCnet Offline home page allows Check Capture Supervisors, Check Capture Lead Operators and Check Capture Operators to capture checks along with transaction data, perform administrative functions and access information for help. The OTCnet Offline home page is accessible by users to either view or perform any of the functionality above.


[bookmark: _Toc490834184]OTCnet Online Main Menu
To access the OTCnet Main Menu, log in with your User ID and Password by accessing https://otcnet.fms.treas.gov. Table 1 below provides a list of the Main Menu options available to you and accessible on the upper right corner of the OTCnet application (highlighted in yellow).
[bookmark: _Ref455760232][bookmark: _Ref455760228][bookmark: _Toc15734622]Table 1. Main Menu Link Descriptions
	Link
	Description

	Home
	Allows a user to return to the OTCnet home page.

	My Profile
	Allows a user to retrieve his or her User ID or reset a Password.

	Training
	Allows a user to access the WBT training and other corresponding training materials.

	Print
	Allows a user to print the page.

	Help
	Allows a user to access help for the page they are on.

	Log Out
	Allows a user to log out of OTCnet.



The Main Menu is shown in Figure 34. The links are accessible on the upper right side of the OTCnet home page.
[bookmark: _Ref455760364][bookmark: _Ref455760291][bookmark: _Toc40079871]Figure 34. OTCnet Main Menu Page
 [image: ]
[bookmark: _Toc426719686][bookmark: _Toc490834185]OTCnet Online Deposit Processing Tab Functionality
To access the OTCnet Deposit Processing functionality, log in with your user ID and password. Table 2 below provides a list of the Deposit Processing functions that are available to you.
[bookmark: _Ref455760322][bookmark: _Toc15734623]Table 2. Deposit Processing Tab Descriptions
	Function
	Description

	Create Deposit
	Allows a user to create deposits for US Currency, Foreign Check Items, and/or Foreign Currency Cash.

	Search Deposits
	Allows a user to search for deposits.

	Search Adjustments
	Allows a user to search for adjustments.

	Create Returned
Item Adjustment
	Allows a user to create a returned item adjustment.


The Deposit Processing tab is shown in Figure 35. Depending on your user role, you may not see all functionality shown in the image.
[bookmark: _Ref455760351][bookmark: _Ref486184846][bookmark: _Toc40079872]Figure 35. Deposit Processing Tab
[bookmark: _Toc426719687][image: ]


[bookmark: _Toc490834186]OTCnet Online Check Processing Tab Functionality
To access the OTCnet Check Processing functionality, log in with your user id and password. Table 3 provides a list of the Check Processing functions that are available to you. 
[bookmark: _Ref455760392][bookmark: _Toc15734624]Table 3. Check Processing Tab Descriptions
	Function
	Description

	Manage Verification
	Allows a user to search and/or create an MVD record.

	CIRA Query
	Allows a user to view and/or modify a CIRA record.

	Batch Management
	Allows a user to search, view, close, approve and submit a batch. A user may edit and void an item within a batch with the proper permission.

	Check Scan
	Allows a user to scan checks.

	Transmission History
	Allows a user to view transmission history for batches that are uploaded from the offline check capture application.


The Check Processing tab is shown in Figure 36. Depending on your user role, you may not see all functionality shown in the image.
[bookmark: _Ref455760415][bookmark: _Ref486184869][bookmark: _Toc40079873]Figure 36. Check Processing Tab
[image: ]



OTCnet Online Card Processing Tab Functionality
To access the OTCnet card processing functionality, log in with your user id and password. Table 4 provides a list of the card processing functions that are available to you. 
[bookmark: _Ref17200838][bookmark: _Toc15734625]Table 4. Card Processing Tab Descriptions
	Function
	Description

	Card Transaction Query
	Allows a user to query a card transaction.

	Process Card Payment
	Allows a user to process a card payment.


The Card Processing tab is shown in Figure 37. Depending on your user role, you may not see all functionality shown in the image.
[bookmark: _Ref16171200][bookmark: _Toc40079874]Figure 37. Card Processing Tab
[image: ]



[bookmark: _Toc426719688][bookmark: _Toc490834187]OTCnet Online Administration Tab Functionality
To access the OTCnet Administration functionality, log in with your user id and password.
Table 5 below provides a list of the Administration functions that are available to you.
[bookmark: _Ref455760432][bookmark: _Toc15734626]Table 5. Administration Tab Descriptions
	Function
	Description

	Manage Organizations
	Allows a user to manage Organization Hierarchy, Accounting Codes, Custom Labels, Processing Options, and User Defined Fields.

	Manage FI
	Allows a user to create and/or modify a Financial Institution, transfer FI RTN Numbers, transfer CA$HLINK accounts, and maintain FRB CA$HLINK accounts.

	Manage Users
	Allows a user to manage OTCnet user accounts and profiles.

	Management
	Allows a user to manage OTCnet processes.

	Manage Check Processing
	Allows a user to manage terminal configuration and forms.

	Manage Card Processing
	Allows a user to manage terminal configuration.

	Manage Centralized Deployment
	Allows users access to the following: Release Configuration, Edit Release and Download Release.

	Audit
	Allows a user to review the audit log history.

	Utilities
	Allows a user to review batch utilities, including Batch Recreate and Batch Repair.





The Administration tab is shown in Figure 38. Depending on your user role, you may not see all functionality shown in the image. 
Figure 38. Administration Tab
[image: ]



[bookmark: _Toc426719689][bookmark: _Toc490834188]OTCnet Online Reports Tab Functionality
To access the OTCnet Reports functionality, log in with your user id and password. Table 6 below provides a list of the Reports functions that are available to you. Depending on your user role, you will only see reports that you have access to view and download.
[bookmark: _Ref486095263][bookmark: _Toc15734627]Table 6. Reports Tab Descriptions
	Function
	Description

	Deposit Processing Reports
	Allows a user to view and download Business, Security and Administration reports.

	Check Processing Reports
	Allows a user to access Check Processing reports. 

	Historical Reports
	Allows a user to query and download historical reports.


The Reports tab is shown in Figure 39. Depending on your user role, you may not see all functionality shown in the image.
Figure 39. Manage Reports
[image: ]


[bookmark: _Toc426719690]

[bookmark: _Toc490834189]OTCnet Offline Administration Tab Functionality
To access the OTCnet Offline Administration functionality, log in with your user id and password. Table 7 below provides a list of the Administration functions that are available to you. 
[bookmark: _Ref455760509][bookmark: _Toc15734628]Table 7. OTCnet Offline Administration Descriptions
	Function
	Description

	Manage OTC Endpoints
	Allows a user to select and download OTC Endpoints.

	User Administration
	Allows a user to download, update, and manage user profiles. 

	Manage Check Processing
	Allows a user to manage terminal configuration and forms.

	Audit
	Allows a user to review the audit log history.


The Administration tab is shown in Figure 40. Depending on your user role, you may not see all functionality shown in the image.
[bookmark: _Ref40079802][bookmark: _Toc40079877][bookmark: _Toc426719691][bookmark: _Toc490834190]Figure 40. OTCnet Offline Administration
Offline Application[image: ]


OTCnet Offline Check Processing Functionality
To access the OTCnet Offline Check Processing functionality, log in with your user id and password. Table 8 below provides a list of the Check Processing functions that are available to you.
[bookmark: _Ref455760536][bookmark: _Toc15734629]Table 8. OTCnet Offline Administration Descriptions
	Function
	Description

	Manage Verification
	Allows a user to select and download OTC Endpoints.

	Batch Management
	Allows a user to search, view, close, approve, upload and acknowledge a batch. A user may edit and void an item within a batch with the proper permission.

	Check Scan
	Allows a user to scan checks.


The Administration tab is shown in Figure 41. Depending on your user role, you may not see all functionality shown in the image.
[bookmark: _Ref455760549][bookmark: _Toc40079878]Figure 41. OTCnet Offline Check Processing Descriptions
[image: figure 37]


[bookmark: _Toc426719692][bookmark: _Toc490834191]Summary
This chapter provided information on:
55. How to start and stop the OTCnet Local Bridge (OLB) application
56. How to log in to OTCnet Online/Offline
57. How to access your User Id and reset your Password
58. How to navigate the OTCnet Online/Offline home page
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[bookmark: _Toc490834193]Glossary
[bookmark: _Toc455135980]A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one or many agency defined accounting codes or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

[bookmark: _Toc455135981]B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so) or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

[bookmark: _Toc455135982]C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System. 

[bookmark: _Hlk60905197]Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

[bookmark: _Hlk60905288]CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

[bookmark: _Hlk60905261]CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.

[bookmark: _Toc455135983]D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. 

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 
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Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).
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Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.
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Highest Level Organization – The primary level of the organization hierarchy.
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IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).
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Kiosk Operator User Role – A user with limited permissions for the OTC Kiosk tablet. Permissions include logging into the OTCnet Kiosk application, scanning checks, processing card payments and printing receipts.

Kiosk Lockdown Software – A process used to lock down the Windows Surface Pro workstation for use with the OTCnet Kiosk Tablet application. This involves removing the options, “Lock”, “Sign out”, “Change a password” and “Task Manager” when CTRL-ALT-Delete is pressed. This process only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing any other websites).

L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.



[bookmark: _Toc455135989]M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

[bookmark: _Hlk60905310]Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

[bookmark: _Hlk60905338]Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.
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Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 
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Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.
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Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 
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Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.
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Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.
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Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 

SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.

[bookmark: _Toc455135996]T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.
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Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

[bookmark: _Toc455135998]V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 
Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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The intended audience for the Managing User Accounts Participant User Guide includes:
59. Primary Local Security Administrator (PLSA)
60. Local Security Administrator (LSA)
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Welcome to Managing User Accounts. In this chapter, you will learn:
61. The purpose of managing user accounts
62. How to identify users who can manage other user accounts
63. How to create a User Identity (ID)
64. How to create, assign and edit an OTCnet account for a user
65. How to manage a user password
66. How to manage personal information
67. How to approve/reject an OTCnet user request
68. How to modify a user status
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This chapter is organized by the following topics:
1. Purpose of Managing User Accounts
2. Creating a User Identity (ID)
3. Creating, Assigning and Editing an OTCnet Account
4. Managing a User Password
5. Managing Personal Information
6. Approving or Rejecting an OTCnet User Request
7. Modifying User Status


[bookmark: _Toc426719776][bookmark: _Toc513742439]Topic 1. Purpose of Managing User Accounts
[bookmark: _Hlk514257913]As the Primary Local Security Administrator (PLSA) or Local Security Administrator (LSA) for your organization, you are able to manage which users can access OTCnet. Before a user can access OTCnet, you will need to access IBM Security Identity Manager (ISIM) through OTCnet Online.  

Managing a user’s account involves (in order): 
69. Creating a User Identity (ID)
70. Creating, assigning and updating an OTCnet account for a user
71. Managing the user’s password

The three steps referenced above are necessary to ensure that a user can access OTCnet. Creating a new user identity is only necessary if a user does not already have a Fiscal Service Single Sign On User identity. A temporary password is automatically sent to the user’s email address after the user identity is created. 

Managing a user’s password is only required for resetting a user’s password (typically reset by the Primary/Local Security Specialist (P/LSA) if a user forgets his/her password).
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Creating the User ID is the first step in managing a user’s access to OTCnet, if a user does not already have an existing Fiscal Service Single Sign On (SSO) account. After you create the User ID, create and assign an OTCnet account to the User Identity, and then manage the user’s password so he/she can access OTCnet (in this order).

Creating a user identity does not require approval from another PLSA or LSA. Upon successful creation of a user’s identity, the user receives an email notification containing information about his/her new User Identity.

To create a User Identity, you will enter the user’s personal information such as name, agency name, and the application name (OTCnet) the user will be using.
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1. Log into OTCnet and select Manage Users under the Administration tab (see Figure 1). 
[bookmark: _Toc59445370]Figure 1. Access ISIM
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2. The IBM Security Identity Manager (ISIM) log-in page will appear (see Figure 2).


[bookmark: _Toc59445371]Figure 2. Log into ISIM
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3. Log into ISIM with your OTCnet credentials. The Request Management-Your To-Do List page appears. Select Organization from the main menu bar and click New External User Identity (see Figure 3). 
[bookmark: _Toc59445372]Figure 3. New External User Identity
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4. The New External Identity page appears. Under the External tab, enter the personal information details (see Figure 3).
1. Enter the user’s Legal Prefix
2. Enter the user’s Legal Name, required
3. Enter the user’s Legal First Name, required
4. Enter the user’s Legal Middle Name
5. Enter the user’s Legal Last Name, required

The Generation Identifier/Suffix and Organizational Roles details are not applicable. The Organizational Roles details populates after the user’s identity is successfully created. 
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5. Click the Corporate tab. From Identity Organization, click Search, as shown in Figure 4. 
[bookmark: _Ref467494502][bookmark: _Toc59445374]Figure 5. Corporate Tab (Identity Organization)
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6. The Search: Identity Organization dialog box appears. Enter the organization name in the blank text box and click Search. If you do not know the full name of the organization, you can enter a partial name search.

From the resulting list, click the organization’s name you want to add. Then, scroll to the bottom of the dialog box, and click Add and Done, as shown in Figure 5.


[bookmark: _Ref467494511][bookmark: _Toc59445375]Figure 6. Search: Identity Organization Dialog Box
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7. Click Search for Sponsoring Application as shown in Figure 6. 

The Primary Location search functionality is optional to identify the user’s primary base location. The steps mirror those of Sponsoring Application. 
[bookmark: _Ref467494519][bookmark: _Toc59445376]Figure 7. Corporate Tab (Sponsoring Application)
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8. The Search: Sponsoring Application dialog box appears (see Figure 7). Select OTCnet (SSO) from the list, scroll to the bottom of the dialog box, and click Add and Done.
[bookmark: _Ref467494530][bookmark: _Toc59445377]Figure 8. Search: Sponsoring Application Dialog Box
[image: ]

9. Click the Contact tab and enter the appropriate contact details as shown in Figure 9 below. 

a) Enter an Email Address, required
b) Enter a Mobile Phone
c) Enter an Office Telephone Number, required
d) Enter a Pager number
e) Enter an Office Fax Number
f) Enter an Office Room Number, if applicable
g) Enter an Office Street address, required
h) Enter an Office Street Address 2, if applicable
i) Enter a City, required
j) Enter an Office State, required
k) Enter an Office Postal Code, required
l) Enter an Office Country, required

The Telephone Number field may not include special characters including, but not limited to hyphens, periods, spaces, and parenthesis. 

10. Click the Schedule for Now or Schedule for Later radio button. You can choose to schedule the User Identity to be created at a later time by clicking the Schedule for Later button and entering the preferred scheduled date and time. 

11. Click Submit, as shown in Figure 9 below. The Request Management- Your Pending Requests page appears. To verify creation of a new identify, select Request Management, and click the View Pending Requests or View Completed Requests.
[bookmark: _Ref467494540][bookmark: _Toc59445378]Figure 9. Contact Tab
[image: ]
1. 

[bookmark: _Toc467496952][bookmark: _Toc513742442][image: ]Create a User Identity
To create a user identity, complete the following steps:

1. Log into OCTnet and select Manage Users under the Administration tab. 

2. Log into the IBM Security Identity Manager (ISIM) with your OTCnet credentials. The Request Management-Your To-Do List page appears.

3. From the main menu bar, select Organization and click New External User Identity. The New External Identity page appears.

4. Under the External tab, enter the personal information details.
1. Enter the user’s Legal Prefix
2. Enter the user’s Legal Name, required
3. Enter the user’s Legal First Name, required
4. Enter the user’s Legal Middle Name
5. Enter the user’s Legal Last Name, required
	[image: MCj04421280000[1]]Application Tip
The Generation Identifier/Suffix and Organizational Roles details are not applicable. The Organizational Roles details populates after the user’s identity is successfully created.


5. Click the Corporate tab.

6. From Identity Organization, click Search. The Search: Identity Organization dialog box appears.

7. Enter the organization’s name in the text box and click Search.
	[image: MCj04421280000[1]]Application Tip
If you do not know the full name of the organization, you can enter a partial name search.


8. From the resulting list, click the organization’s name you want to add.

9. Scroll to the bottom of the dialog box and click Add and Done.

10. From Sponsoring Application, click Search. The Search: Sponsoring Application dialog box appears.

11. Select OTCnet (SSO) from the list.


12. Scroll to the bottom of the dialog box and click Add and Done.

13. Click the Contact tab.

14. Enter the appropriate contact details.
a) Enter an Email Address, required
b) Enter a Mobile Phone
c) Enter an Office Phone, required
d) Enter a Pager number
e) Enter an Office Fax Number
f) Enter an Office Room Number, if applicable
g) Enter an Office Street address, required
h) Enter an Office Street Address 2, if applicable
i) Enter a City, required
j) Enter an Office State, required
k) Enter an Office Postal Code, required
l) Enter an Office Country, required

15. Click the Schedule for Now or Schedule for Later radio button.
	[image: MCj04421280000[1]]Application Tip
If the Schedule for Later radio button is selected, enter the Date and Time the identity should be created.


16. Click Submit. The Request Management – Your Pending Requests page appears.
	[image: MCj04421280000[1]]Application Tip
To verify creation of a new identify, select Request Management, and click the View Pending Requests or View Completed Requests.





[bookmark: _Toc426719779][bookmark: _Toc513742443]Topic 3. Creating, Assigning and Editing an OTCnet Account
You can create and assign an OTCnet account to a user only after the user’s identity (User ID) is created (see Topic 2 of this chapter for step-by-step instructions). When creating an OTCnet account, you can assign more than one role to a user. For example, you can assign a user both the Deposit Preparer and Deposit Approver roles. You can edit a user’s account only after the OTCnet account is assigned to the user.

After a PLSA or LSA creates and assigns an OTCnet account to a user, IBM Security Identity Manager (ISIM) looks for other approvers within the same OTC Endpoint or hierarchy and notifies them of the pending request. Approvers are other PLSAs and LSAs that exist in the same OTC Endpoint or hierarchy as the requestor. 
[bookmark: _Toc426719780]

[bookmark: _Toc513742444]Create and Edit an OTCnet Account 
· From the main menu bar, select Search and click Person. The Search Person page appears. 
1. From the Select drop-down menu, select External (set to default)
2. From the Where drop-down menu, select a criteria type

By default, the Where drop-down menu is set to Full Name. You can choose any option as needed.
3. Enter the search criteria in the blank text box on the right and click Search (see Figure 10).
[bookmark: _Ref467494790][bookmark: _Toc59445379]Figure 10. Search Person Page (Criteria) - Person
[image: ]
· The Search Person page appears with the results of your search criteria.

Click the Select hyperlink of the name of the user for which you would like to create/assign an OTCnet account (see Figure 11). 
[bookmark: _Ref467494827][bookmark: _Toc59445380]Figure 11. Search Person Page (Selection) - Accounts
[image: ]

· A Manage User page appears. Click Manage Accounts (see Figure 12)
[bookmark: _Ref467494843][bookmark: _Toc59445381]Figure 12. Manage User Page - Accounts
[image: ]


· The Manage Accounts page appears. To create a new OTCnet account for a user, click New (see Figure 13). The Create Account for: page appears. 
[bookmark: _Ref467494853][bookmark: _Toc59445382]Figure 13. Manage Accounts Page
[image: ]
Or

To modify an existing OTCnet account for a user, click the User ID hyperlink for the OTCnet account and proceed to Step 6 below.

· Click OTCnet for the account type and then click Submit as shown in Figure 14 below. Selecting OTCnet indicates that the user can log on to OTCnet. Proceed to Step 8 if you are only modifying the user’s role group.
[bookmark: _Toc59445383]Figure 14. Create Account for Page
[image: ]
· The Edit Account: OTCnet page appears. From Managed Organizations, click Search as shown in Figure 15.

Managed Organizations is only used by PLSAs for creating LSA users. When creating any other user, this field should be left blank. LSAs should never use this field when creating users. 

The name in the Managed Organizations field is typically the same as the Identity Organization name. The Identity Organization was originally used when you created a user identity.


[bookmark: _Ref467494914][bookmark: _Toc59445384]Figure 15. Edit Account Manage Organizations Page
[image: ]
· The Search: Managed Organizations dialog box appears. Enter the organization name in the blank text box and click Search. Enter the name of the organization you want to add. If you do not know the full name of the organization, you can enter a partial name search.

Click the name of the organization you want to add, then click Add and then click Done to return to the Edit Account: OTCnet page (see Figure 16).

Proceed to Step 8 if you are modifying the user’s role group. If not, proceed to Step 11. 
[bookmark: _Ref467494995][bookmark: _Toc59445385]Figure 16. Search Managed Organizations Page
[image: ]

· From Assign Permission click the Click to Modify hyperlink (see Figure 17). 


[bookmark: _Ref467495165][bookmark: _Toc59445386]Figure 17. Edit Account Assign Permission
[image: ]
If the Allow OTC Endpoint to create deposits for over-the-counter collections check box and/or the Enable Check Capture check box is not checked when modifying OTC Endpoint Information, you will not be able to provision the user to the appropriate OTCnet Endpoint. Refer to the Chapter 4: Managing Your Organization Hierarchy user guide for more details about managing your organization’s hierarchy.

· The OTCnet Module Role Access Group dialog box appears. Select a Role from the Choose a Role drop-down (see Figure 18).
[bookmark: _Ref467495182][bookmark: _Toc59445387]Figure 18. OTCnet Module Role Access Group Page
[image: ]

· Select an access group from the Level 1 drop-down. The Level 2 drop-down appears, if applicable. Select an access group from the Level 2 drop-down, if applicable and so on (as shown in Figure 19). 

Repeat this step as necessary for each successive level until you select the desired access group, then click Submit to return to the Edit Account: OTCnet page



Wait for the Level 2 drop-down to appear. Since ISIM is a web application there may be a slight delay. It is not required to select an access group from the next level if you want to provision a user at a higher-level access (Level 2, 3, etc. is not required).
[bookmark: _Ref467495204][bookmark: _Toc59445388]Figure 19. Access Group Level Selection
[image: ]
· Click the Schedule for Now or Schedule for Later radio button, click Submit (see Figure 20).
 
If the Schedule for Later radio button is selected, enter the Date and Time when the OTCnet account should be created.
[bookmark: _Ref467495219][bookmark: _Toc59445389]Figure 20. Edit Account: Schedule Now or Schedule Later
[image: ]

· The Request Management – Your Pending Requests page appears (see Figure 21).


[bookmark: _Ref467495230][bookmark: _Toc59445390]Figure 21. Request Management- Your Pending Requests page
[image: ]
To finalize a user’s access to OTCnet, an approver (PLSA or LSA) within the same OTC Endpoint or hierarchy must approve the request.

To verify account was successfully provisioned, select Request Management and click The View Pending Requests or View Completed Requests. A request will only be listed as completed if an approver has already approved the request.


[bookmark: _Toc467496955][bookmark: _Toc513742445][image: MCj04420720000[1]]Create and Edit an OTCnet Account for a User
To create and edit an OTCnet account for a user, complete the following steps:

· From the main menu bar, select Search and click Person. The Search Person page appears.

· From the Select drop-down menu, select External. 

	[image: MCj04421280000[1]]Application Tip
By default, the Select drop-down menu is set to External.


· From the Where drop-down menu, select a criteria type.
	[image: MCj04421280000[1]]Application Tip
By default, the Where drop-down menu is set to Full Name. You can choose any option as needed.


· Enter the search criteria in the blank text box on the right and click Search. The Search Person page appears with the results of your search criteria.
	[image: MCj04421280000[1]]Application Tip
By default, the drop-down menu after Where is set to Contains. You can choose any option as needed.


· Click the Select hyperlink of the name of the user for which you would like to create and assign an OTCnet account. A Manage User page appears.

· Click Manage Accounts. The Manage Accounts page appears. 

· To create a new OTCnet account for a user, click New. The Create Account for: page appears.

Or

To modify an existing OTCnet account for a user, click the User ID hyperlink for the OTCnet account and proceed to Step 9.
· 
Click OTCnet for the account type and then click Submit. The Edit Account: OTCnet page appears.
	[image: MCj04421280000[1]]Application Tip
Selecting OTCnet indicates that the user can log on to OTCnet.



	[image: MCj04421280000[1]]Application Tip
Proceed to Step 13 if you are only modifying the user’s role group.


· From Managed Organization, click Search. The Search: Managed Organization dialog box appears.
	[image: MCj04421280000[1]]Application Tip
Managed Organizations is only used by PLSAs for creating LSA users. When creating any other user, this field should be left blank. LSAs should never use this field when creating users. 

The name in the Managed Organizations field is typically the same as the Identity Organization name. The Identity Organization was originally used when you created the user’s identity.


· Enter the organization name in the blank text box and click Search.
	[image: MCj04421280000[1]]Application Tip
If you do not know the full name of the organization, you can enter a partial name search.



· Click the name of the organization you want to add.

· Click Add and then click Done to return to the Edit Account: OTCnet page.

	[image: MCj04421280000[1]]Application Tip
Proceed to Step 13 if you are modifying the user’s role group. If not, proceed to Step 18.


· From Assign Permission, click the Click to Modify hyperlink. The OTCnet Module Role Access Group dialog box appears.
	[image: MCj04421280000[1]]Application Tip
If the Allow OTC Endpoint to create deposits for over-the-counter collections check box and/or the Enable Check Capture check box is not checked when modifying OTC Endpoint Information, you will not be able to provision the user to the appropriate OTCnet Endpoint. Refer to the Chapter 4: Managing Your Organization Hierarchy user guide for more details about managing your organization’s hierarchy.


· Select a Role from the Choose a Role drop-down.

· Select an access group from the Level 1 drop-down. The Level 2 drop-down appears, if applicable.
	[image: MCj04421280000[1]]Application Tip
Wait for the Level 2 drop-down to appear. Since ISIM is a web application there may be a slight delay.


· Select an access group from the Level 3 drop-down. The Level 4 drop-down appears, if applicable.
	[image: MCj04421280000[1]]Application Tip
Repeat Step 15 as necessary for each successive level until you select the desired access group.



· Click Submit to return to the Edit Account: OTCnet page.

· Click the Schedule for Now or Schedule for Later radio button.

	[image: MCj04421280000[1]]Application Tip
If the Schedule for Later radio button is selected, enter the Date and Time when the OTCnet account should be created.


· Click Submit. The Request Management – Your Pending Requests page appears.

	[image: MCj04421280000[1]]Application Tip
To add additional user roles, repeat Steps 13 through 19.



	[image: MCj04421280000[1]]Application Tip
To finalize a user’s access to OTCnet, an approver (PLSA or LSA) within the same OTC Endpoint or hierarchy must approve the request.



	[image: MCj04421280000[1]]Application Tip
To verify account was successfully provisioned, select Request Management and click View Pending Requests or View Completed Requests. A request will only be listed as completed if an approver has already approved the request.





[bookmark: _Toc426719781][bookmark: _Toc513742446]Topic 4. Managing a User Password
As a PLSA or LSA, you will need to access IBM Security Identity Manager (ISIM) to manage a user’s password. You can only manage a user’s password after the following occurs (refer to Topics 2 and 3 of this User Guide for step-by-step instructions for the below tasks):

1. The User’s identity is created.
2. An OTCnet account is created and assigned to the user’s identity (User ID).
3. An approver (another PLSA or LSA user within the same OTC Endpoint or hierarchy) approves the OTCnet account creation request.

After an OTCnet account is created and assigned to a user (and the request is approved), you will have the ability to manage the user’s password. You can reset a user’s password using the Manage Passwords function. Resetting a user’s password does not require approval from another PLSA or LSA. Once the password reset has been successfully completed, an email notification is sent to the user with a temporary password.


[bookmark: _Toc426719782][bookmark: _Toc467496957][bookmark: _Toc513742447]Manage a User Password
1. From the main menu bar, select Search and click Person. The Search Person page appears (see Figure 22). 

1. From the Select drop-down menu, select External (set to default)
2. From the Where drop-down menu, select a criteria type
3. Enter the search criteria in the blank text box on the right 
4. Click Search

By default, the drop-down menu after Where is set to Contains. You can choose any option as needed.
[bookmark: _Ref467495929][bookmark: _Toc59445391]Figure 22. Search Person Page (Criteria) - Password
[image: ]


2. The Search Person page appears with the results of your search criteria. Click the Select hyperlink of the name of the user for whom you would like to manage the password (see Figure 23).
[bookmark: _Ref467495952][bookmark: _Toc59445392]Figure 23. Search Person Page (Selection)
[image: ]

3. The Manage User page appears. Click Manage Passwords (see Figure 24).
[bookmark: _Ref467495961][bookmark: _Toc59445393]Figure 24. Manage User Page
[image: ]
4. Click the Select check boxes for the Single Sign On (FSLDAP) and OTCnet services (see Figure 25) and click Submit.
[bookmark: _Ref467495973][bookmark: _Toc59445394]Figure 25. Reset Password Page
[image: ]
5. The Request submitted message appears (see Figure 26).
[bookmark: _Ref467495990][bookmark: _Toc59445395]Figure 26. Request Submitted Page
[image: ]


[bookmark: _Toc467496958][bookmark: _Toc513742448][image: ]Manage a User Password
To manage a password for a user, complete the following steps:

a) From the main menu bar, select Search and click Person. The Search Person page appears.

b) From the Select drop-down menu, select External. 
	[image: MCj04421280000[1]]Application Tip
By default, the Select drop-down menu is set to External.


c) From the Where drop-down menu, select a criteria type.
	[image: MCj04421280000[1]]Application Tip
By default, the Where drop-down menu is set to Full Name. You can choose any option as needed.


d) Enter the search criteria in the blank text box on the right and click Search. The Search Person page appears with the results of your search criteria.
	[image: MCj04421280000[1]]Application Tip
By default, the drop-down menu after Where is to Contains. You can choose any option as needed.


e) Click the Select hyperlink of the name of the user for whom you would like to manage the password. A Manage User page appears.

f) Click Manage Passwords.

g) Click the Select check boxes for the Single Sign On (FSLDAP) and OTCnet services. 

h) Click Submit. A Request submitted message appears.
	[image: MCj04421280000[1]]Application Tip
After the request to reset the password is submitted, the user receives an email with a temporary password and link to access OTCnet.


[bookmark: _Toc426719783][bookmark: _Toc513742449]Topic 5. Managing Personal Information
As a PLSA or LSA, you will need to access ISIM to manage a user’s personal information (e.g. external, corporate, and contact information). You can only manage a user’s personal information after the user identity (User ID) is created (refer to Topic 2 of this User Guide for step-by-step instructions). 

[bookmark: _Toc426719784][bookmark: _Toc467496960][bookmark: _Toc513742450]Manage a User’s Personal Information
· From the main menu bar, select Search and click Person. The Search Person page appears (see Figure 27). 

1. From the Select drop-down menu, select External (set to default)
2. From the Where drop-down menu, select a criteria type
3. Enter the search criteria in the blank text box on the right 
4. Click Search

By default, the drop-down menu after Where is set to Contains. You can choose any option as needed.
[bookmark: _Ref467496122][bookmark: _Toc59445396]Figure 27. Search Person Page (Criteria) - Full Name
[image: ]
· The Search Person page appears with the results of your search criteria. Click the Select hyperlink of the name of the user for whom you would like to manage the password (see Figure 28). 
[bookmark: _Ref467496194][bookmark: _Toc59445397]Figure 28. Search Person Page (Selection) – Personal Info
[image: ]
· The Manage User page appears. Click Manage Personal Info (see Figure 29).


[bookmark: _Ref467496216][bookmark: _Toc59445398]Figure 29. Manage User Page - Personal Info
[image: ]

· From the Personal Information page (see Figure 30),

· Click External tab and update the appropriate fields. 
· Click Corporate tab and update the appropriate fields.
· Click Contact tab and update the appropriate fields.

· Click the Schedule for Now or Schedule for Later radio button. If the Schedule for Later radio button is selected, enter the Date and Time when the user’s personal information should be managed. Then, click Submit. 
[bookmark: _Ref467496227][bookmark: _Toc59445399]Figure 30. Personal Information Page
[image: ]


[bookmark: _Toc467496961][bookmark: _Toc513742451][image: ]Manage Personal Information
To edit a user’s personal information, complete the following steps:

· From the main menu bar, select Search and click Person. The Search Person page appears.

· From the Select drop-down menu, select External. 
	[image: MCj04421280000[1]]Application Tip
By default, the Select drop-down menu is set to External.


· From the Where drop-down menu, select a criteria type.
	[image: MCj04421280000[1]]Application Tip
By default, the Where drop-down menu is set to Full Name. You can choose any option as needed.


· Enter the search criteria in the blank text box on the right and click Search. The Search Person page appears.
	[image: MCj04421280000[1]]Application Tip
By default, the drop-down menu after Where is set to Contains. You can choose any option as needed.


· Click the Select hyperlink of the name of the user you would like to manage. A Manage User page appears.

· Click Manage Personal Info. The Personal Information page appears.

· From the Personal Information page, 
· Click the External tab and update the appropriate fields. 
· Click the Corporate tab and update the appropriate fields.
· Click the Contact tab and update the appropriate fields.

· Click the Schedule for Now or Schedule for Later radio button.


	[image: MCj04421280000[1]]Application Tip
If the Schedule for Later radio button is selected, enter the Date and Time the identity should be created.


· Click Submit.
	[image: MCj04421280000[1]]Application Tip
Additional button on the page that help you perform other tasks:
1. Click Cancel to return to the ISIM Home Page. No data will be saved.





[bookmark: _Toc426719785][bookmark: _Toc513742452]Topic 6. Approving or Rejecting an OTCnet User Request 
As a PLSA or LSA, you are able to approve or reject an OTCnet account creation or modification request. You will need to access ISIM to approve or reject a request. You can only approve or reject a request after another PLSA or LSA within the same OTC Endpoint or hierarchy generates the request by creating or modifying an OTCnet account for a user. 

After you approve the request, the user for which the OTCnet account applies, receives an email notification containing information about the changes to their OTCnet account. If you reject the request, the PLSA or LSA who created the request receives an ISIM notification of the rejection.


[bookmark: _Toc426719786][bookmark: _Toc467496963][bookmark: _Toc513742453]Approve/Reject an OTCnet User Request
· Log into OTCnet and select Manage Users under the Administration tab. 
[bookmark: _Toc59445400]Figure 31. Access ISIM
[image: ]

· The IBM Security Identity Manager (ISIM) log-in page will appear. Log in with your OTCnet credentials. 


[bookmark: _Toc59445401]Figure 32. ISIM Log in
[image: ]

· The Request Management-Your To-Do List page appears (see Figure 33). Click Account Approval. 
[bookmark: _Toc59445402]Figure 33. Request Management- Your To Do List Page
[image: ]
· The Approve/Reject the Request page appears (see Figure 34). Click Approve, Reject or Cancel. Click View Request Data to view details of the request. Click Back to return to the Approve/Reject the Request page.
[bookmark: _Ref467496404][bookmark: _Toc59445403]Figure 34. Approve/Reject the Request Page
[image: ]


[bookmark: _Toc467496964][bookmark: _Toc513742454][image: ]Approve or Reject an OTCnet Account
To approve or reject an OTCnet account creation or modification request, complete the following steps:

· Log into OTCnet and select Manage Users under the Administration tab. 

· Log into IBM Security Identity Manager (ISIM) with OTCnet credentials. The Request Management-Your To-Do List page appears. 

· Click Account Approval. The Approve/Reject the Request page appears.

· Click the Schedule for Now or Schedule for Later radio button.
	[image: MCj04421280000[1]]Application Tip
If the Schedule for Later radio button is selected, enter the Date and Time the identity should be created.


· Click Approve, Reject or Cancel.
	[image: MCj04421280000[1]]Application Tip
Click Approve to approve the user account request. Click Reject to reject the user account request. Click Cancel to return to the ISIM Home Page. No data will be saved.



	[image: MCj04421280000[1]]Application Tip
Click View Request Data to view details of the request. Click Back to return to the Approve/Reject the Request page.


[bookmark: _Toc426719787][bookmark: _Toc513742455]Topic 7. Modify User Status
After a PLSA or LSA creates and assigns an OTCnet account to a user, ISIM looks for other approvers within the same OTC Endpoint or hierarchy and notifies them of the pending request (approvers are other PLSAs and LSAs).

As the PLSA or LSA for your organization, you are the only users who can modify another user’s OTCnet status. You can: 

72. Suspend (deactivate) a user’s OTCnet account
73. Restore (activate) a user’s OTCnet account
74. De-Provision (delete) a user’s OTCnet account

[bookmark: _Toc426719788][bookmark: _Toc467496966][bookmark: _Toc513742456]Modify User Status
· From the main menu bar, select Search and click Person. The Search Person page appears (as shown in Figure 35). 

1. From the Select drop-down menu, select External (set to default)
2. From the Where drop-down menu, select a criteria type
3. Enter the search criteria in the blank text box on the right 
4. Click Search

By default, the drop-down menu after Where is set to Contains. You can choose any option as needed.
[bookmark: _Toc59445404]Figure 35. Search Person Page (Criteria) - Modify Status
[image: ]
· The Search Person page appears with the results of your search criteria.
Click the Select hyperlink of the name of the user to suspend, restore or de-provision an OTCnet account (see Figure 36). 
[bookmark: _Ref467496601][bookmark: _Toc59445405]Figure 36. Search Person Page (Selection) - Modify Status
[image: ]

· A Manage User page appears. Click Manage Accounts (see Figure 37).
[bookmark: _Ref467496612][bookmark: _Toc59445406]Figure 37. Manage User Page - Modify Status
[image: ]
· The Manage Accounts page appears (see Figure 38). Select the Service (OTCnet) you want to suspend, restore or de-provision by checking the check box under the Select column, then:

1. Click Suspend
Or
2. Click Restore
Or
3. Click De-Provision
[bookmark: _Ref467496624][bookmark: _Toc59445407]Figure 38. Manage Accounts Page- Select User ID
[image: ]
· The Manage Accounts page appears. Click the Schedule for Now or Schedule for Later radio button. You can choose to schedule the User Identity to be created at a later time by clicking the Schedule for Later button and entering the preferred scheduled date and time. Click Submit, as shown in Figure 39.
[bookmark: _Ref467496668][bookmark: _Toc59445408]Figure 39. Manage Accounts Page- Submit
[image: ]


To finalize the modification of a user’s OTCnet account, an approver (PLSA or LSA) within the same OTC Endpoint or hierarchy must approve the request. This will require a PLSA/LSA to log into ISIM to approve the account.

· After logging into ISIM, click Account Approval under Activity (see Figure 40).
[bookmark: _Ref467496707][bookmark: _Toc59445409]Figure 40. Request Management- Your-To-Do List (Account Approval)
[image: ]
The Approve/Reject the Request page appears. Click Approve (see Figure 41)
[bookmark: _Ref467496718][bookmark: _Toc59445410]Figure 41. Approve / Reject the Request Page
[image: ]
· The Request Management – Your Pending Requests page appears (see Figure 42).
[bookmark: _Ref467496729][bookmark: _Toc59445411]Figure 42. Your Pending Requests Page
[image: ]



[bookmark: _Toc467496967][bookmark: _Toc513742457][image: ] Modify User Status
To modify a user’s status, complete the following steps:

· From the main menu bar, select Search and click Person. The Search Person page appears.

· From the Select drop-down menu, select External. 
	[image: MCj04421280000[1]]Application Tip
By default, the Select drop-down menu is set to External.


· From the Where drop-down menu, select a criteria type.
	[image: MCj04421280000[1]]Application Tip
By default, the Where drop-down menu is set to Full Name. You can choose any option as needed.


· Enter the search criteria in the blank text box on the right and click Search. The Search Person page appears with the results of your search criteria.
	[image: MCj04421280000[1]]Application Tip
By default, the drop-down menu after Where is to Contains. You can choose any option as needed.


· Click the Select hyperlink of the account for whom you would like to suspend, restore, or de-provision an OTCnet account. A Manage User page appears.

· Click Manage Accounts. The Manage Accounts page appears. 

· Select the Service (OTCnet) you want to suspend, restore or de-provision by checking the check box under the Select column, then:

4. Click Suspend. The Manage Accounts page appears. 
Or
5. Click Restore. The Manage Accounts page appears.
Or
6. Click De-Provision. The Manage Accounts page appears.



· Click the Schedule for Now or Schedule for Later radio button.

	[image: MCj04421280000[1]]Application Tip
If the Schedule for Later radio button is selected, enter the Date and Time the identity should be created.


· Click Submit. The Request Management – Your Pending Requests page appears.
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To verify account was successfully modified, select Request Management and click The View Pending Requests or View Completed Requests.
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To finalize the modification of a user’s OTCnet account, an approver (PLSA or LSA) within the same OTC Endpoint or hierarchy must approve the request.
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In this chapter, you learned: 
7. The purpose of managing user accounts
8. How to identify users who can manage other user accounts 
9. How to create a User Identity (ID)
10. How to create, assign and edit an OTCnet account for a user
11. How to manage a user password
12. How to manage personal information
13. How to approve/reject an OTCnet user request
14. How to modify a user status 

[bookmark: _Toc456613224][bookmark: _Toc513742459]Notes
____________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________ 
[bookmark: _Toc513742460]Glossary
A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one or many agency defined accounting codes or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations, and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so), or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
[bookmark: _Hlk60905756](80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System.

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU, and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.

D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. User Defined Field 1 is usually the SSN number of an individual.

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file, and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).

K
Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

 Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, deposit processing, scanning checks, processing card payments and printing receipts. 

L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity, and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 

Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.

R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.

S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 

SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.
T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 
Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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[bookmark: _Toc467490437]Audience, Overview and Topics
[bookmark: _Toc279611968][bookmark: _Toc382481693][bookmark: _Toc382482299][bookmark: _Toc397515531][bookmark: _Toc462057941][bookmark: _Toc462138801][bookmark: _Toc462300887][bookmark: _Toc467490438]Audience
The intended audience for the Managing Your Agency’s Hierarchy Participant User Guide varies by system.  Please note the intended audience by system you are capturing or processing on:
Deposit Processing
· Accounting Specialist 
· Local Accounting Specialist (refer to Chapter 1 for permission details)
· Viewer (View their organization’s hierarchy endpoint only)
Check Capture and Check Processing
· Check Capture Administrator 
· Check Capture Supervisor (refer to Chapter 1 for permission details)
· Check Capture Lead Operator
Card Processing
· Card Administrator
· Card Operator

[bookmark: _Toc279611969][bookmark: _Toc382481694][bookmark: _Toc382482300][bookmark: _Toc397515532][bookmark: _Toc462057942][bookmark: _Toc462138802][bookmark: _Toc462300888][bookmark: _Toc467490439]Overview
Welcome to Managing Your Agency’s Hierarchy. In this chapter, you will learn:
· The purpose of organizational hierarchy
· How to add lower level endpoints to the highest level of an organization hierarchy  
· How to add additional lower level endpoints/ add financial institution relationship to a hierarchy that was previously defined 
· How to make changes to OTC Endpoints  
· How to delete or neutralize OTC Endpoints  
· How to view OTC Endpoints  
· How to modify accounting codes
· How to modify endpoint mappings
· How to modify processing options
· How to view processing options

Topics
This chapter is organized by the following topics:
1. Purpose of the Organizational Hierarchy 
2. Creating an Organizational Hierarchy 
3. Managing the Organizational Hierarchy  
4. Managing Accounting Codes
5. Managing Processing Options



[bookmark: _Toc467490441]Topic 1. Purpose of the Organizational Hierarchy
[bookmark: _Hlk5976667]As your Agency’s Accounting Specialist (AS), Local Accounting Specialist (LAS), Check Capture Administrator (CCA), and Card Administrator (CA) you are responsible for identifying and maintaining the organizational structure for your Agency’s deposits, check capture, and card processing settings. This organizational structure is called a hierarchy. 
Creating this hierarchy accomplishes the following:
· [bookmark: _Hlk7173647]Describes the relationships and reporting structures between OTC Endpoints within your organization that create or submit deposits or process card transactions in OTCnet
· Defines the content of the reports that individuals may run based on their OTC Endpoints within the hierarchy
· Enables staff to create deposits, process card transactions, and pull reports on all appropriate OTC Endpoints in the organization

You will work with your management to determine the desired hierarchy, and then use the OTCnet tools provided to define that hierarchy in OTCnet.  
The organizational hierarchy you create contains specific OTC Endpoints from which Deposit Preparers may create deposits, Check Capture Operators may scan checks, and Card Operators may process payments via credit card, debit card and gift card payments. These locations are called OTC Endpoints. You are responsible for indicating which locations in the hierarchy are OTC Endpoints, and how deposits at OTC Endpoints should be handled. A Deposit Processing endpoint will be indicated with a (TGA) next to the endpoint; a Check Capture endpoint is indicated with a (CHK) next to it and a Card Processing endpoint is indicated with a Card Debit Card (CDC) next to it. An M indicates that an OTC Endpoint was mapped to an accounting code.


[bookmark: _Toc467490442]Topic 2. Creating an Organizational Hierarchy
Once your High-Level Agency Support (HLAS) has entered your organization into OTCnet, you are responsible for entering your organizational hierarchy. As part of your setup process, the HLAS creates the highest level of your hierarchy for you; you add to that hierarchy according to your organization’s needs. The highest level of your organization cannot be a depositing endpoint.
You may create as many lower levels in your hierarchy as you need, with as many OTC Endpoints in each level as you need. 
[bookmark: _Hlk6318605]You may edit your hierarchy as desired by updating the information for each OTC Endpoint you create. You may delete an OTC Endpoint from which no deposit, check transaction or card transaction has been made, but may not delete an OTC Endpoint once a deposit, check or card transaction has been made from that OTC Endpoint. OTC Endpoints may not be deleted after a deposit, check or card transaction has been made because historical information about that deposit or check transaction would also be deleted, creating inaccurate reporting. However, you may neutralize an OTC Endpoint, if deposits or check transactions have been created. Card Processing Endpoints can also be neutralized. For more information on deleting or neutralizing OTC Endpoints, refer to Delete or Neutralize an OTC Endpoint. 
Your organization’s hierarchy is accessible by clicking the Administration tab and then the Manage Organization menu option.



[bookmark: _Toc467490443]Add an OTC Endpoint
The Accounting Specialist, Local Accounting Specialist, Check Capture Administrator, Check Capture Supervisor and Card Administrators can add endpoints. 

To add an OTC Endpoint from the highest level of an organization hierarchy, complete the following steps:

· Click the Administration tab. Select Manage Organizations>Organization Hierarchy and click Modify.
[bookmark: _Toc19199389]Figure 1. Select Manage Organizations>Organization Hierarchy>Modify
[image: ]

· The Step 1 of 3: Select an OTCnet Endpoint page appears. Select your organization’s OTC Endpoint as it appears in the list.
[bookmark: _Toc19199390]Figure 2. Step 1 of 3: Select the OTC Endpoint
[image: ]




· The Step 2 of 3: Update OTC Endpoint Information page appears.
As shown in (Figure 3) check the Add lower levels to this OTC Endpoint checkbox. In the table that appears you can add new OTC Endpoints that fall in the level under the current OTC Endpoint.
Enter the Lower Level OTC Endpoint(s)’s Short Name(s) and Description(s) and then click Next. The Short Name and Description field provide an abbreviation and a full description, respectively, of the OTC Endpoint you are adding.
Short name(s) are user-defined text describing an organization. Short names must be unique within an organization hierarchy (e.g. Short name: IRS; Description: Internal Revenue Service).
Special characters are accepted in Short Name and Description fields; however, only use standard American Standard Code for Information Interchange (ASCII) characters. The standard ASCII range is 32-126. If non-standard ASCII characters (0-31, 127-255) are entered in the Short Name and Description fields, ISIM will not display the endpoint name in the Level drop-down field. Additionally, if non-standard ASCII characters are entered, you will not be able to manage OTC Endpoints (select endpoints) in OTCnet Offline. Instead an error message appears asking that Customer Support is contacted. 
[bookmark: _Ref39665509][bookmark: _Toc19199391]Figure 3. Step 2 of 3: Update OTC Endpoint Information
[image: ]



· The Step 3 of 3: Review OTC Endpoint(s) page appears. Review and verify the OTC Endpoint details and click Submit.
Figure 4. Step 3 of 3: Review OTC Endpoint
[image: ]

· A Confirmation page appears showing the OTC Endpoint has been modified (added lower level OTC Endpoint).


Figure 5. Modify Organization Confirmation
[image: ]

[bookmark: _Toc462057947][bookmark: _Toc462138807][bookmark: _Toc462300893][bookmark: _Toc467490444]
[image: ]	Add an OTC Endpoint from the Highest Level of an Organizational Hierarchy
[bookmark: _Hlk18642898]The Accounting Specialist, Local Accounting Specialist, Check Capture Administrator, Check Capture Supervisor and Card Administrator can add endpoints. 

To add an OTC Endpoint from the highest level of an organization hierarchy, complete the following steps:
 
1. Click the Administration tab.

2. From the Manage Organization menu, select Organization Hierarchy and click Modify. The Step 1 of 3: Select an OTC Endpoint page appears. 

3. Select your OTC Endpoint that appears in the list. The Step 2 of 3: Update OTC Endpoint Information page appears.

Check the Add lower levels to this OTC Endpoint.

	[image: ]Application Tip
In the table that appears you can add new OTC Endpoints that fall in the level under the current OTC Endpoint.



4. Enter the Lower Level OTC Endpoint’s Short Name(s) and Description(s) and click Next. 
	[image: ]Application Tip
Short name(s) are user-defined text describing an organization. Short names must be unique within an organization hierarchy (e.g. Short name: IRS; Description: Internal Revenue Service).



	[image: ]Application Tip
Special characters are accepted in Short Name and Description fields; however, only use standard American Standard Code for Information Interchange (ASCII) characters. The standard ASCII range is 32-126. If non-standard ASCII characters (0-31, 127-255) are entered in the Short Name and Description fields, ISIM will not display the endpoint name in the Level drop-down field. Additionally, if non-standard ASCII characters are entered, you will not be able to manage OTC Endpoints (select endpoints) in OTCnet Offline. Instead an error message appears asking that Customer Support is contacted.



5. In the Step 3 of 3: Review OTC Endpoint(s) page, review and verify the OTC Endpoint details and click Submit. A confirmation page appears showing the OTC Endpoint has been modified (added lower level OTC Endpoint).

	[image: ]Application Tip
Additional buttons on the page help you perform other tasks:
· Click Add More Lines to insert additional rows to the table, to input additional Agency accounting codes.
· Click Cancel to return to the OTCnet Home Page. No data will be saved. 
· Click Previous to return to the previous page.
· Click Return Home to return to the OTCnet Home Page.





[bookmark: _Toc467490445]Topic 3. Managing the Organizational Hierarchy
Once Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors and Card Administrators have performed initial setup of your organizational hierarchy, you can add to it and adjust it to suit your needs by performing the following tasks:
· Add a lower level to existing an OTC Endpoint
· Modify OTC Endpoint Information
· Delete an OTC Endpoint
· View an OTC Endpoint

Note: Before a user can be provisioned to a deposit processing OTC Endpoint (TGA) in ISIM, ensure the Allow OTC Endpoint to create deposits for over-the-counter collections checkbox is checked.
Before a user can be provisioned to a check capture OTC Endpoint (CHK) in ISIM, ensure the Enable Check Capture checkbox is checked.
Before a user can be provisioned to a card processing OTC Endpoint (CDC) in ISIM, ensure the Enable Card Processing checkbox is checked. 
Note: required fields for Enable Card Processing include Chain Code, Division, ALC, Merchant ID, Address, Signature Capture and Return Policy.
If the Allow OTC Endpoint to create deposits for over-the-counter collections checkbox, the Enable Check Capture checkbox and Enable Card Processing checkboxes are not checked when modifying OTC Endpoint Information, you will not be able to provision the user to the appropriate OTCnet Endpoint. Refer to the Chapter 4: Managing Your Organization Hierarchy user guide for more details about managing your organization’s hierarchy.


[bookmark: _Toc467490446]Add a Lower Level to an Existing OTC Endpoint
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors and Card Administrators, can add as many levels to your Agency hierarchy as your organization needs, each with as many OTC Endpoints as needed.

To add a lower level to an OTC Endpoint, complete the following steps:
· Click the Administration tab.  From the Manage Organizations menu, select Organization Hierarchy and select Modify.
[bookmark: _Toc19199394]Figure 6. Select Manage Organizations>Organization Hierarchy>Modify
[image: ]

· The Step 1 of 3: Select an OTC Endpoint page appears. Select your OTC Endpoint from
the list. 
[bookmark: _Toc19199395]Figure 7. Step 1 of 3: Select OTC Endpoint
[image: ]

· The Step 2 of 3: Update OTC Endpoint Information page appears. 

Check the Add lower levels to this OTC Endpoint checkbox to add lower levels to the existing endpoint. Short Name and Description text boxes appear. Enter Short Name and Description fields for all the OTC Endpoints in the next lower level. When you have finished, click Next.
[bookmark: _Toc19199396]Figure 8. Step 2 of 3: Update OTC Endpoint Information
[image: ]
· 
The Step 3 of 3: Review OTC Endpoint appears. Verify the OTC Endpoint details are correct and click Submit. A confirmation page appears showing the OTC Endpoint has been modified (added). Verify the OTC Endpoint details are correct and click Submit. A confirmation page appears showing the OTC Endpoint has been modified.
[bookmark: _Toc462057950][bookmark: _Toc462138810][bookmark: _Toc462300896]Figure 9. Step 3 of 3: Review OTC Endpoint
[image: ]
[bookmark: _Toc467490447]
[image: ]	Add a Lower Level to an OTC Endpoint 
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors and Card Administrators, can add as many levels to your Agency hierarchy as your organization needs, each with as many OTC Endpoints as needed.

To add a lower level to an OTC Endpoint, complete the following steps:
· Click the Administration tab.

· From the Manage Organization menu, select Organization Hierarchy and select Modify. The Step 1 of 3: Select an OTC Endpoint page appears. 

· Select your OTC Endpoint that appears in the list. The Step 2 of 3: Update OTC Endpoint Information page appears.

· Check the Add lower levels to this OTC Endpoint, to add lower level to the existing endpoint. Short Name and Description text boxes appear. The Step 3 of 3: Review OTC Endpoint appears.

· Verify the OTC Endpoint details are correct and click Submit. A confirmation page appears showing the OTC Endpoint has been modified.

	[image: ]Application Tip
Additional buttons on the page help you perform other tasks:
· Click Add More Lines to insert additional rows to the table, to input additional Agency accounting codes.
· Click Cancel to return to the OTCnet Home Page. No data will be saved. 
· Click Previous to return to the previous page.
· Click Return Home to return to the OTCnet Home Page. 





1. 

[bookmark: _Toc467490448]Modify OTC Endpoint Information 
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors and Card Administrators can modify the Short Name or Description of an existing OTC Endpoint, enable the OTC Endpoint to create deposits, capture checks, process card transactions, or add a lower level to the OTC Endpoint.

Note: Similarly, any CDC endpoint that is also a TGA and/or CHK endpoint, will require a card processing role with permission to modify an organization (i.e., Card Administrator).
To modify endpoint information settings for an OTC Endpoint with TGA, CHK and CDC, the user must have Accounting Specialist, Check Capture Administrator and Card Administrator privileges. 
To modify an OTC Endpoint, complete the following steps:
· Click the Administration tab. From the Manage Organizations menu, select Organization Hierarchy and select Modify. 
[bookmark: _Toc19199398]Figure 10. Select Manage Organizations>Organization Hierarchy>Modify
[image: ]
· The Step 1 of 3: Select an OTC Endpoint page appears. Select your organization’s endpoint that you want to modify, from the list that appears.
[bookmark: _Toc19199399]Figure 11. Select 1 of 3: Select OTC Endpoint
[image: ]
To modify endpoint information settings for an OTC Endpoint that is TGA, CHK, and CDC, the user must have Accounting Specialist, Check Capture Administrator, or Card Administrator privileges.

· Select the OTC Endpoint you want to modify from the list that appears. The Step 2 of 3: Update OTC Endpoint Information page appears.
[bookmark: _Toc19199400][bookmark: _Hlk10629083]Figure 12. Step 2 of 3: Update OTC Endpoint Information - Collapsed

[image: ]

· Update the OTC Endpoint information:

· Update General by entering the Short Name and Description details.

A short name must be entered to identify the OTC Endpoint that is being updated. If an OTC Endpoint exists, the data displayed in the text is available for update.

Note: Special characters are accepted in Short Name and Description fields; however, only use standard American Standard Code for Information Interchange (ASCII) characters. The standard ASCII range is 32-126. If non-standard ASCII characters (0-31, 127-255) are entered in the Short Name and Description fields, ISIM will not display the endpoint name in the Level drop-down field. Additionally, if non-standard ASCII characters are entered, you will not be able to manage OTC Endpoints (select endpoints) in OTCnet Offline. Instead an error message appears asking that Customer Support is contacted.
	
To allow the OTC Endpoint to create deposits, you can: Click the Allow OTC Endpoint to create deposits for over-the-counter collections checkbox.

[bookmark: _Hlk6413543]Note: Before a user can be provisioned to a deposit processing OTC Endpoint (TGA) in ISIM, ensure the Allow OTC Endpoint to create deposits for over-the-counter collections checkbox is checked.

· Update Agency Location Code by entering the ALC
· Update Address by entering the address details

Note: This is now a required field for configuring a lower level CDC endpoint.

· Update Financial Institution Relationship(s) by
· Selecting both the Financial Institution and RTN (Routing Transit Number)
· Entering the DDA (Demand Deposit Account) and Retype DDA and click Add

To delete the Financial Institution relationship, click the Delete checkbox(es) under the Delete column.
[bookmark: _Toc19199401]Figure 13. Allow OTC Endpoint to create deposits for over-the-counter collections
[image: ]


· To specify the check cashing policies of the OTC Endpoint, you can:
· Click the Check Cashing Policies checkbox.

If the checkbox is checked and grayed out, it indicates that this OTC Endpoint is either inheriting the policies from the parent Organization or its own information has already been defined and the user does not have the privilege to make modifications. Only a CCA has privileges to modify the check cashing policies.

· Add Default Reason Codes by,
· Selecting a default reason code and then clicking Add, optional. Repeat steps as necessary

The Default Reason Codes allows you to specify the return reason codes relevant to your Agency’s program. These codes represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes.
[bookmark: _Toc19199402]Figure 14. Check Cashing Policies
[image: ]


· Delete Assigned Return Reason Code Filters by
· Checking Delete box(es) under the Delete column, optional

4. Update Agency Assigned Suspensions by, optional
· Entering the number of Days
· Entering the Occurrence number 
· Selecting Agency Assigned Suspensions you want to Delete by checking the boxes under the Delete column, if applicable

To update the Agency Assigned Suspensions, select the Default Reason Code it will
apply, by clicking in the box provided.

The Agency Assigned Suspensions - Days allows you to specify the number of calendar days than an individual is unable to cash a check or pay by check and is calculated from the date the system is aware of the return file. The Agency Assigned Suspensions - Occurrence allows you to specify the suspension level.

5. Update Agency Verification Policy by, optional
3. Clicking Include Represented and Retired Check or Include Retired Check Only
4. Checking Include Expired
5. Entering the number of Expired Days
6. Checking Agency Verification Policies—Delete

Include Represented and Retired Check or Include Retired Check Only allows you to specify whether the verification record is generated on Represented or Retired items. Include Retired Check Only allows you to specify whether the verification record is generated on only Retired items.

Include Expired indicates whether previous suspensions that have since expired are counted when accessing the suspension level to assign when the individual writes a check. Agency Verification Policies—Delete allows you to remove the check cashing policy for your OTC Endpoint. Once the check cashing policy is removed for the OTC Endpoint, the higher-level organization’s check cashing policy will be automatically assigned to your OTC Endpoint.



To specify the data privacy of the OTC Endpoint, you can:
1. Click the Data Privacy checkbox.
2. Update Data Privacy by, 
3. Selecting the Data Privacy – Agency Available Attributes you want to block or unblock by checking the boxes under the Blocked column. 

Data Privacy defines the extent that users from other locations are able to view verification records from other locations. By default, Account, User Defined Field 1, Bank Routing Number, Note and Mask PII are checked as Blocked. If checkbox is checked, it indicates that the OTC Endpoint information has been defined. For maximum data privacy, all fields would be marked as blocked, except for Short Name. However, there may be situations where it is acceptable for outside users to view certain fields of verification records. 
Figure 15. Data Privacy Available Attributes
[image: ]



To enable the OTC Endpoint to capture checks, you can:
· Click the Enable Check Capture checkbox
· Update Enable Check Capture by, 
· Entering the (Agency Location Code) ALC+2

The ALC+2 is required for initial setup. Once the ALC+2 is entered it cannot be updated.

· Update OTC Verification Group by, 
· Entering the Short Name (Starting With) and clicking Search
· Clicking Yes or No for Queue Interface
· Selecting the OTC Endpoint, you want to add by checking the box under the Assign column and then clicking Add Agency Group

By default, the OTC Endpoint Short Name displays. You can add additional OTC Endpoints to the OTC Verification Group by clicking the Clear button to clear the Short Name and then entering a Short Name and clicking Search.

Designating an OTC Verification Group allows for verification data to be shared among non-related OTC Endpoints. For example, Lower Level 1 and Lower Level 2 are siblings under the High-level organization, Training Team Top Level). Since there is no parent-child relationship between these two OTC Endpoints, users from one OTC Endpoint are isolated from the other’s Verification data. By adding both unrelated locations to an OTC Verification Group, they are able to share information.

The Queue Interface is used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge.

· Under OTC Verification Group, Current Agency Site, 
· Select the OTC Endpoint you want to delete by checking the box under the Delete column. 



[bookmark: _Toc19199404]Figure 16. Enable Check Capture
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[bookmark: _Hlk18952303]To enable the OTC Endpoint to process card payments click the Enable Card Processing checkbox.

Before a user can be provisioned to a card processing OTC Endpoint (CDC) in ISIM, ensure the Enable Card Processing checkbox is checked.

· Update Enable Card Processing by, 
· Entering the Chain Code
· Entering the Division
· Entering the ALC
· Entering the Merchant ID

A Chain Code is an alphanumeric designator (e.g. 0F123B) assigned by WorldPay to reflect unique channel of card processing. A Chain Code is required for initial setup with lower level endpoints and once the Chain Code is saved, the Chain Code cannot be changed. An agency can have multiple Chain Codes, but no two agencies will have the same Chain Code.

A Division is a three-digit value assigned at lower level endpoints under the chain code to designate unique lines of accounting. The Division code for all OTC Endpoints is any value from 001 to 999.

The Agency Location Code (ALC) is required for initial setup and once the ALC is saved it cannot be changed. If an endpoint is adding the card processing functionality to an existing TGA or CHK endpoint, the ALC will already be populated.
The Merchant ID is a unique alphanumeric designator, received from CAS, and reflects the card processing location. An ALC can be associated with multiple merchant IDs; however, each merchant ID must be unique for each lower level endpoint. The Merchant ID field may contain up to 13 characters.

Once the Chain Code, Division, ALC, and Merchant ID are saved, they will grey out and cannot be changed. If any of these details need to be changed, a new endpoint must be created, and the information will need to be added again.

· Update the Address fields by completing: 
· Address Field 1, required
· Address Field 2, optional
· City, required
· State/Province, required
· Postal Code, required
· Phone Number, optional

· Designate the Signature Capture by checking the Signature Capture checkbox, optional

If the Signature Capture checkbox is checked, the customer’s signature, the “I agree to pay the above total amount in accordance with the card issuer’s agreement” message will appear on your agency’s sales receipts and the “I agree that I have received a refund for the amount stated above” message appears on your agency’s refund receipts. By default, the Signature Capture checkbox is unchecked. 
· Select a Return Policy by clicking the appropriate card transaction policy radio button for your organization, optional

A Return Policy indicates the agency’s return policy for card transactions, it is stored in the system and generated on receipts as mandated by the Treasury Financial Manual. The default return policy choice is None. Selecting a Return Policy is optional and does not apply to all endpoints (e.g. where the card user is not purchasing an item, but only paying fee/payment a return policy is not required) appears on receipts. 

Return Policy choices include:
· NO REFUND, ALL SALES FINAL – For any agency that does not accept merchandise in return or exchange and does not issue refunds to cardholders.
· EXCHANGE ONLY – For any agency that only accepts merchandise in immediate exchange for similar merchandise of a price equal to the amount of the original transaction.
·  IN-STORE CREDIT ONLY – For any agency that accepts merchandise in return and delivers to the cardholder an in-store credit equal to the value of the merchandise returned that may be used only in the agency’s place (s) of business.
· REFUNDS ONLY AVAILABLE WITHIN 30 DAYS OF SERVICE OR PURCHASE – For any agency that issues refunds to the original credit or debit card within 30 days of purchase or service.
· Other – The agency is prompted to enter some descriptive text outlining their agency’s return policy.
· None – Select if a return policy does not apply to an agency.   
[bookmark: _Toc19199405]Figure 17. Enable Card Processing, Address
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Figure 18. Enable Card Processing, Signature Capture and Return Policy
[image: ]

[bookmark: _Hlk10749478]To add lower level endpoints, you can:
· Click the Add lower levels to this OTC Endpoint checkbox.
· Update Add lower levels to this OTC Endpoint:
· Enter the Short Name and Description
· Click Add More Lines to add additional lower levels to this OTC Endpoint

A short name must be entered to identify the OTC Endpoint that is updated. If an OTC Endpoint exists, the data displayed in the text is available for update.

[bookmark: _Hlk10749494]Check the Add lower levels to this OTC Endpoint to add a lower level to the existing endpoint.
[bookmark: _Toc19199407]Figure 19. Add Lower Level to this OTC Endpoint
[image: ]


To specify the advanced administration:
· Click Advanced Administration
· Specify Advanced Administration 
· Click Yes or No for Debit Gateway

Prior to specifying Debit Gateway, confirmation must be received from the OTCnet Deployment Team to set up each applicable OTCnet Endpoint. Once received, users with Accounting Specialist and/or Check Capture Administrator privileges can specify the Advanced Administration information if the OTC Endpoint can capture checks. 

No indicates that Debit Gateway setup is not complete, and the OTC Endpoint is not ready for performing check capturing activities. 

[bookmark: _Hlk10753487]Yes indicates that Debit Gateway setup is complete, and the OTC Endpoint is now ready for performing check capture activities. A notification message appears as a reminder to submit your Agency Site Profile (ASP) for all check capture endpoints. If the ASP is not submitted to the OTCnet Deployment Team, this can prevent transactions from processing. Click OK.                     
[bookmark: _Toc19199408]                    Figure 20. Debit Gateway Notification Message for ASP
[image: ]

· View or specify the Forms Rendered Solution 

By default, all forms are set to be rendered and viewed in HTML. Under general circumstances, the ActiveX option does not need to be specified. 

The Forms Rendered Solution is read-only and only a 123 can specify the option to switch between viewing and accessing forms in HTML or ActiveX. 

· Viewing Report Only Summary Level Data to CIR checkbox

The Report Only Summary Level Data to CIR Information is read-only and only an HLAS can specify the information.

A checked box indicates that detailed level data will not be transmitted to Collections Information Repository (CIR) and only summary data will be reported to CIR for all the check transactions that are processed under this OTC Endpoint (CHK) or ALC+2. This is mainly for the OTC Endpoints that will be used to process tax data. An unchecked box indicates that detailed level data will be transmitted to CIR.

1. View or specify Summary Level Classification

The Summary Level Classification is read-only and only an HLAS, Check Capture Supervisor, and Check Lead Operator can specify the information.

A checked box indicates that the Check Capture Operators cannot classify individual checks. Instead the classification of the batch will occur after all the checks have been scanned.  An unchecked box indicates the Check Capture Operator will have to classify checks at the item level.

1. [bookmark: _Hlk506305854][bookmark: _Hlk505270112]Specify Batch List Report Print/Export Required During options by,
a. Checking or unchecking the Close Batch checkbox.
b. Checking or unchecking the Approve Batch checkbox.
[bookmark: _Toc19199409]Figure 21. Advanced Administration - Batch Print Options
[image: C:\Users\576435\AppData\Local\Temp\SNAGHTML5845637.PNG]

[bookmark: _Hlk506844913]
By default, all agencies will have the Close Batch checkbox checked. In order to close the batch, the user must print the PDF report or export the batch list report.

If the Close Batch checkbox is unchecked, the user can close the batch without having to print the PDF report or export the batch list report.

[bookmark: _Hlk506215403]By default, all agencies will have the Approve Batch checkbox checked. In order to approve the batch, the user must print the PDF report or export the batch list report.

If the Approve Batch checkbox is unchecked, the user can approve the batch without having to print the PDF report or export the batch list report. 
[bookmark: _Hlk506215090]
If the user is closing or approving multiple batches online and the Close Batch or Approve Batch checkboxes are checked for any OTCnet endpoint, then the user must print the PDF reports or export the list reports. The batch is not closed or approved until Confirm is clicked, which is enabled when the Print PDF Report or Export is clicked. 

If the user is closing and/or approving multiple batches online and the Close Batch or Approve Batch checkboxes are not checked for any OTCnet endpoint, then the user can close and/or approve multiple batches without printing the PDF reports or exporting the list reports. Confirm is enabled and the user can click to close and/or approve the multiple batches.
If the user is closing and/or approving multiple batches offline, Confirm is enabled and the user can close and/or approve multiple batches without needing to print the PDF reports or export the batch list reports. As a best practice, print the PDF reports or export the batch lists prior to closing and/or approving multiple batches. 

A user may print the PDF report or export the batch list report, regardless if the Close Batch and/or Approve Batch checkboxes are checked or unchecked. 

2. View or specify Agency Comments

An HLAS, CCS or CCLO can add, edit, or remove Agency comments.

The Specify Agency Comments field allows agencies to add, edit, or remove Agency Comments which are sent to CIR as part of the check transmission.
[bookmark: _Toc19199410]Figure 22. Update OTC Endpoint Information
[image: ]

If Special Designation is selected, a user is able to view which ALCs are CARS Reporters. 

The CARS Reporter special designation information is read-only and displays for TGA and CHK endpoints. Only an HLAS can specify the Special Designation information.

Yes, indicates that the OTC Endpoint is associated with an ALC that has been designated as a CARS Reporter. No indicates that the OTC Endpoint is not associated with an ALC that has been designated as a CARS Reporter. If an ALC is identified as a CARS Reporter, entering the Accounting Code information is mandatory. This will apply to all ALC+2 within the hierarchy of the ALC.



· Click Next after completing the OTC Endpoint Information page.

[bookmark: _Toc19199411]Figure 23. Special Designation
[image: ]

· The Step 3 of 3: Review OTC Endpoint page appears. Verify the OTC Endpoint details are correct and click Submit.
Figure 24. Step 3 of 3: Review OTC Endpoint
[image: ]                                                                                                                        

· A Confirmation page appears showing the OTC Endpoint has been modified. 
[bookmark: _Toc19199413]Figure 25. Modify Organization Confirmation
[image: ]


[bookmark: _Toc462057952][bookmark: _Toc462138812][bookmark: _Toc462300898][bookmark: _Toc467490449]
[image: MCj04420720000[1]]  Modify OTC Endpoint Information
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors and Card Administrators modify OTC Endpoint information, by completing the following steps:

To modify an OTC Endpoint, complete the following steps:
1. Click the Administration tab.

2. From the Manage Organizations menu, select Organization Hierarchy and select Modify. The Step 1 of 3: Select an OTC Endpoint page appears. 

	[image: ]Application Tip 
To modify endpoint information settings for an OTC Endpoint with TGA, CHK and CDC, the user must have Accounting Specialist, Check Capture Administrator and Card Administrator privileges. 


3. Select your OTC Endpoint that appears in the list. The Step 2 of 3: Update OTC Endpoint Information page appears.

4. Update the OTC Endpoint Information.

To update the general details of an OTC Endpoint, you can:
Update General by, 
3. Entering the updated OTC Endpoint’s Short Name and Description details.

	[image: ]Application Tip 
A short name must be entered to identify the OTC Endpoint that is being updated. If an OTC Endpoint exists, the data displayed in the text is available for update.



	[image: ]Application Tip
Special characters are accepted in Short Name and Description fields; however, only use standard American Standard Code for Information Interchange (ASCII) characters. The standard ASCII range is 32-126. If non-standard ASCII characters (0-31, 127-255) are entered in the Short Name and Description fields, ISIM will not display the endpoint name in the Level drop-down field. Additionally, if non-standard ASCII characters are entered, you will not be able to manage OTC Endpoints (select endpoints) in OTCnet Offline. Instead an error message appears asking that Customer Support is contacted.



To allow the OTC Endpoint to create deposits, you can:
4. Click the Allow OTC Endpoint to create deposits for over-the-counter collections checkbox.

	[image: ]Application Tip 
Before a user can be provisioned to a deposit processing OTC Endpoint (TGA) in ISIM, ensure the Allow OTC Endpoint to create deposits for over-the-counter collections checkbox is checked. 


5. Update Agency Location Code by
a. Entering the ALC
6. Update Address by
a. Entering the address details
7. Update Financial Institution Relationship(s) by
a. Selecting both the Financial Institution and the associated RTN (Routing Transit Number)
b. Entering the DDA (Demand Deposit Account) and Retype DDA and click Add.

	[image: ]Application Tip 
To delete the Financial Institution relationship, click the Delete checkbox(es) under the Delete column. 


To specify the check cashing policies of the OTC Endpoint, you can:
1. Click the Check Cashing Policies checkbox.

	[image: ]Application Tip 
If checkbox is checked and grayed out, it indicates that this OTC Endpoint is either inheriting the policies from the parent Organization or its own information has already been defined and the user does not have the privilege to make modifications. Only a CCA has privileges to modify the check cashing policies. 


2. Add Default Reason Codes by,
a. Selecting a default reason code and then clicking Add, optional. Repeat steps as necessary
3. Delete Assigned Return Reason Code Filters by
a. Checking Delete box(es) under the Delete column, optional


	[image: ]Application Tip 
The Default Reason Codes allows you to specify the return reason codes relevant to your agency’s program. These codes represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes.


1. Update Agency Assigned Suspensions by, optional
a. Entering the number of Days
b. Entering the Occurrence number 
c. Selecting Agency Assigned Suspensions you want to Delete by checking the boxes under the Delete column, if applicable

	[image: ]Application Tip 
To update the Agency Assigned Suspensions, select the Default Reason Code it will apply, by clicking in the box provided.



	[image: ]Application Tip 
The Agency Assigned Suspensions - Days allows you to specify the number of calendar days than an individual is unable to cash a check or pay by check and is calculated from the date the system is aware of the return file. The Agency Assigned Suspensions - Occurrence allows you to specify the suspension level.



2. Update Agency Verification Policy by, optional
a. Clicking Include Represented and Retired Check or Include Retired Check Only
b. Checking Include Expired
c. Entering the number of Expired Days
d. Checking Agency Verification Policies—Delete

	[image: ]Application Tip 
Include Represented and Retired Check or Include Retired Check 
Only allows you to specify whether the verification record is generated 
on Represented or Retired items. Include Retired Check Only allows 
you to specify whether the verification record is generated on only 
Retired items. 




	[image: ]Application Tip 
Include Expired indicates whether previous suspensions that 
have since expired are counted when accessing the suspension level 
to assign when the individual writes a check. Agency Verification Policies—Delete allows you to remove the check cashing policy for your OTC Endpoint. Once the check cashing policy is removed for the 
OTC Endpoint, the higher-level organization’s check cashing policy will 
be automatically assigned to your OTC Endpoint.


To specify the data privacy of the OTC Endpoint, you can:
3. Click the Data Privacy checkbox.
4. Update Data Privacy by, 
5. Select the Data Privacy – Agency Available Attributes you want to block or unblock by checking the boxes under the Blocked column. 

	[image: ]Application Tip 
By default, Account, User Defined Field 1, Bank Routing Number, Note and Mask PII are checked as Blocked. 



To enable the OTC Endpoint to capture checks, you can:
Click the Enable Check Capture checkbox.

	[image: ]Application Tip 
Before a user can be provisioned to a check capture OTC Endpoint (CHK) in ISIM, ensure the Enable Check Capture checkbox is checked.



	[image: ]Application Tip 
If checkbox is checked, it indicates that the OTC Endpoint information has been defined. 



1. Update Enable Check Capture by, 
2. Entering the (Agency Location Code) ALC+2.
	[image: ]Application Tip
The ALC+2 is required for initial setup. Once the ALC+2 is entered it cannot be updated. 


· 
Update OTC Verification Group by, 
a. Entering the Short Name (Starting With) and clicking Search

	[image: ]Application Tip 
By default, the OTC Endpoint Short Name displays. You can add additional OTC Endpoints to the OTC Verification Group by clicking the Clear button to clear the Short Name and then entering a Short Name, clicking Search and then clicking Add Agency Group.



	[image: ]Application Tip 
Designating an OTC Verification Group allows for verification data to be shared among non-related OTC Endpoints. For example, Lower Level1 and Lower Level 2 are siblings under the High-level organization, Training Team Top Level. Since there is no parent-child relationship between these two OTC Endpoints, users from one OTC Endpoint are isolated from the other’s Verification data. By adding both unrelated locations to an OTC Verification Group, they are able to share information.


b. Clicking Yes or No for Queue Interface

	[image: ]Application Tip 
The Queue Interface is used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge.


c. Select the OTC Endpoint you want to add by checking the box under the Assign column and then clicking Add Agency Group

1. Under OTC Verification Group, Current Agency Site, 
2. Select the OTC Endpoint you want to delete by checking the box under the Delete column.



To enable the OTC Endpoint to process card payments, you can:
· Click the Enable Card Processing checkbox

Before a user can be provisioned to a card processing OTC Endpoint (CDC) in ISIM, ensure the Enable Card Processing checkbox is checked.

· Update Enable Card Processing by, 
· Entering the Chain Code
· Entering the Division
· Entering the ALC
· Entering the Merchant ID

	[image: ]Application Tip 
A Chain Code is an alphanumeric designator (e.g. 0F123B) assigned by WorldPay to reflect unique channel of card processing. A Chain Code is required for initial setup with lower level endpoints and once the Chain Code is saved, the Chain Code cannot be changed. An agency can have multiple Chain Codes, but no two agencies will have the same Chain Code.
A Division is a three-digit value assigned at lower level endpoints under the chain code to designate unique lines of accounting. The default Division code is 001.
The Agency Location Code (ALC) is required for initial setup and once the ALC is saved it cannot be changed. If an endpoint is adding the card processing functionality to an existing TGA or CHK endpoint, the ALC will already be populated.
The Merchant ID is a unique designator assigned by WorldPay to reflect the card processing location. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint. The Merchant ID field may contain up to 20 characters. 
Once the Chain Code, Division, ALC, and Merchant ID are saved, they will grey out and cannot be changed. If any of these details need to be changed, a new endpoint must be created, and the Chain Code, Division, ALC, and Merchant ID will need to be added again.




· Designate the Signature Capture by
· Checking the Signature Capture check box, optional



	[image: ]Application Tip 
If the Signature Capture checkbox is checked, the customer’s signature, the “I agree to pay the above total amount in accordance with the card issuer’s agreement” message will appear on your agency’s sales receipts and the “I agree that I have received a refund for the amount stated above” message appears on your agency’s refund receipts. By default, the Signature Capture checkbox is unchecked. 




· Select a Return Policy by,
· Clicking the appropriate card transaction policy radio button for your organization, optional

	[image: ]Application Tip 
A Return Policy indicates the agency’s return policy for card transactions, it is stored in the system and generated on receipts as mandated by the Treasury Financial Manual. The default return policy choice is None. Selecting a Return Policy is optional and does not apply to all endpoints (e.g. where the card user is not purchasing an item, but only paying fee/payment a return policy is not required) appears on receipts. 

Return Policy choices include:
· NO REFUND, ALL SALES FINAL – For any agency that does not 
accept merchandise in return or exchange and does not issue refunds 
to cardholders.
· EXCHANGE ONLY – For any agency that only accepts merchandise 
in immediate exchange for similar merchandise of a price equal to the amount of the original transaction.
·  IN-STORE CREDIT ONLY – For any agency that accepts merchandise in return and delivers to the cardholder an in-store credit equal to the value of the merchandise returned that may be used only in the 
agency’s place (s) of business.
· REFUNDS ONLY AVAILABLE WITHIN 30 DAYS OF SERVICE OR PURCHASE – For any agency that issues refunds to the original credit or debit card within 30 days of purchase or service.
· Other – The agency is prompted to enter some descriptive text outlining their agency’s return policy.
· None – Does not apply to an agency.   




To add lower level endpoints, you can:
3. Click the Add lower levels to this OTC Endpoint checkbox.
4. Update Add lower levels to this OTC Endpoint by,
· Entering the Short Name and Description. 
· Click Add More Lines to add additional lower levels to this OTC Endpoint

	[image: ]Application Tip 
A short name must be entered to identify the OTC Endpoint that is being updated. If an OTC Endpoint exists, the data displayed in the text is available for update. 


To specify the advanced administration, you can:
1. Click Advanced Administration.
2. Specify Advanced Administration by,
· Clicking Yes or No for Debit Gateway

	[bookmark: _Hlk10054653][image: ]Application Tip 
Prior to specifying Debit Gateway, confirmation must be received from the OTCnet Deployment Team to set-up each applicable OTCnet Endpoint. Once received, users with Accounting Specialist and/or Check Capture Administrator privileges can specify the Advanced Administration information if the OTC Endpoint is allowed to capture checks. 



	[image: ]Application Tip 
No, indicates that Debit Gateway set-up is not completed, and the OTC Endpoint is not ready for performing check capture activities.  



	[image: ]Application Tip 
Yes, indicates that Debit Gateway setup is completed, and the OTC Endpoint is now ready for performing check capture activities. A notification message appears as a reminder to submit your Agency Site Profiles (ASP) for all check capture endpoints. If the ASP is not submitted to the OTCnet Deployment Team, this can prevent transactions from processing. Click OK.



View or specify the Forms Rendered Solution 

	[image: ]Application Tip 
By default, all forms are set to be rendered and viewed in HTML. Under general circumstances, the ActiveX option does not need to be specified. The Forms Rendered Solution is read-only and only an HLAS can specify the option to switch between viewing and accessing forms in HTML or ActiveX. 



· View the Report Only Summary Level Data to CIR 

	[image: ]Application Tip 
The Report Only Summary Level Data to CIR Information is read-only and only an HLAS can specify the information.



	[image: ]Application Tip 
A checked box indicates that detailed level data will not be transmitted to Collections Information Repository (CIR) and only summary data will be reported to CIR for all the check transactions that are processed under this OTC Endpoint (CHK) or ALC+2. This is mainly for the OTC Endpoints that will be used to process tax data. An unchecked box indicates that detailed level data will be transmitted to CIR.



· View the Summary Level Classification

	[image: ]Application Tip 
The Summary Level Classification is read-only and only a High-Level Agency Support (HLAS), Check Capture Supervisor, and Check Lead Operator can specify the information.



	[image: ]Application Tip 
A checked box indicates that Check Capture Lead Operators and Check Capture Operators cannot classify individual checks. Instead the classification of the batch will occur after all the checks have been 
scanned. An unchecked box indicates the Check Capture Operator will have to classify checks at the item level.



· Specify Batch List Print/Export Required During options by, 
· Checking or unchecking the Close Batch checkbox
· Checking or unchecking the Approve Batch checkbox 



	[image: ]Application Tip 
By default, all agencies will have the Close Batch checkbox checked. In order to close the batch, the user must print the PDF report or export the batch list report. 
If the Close Batch checkbox is unchecked, the user can close the batch without having to print the PDF report or export the batch list report.  



	[image: ]Application Tip 
By default, all agencies will have the Approve Batch checkbox checked. In order to approve the batch, the user must print the PDF report or export the batch list report. 
If the Approve Batch checkbox is unchecked, the user can approve the batch without having to print the PDF report or export the batch list report.   



	[image: ]Application Tip 
If the user is closing or approving multiple batches online and the Close Batch and/or Approve Batch checkboxes are checked for any OTCnet endpoint, then the user must print the PDF reports or export the batch list reports. The batch is not closed and/or approved until Confirm is clicked, which is enabled when the Print PDF Report or Export is clicked.



	[image: ]Application Tip 
If the user is closing and approving multiple batches offline, Confirm is enabled and the user can close/approve multiple batches without needing to print the PDF reports or exporting the batch list reports. As a best practice, print the PDF reports or export the batch list reports prior to closing and/or approving multiple batches. 



	[image: ]Application Tip 
A user may print the PDF report or export the batch list report, regardless if the Close Batch and/or Approve Batch checkboxes are checked or unchecked.


· View or specify Agency Comments

	[image: ]Application Tip 
A Check Capture Lead Operator, Check Capture Supervisor, and HLAS can add, edit, or remove Agency comments Agency Comments. A Check Capture Administrator, Check Capture Operator, Agency Manager, and CIRA Viewer can view Agency Comments. 




	[image: ]Application Tip 
The Specify Agency Comments field allows agencies to add, edit, or remove Agency comments which are sent to CIR as part of the check transmission. 



To view the special designation, you can:
3. Click Special Designation

	[image: ]Application Tip 
The CARS Reporter special designation information is read-only 
and displays for TGA and CHK endpoints. Only an HLAS can specify the Special Designation information.



	[image: ]Application Tip 
Yes, indicates that the OTC Endpoint is associated with an ALC that has been designated as a CARS Reporter. No indicates that the OTC Endpoint is not associated with an ALC that has been designated as a CARS Reporter.



5. Click Next. The Step 3 of 3: Review OTC Endpoint page appears.

6. Verify the information is correct and click Submit. Click Edit, if you need to modify the information entered and return to Step 4.

7. A Confirmation page appears showing the OTC Endpoint has been modified.



	[image: ]Application Tip 
Additional buttons on the page that help you perform other tasks:
4. Click Previous to return to the previous page.
5. Click Cancel to return to the OTCnet Home Page. No data will be saved. 
6. Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc467490450]


Delete or Neutralize an OTC Endpoint
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors and Card Administrators can delete an OTC Endpoint as long as no deposits or check transactions have been made to that endpoint. You cannot delete an OTC Endpoint with deposits or check transactions because deleting the OTC Endpoint deletes all information associated with that OTC Endpoint. This would delete deposit information that impacts the reports you run in OTCnet. 
You can neutralize an OTC Endpoint if deposits or check transactions have been created. Once the OTC Endpoint is neutralized, deposits or check transactions cannot be created from that OTC Endpoint; however, the information from previously created deposits or check transactions can be accessed in OTCnet reporting. 
Additionally, to delete or neutralize an OTC Endpoint, all ISIM user accounts must be removed from the OTCnet Endpoint (Deposit Processing and Check Processing) and the Agency Form Data must be removed. To remove a user from an OTCnet Endpoint, refer to the Administration: Chapter 3. Managing User Accounts, Topic 3. Creating, Assigning, and Editing an OTCnet Account user guide. To remove the Agency Form Data, contact Customer Support at: fiscalservice.otcchannel@citi.com.
To delete or neutralize an OTC Endpoint, complete the following steps:
1. Click the Administration tab. From the Manage Organizations menu, select Organization Hierarchy and select Delete.
[bookmark: _Toc19199414]Figure 26. Select Manage Organizations>Organization Hierarchy>Delete
[image: ]



2. The Step 1 of 2: Select the OTC Endpoint(s) page appears. Select the OTC Endpoint(s) you would like to Delete or Neutralize and click Next. 


[bookmark: _Toc19199415]Figure 27. Step 1 of 2: Select the OTC Endpoint(s)
[image: ]
1. The Step 2 of 2: Review OTC Endpoint(s) page appears. Verify the correct endpoint is marked for deletion/neutralization and click Submit. 
[bookmark: _Toc19199416][bookmark: _Hlk10637953]Figure 28. Step 2 of 2: Review OTC Endpoint(s)
[image: ]


2. The Step 1 of 2: Select the OTC Endpoint(s) page appears. Select the OTC Endpoint(s) you would like to Delete or Neutralize and click Next.

A Confirmation page appears confirming the OTC Endpoint has been deleted or neutralized. 
[bookmark: _Toc19199417]Figure 29. Delete Organization Confirmation
[image: ]



[bookmark: _Toc467490451][image: MCj04420720000[1]]	Delete or Neutralize an OTC Endpoint
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors and Card Administrators, can delete or neutralize an OTC Endpoint.
To delete or neutralize an OTC Endpoint, complete the following steps:
i. Click the Administration tab.

ii. From the Manage Organizations menu, select Organization Hierarchy and select Delete. The Step 1 of 2: Select the OTC Endpoint(s) page appears.

iii. Select the OTC Endpoints you would like to Delete and click Next. 

	[image: ]Application Tip
Consider the following information about deleting an OTC Endpoint:
· An OTC Endpoint can be deleted only if no deposits or check transactions have been made to that endpoint. You cannot delete an OTC Endpoint with deposits or check transactions because deleting the OTC Endpoint deletes all information associated with that OTC Endpoint. This would delete deposit and check transaction information that impacts the reports you run in OTCnet. 
· Before you can delete an OTC Endpoint, All ISIM user accounts must be removed from the OTCnet Deposit Processing Endpoint and OTCnet Check Processing Endpoint.
· The Agency Form Data must be removed. To remove the Agency Form Data, contact the Customer Support at fiscalservice.otcchannel@citi.com.


Or
 Select the OTC Endpoints you would like to Neutralize and click Next.

	[image: ]Application Tip
Consider the following information about neutralizing an OTC Endpoint:
· An OTC Endpoint can be neutralized if deposits or check transactions have been created. Once neutralized, deposits or check transactions cannot be created from that OTC Endpoint; however, the information from previously created deposits or check transactions can be accessed in OTCnet reporting. 
· Before you can neutralize an OTC Endpoint:
· All ISIM user accounts must be removed from the OTCnet Deposit Processing Endpoint and OTCnet Check Processing Endpoint. 
· The Agency Form Data must be removed. To remove the Agency Form Data, contact the Customer Support at fiscalservice.otcchannel@citi.com.


iv. The Step 2 of 2: Review OTC Endpoint(s) page appears. Verify the correct endpoint is marked for deletion or neutralization and click Submit. 

v. A Confirmation page appears confirming the OTC Endpoint has been deleted.

	[image: ]Application Tip
Additional button on the page helps you perform other tasks:
· Click Return Home to return to the OTCnet Home Page. 



[bookmark: _Toc467490452]
View OTC Endpoint 
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors, Check Capture Lead Operators, Card Administrators and Card Operators can view an OTC Endpoint.

To view an OTC Endpoint, complete the following steps:

· Click the Administration tab. From the Manage Organizations menu, select Organization Hierarchy and select View. 
Figure 30. Select Manage Organizations> Organization Hierarchy>View
[image: ]
· The View Organization page appears. Select the OTC Endpoint you would like to view.
[bookmark: _Toc19199419]Figure 31. Select the OTC Endpoint
[image: ]


· The View OTC Endpoint page appears. View OTC Endpoint Information.
Figure 32. View OTC Endpoint
[image: ]
[bookmark: _Toc462057955][bookmark: _Toc462138815][bookmark: _Toc462300901][bookmark: _Toc467490453]
[image: MCj04420720000[1]]	View OTC Endpoint
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors, Check Capture Lead Operators, Card Administrators and Card Operators can view an OTC Endpoint.
To view an OTC Endpoint, complete the following steps:
1. Click the Administration tab.

2. From the Manage Organizations menu, select Organization Hierarchy and select View. The View Organization page appears.

3. Select the OTC Endpoint you would like to view. The View OTC Endpoint page appears.


	[image: ]Application Tip
Additional button on the page helps you perform other tasks:
· Click Previous to return to the previous page.
· Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc467490454]
Search OTC Endpoint 
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors, Check Capture Lead Operators, Card Administrators and Card Operators can search an OTC Endpoint.

To search for an OTC Endpoint, complete the following steps:

1. Click the Administration tab.

2. From the Manage Organizations menu, select Organization Hierarchy and select Search. 
[bookmark: _Toc19199421]Figure 33. Select Manage Organizations>Organization Hierarchy>Search
[image: ]
3. The Search Organization page appears. Select the OTC Endpoint you would like to search. Click Search.
[bookmark: _Toc19199422]Figure 34. Step 1 of 2: Search OTC Endpoint
[image: ]


The View the OTC Endpoint (for Search Organization) page appears. Search OTC Endpoint Information. 
Figure 35. Step 2 of 2: View OTC Endpoint
[image: ]

[bookmark: _Toc462057957][bookmark: _Toc462138817][bookmark: _Toc462300903][bookmark: _Toc467490455]
[image: MCj04420720000[1]]	Search OTC Endpoint
Accounting Specialists, Local Accounting Specialists, Check Capture Administrators, Check Capture Supervisors, Check Capture Lead Operators, Card Administrators and Card Operators can search an OTC Endpoint.

To search for an OTC Endpoint, complete the following steps:
1. Click the Administration tab.

2. From the Manage Organizations menu, select Organization Hierarchy and select Search. The View Organization page appears.

3. Select the OTC Endpoint you would like to view. The View OTC Endpoint page appears.

	[image: ]Application Tip
Additional button on the page helps you perform other tasks:
· Click Previous to return to the previous page.
· Click Return Home to return to the OTCnet Home Page.






[bookmark: _Toc467490456]Topic 4. Managing Accounting Codes
OTCnet provides enhanced check capture and deposit reporting functionalities to support the Central Accounting Reporting System (CARS). The CARS objectives are to capture classification information at the earliest possible time, streamline central accounting and reporting, eliminate burdensome reconciliation, and provide timely Fund Balance with Treasury (FBWT) information to Agencies. 

OTCnet captures classification information for transactions (over-the-counter deposits) processed through the Deposit Reporting function and the Check Capture function to support the CARS requirement that all transactions capture standard classification information.
For OTCnet, standard classification information will be accepted in the form of a Treasury Account Symbol (TAS) String or a Classification Key (C-Key), which is an internal Agency Accounting Code that can be translated into a valid TAS. 

OTCnet sends this C-Key information to CARS through the Collections Information Repository (CIR). CARS then communicates with the Shared Accounting Module (SAM) application to translate the C-Key into a valid TAS/BETC through the Cash Flow and Default Profiles that have been setup in SAM. Initially, classification of check transactions for non-CARS Reporting Agencies is optional.

To learn more about CARS, please visit http://fms.treas.gov/CARS/index.html.

[bookmark: _Toc467490457][bookmark: _Hlk33782537]
Modify Accounting Codes
The Check Capture Administrator, Check Capture Supervisor and Accounting Specialist can modify accounting code(s) by following the steps below.

To modify an existing accounting code, complete the following steps:

· Click the Administration tab. From the Manage Organizations menu, select Accounting Codes>Modify. 
[bookmark: _Toc19199424]Figure 36. Select Manage Organizations>Accounting Codes>Modify
[image: ]
· The Step 1 of 3 Select Organization Endpoint page appears. Select the organization endpoint for which you want to modify accounting codes. 
[bookmark: _Toc19199425]Figure 37. Step 1 of 3: Select OTC Endpoint
[image: ]

· The Step 2 of 3: Update Accounting Codes page appears. Under the New Accounting Codes to be Added table, enter the accounting code details and click Next. 
· Enter the Agency Accounting Code details
· Enter the accounting code Description details
· Click the TAS checkbox to indicate the accounting code is a Treasury Account Symbol, if applicable

To input additional rows and accounting codes to the table, click Add More Lines.


 
If an Agency Accounting Code label is customized, it is displayed as the label above the imported codes, according to the custom label that was defined for the highest-level organization. This applies to OTC Endpoints that use the deposit processing and/or check processing functionalities. The default accounting code label is Agency Accounting Code.
[bookmark: _Toc19199426]Figure 38. Step 2 of 3: Update Accounting Codes
[image: ]

1. The Step 3 of 3: Review Accounting Codes page appears. Verify the information is correct and click Submit. 
[bookmark: _Toc19199427]Figure 39. Step 3 of 3: Review Accounting Codes
[image: ]

2. A Confirmation page appears showing the accounting codes have been saved. 
[bookmark: _Toc19199428]Figure 40. Modify Accounting Codes Confirmation
[image: ]
[bookmark: _Toc462057960][bookmark: _Toc462138820][bookmark: _Toc462300906][bookmark: _Toc467490458]
[image: MCj04420720000[1]]  Modify an Accounting Code
The Accounting Specialist, Check Capture Administrator and Check Capture Supervisor are authorized to modify accounting codes.

To modify an existing accounting code, complete the following steps:
· Click the Administration tab.

· From the Manage Organizations menu, select Accounting Codes>Modify. The Step 1 of 3: Select OTC Endpoint page appears.
· Select the organization endpoint for which you want to modify accounting codes. 

· The Step 2 of 3: Update Accounting Codes page appears. Under the New Accounting Codes to be Added table, enter the accounting code details and click Next. 

	[image: ]Application Tip
If an Agency Accounting Code label is customized, it is displayed as the label above the imported or modified codes within the Maintain Accounting Codes module, according to the custom label that was defined for the highest-level organization. Within the rest of the application, custom labels apply to deposit processing functionalities, but are not extended to check processing functionalities. The default accounting code label is Agency Accounting Code.


	You can update the details by
1. Clicking the TAS checkbox to indicate that the accounting code is a Treasury Account Symbol (TAS), if applicable 
2. Entering the details in both the Agency Accounting Code and Description text boxes
3. Checking the Skip Selected box to skip saving any of the imported accounting codes

· The Step 3 of 3: Review Accounting Codes page appears. Verify the information is correct and click Submit. 

· A Confirmation page appears showing that the accounting codes have been imported. Simultaneously, accounting codes flagged as TAS will need to be transmitted to the Shared Accounting Module (SAM) to confirm that they are valid TAS strings
	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
· Click Return Home to return to the OTCnet Home Page.


[bookmark: _Toc467490459]Import Accounting Codes
The Check Capture Administrator, Check Capture Supervisor and Accounting Specialist can import accounting codes by following the steps below.
To import an accounting code, complete the following steps:

· Click the Administration tab.

· From the Manage Organizations menu, select Accounting Codes>Import. 
[bookmark: _Toc19199429]Figure 41. Select Manage Organizations>Accounting Codes>Import
[image: ]

· The Step 1 of 4: Select OTC Endpoint page appears. Select the top-level organization endpoint for which you want to import accounting codes. 
[bookmark: _Toc19199430]Figure 42. Step 1 of 4: Select OTC Endpoint
[image: ]




· The Step 2 of 4: Import from File page appears. Select the type of accounting code to import into the system and browse to its location and click Import.
[bookmark: _Toc19199431]Figure 43. Step 2 of 4: Import from File
[image: ]

· The Step 3 of 4: Select Accounting Codes page appears. Update the list of accounting codes that will be imported into the system and click Next.

If an Agency Accounting Code label is customized, it is displayed as the label above the imported codes, according to the custom label that was defined for the highest-level organization. This applies to OTC Endpoints that use the deposit processing and/or check processing functionalities. The default accounting code label is Agency Accounting Code.
[bookmark: _Toc19199432]Figure 44. Step 3 of 4: Select Accounting Codes
[image: ]
	You can update the details by
· Clicking the TAS checkbox to indicate that the accounting code is a Treasury Account Symbol (TAS), if applicable 
· Entering the details in both the Agency Accounting Code and Description text boxes
· Checking the Skip Selected box to skip saving any of the imported accounting codes
· The Step 4 of 4: Review page appears. Verify the information is correct and click Submit. 
[bookmark: _Toc19199433]Figure 45. Step 4 of 4: Review
[image: ]
· A Confirmation page appears showing that the accounting codes have been imported. 

Note: Once accounting codes have been imported successfully, the Confirmation page appears. Simultaneously, the accounting codes flagged as TAS will need to be transmitted to the Shared Accounting Module (SAM) to confirm that they are valid TAS strings.
[bookmark: _Toc19199434]Figure 46. Import Accounting Codes Confirmation
[image: ]
[bookmark: _Toc462057962][bookmark: _Toc462138822][bookmark: _Toc462300908][bookmark: _Toc467490460]
[image: MCj04420720000[1]]  Import an Accounting Code
The Check Capture Administrator, Check Capture Supervisor and Accounting Specialist are authorized to import accounting codes.
To import an accounting code, complete the following steps:
	[image: ]Application Tip
You can download Treasury Account Symbols (TAS), for import from the Shared Account Module (SAM) site at: https://www.sam.fms.treas.gov/sampublic/tasbetc.htm.


· Click the Administration tab.

· From the Manage Organizations menu, select Accounting Codes>Import. The Step 1 of 4: Select OTC Endpoint page appears.

· Select the top-level organization endpoint for which you want to import accounting codes. The Step 2 of 4: Import from File page appears. 

· Select the type of accounting code to import into the system and browse to its location and click Import. The Step 3 of 4: Select Accounting Codes page appears.

· Update the list of accounting codes that will be imported into the system and click Next.

	[image: ]Application Tip
If an Agency Accounting Code label is customized, it is displayed as the label above the imported or modified codes within the Maintain Accounting Codes module, according to the custom label that was defined for the highest-level organization. Within the rest of the application, custom labels apply to deposit processing functionalities, but are not extended to check processing functionalities. The default accounting code label is Agency Accounting Code.



You can update the details by
· Clicking the TAS checkbox to indicate that the accounting code is a Treasury Account Symbol (TAS), if applicable 
· Entering the details in both the Agency Accounting Code and Description text boxes
· Checking the Skip Selected box to skip saving any of the imported accounting codes

· The Step 4 of 4: Review page appears. Verify the information is correct and click Submit. 


· A Confirmation page appears showing that the accounting codes have been imported. Simultaneously, accounting codes flagged as TAS will need to be transmitted to the Shared Accounting Module (SAM) to confirm that they are valid TAS strings.

	
[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
· Click Return Home to return to the OTCnet Home Page.



[bookmark: _Toc462138823][bookmark: _Toc467490461]
View Accounting Codes
The Accounting Specialist, Local Accounting Specialist, Check Capture Administrator, and Check Capture Supervisor can view accounting codes.

To view an accounting code, complete the following steps: 	
1. Click the Administration tab. From the Manage Organizations menu, select Accounting Codes>View. 
[bookmark: _Toc19199435]Figure 47. Select Manage Organizations>Accounting Codes>View
[image: ]
2. The View Accounting Codes page appears. Select the highest-level organization endpoint’s accounting codes you would like to view. 
[bookmark: _Toc19199436]Figure 48. Select Organization Endpoint
[image: ]



3. The View Accounting Codes page appears.
[bookmark: _Toc19199437]Figure 49. View Accounting Codes
[image: ]

[bookmark: _Toc462057964][bookmark: _Toc462138824][bookmark: _Toc462300910][bookmark: _Toc467490462]
[image: MCj04420720000[1]]  View an Accounting Code	
The Accounting Specialist, Local Accounting Specialist, Check Capture Administrator, and Check Capture Supervisor can view accounting codes.

To view an accounting code, complete the following steps: 
· Click the Administration tab.

· From the Manage Organizations menu, select Accounting Codes>View. The View Accounting Codes page appears.

· Select the highest-level organization endpoint’s accounting codes you would like to view. The View Accounting Codes page appears.

	[image: ]Application Tip
If an Agency Accounting Code label is customized, it is displayed as the label above the imported codes, according to the custom label that was defined for the highest-level organization. This applies to OTC Endpoints that use the deposit processing and/or check processing functionalities. The default accounting code label is Agency Accounting Code.



	[image: ]Application Tip 
Only active accounting codes available for deposit processing and check processing (if applicable) appear. 



	[image: ]Application Tip 
Under the Active Accounting Code table, both Treasury Account Symbols (TAS) and accounting codes not identified as TAS display. 



	[image: ]Application Tip 
If an accounting code is a TAS, a check mark displays under the TAS column and the SAM validation status (Valid, Invalid or In Process) displays under the Validation Status column. 



	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
· Click Return Home to return to the OTCnet Home Page.


[bookmark: _Toc467490463]
Modify Endpoint Mappings
[bookmark: _Toc327813820][bookmark: _Toc382481751]An endpoint mapping is the assignment of accounting codes to an agency’s OTC Endpoint, to which a deposit amount can be allocated.

To modify endpoint mappings, complete the following steps:

· Click the Administration tab.

· From the Manage Organizations menu, select Accounting Codes and click Modify OTC Endpoint Mappings. 
[bookmark: _Toc19199438]Figure 50. Manage Organizations>Accounting Codes>Modify OTC Endpoint Mappings
[image: ]

· The Step 1 of 4: Select OTC Endpoint page appears. Select the OTC Endpoint for the accounting code endpoint mapping you would like to assign or remove. 
[bookmark: _Toc19199439]Figure 51. Step 1 of 4: Select OTC Endpoint
[image: ]


· The Step 2 of 4: View Assigned Accounting Codes page appears. Click Assign Mappings to assign an accounting code to an OTCnet Endpoint. The Step 2 of 4 Continued: Search and Assign Accounting Codes page appears. 
or 

Click Remove Mappings to remove an accounting code from an OTCnet Endpoint. The Step 3 of 4: Remove Accounting Codes page appears.
[bookmark: _Toc19199440]Figure 52. View Assigned Accounting Codes 
[image: ]

· Assign or remove an accounting code to or from an OTCnet Endpoint.

To Assign Mappings to an OTCnet Endpoint, 
· Enter the Accounting Code (Starting With) search criteria, optional
· Enter the Description (Contains) search criteria, optional
· Click Search, optional
· Check the Assign box(es) for the accounting codes that you want to assign
· Click Next (Proceed to Step 3 of 4: Assign Accounting Codes)
	
If an Agency has identified accounting codes as a TAS, only TAS identified as Valid by SAM will be available for mapping to an OTC Endpoint.


[bookmark: _Toc19199441]Figure 53. Step 2 of 4 Continued: Search and Assign Accounting Codes
[image: ]
Note: All accounting codes that meet your search criteria and are not assigned 
to your OTC Endpoint display on the page. If you do not enter search criteria, 
all the accounting codes defined for the highest-level organization appear.

If an Agency has identified accounting codes as a TAS, only TAS identified as Valid by SAM will be available for mapping to an OTC Endpoint. 

or

To Remove Mappings from an OTCnet Endpoint, 
· Check the Remove box(es) for the accounting codes that you want to remove
· Click Next (Proceed to Step 4 of 4: Review Accounting Codes from Endpoint)


[bookmark: _Toc19199442]Figure 54. Step 3 of 4: Assign Accounting Codes
[image: ]

· The Step 3 of 4: Assign Accounting Codes page appears. Review and verify the accounting code(s) you would like to assign and click Next. 
[bookmark: _Toc19199443]Figure 55. Step 3 of 4: Assign Accounting Codes 
[image: ]

Note: Check the Remove box(es) and click the Update button to delete the OTC Endpoint mapping for an accounting code.


A mapped accounting code is not eligible for removal if a batch is associated with a transaction within an active batch that is Open, Closed, or Approved or a deposit that is in Draft or Awaiting Approval (AWAP) status. An error message will be displayed to a user if this scenario occurs.
 
· The Step 4 of 4: Review Accounting Codes to Endpoint page appears. Confirm the information is correct and click Submit to assign the accounting code(s) to the OTC Endpoint.
[bookmark: _Toc19199444]Figure 56. Step 4 of 4: Review Accounting Codes to OTC Endpoint – 
Accounting Code Marked for Assignment 
[image: ]
or

Confirm the information is correct and click Submit to remove the accounting code(s) from the OTC Endpoint. 
[bookmark: _Toc19199445]Figure 57. Step 4 of 4: Review Accounting Codes to Endpoint
[image: ]
· 
A Confirmation page appears showing that the accounting codes have been assigned to or removed from the OTC Endpoint.
[bookmark: _Toc19199446]Figure 58. Assigned Accounting Code Confirmation
[image: ]

[bookmark: _Toc462057966][bookmark: _Toc462138826][bookmark: _Toc462300912]

[bookmark: _Toc467490464][image: MCj04420720000[1]]  Map Accounting Codes to OTC Endpoints
The Accounting Specialist, Local Accounting Specialist, Check Capture Administrator, and Check Capture Supervisor can map accounting codes to OTC Endpoints.

To map accounting codes to OTC Endpoints, complete the following steps:
· Click the Administration tab.

· From the Manage Organizations menu, select Accounting Codes and click Modify OTC Endpoint Mappings. The Step 1 of 4: Select OTC Endpoint page appears.

· Select the OTC Endpoint for the accounting code endpoint mapping you would like to assign or remove. The Step 2 of 4: View Assigned Accounting Codes page appears.

	[image: ]Application Tip
If an Agency Accounting Code label is customized, it is displayed as the label above the imported or modified codes within the Maintain Accounting Codes module, according to the custom label that was defined for the highest-level organization. Within the rest of the application, custom labels apply to deposit processing functionalities, but are not extended to check processing functionalities. The default accounting code label is Agency Accounting Code.



· Click Assign Mappings to assign an accounting code to an OTCnet Endpoint. The Step 2 of 4 Continued: Search and Assign Accounting Codes page appears. 
or 
Click Remove Mappings to remove an accounting code from an OTCnet Endpoint. The Step 3 of 4: Remove Accounting Codes page appears. 

· Assign or remove an accounting code to or from an OTCnet Endpoint.
To Assign Mappings to an OTCnet Endpoint, 
· Enter the Accounting Code (Starting With) search criteria, optional
· Enter the Description (Contains) search criteria, optional
· Click Search, optional

	[image: ]Application Tip
All accounting codes that meet your search criteria and are not assigned 
to your OTC Endpoint display on the page. If you do not enter search criteria, 
all the accounting codes defined for the highest-level organization appear.





	
[image: ]Application Tip
If an Agency has identified accounting codes as a Treasury Account Symbol (TAS), only TAS identified as Valid by Shared Accounting Module (SAM) will be available for mapping to an OTC Endpoint.


· Check the Assign box(es) for the accounting codes that you want to assign
· Click Next (Proceed to Step 3 of 4: Assign Accounting Codes)

or

To Remove Mappings from an OTCnet Endpoint, 
· Check the Remove box(es) for the accounting codes that you want to remove
· Click Next (Proceed to Step 4 of 4: Review Accounting Codes from Endpoint)

· The Step 3 of 4: Assign Accounting Codes page appears. Review and verify the accounting code(s) you would like to assign and click Next. (Proceed to Step 4 of 4: Review Accounting Codes to Endpoint)

	[image: ]Application Tip
Check the Remove box(es) and click the Update button to delete the OTC Endpoint mapping for an accounting code.



	[image: ]Application Tip
A mapped accounting code is not eligible for removal if a batch is associated with a transaction within an active batch that is Open, Closed, 
or Approved or a deposit that is in Draft or Awaiting Approval (AWAP) status. An error message will be displayed to a user if this scenario occurs.


· The Step 4 of 4: Review Accounting Codes to Endpoint page appears. Confirm the information is correct and click Submit to assign the accounting code(s) to the OTC Endpoint. 

or

The Step 4 of 4: Review Accounting Codes from Endpoint page appears. Confirm the information is correct and click Submit to remove the accounting code(s) from the OTC Endpoint. 

· A Confirmation page appears showing that the accounting codes have been assigned to or removed from the OTC Endpoint.


	[image: ]Application Tip
Additional buttons on the page help you perform other tasks:
· Click Return Home to return to the OTCnet Home Page.
· Click Manage Additional to manage another accounting code.


[bookmark: _Toc257798071][bookmark: _Toc396899617]


[bookmark: _Toc467490465]Topic 5. Managing Processing Options
As part of managing your organization hierarchy, you need to define your deposit processing options. Processing options are parameters for the deposit and adjustments process. You must first define processing options at the highest level of the organization before defining lower level options. For lower-level organizations, if you do not define these options, then the lower-level organizations will take on the options set for the next higher-level organization that does have the options set.

If you do not define processing options, your organization cannot create deposits or classify a batch at the summary level. You can define processing options at any level within your organization. You can also view the processing options by OTC Endpoint report to manage processing options in your organization.

As an Accounting Specialist, you can modify the following processing options for your organization’s hierarchy:

· Accounting Classifications for Adjustments, Corrections, and Returned Items: Identifies the default accounting codes to which you want adjusted amounts credited and debited. This also applies to credit and debit voucher ALC Account Switch Corrections, returned items, and batches that are classified at the summary level which contain a failed item 

Accounting Specialists, Check Capture Supervisors and Check Capture Lead Operators can only apply Accounting classifications for adjustments. Check Capture Supervisors and Check Capture Lead Operators can only apply accounting classifications for corrections and returned items.

· Correspondence: Provides the financial institution with address information for any correspondence including returned item information

· Deposit Preparation: Sets default settings for deposit preparation to save time for Deposit Preparers

· [bookmark: _Toc396899618]Transaction History: Sets default settings for historical data about transactions
[bookmark: _Toc467490466]
Modify Processing Options 
As an Accounting Specialist and Local Accounting Specialist, you can modify processing options by completing the following steps:

· Click the Administration tab. From the Manage Organizations menu, select Processing Options and click Modify. The Step 1 of 3: Select OTC Endpoint page appears.

Note: Processing options must first be defined for the highest-level organization before any lower level organization’s processing options can be defined. If the processing options are not defined for the highest-level organization, all lower level organization links will be disabled.
Figure 59. Step 1 of 3: Select OTC Endpoint
[image: ]
· Select the OTC Endpoint for which you want to modify a processing option. 
[bookmark: _Toc19199448]Figure 60. Step 1 of 3: Select OTC Endpoint
[image: ]


· The Step 2 of 3: Define Processing Options page appears. Modify the processing option(s) and click Next.
[bookmark: _Toc396899647][bookmark: _Toc19199449]Figure 61. Step 2 of 3: Define Processing Options
[image: ]

Note: To narrow an accounting code search, enter a partial or full accounting code. 

All accounting codes that meet your search criteria and are not applied as a debit or credit adjustment to your OTC Endpoint are displayed on the page. If you do not enter search criteria, all the accounting codes defined for the highest-level organization appear.

By default, the first ten accounting codes display, first by ascending special character order, then by numerical order and then by ascending alphabetical order by accounting code. 

If organization has more than ten accounting codes, click the pagination menu above the section containing the existing accounting codes to view additional pages of results. The system will only allow a user to view and apply active accounting codes not designated as TAS or those designated as TAS and have been validated by SAM.

An accounting code can be assigned to both a debit adjustment and credit adjustment.

After an accounting code is assigned to debit or credit adjustment it appears in the Adjustment Type/Default Accounting Code table.


To modify Accounting Classifications for Adjustments, Corrections, and Returned Items, you can:

Update Default Accounting Codes by,
· Selecting either Use parent’s values or Use my values
· If selecting to Use My Values, entering the Agency Accounting Code and clicking the Search button (magnifying glass)
· Selecting the Accounting Code for the adjustment types you want to modify and clicking Assign to Debit or Assign to Credit.
· Selecting Yes or No to allow changes by an organization lower in hierarchy
Note: Click Apply to Debit to assign an accounting code to all debt adjustments.
Click Apply to Credit to assigning an accounting code to all credit adjustments.
Update Default Accounting Code Usage by,
· Selecting either Use parent’s values or Use my values.
· Selecting either Always Use the Default for Deposit Adjustments or Default based upon Deposit Subtotals for Deposit Adjustments
· Selecting Yes or No to allow changes by an organization lower in hierarchy.


[bookmark: _Toc396899648]

[bookmark: _Toc19199450]Figure 62. Step 2 of 3: Define Processing Options page with
Accounting Classifications for Adjustments, Corrections, and Returned Items expanded
[image: ]

To modify Correspondence, you can:

Update Returned Items by,
1. Selecting Use parent’s values or Use my values
2. Entering the corresponding address information that you would like 
to be displayed to a financial institution when return item adjustment is created
3. Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Deposit Adjustment by,
· Selecting Use parent’s values or Use my values
· Entering the corresponding address information that you would like to be displayed to a financial institution when a deposit adjustment is created
· Selecting Yes or No to allow changes by an organization lower in hierarchy
[bookmark: _Toc396899649][bookmark: _Toc19199451]
Figure 63. Define Processing Options page with Correspondence expanded
[image: ]


To modify Deposit Preparation, you can:

Update ITGA Deposit Creation by,
1. Selecting Use parent’s values or Use my values
1. Selecting Yes or No to allow endpoint to create foreign deposits
· If the endpoint accepts foreign deposits, enter the Default foreign currency when creating deposits details
· Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Subtotals and Cash Count by,
· Selecting Use parent’s values or Use my values
· Selecting Yes or No for each of the following options 
· Include Sub-totals for Checks/Money Orders and Cash
· Include Currency count and sub-totals by denomination 
· Include Coin count and sub-totals by denomination
· Allow changes by an organization lower in hierarchy

Update Accounting Code Subtotals by,
· Selecting Use parent’s values or Use my values
· Selecting Yes or No radio for each of the following options 
· Allow negative accounting code subtotals
· Allow changes by an organization lower in hierarchy

Update Separation of Duties by,
· Selecting Use parent’s values or Use my values
· Selecting Yes or No radio for each of the following options
· Deposits must be prepared and approved by different employees
· [bookmark: _Toc396899650]Allow changes by an organization lower in hierarchy
· 

[bookmark: _Toc19199452]Figure 64. Update Deposit Processing Options with Deposit Preparation expanded
[image: ]
[bookmark: _Toc396899651]
Modify Transaction History by,
· Selecting Use parent’s values or Use my values
· Entering the Number of days displayed in the text box (if applicable)
· Selecting Yes or No to allow changes by an organization lower in hierarchy and click Next.
[bookmark: _Toc19199453]Figure 65. Deposit Procession Options with Transaction History expanded
[image: ]


· The Step 3 of 3: Review the following processing options page appears. Verify the information is correct and click Submit.
[bookmark: _Toc396899652][bookmark: _Toc19199454]Figure 66. Step 3 of 3: Review the Following Processing Options with Accounting 
Classifications for Adjustments, Corrections, and Returned Items expanded
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[bookmark: _Toc396899653]

[bookmark: _Toc19199455]Figure 67. Review the Following Processing Options with Correspondence expanded
[image: ]

[bookmark: _Toc396899654]

[bookmark: _Toc19199456]Figure 68. Review the Following Processing Options with Deposit Preparation expanded
[bookmark: _Toc257798032][image: ]
[bookmark: _Toc396899655][bookmark: _Toc19199457]Figure 69. Review the Following Processing Options with Transaction History expanded
[image: ]


· A Confirmation page appears showing which processing options were applied to the organization.
[bookmark: _Toc396899656][bookmark: _Toc19199458]Figure 70. Modify Processing Options Confirmation
[image: ]
[bookmark: _Toc462057969][bookmark: _Toc462138829][bookmark: _Toc462300915][bookmark: _Toc467490467]
[image: MCj04420720000[1]]  Modify a Processing Option	
As an Accounting Specialist and Local Accounting Specialist, you can modify processing options by completing the following steps:
· Click the Administration tab.

· From the Manage Organizations menu, select Processing Options>Modify. The Step 1 of 3: Select Organization Endpoint page appears.

	[image: ]Application Tip
Processing options must first be defined for the highest-level organization before any lower level organization’s processing options can be defined. 
If the processing options are not defined for the highest-level organization, all lower level organization links will be disabled.



· Select the OTC Endpoint for which you want to modify a processing option. The Step 2 of 3: Define Processing Options page appears. 

· Modify the processing option(s) and click Next.

To modify Accounting Classifications for Adjustments, Corrections, and Returned Items, you can:

	[image: ]Application Tip
Accounting classifications for adjustments apply to Accounting Specialists, Check Capture Supervisors and Check Capture Lead Operators. Accounting Classifications for corrections and returned items apply Check Capture Supervisors and Check Capture Lead Operators.



Update Default Accounting Codes by
· Selecting either Use parent’s values or Use my values
· Entering the search criteria for the accounting code you would like to view and click Search (magnifying glass)

	[image: ]Application Tip
To narrow an accounting code search, enter a partial or full accounting code. 





Or

· Clicking Search (magnifying glass) to view accounting codes

	[image: ]Application Tip
All accounting codes that meet your search criteria and are not applied as 
a debit or credit adjustment, correction or returned item to your OTC Endpoint are displayed on the page. If you do not enter search criteria, all the accounting codes defined for the highest-level organization appear.



	[image: ]Application Tip
By default, the first ten accounting codes display, first by ascending special character order, then by numerical order and then by ascending alphabetical order by accounting code. 



	[image: ]Application Tip
If organization has more than ten accounting codes, click the pagination menu above the section containing the existing accounting codes to view additional pages of results. The system will only allow a user to view and apply active accounting codes not designated as TAS or those designated as TAS and have been validated by SAM.



· Selecting the accounting code to apply a credit and/or debit type and clicking Assign to Debit and/or Assign to Credit

	[image: ]Application Tip
An accounting code can be assigned to debit and credit adjustment, correction, and returned item types.



	[image: ]Application Tip
After an accounting code is assigned to debit or credit adjustment it appears in the Adjustment Type/Default Accounting Code table.



· Selecting Yes or No to allow changes by an organization lower in hierarchy


Update Default Accounting Code Usage by
· Selecting either Use parent’s values or Use my values
· Selecting either Always Use the Default for Deposit Adjustments or Default based upon Deposit Subtotals for Deposit Adjustments 
· Selecting Yes or No to allow changes by an organization lower in hierarchy

To modify Correspondence, you can:
Update Returned Items by
· Selecting Use parent’s values or Use my values 
· Entering the corresponding address information that you would like to be displayed to a financial institution when return item adjustment is created
· Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Deposit Adjustment by 
· Selecting Use parent’s values or Use my values 
· Entering the corresponding address information that you would like to be displayed to a financial institution when a deposit adjustment is created
· Selecting Yes or No to allow changes by an organization lower in hierarchy

To modify Deposit Preparation, you can
Update ITGA Deposit Creation by
2. Selecting Use parent’s values or Use my values
2. Selecting Yes or No to allow endpoint to create foreign deposits
· If the endpoint accepts foreign deposits, enter the Default foreign currency when creating deposits details
· Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Subtotals and Cash Count by 
· Selecting Use parent’s values or Use my values
· Selecting Yes or No for each of the following options 
· Include Sub-totals for Checks/Money Orders and Cash
· Include Currency count and sub-totals by denomination 
· Include Coin count and sub-totals by denomination
· Allow changes by an organization lower in hierarchy

Update Accounting Code Subtotals by 
· Selecting Use parent’s values or Use my values 
· Selecting Yes or No for each of the following options 
· Allow negative accounting code subtotals
· Allow changes by an organization lower in hierarchy

Update Separation of Duties by 
· Selecting Use parent’s values or Use my values 
· Selecting Yes or No for each of the following options 
· Deposits must be prepared and approved by different employees
· Allow changes by an organization lower in hierarchy 


To modify Transaction History, you can by
3. Selecting Use parent’s values or Use my values 
4. Entering the Number of days displayed in the text box, if applicable
5. Selecting Yes or No to allow changes by an organization lower in hierarchy

· The Step 3 of 3: Review the following processing options page appears. Verify the information is correct and click Submit. 

· A Confirmation page appears showing which processing options were applied to the organization.
	
[image: ]Application Tip
If additional changes are required after reviewing the information, click 
Edit and return to step 4.



	
[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
· Click Cancel to return to the OTCnet Home Page. No data will be saved.
· Click Edit to return to the previous page. 
· Click Next to advance to the next page.
· Click Previous to return to the previous page.
· Click Submit to complete the process and display the Confirmation page.
· Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc396899619][bookmark: _Toc467490468]
View Processing Options
[bookmark: _Toc396899657]As an Accounting Specialist and Local Accounting Specialist, you can view processing options by completing the following steps:

· Click the Administration tab.

· From the Manage Organizations menu, select Processing Options and click View. 
[bookmark: _Toc19199459]Figure 71. Select OTC Endpoint for Processing Options
[image: ]
· The Select OTC Endpoint page appears. Select the highest-level organization or any lower level OTC Endpoint for which you would like to view the processing options.
[bookmark: _Toc19199460]Figure 72. Select OTC Endpoint for Processing Options
[image: ]


· A View Processing Options page appears showing which custom labels are in effect for the organization hierarchy.
[bookmark: _Toc396899659][bookmark: _Toc19199461]Figure 73. View Processing Options
[image: ]


[bookmark: _Toc462057971][bookmark: _Toc462138831][bookmark: _Toc462300917][bookmark: _Toc467490469]
[image: MCj04420720000[1]]  View a Processing Option
As an Accounting Specialist and Local Accounting Specialist, you can view a processing option by completing the following steps:
· Click the Administration tab.

· From the Manage Organizations menu, select Processing Options>View. The Select Organization Endpoint page appears.

· Select the highest-level organization or any lower level OTC Endpoint for which you would like to view the processing options. A View Processing Options page appears showing which custom labels are in effect for the organization hierarchy.

	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
· Click Return Home to return to the OTCnet Home Page. 





[bookmark: _Toc467490470]Summary
In this chapter, you learned: 
· The purpose of organizational hierarchy
· How to add lower level endpoints to the highest level of an organization hierarchy
· How to add additional lower level endpoints/ add financial institution relationship to a hierarchy that was previously defined 
· How to make changes to OTC Endpoints 
· How to delete OTC Endpoints 
· How to view OTC Endpoints 
· How to modify accounting codes
Notes
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[bookmark: _Toc467490471]Glossary
A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one, or many agency-defined accounting codes, or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN; however, it is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so) or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator: An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator: An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions.
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System. 

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.

D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. 

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address—A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).

K
Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

 Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, deposit processing, scanning checks, processing card payments and printing receipts. 

L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet to use check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet to use deposit reporting. 

OTC Endpoint (CDC) – The endpoint (location) setup in OTCnet to use card processing.

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin— A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing and card processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 
Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.

R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.

Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.

S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 

SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.

T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer will be able to view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer will be able to view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System to System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 

Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W
WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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[bookmark: _Toc467583188]Audience, Overview and Topics
[bookmark: _Toc258250066][bookmark: _Toc282518280][bookmark: _Toc396899203][bookmark: _Toc396899611][bookmark: _Toc410128586][bookmark: _Toc410129982][bookmark: _Toc467583189]Audience
The intended audience for the Configuring Deposit and Card Processing Settings Participant User Guide includes:

· Accounting Specialist 
· Local Accounting Specialist (see Chapter 1 for specific permissions)
· Card Administrator

[bookmark: _Toc258250067][bookmark: _Toc282518281][bookmark: _Toc396899204][bookmark: _Toc396899612][bookmark: _Toc410128587][bookmark: _Toc410129983][bookmark: _Toc467583190]Overview
Welcome to Configuring Deposit and Card Processing Settings. In this chapter, you will learn:

· How to create, edit and delete custom labels
· How to set your options for processing and deposits
· How to create, edit and delete user defined fields (UDFs) specific to your agency

[bookmark: _Toc258250068][bookmark: _Toc282518282][bookmark: _Toc396899205][bookmark: _Toc396899613][bookmark: _Toc410128588][bookmark: _Toc410129984][bookmark: _Toc467583191]Topics
This chapter is organized by the following topics:

· Maintaining Accounting Codes
· Managing Custom Labels
· Managing Processing Options
· Creating and Editing User Defined Fields (UDFs)
[bookmark: _Toc257798067]

[bookmark: _Toc467583192]Topic 1.  Managing Custom Labels
After you manage your organization hierarchy and enter the appropriate accounting codes, you can customize the labels of the fields in the deposit preparation page that your organization’s Deposit Preparers and Deposit Approvers see when they are preparing and submitting deposits or in reports. These are called custom labels. A custom label allows you to define a level in the organization hierarchy, the internal control number, or agency accounting code. Performing this customization is optional.

For example, if your agency refers to Accounting Codes as Financial Numbers you can have the custom label changed to Financial Number.  As an Accounting Specialist, you can define, update or view a custom label.

[bookmark: _Toc257798068][bookmark: _Toc467583193]Define a Custom Label (“Define” and “Create” are used interchangeably)
Accounting Specialists can modify custom labels by completing the following steps:

1. Click the Administration tab. 

2. From the Manage Organizations menu, select Custom Labels and click Modify.
[bookmark: _Toc59446723]Figure 1. Select Custom Labels>Modify
[image: ]


3. The Select OTC Endpoint page appears. Select the highest level OTC Endpoint for which you want to modify custom labels. 
[bookmark: _Toc59446724]Figure 2. Select OTC Endpoint
[image: ]

4. The Step 1 of 2: Update Custom Labels page appears. Update the custom label(s) for the organization hierarchy and click Next.

Update the labels by
· Entering a title for your Organization Hierarchy Labels.
· Entering an agency accounting code title for the Accounting Code Definition Label
[bookmark: _Toc59446725]Figure 3. Step 1 of 2: Update Custom Labels
[image: ]
Note: The Accounting Specialist can define a new Organization Hierarchy Label or update the existing label(s) and modify the label of the accounting code definition.


5. The Step 2 of 2: Review Custom Labels page appears. Verify the information is correct and click Submit. 
[bookmark: _Toc59446726]Figure 4. Step 2 of 2: Review Custom Labels
[image: N:\Training\2.2 Training Materials\2.2 UGs\Flattened Images\adm_ug_ch5_cnfg_dep_proc_set_PICTURES\Figure 4. Step 2 of 2 Review Custom Labels.png]
Note: From the Step 2 of 2: Review Custom Labels page, click Edit to make additional changes after reviewing the information and return to Step 3.

6. A Confirmation page appears showing that the custom labels have been modified for the organization hierarchy.
[bookmark: _Toc59446727]Figure 5. Modify Custom Labels Confirmation
[image: ]


[bookmark: _Toc467583194]  [image: MCj04420720000[1]] Define a Custom Label
[bookmark: _Toc257798069]Accounting Specialists can modify custom labels by completing the following steps:

· Click the Administration tab.

· From the Manage Organizations menu, select Custom Labels and click Modify. The Select OTC Endpoint page appears.

· Select the highest level OTC Endpoint for which you want to modify custom labels. The Step 1 of 2: Update Custom Labels page appears.

· Update the custom label(s) for the organization hierarchy and click Next. The Step 2 of 2: Review Custom Labels page appears. 

Update the labels by,
· Entering a title for your Organization Hierarchy Labels.
· Entering an agency accounting code title for the Accounting Code Definition Label
	[image: ]Application Tip
The Accounting Specialist can define a new Organization Hierarchy Label or update the existing label(s) and modify the label of the accounting code definition. 


· Verify the information is correct and click Submit. A confirmation page appears showing that the custom labels have been modified for the organization hierarchy. 
	[image: ]Application Tip
Click Edit to make additional changes after reviewing the information and return to Step 4. 



	[image: ]Application Tip
Additional buttons on the page help you perform other tasks:
· Click Cancel to return to the OTCnet Home Page. No data will be saved. 
· Click Edit to make additional changes.
· Click Previous to return to the previous page.
· Click Submit to complete the process and display the Confirmation page.
· Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc467583195][image: MCj04420720000[1]]  Modify a Custom Label	
Accounting Specialists can modify a custom field label by:

· Click the Administration tab.

· From the Manage Organizations menu, select Custom Labels>Modify. The Select OTC Endpoint page appears.

· Select the organization endpoint for which you want to modify custom labels. The Step 1 of 2: Update Custom Labels appears. 

· Update the custom labels for the organization hierarchy and click Next. The Step 2 of 2: Review Custom Labels page appears. 
	[image: ]Application Tip
If an Agency Accounting Code label is customized, it is displayed as the label above the imported or modified codes within the Maintain Accounting Codes module, according to the custom label that was defined for the highest level organization. Within the rest of the application, custom labels apply to deposit processing functionalities, but are not extended to check processing functionalities. The default accounting code label is Agency Accounting Code.


· Verify the information is correct and click Submit. 

· A Confirmation page appears showing that the custom labels have been modified for the organization hierarchy. 

[bookmark: _Toc257798070][bookmark: _Toc467583196]
View a Custom Label 
Accounting Specialists can View custom labels that are in effect for your organization’s deposit preparation fields by completing the following steps:

· Click the Administration tab. From the Manage Organizations menu, select Custom Labels and click View.  
[bookmark: _Toc59446728]Figure 6. Select Custom Labels>View
[image: ]
· The Select OTC Endpoint page appears. Select the highest level organization for which you would like to view the custom labels.
[bookmark: _Toc59446729]Figure 7. Select OTC Endpoint
[image: ]
The View Custom Labels page appears showing which custom labels are in effect for the organization hierarchy.
[bookmark: _Toc59446730]Figure 8. View Custom Labels
[image: N:\Training\2.2 Training Materials\2.2 UGs\Flattened Images\adm_ug_ch5_cnfg_dep_proc_set_PICTURES\Figure 8. View Custom Labels.png]


[bookmark: _Toc467583197][image: ]	View a Custom Label
Accounting Specialists can View custom labels by following these steps:

· Click the Administration tab.

· From the Manage Organizations menu, select Custom Labels and click View. The Select OTC Endpoint page appears.

· Select the highest level organization for which you would like to view the custom labels. The View Custom Labels page appears showing which custom labels are in effect for the organization hierarchy.
	[image: ]Application Tip
Additional buttons on the page help you perform other tasks:
· Click Cancel to return to the OTCnet Home Page. No data will be saved. 
· Click Return Home to return to the OTCnet Home Page. 





[bookmark: _Toc467583198]Topic 2.  Managing Processing Options
As part of managing your organization hierarchy, you need to define your deposit processing options. Processing options are parameters for the deposit and adjustments process. You must first define processing options at the highest level of the organization before defining lower level options. For lower-level organizations, if you do not define these options, then the lower-level organizations will take on the options set for the next higher level organization that does have the options set.

If you do not define processing options, your organization cannot create deposits. You can define processing options at any level within your organization. You can also view the processing options by OTC Endpoint report to manage processing options in your organization.

As an Accounting Specialist, you can modify the following processing options for your organization’s hierarchy:

· Accounting Classifications for Adjustments: Identifies the default accounting codes to which you want adjusted amounts credited and debited

· Correspondence: Provides the financial institution with address information for any correspondence including returned item information

· Deposit Preparation: Sets default settings for deposit preparation to save time for Deposit Preparers

· Transaction History: Sets default settings for historical data about transactions

· 

[bookmark: _Toc467583199]Modify Processing Options
Accounting Specialists can modify a processing option by completing the following steps:

1. Click the Administration tab. From the Manage Organizations menu, select Processing Options and click Modify. The Step 1 of 3: Select OTC Endpoint page appears.

Note: Processing options must first be defined for the highest level organization before any lower level organization’s processing options can be defined. 
If the processing options are not defined for the highest level organization, all lower level organization links will be disabled.
[bookmark: _Toc59446731]Figure 9. Select Processing Options>Modify
[image: ]
2. Select the OTC Endpoint for which you want to modify a processing option. 
[bookmark: _Toc59446732]Figure 10. Step 1 of 3: Select OTC Endpoint
[image: ]
3. 
The Step 2 of 3: Define Processing Options page appears. Modify the processing option(s) and click Next.
[bookmark: _Toc59446733]Figure 11. Step 2 of 3: Define Processing Options
[image: N:\Training\2.2 Training Materials\2.2 UGs\Flattened Images\adm_ug_ch5_cnfg_dep_proc_set_PICTURES\Figure 11. Step 2 of 3 Define Processing Options.png]
Note: To narrow an accounting code search, enter a partial or full accounting code. 

All accounting codes that meet your search criteria and are not applied as a debit or credit adjustment to your OTC Endpoint are displayed on the page. If you do not enter search criteria, all the accounting codes defined for the highest level organization appear.

By default, the first ten accounting codes display, first by ascending special character order, then by numerical order and then by ascending alphabetical order by accounting code. 

If organization has more than ten accounting codes, click the pagination menu above the section containing the existing accounting codes to view additional pages of results. The system will only allow a user to view and apply active accounting codes not designated as TAS or those designated as TAS and have been validated by SAM.

An accounting code can be assigned to both a debit adjustment and credit adjustment.

After an accounting code is assigned to debit or credit adjustment it appears in the Adjustment Type table.

To modify Accounting Classifications for Adjustments, Corrections, and Returned Items, you can:

Update Default Accounting Codes by,

· Selecting either Use parent’s values or Use my values
· If selecting to Use My Values, entering the Agency Accounting Code and clicking the Search button (magnifying glass)
· Selecting the Accounting Code for the adjustment types you want to modify and clicking Assign to Debit or Assign to Credit.
· Selecting Yes or No to allow changes by an organization lower in hierarchy
Note: Click Apply to Debit to assign an accounting code to all debt adjustments. 
Click Apply to Credit to assigning an accounting code to all credit adjustments.

Update Default Accounting Code Usage by,

· Selecting either Use parent’s values or Use my values.
· Selecting either Always Use the Default for Deposit Adjustments or Default based upon Deposit Subtotals for Deposit Adjustments
· Selecting Yes or No to allow changes by an organization lower in hierarchy.
[bookmark: _Toc59446734]Figure 12. Step 2 of 3: Define Processing Options page with
Accounting Classifications for Adjustments, Corrections, and Returned Items expanded
[image: ]

To modify Correspondence, you can:

Update Returned Items by,
· Selecting Use parent’s values or Use my values
· Entering the corresponding address information that you would like 
· to be displayed to a financial institution when return item adjustment is created
· Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Deposit Adjustment by,
· Selecting Use parent’s values or Use my values
· Entering the corresponding address information that you would like to be displayed to a financial institution when a deposit adjustment is created
· Selecting Yes or No to allow changes by an organization lower in hierarchy
[bookmark: _Toc59446735]Figure 13. Define Processing Options page with Correspondence expanded
[image: ]

To modify Deposit Preparation, you can:

Update ITGA Deposit Creation by,
· Selecting Use parent’s values or Use my values
· Selecting Yes or No to allow endpoint to create foreign deposits
· If the endpoint accepts foreign deposits, enter the Default foreign currency when creating deposits details
· Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Subtotals and Cash Count by,
· Selecting Use parent’s values or Use my values
· Selecting Yes or No for each of the following options 
· Include Sub-totals for Checks/Money Orders and Cash
· Include Currency count and sub-totals by denomination 
· Include Coin count and sub-totals by denomination
· Allow changes by an organization lower in hierarchy

Update Accounting Code Subtotals by,
· Selecting Use parent’s values or Use my values
· Selecting Yes or No radio for each of the following options 
· Allow negative accounting code subtotals
· Allow changes by an organization lower in hierarchy

Update Separation of Duties by,
· Selecting Use parent’s values or Use my values
· Selecting Yes or No radio for each of the following options
· Deposits must be prepared and approved by different employees
· Allow changes by an organization lower in hierarchy
· 

[bookmark: _Toc59446736]Figure 14. Update Deposit Processing Options with Deposit Preparation expanded
[image: ]

Modify Transaction History by,
· Selecting Use parent’s values or Use my values
· Entering the Number of days displayed in the text box (if applicable)
· Selecting Yes or No to allow changes by an organization lower in hierarchy and click Next.
[bookmark: _Toc59446737]Figure 15. Deposit Procession Options with Transaction History expanded
[image: ]


4. The Step 3 of 3: Review the following processing options page appears. Verify the information is correct and click Submit.
[bookmark: _Toc59446738]Figure 16. Step 3 of 3: Review the Following Processing Options with Accounting 
Classifications for Adjustments, Corrections, and Returned Items expanded
[image: ]


[bookmark: _Toc59446739]Figure 17. Review the Following Processing Options with Correspondence expanded
[image: ]



[bookmark: _Toc59446740]Figure 18. Review the Following Processing Options with Deposit Preparation expanded
[image: ]
[bookmark: _Toc59446741]Figure 19. Review the Following Processing Options with Transaction History expanded
[image: ]

5. A Confirmation page appears showing which processing options were applied to the organization.
[bookmark: _Toc59446742]Figure 20. Modify Processing Options Confirmation
[image: ]
[bookmark: _Toc467583200]
[image: MCj04420720000[1]]  Modify a Processing Option	
Accounting Specialists can modify a processing option by completing the following steps:

· Click the Administration tab.

· From the Manage Organizations menu, select Processing Options>Modify. The Step 1 of 3: Select Organization Endpoint page appears.
	[image: ]Application Tip
Processing options must first be defined for the highest level organization before any lower level organization’s processing options can be defined. 
If the processing options are not defined for the highest level organization, all lower level organization links will be disabled.


· Select the OTC Endpoint for which you want to modify a processing option. The Step 2 of 3: Define Processing Options page appears. 

· Modify the processing option(s) and click Next.

To modify Accounting Classifications for Adjustments, Corrections, and Returned Items, you can:

Update Default Accounting Codes by
1. Selecting either Use parent’s values or Use my values
2. Entering the search criteria for the accounting code you would like to view and click Search (magnifying glass)
	[image: ]Application Tip
To narrow an accounting code search, enter a partial or full accounting code.


Or

1. Clicking Search (magnifying glass) to view accounting codes
	[image: ]Application Tip
All accounting codes that meet your search criteria and are not applied as 
a debit or credit adjustment to your OTC Endpoint are displayed on the page. If you do not enter search criteria, all the accounting codes defined for the highest level organization appear.



	[image: ]Application Tip
By default, the first ten accounting codes display, first by ascending special character order, then by numerical order and then by ascending alphabetical order by accounting code. 



	[image: ]Application Tip
If organization has more than ten accounting codes, click the pagination menu above the section containing the existing accounting codes to view additional pages of results. The system will only allow a user to view and apply active accounting codes not designated as TAS or those designated as TAS and have been validated by SAM.


2. Selecting the accounting code to apply a credit and/or debit adjustment type and click Assign to Debit and/or Assign to Credit
	[image: ]Application Tip
An accounting code can be assigned to both a debit adjustment and credit adjustment.



	[image: ]Application Tip
After an accounting code is assigned to debit or credit adjustment it appears in the Adjustment Type table.


3. Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Default Accounting Code Usage by
4. Selecting either Use parent’s values or Use my values
5. Selecting either Always Use the Default for Deposit Adjustments or Default based upon Deposit Subtotals for Deposit Adjustments 
6. Selecting Yes or No to allow changes by an organization lower in hierarchy

To modify Correspondence, you can:

Update Returned Items by
· Selecting Use parent’s values or Use my values 
· Entering the corresponding address information that you would like to be displayed to a financial institution when return item adjustment is created
· Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Deposit Adjustment by 
1. Selecting Use parent’s values or Use my values 
2. Entering the corresponding address information that you would like to be displayed to a financial institution when a deposit adjustment is created
3. Selecting Yes or No to allow changes by an organization lower in hierarchy


To modify Deposit Preparation, you can

Update ITGA Deposit Creation by
· Selecting Use parent’s values or Use my values
· Selecting Yes or No to allow endpoint to create foreign deposits
· If the endpoint accepts foreign deposits, enter the Default foreign currency when creating deposits details
· Selecting Yes or No to allow changes by an organization lower in hierarchy

Update Subtotals and Cash Count by 
1. Selecting Use parent’s values or Use my values
2. Selecting Yes or No for each of the following options 
i. Include Sub-totals for Checks/Money Orders and Cash
ii. Include Currency count and sub-totals by denomination 
iii. Include Coin count and sub-totals by denomination
iv. Allow changes by an organization lower in hierarchy

Update Accounting Code Subtotals by 
· Selecting Use parent’s values or Use my values 
· Selecting Yes or No for each of the following options 
· Allow negative accounting code subtotals
· Allow changes by an organization lower in hierarchy

Update Separation of Duties by 
· Selecting Use parent’s values or Use my values 
· Selecting Yes or No for each of the following options 
· Deposits must be prepared and approved by different employees
· Allow changes by an organization lower in hierarchy 

To modify Transaction History, you can by
1. Selecting Use parent’s values or Use my values 
2. Entering the Number of days displayed in the text box, if applicable
3. Selecting Yes or No to allow changes by an organization lower in hierarchy

· The Step 3 of 3: Review the following processing options page appears. Verify the information is correct and click Submit. 

· A Confirmation page appears showing which processing options were applied to the organization.


	
[image: ]Application Tip
If additional changes are required after reviewing the information, click 
Edit and return to step 4.



	
[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
1. Click Cancel to return to the OTCnet Home Page. No data will be saved. 
Click Edit to make additional changes. 
2. Click Next to advance to the next page.
3. Click Previous to return to the previous page.
4. Click Submit to complete the process and display the Confirmation page.
5. Click Return Home to return to the OTCnet Home Page. 




[bookmark: _Toc467583201]View Processing Options
Accounting Specialists can view processing options by completing the following steps:

· Click the Administration tab.

· From the Manage Organizations menu, select Processing Options and click View 
[bookmark: _Toc59446743]Figure 21. Select Processing Options>View 
[image: ]
· The Select OTC Endpoint page appears. Select the highest level organization or any lower level OTC Endpoint for which you would like to view the processing options.
[bookmark: _Toc59446744]Figure 22. Select OTC Endpoint for Processing Options
[image: ]

· 
A View Processing Options page appears showing which custom labels are in effect for the organization hierarchy.
[bookmark: _Toc59446745]Figure 23. View Processing Options
[image: N:\Training\2.2 Training Materials\2.2 UGs\Flattened Images\adm_ug_ch5_cnfg_dep_proc_set_PICTURES\Figure 23. View Processing Options.png]


[bookmark: _Toc467583202]
[image: MCj04420720000[1]]  View a Processing Option	
Accounting Specialists can view processing options by completing the following steps.

1. Click the Administration tab.

2. From the Manage Organizations menu, select Processing Options>View. The Select Organization Endpoint page appears.

3. Select the highest level organization or any lower level OTC Endpoint for which you would like to view the processing options. A View Processing Options page appears showing which custom labels are in effect for the organization hierarchy.
	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
1. Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc257798072][bookmark: _Toc467583203]Topic 3.  Creating and Editing User Defined Fields (UDFs)
As an Accounting Specialist and Card Administrator you can create, modify and delete a UDF for your organization hierarchy. Deposit Preparers use the UDFs when entering deposit activity and accounting activity information during the deposit preparation process. Card Operators use UDFs when entering card payment details during card transaction processing. A UDF is an optional field for the Deposit Preparer and Card Operator to complete that describes a deposit activity or deposit accounting activity (e.g., a vendor number) or a card transaction, specific to your organization.  

If your organization elects to use UDFs, you should communicate this to each of your OTC Endpoints and identify what information should be included.

Accounting Specialists and Card Administrators perform several tasks in working with UDFs:
2. Create a UDF 
3. Modify a UDF
4. Delete a UDF
5. [bookmark: _Toc257798073]View a UDF

Note: If an Accounting Specialist or Card Administrator has selected an endpoint that is both a Deposit Processing and a Card Processing Endpoint, and this endpoint has a deposit that is currently in progress, the deposit processing activities will be disabled to read-only. You will not be able to modify or delete any deposit processing UDFs at this endpoint. You will only be able to select the Create Card Processing activity.

[bookmark: _Toc467583204]Create a User Defined Field
Accounting Specialists and Card Administrators can create up to four UDFs for deposit activity and three UDFs for card processing, for your agency. You can create up to three UDFs for a Create Deposit UDF and up to two UDFs for the Create Deposit Subtotals UDF. To create a user defined field: 

· Click the Administration tab. From the Manage Organizations select, User Defined Fields and click Modify.
[bookmark: _Toc59446746]Figure 24. Select User Defined Fields>Modify
[image: ]
· The Select OTC Endpoint screen appears. Select the highest level organization for which you want to modify UDFs.
[bookmark: _Toc257798033][bookmark: _Toc59446747]Figure 25. Select OTC Endpoint page

[image: ]



· The Step 1 of 3: Select User Defined Field to Maintain page appears. Click the Create UDF.
[bookmark: _Toc59446748]Figure 26. Select 1 of 3: Select User Defined Field to Maintain
[image: ]


· The Step 2 of 3: Modify the User Defined Field page appears. Add the user defined fields and click Done. 

Note: A message is displayed discouraging users from creating UDFs that request Personally Identifiable Information (PII) data.
You can add a user defined field by:
1. Selecting the Activity type for the UDF.

There are two types of deposit processing activities (Create Deposit and Create Deposit Subtotal) and one activity for card processing (Create Card Processing). 

Note: For TGA/CDC Endpoints with active deposits, in the drop down Activity menu, the deposit activities will be disabled. In this case, Accounting Specialists and Card Administrators can only select the Create Card Processing activity.

1. Entering the Label and Description
1. Selecting a Data Type
2. If the Drop Down List of Alphanumeric Values Data Type is selected, proceed to step 5
3. If another Data Type is selected, continue entering in information for the fields below and then proceed to step 6

4. Entering the
5. Maximum Input Length (Maximum length is 255)
6. Minimum Input Length
7. Display Order Number

8. Selecting Mandatory or Optional for Activity User Entry. 
[bookmark: _Toc59446749]Figure 27.  Step 2 of 3: Modify User Defined Field
Mod[image: ]
Note: When a deposit is in progress at a TGA or CDC endpoint, a UDF cannot be modified or deleted if the deposit is in Draft or Awaiting Approval (AWAP) status. If an endpoint that is both TGA and CDC is selected, and it has a deposit that is currently in progress, the deposit processing activities will be disabled to read-only. 

Only the Card Processing activity will be active. The Card Administrator can continue card processing activities when a deposit is in progress.

If the Drop Down List of Alphanumeric Values data type is selected, a Permitted Values section appears. Click List Values. A Step 2 of 3 (Continued): Define Permitted Values page appears. Enter details for both the Value and Description and click Done to return to the Step 2 of 3: Modify User Defined Field page.

· [bookmark: _Hlk17207329]The Step 1 of 3: Select User Defined Field to Maintain page appears again. Select Next.
[bookmark: _Toc59446750]Figure 28. Step 1 of 3: Select User Defined Field to Maintain
Modify User Defined Fields,
Step 1 of 3: Select User Defined Field to Maintain
[image: ]

· The Step 3 of 3: Review page appears. Verify the UDF information is correct. Select the plus sign next to the UDF to expand it. 
[bookmark: _Toc59446751]Figure 29. Step 3 of 3: Review

[image: ]

Click Edit to make additional changes before submitting the information and return to Step 4. 


· [bookmark: _Toc257798037]The Step 3 of 3: Review page appears. Click Submit.
[bookmark: _Toc59446752]Figure 30. Review User Defined Fields page
[image: ]
· A Confirmation page appears showing that the UDF data has been saved to the database. 
[bookmark: _Toc59446753]Figure 31. Modify User Defined Fields Confirmation
[image: ]
[bookmark: _Toc467583205][image: ]	Create a User Defined Field
Accounting Specialists and Card Administrators can create UDFs by complete the following steps.

1. Click the Administration tab.

2. From the Manage Organizations menu, select User Defined Fields and click Modify. The Select OTC Endpoint screen appears. 
3. Select the highest level organization for which you want to modify UDFs. The Step 1 of 3: Select User Defined Field to Maintain page appears. 

4. Click the Create UDF. The Step 2 of 3: Modify the User Defined Field page appears.

	[bookmark: _Hlk39575774][image: ]Application Tip
A message is displayed discouraging users from creating UDFs that request PII data.




5. Add the UDF and click Done.
You can add a UDF by:
1. Selecting the Activity type for the UDF

	[bookmark: _Hlk38365834][image: ]Application Tip
There are two types of deposit processing activities (Create 
Deposit and Create Deposit Subtotal) and one activity for card processing (Create Card Processing). 

For TGA/CDC Endpoints with active deposits, in the drop-down Activity menu, the deposit activities will be disabled. In this case, Accounting Specialists and Card Administrators can only 
select the Create Card Processing activity.



· Entering the Label and Description
· Selecting a Data Type
· If the Drop Down List of Alphanumeric Values Data Type is selected, proceed to step 6. 
· If another Data Type is selected, continue entering in information for the fields below and then proceed to step 7. 

· Entering the 
· Maximum Input Length (Maximum length is 255)
· Minimum Input Length
· Display Order Number

· Selecting Mandatory or Optional for Activity User Entry
	[image: ]Application Tip
Note: When a deposit is in progress at a TGA or CDC endpoint, a UDF cannot be modified or deleted if the deposit is in Draft or Awaiting Approval (AWAP) status. If the Accounting Specialist or Card Administrator has selected an endpoint that is both a TGA, and a CDC Endpoint and this endpoint has a deposit that is currently in progress, the deposit processing activities will be disabled to read-only. Only the Card Processing activity will be active. The Card Administrator can continue card processing activities when a deposit is in progress.



	[image: ]Application Tip
If the Drop Down List of Alphanumeric values data type is selected a Permitted Values section appears. Click List Values. A Step 2 of 3 (Continued): Define Permitted Values page appears. Enter details for both the Value and Description and click Done to return to the Step 2 of 3: Modify the User Defined Field page. 



6. The Step 1 of 3: Select User Defined Field to Maintain page appears again. Select Next.
7. The Step 3 of 3: Review page appears. Verify the UDF information is correct. Select the plus sign next to the UDF to expand it. 
8. The Step 3 of 3: Review page appears. Verify the UDF information is correct and click Submit. A confirmation page appears showing that the UDF data has been saved to the database.  
	[image: ]Application Tip
Click Edit to make additional changes before submitting the information and return to Step 5.



	[image: ]Application Tip
Additional buttons on the page help you perform other tasks:
1. Click Cancel to return to the OTCnet Home Page. No data will be saved. 
2. Click Edit if you need to make additional changes.
3. Click Next to advance to the next page.
4. Click Previous to return to the previous page.
5. Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc257798074][bookmark: _Toc467583206]

Modify a User Defined Field
Accounting Specialists and Card Administrators can modify UDFs, as needed, to accommodate your organization’s changing needs. 

Note: For deposit processing however, you cannot modify a UDF that is associated with a deposit that is still in Draft or AWAP status. Draft or AWAP deposits must be submitted to the Financial Institution before you can modify any UDFs associated with them. These Draft or AWAP status do not impact card processing.

· Click the Administration tab. From Manage Organizations select User Defined Fields and click Modify.
[bookmark: _Toc59446754]Figure 32. Select User Defined Fields>Modify
[image: ]

· The Select OTC Endpoint screen appears. Select the highest level organization for which you want to modify UDFs. 


· The Step 1 of 3: Select User Defined Field to Maintain page appears. Click the user defined field Label hyperlink.
[bookmark: _Toc59446755]Figure 33. Step 1 of 3: Select User Defined Field to Maintain
[image: ]
· The Step 2 of 3: Modify the User Defined Field page appears. Make the changes to the UDF and click Done.
Note: A message is displayed discouraging users from creating UDFs that request PII data.
[bookmark: _Toc59446756]Figure 34. Select User Defined Field to Maintain
[image: ]

Note: A UDF, during deposit processing, cannot be modified if it is associated with a deposit that is in Draft or AWAP status. Only the Card Processing activity will be active. 
· The Step 1 of 3: Select User Defined Field to Maintain page appears again. Select Next.

· The Step 3 of 3: Review page appears. Verify the UDF information is correct. Select the plus sign next to the UDF to expand it. Review and click Submit. A confirmation page appears showing that the UDF data has been saved to the database. 
[bookmark: _Toc59446757]Figure 35. Review User Defined Fields
[image: ]
Note: Click Edit if you need to make additional changes before submitting the information and return to Step 4.
[bookmark: _Toc467583207]

[image: ]	Modify a User Defined Field
Accounting Specialists and Card Administrators can modify an existing user defined field (UDF) by completing the following steps.

· Click the Administration tab.

· From the Manage Organizations menu, select User Defined Fields and click Modify. The Select OTC Endpoint screen appears. 

· Select the highest level organization for which you want to modify a UDF. The Step 1 of 3: Select User Defined Field to Maintain page appears.

· Click the UDF Label hyperlink. The Step 2 of 3: Modify User Defined Field page appears. 

	[image: ]Application Tip
A message is displayed discouraging users from creating UDFs that request personally identifiable information (PII) data.




· Make the changes to the UDF and click Done. The Step 1 of 3: Select User Defined Field to Maintain page appears.

	[image: ]Application Tip
You can modify a UDF as needed to accommodate your organization’s changing needs. For deposit processing however, you cannot modify a UDF that is associated with a deposit that is still in Draft or AWAP status. Draft or AWAP deposits must be submitted to the Financial Institution before you can modify any UDFs associated with them. These Draft or AWAP status do not impact card processing.



· Click Next. The Step 3 of 3: Review page appears.

· Verify the correct UDF information is correct and click Submit. A confirmation page appears showing that the UDF data has been saved to the database.

	[image: ]Application Tip
Click Edit if you need to make additional changes before submitting the data and return to Step 4.



	[image: ]Application Tip
· Click Cancel to return to the OTCnet Home Page. No data will be saved. 
· Click Create UDF to create a new UDF.
· Click Next to advance to the next page.
· Click Previous to return to the previous page.
· Click Edit to make additional changes to a UDF. 
· Click Submit to complete the process and display the Confirmation page.
· Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc257798075]


[bookmark: _Toc467583208][bookmark: _Hlk15219669]Delete a User Defined Field
Accounting Specialists and Card Administrators can delete a UDF. If you find that you do not need a particular UDF, you can delete it to save labor for your Deposit Preparers and Card Administrators. Delete a UDF by following these steps:

1. Click the Administration tab. From the Manage Organizations select User Defined Fields and click Modify.

2. The Select OTC Endpoint screen appears. Select the highest level organization for which you want to delete the UDF. 

3. The Step 1 of 3: Select User Defined Field to Maintain page appears. Click the Delete checkbox next to the appropriate field (note that to delete all the UDFs, you can click Delete All) and click Next. 
Note: A UDF, during deposit processing, cannot be modified if it is associated with a deposit that is in Draft or AWAP status. Only the Card Processing activity will be active.
[bookmark: _Toc59446758]Figure 36. Select 1 of 3: Select User Defined Field to Maintain

[image: ]


4. The Step 3 of 3: Review page appears. Select the plus sign next to the UDF you want to delete, to expand it. Verify the correct information is marked for deletion and click Submit. A confirmation page appears showing that the UDF data has been saved to the database. 
[bookmark: _Toc59446759]Figure 37. Submit User Defined Fields
[image: ]
Note: Click Edit if you need to make additional changes before submitting the information and return to Step 3.



[bookmark: _Toc467583209][image: ]	Delete a User Defined Field
Accounting Specialists and Card Administrators can delete a UDF by completing the following steps:

· Click the Administration tab.

· Click Manage Organizations, select User Defined Fields and click Modify. The Select OTC Endpoint screen appears.

· Select the highest level organization for which you want to delete the UDF. The Step 1 of 3: Select User Defined Field to Maintain page appears. 

· Click the Delete checkbox next to the appropriate field and click Next. The Step 3 of 3: Review page appears. Select the plus sign next to the UDF to expand it.
	[image: ]Application Tip
A UDF, during deposit processing, cannot be modified if it is associated with a deposit that is in Draft or AWAP status. Only the Card Processing activity will be active.


· Verify the correct information is marked for deletion and click Submit. A confirmation page appears showing that the UDF data has been saved to the database.  
	[image: ]Application Tip
Click Edit to make additional changes before submitting the data and return to Step 4.



	[image: ]Application Tip
1. Click Cancel to return to the OTCnet Home Page. No data will be saved. 
2. Click Create UDF to create a new UDF.
3. Click Next to advance to the next page.
4. Click Previous to return to the previous page.
5. Click Edit to make additional changes to a UDF. 
6. Click Submit to complete the process and display the Confirmation page.
7. Click Return Home to return to the OTCnet Home Page. 


[bookmark: _Toc257798076][bookmark: _Toc467583210]
View a User Defined Field
As an Accounting Specialist, Local Accounting Specialist, Viewer and Card  Administrator, you can view the UDFs that exist for your organization by completing the following steps: 

1. Click the Administration tab.  From the Manage Organizations menu, select User Defined Fields and click View. 
[bookmark: _Toc59446760]Figure 38. Select User Defined Fields>View
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2. The Select OTC Endpoint screen appears. Select the highest level organization for which you would like to view a UDF.  
[bookmark: _Toc59446761]Figure 39. Select OTC Endpoint
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3. 
The View User Defined Field page appears. Click on any of the UDFs to view its characteristics (e.g. activity type, label, description, etc.). The characteristics appear. 
[bookmark: _Toc59446762]Figure 40. View User Defined Field
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As an Accounting Specialist, Local Accounting Specialist, Viewer and Card  Administrator, you can view the UDFs that exist for your organization by completing the following steps: 


· Click the Administration tab.

· From the Manage Organizations menu, select User Defined Fields and click View.  The Select OTC Endpoint screen appears.

· Select the highest level organization for which you would like to view UDF. A View User Defined Field page appears.

· Click on any of the UDFs to view it characteristics (e.g. activity type, label, description, etc.). The characteristics appear.



[bookmark: _Toc467583212]Summary
This chapter provided information on: 
· How to create, edit and delete custom labels
· How to set your options for processing deposits
· How to create, edit and delete UDFs specific to your agency
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[bookmark: _Toc467583214]Glossary


A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one, or many agency-defined accounting codes, or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so) or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System. 

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.
D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1.

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).

K

Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

 Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, deposit processing, scanning checks, processing card payments and printing receipts. 

L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 

Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.

R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.

S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 
SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.

T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 

Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.


W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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The intended audience for the Viewing Financial Institutions Participant User Guide includes:
· FI Confirmer
· FRB Confirmer
· FI Viewer
· FRB Viewer
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Welcome to Viewing Financial Institutions. In this chapter, you will learn:
· How to view a Financial Instruction 
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This chapter covers the following topic:
· Viewing Financial Institutions	
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Topic 1.  Viewing Financial Institutions
If you are assigned the role of FI Confirmer, FRB Confirmer, FI Viewer, or FRB Viewer you can locate and view Financial Institution details for which you have access to. You can only view a Financial Institution that has an Active status.

Viewing a Financial Institution allows you to see related details such as:
1. Institution Information
2. Routing Transit Numbers (RTN) and Status
3. CAN/Acct Key Relationships 
[bookmark: _Toc256982322][bookmark: _Toc426719987]View a Financial Institution
1. Click the Administration tab, select Manage FI, select Financial Institution, and click View (see Figure 1).
[bookmark: _Ref419392017][bookmark: _Toc425600241]Figure 1. Select Administration>Manage FI>Financial Institution>View
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2. 
The View the Financial Institution page appears. View details for Financial Institutions as show in Figure 2 and Figure 3.
[bookmark: _Ref467584360][bookmark: _Toc425600242]Figure 2. View FRB Detail
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[bookmark: _Ref467584368]Figure 3. View Financial Institution Detail
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[image: ]	View a Financial Institution
To view a Financial Institution:
1. Click the Administration tab.

2. Select Manage FI menu, select Financial Institution, and click View. 

3. The View the Financial Institution page appears.
	[image: MCj04421280000[1]]Application Tip
FI Confirmers, FRB Confirmers, FI Viewers, and FRB Viewers can view Institution Information, Routing Transit Numbers (RTN) and Status, and CAN/Acct Key Relationships.



	[image: MCj04421280000[1]]Application Tip
Additional button on the page that helps you perform other tasks:
1. Click Return Home to return to the OTCnet Home Page.
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Summary
In this chapter, you learned: 
1. How to view a Financial Institution 
Notes
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Glossary
A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one, or many agency-defined accounting codes, or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations, and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so) or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System.

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.

D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. User Defined Field 1 is usually the SSN number of an individual.

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).
K
Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, deposit processing, scanning checks, processing card payments and printing receipts. 

L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 

Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.

R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.

S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.

T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 

Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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[bookmark: _Toc397690666][bookmark: _Toc282520919][bookmark: _Toc279039719][bookmark: _Toc275900990][bookmark: _Toc275296308][bookmark: _Toc275295682][bookmark: _Toc275128071]The intended audience for the Configuring Check Processing Settings Participant User Guide includes:
View / Modify Configuration Functions
· Check Capture Administrator 
· Check Capture Supervisor
· Card Administrator
View Configuration Only
· Check Capture Lead Operator
· Check Capture Operator
· Card Operator
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The purpose of configuring check capture settings
How to set up or modify a terminal configuration
How to view a terminal configuration
How to search an audit log
How to download and install firmware
How to download and install the OTCnet Local Bridge (OLB) application
How to create the OTCnet Local Bridge (OLB) profile
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This chapter is organized by the following topics:
1. Purpose of Configuring Check Processing Settings
2. Set Up or Modify a Terminal Configuration
3. View a Terminal Configuration
4. Search an Audit Log
5. Download and Install Firmware
6. Download and Install the OTCnet Local Bridge (OLB) Application
7. Create the OTCnet Local Bridge (OLB) Profile
8. Import the OTCnet Local Bridge (OLB) Credentials

[bookmark: _Toc44402377][bookmark: _Toc44403517][bookmark: _Toc44411371][bookmark: _Toc44498875]Topic 1. Purpose of Configuring Check Processing Settings Online
Only Check Capture Administrators (CCA) and Check Capture Supervisors (CCS) are authorized to configure the check processing settings for your Agency’s terminal. Depending on your user role, you can see all, or only specific check capture activities transacted within your Agency. Additionally, as a CCA, you can manually download or upgrade application software to be used on a terminal (e.g., the OTCnet Local Bridge [OLB] Application) which is used to communicate between OTCnet and the check capture terminal.
*Note: CCAs and Card Administrators (CA) can also download or upgrade the OLB.
If you are to meet your location’s check capturing needs, each OTCnet terminal must have configuration settings individually applied.  You can add or update the following:
· System Configuration: Used to define LVD usage (offline users) and receipt printing
· Application Configuration: Used to define a Terminal ID, processing mode, specify a cashflow method, as well as to specify batch control and batch control prompts
· Devices Configuration: Used to specify the scanner type and communication channel, as well as enable franking
· Available OTC Endpoints: Used to add available OTC Endpoints for data entry 
· Configured OTC Endpoints: Used to set a default OTC Endpoint, review already-configured OTC Endpoints or remove unused OTC Endpoints from the terminal


[bookmark: _Toc44402378][bookmark: _Toc44403518][bookmark: _Toc44411372][bookmark: _Toc44498876]Topic 2. Set Up or Modify a Terminal Configuration
The CCA and CCS are authorized to configure a check capture terminal. The CA is authorized to configure a card terminal.

If you are configuring a check capture terminal, you must first start the OTCnet Local Bridge (OLB) application. For more details, refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid.

Before starting the OLB application, ensure the following steps have been completed in this order:

· The CCA or CA can download the OLB application
· The OLB certificate is installed on the terminal (applicable for OLB versions 1.2.0 and older)
· The OLB application is installed on the terminal
· Each user has created their OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated) 
· Each user has imported their OLB credentials to the workstation

For step-by-step instructions, refer to the Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, Create the OTCnet Local Bridge (OLB) Profile, and Import OTCnet Local Bridge (OLB) Credentials printable job aids.

To configure a check capture terminal online, complete the following steps:

· Click the Administration tab. 
· Click Manage Check Processing>Terminal Configuration>Modify. The Step 1 of 4: Gathering Terminal Information page may appear briefly (see Figure 1).
[bookmark: _Toc44334685][bookmark: _Toc44411263][bookmark: _Toc44498806][bookmark: _Toc57897393]Figure 1. Administration >Manage Check Processing>Terminal Configuration>Modify
[image: ]

If you are configuring a check capture terminal and the OLB application has not been started, the following message will appear: Terminal detection failed. Please ensure that the OLB application is running. Refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid for step-by-step instructions on starting the OLB application.

· The Step 2 of 4: Update the Terminal Configuration page appears. Enter the system configuration.

Under System Configuration (see Figure 2 below), 
Set LVD Usage by, optional
1. Checking or unchecking Personal Check and/or Non- Personal for Customer Present
2. Checking or unchecking Personal Check and/or Non- Personal for Customer Not Present

By default, all four checkboxes (Personal and/or Non- Personal checks and Customer Present and/or Customer Not Present) for (Local Verification Database) LVD Usage are checked and they are optional. If all of them not checked, then LVD verification feature is disabled. 
Set Receipt Printing by, optional
1. Checking Person Present
1. Click the Manual or Automatic radio button
a. Check with preview
b. Checking Person Not Present
2. Click the Manual or Automatic radio button
a. Check with preview
Leaving both the Person Present and Person Not Present fields unchecked results in the disabling of this option. Click the appropriate box(es) if receipts are desired. Choosing Manual requires that the operator take additional steps to print the receipt. 
Choosing Automatic results in a receipt printout each time a transaction has been entered. Choosing With Preview option allows the operator to see the receipt on the screen prior to the generation of the printout. When the Person Present and/or Person Not Present fields are selected, the default setting is Manual.
When printing receipts, the system will go to the Windows default printer. All receipts will print to the Windows default printer.


[bookmark: _Ref467584290][bookmark: _Ref467584271][bookmark: _Toc44334686][bookmark: _Toc44411264][bookmark: _Toc44498807][bookmark: _Toc57897394]Figure 2. Step 2 of 4: Update the Terminal Configuration
[image: ]

Under Application Configuration (see Figure 3), 
1. Enter the Terminal ID
· Select Single or Batch for Processing mode
· Select Settle Best Method or Truncate All Items for Cashflow
a. Check Back Office Processing Only
b. Select Optional or Mandatory for Batch Control
c. Click Prompt on Batch Create and/or Prompt on Batch Close for Batch Control Prompts

The Terminal ID field is available for data entry during initial setup. After the Terminal ID is assigned, it is protected and cannot be changed. 
The Host Name field is automatically generated based on your computer’s registry and cannot be changed.
The Single processing mode is designed to allow the user to scan one check at a time. The Batch processing mode allows groups of checks to be scanned all at once, prior to the data entry for the items. The Batch processing mode is available for EC7000i, EC9100i, and all Panini scanners.
The Settle Best Method is the default selection and when selected exclusively on the configuration screen, all processing methods (Customer Present, Customer Not Present, and Back Office) are allowed for either personal or non-personal items on the Entry Screen.

The Back Office Processing method should be used by agencies that receive payments in person, and then scan the checks at a later time in a controlled, back office environment. Truncate All Items represents only non-personal items are allowed (for all processing methods) on the Entry Screen.
If the Batch Control is set to Optional, OTCnet prompts the user to use the batch control. If the Batch Control is set to Mandatory, OTCnet prompts for batch control totals.
[bookmark: _Ref467584731][bookmark: _Toc44334687][bookmark: _Toc44411265][bookmark: _Toc44498808][bookmark: _Toc57897395]Figure 3. Application Configuration
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 3. Application Configuration.png]
[bookmark: _Ref415829236]
Under Devices Configuration, 
17. Select the Scanner model, (required) (see Table 1 below)
18. Select USB Port or Serial Port, (required)
a. Select the Serial Port type

A “No Serial Ports are available for configuration” message displays if a Serial Port is not available for the terminal. A “No Serial Ports are available for configuration” message does not display if the terminal has a COM port enabled or if there a COM port enabled and there is no physical Serial Port. 

19. Check Franking Enabled, (optional)

The Franking Enabled option allows the scanner to automatically stamp the front of checks. Franking is available for EC7000i, EC9100i, and Panini I: Deal scanners.
When you complete the Devices Configuration, click Next (see Figure 4). 


[bookmark: _Ref460488113][bookmark: _Toc44334688][bookmark: _Toc44411266][bookmark: _Toc44498809][bookmark: _Toc57897396]Figure 4. Devices Configuration
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 4. Devices Configuration.png]
[bookmark: _Ref467584797][bookmark: _Toc485924182]Table 1. Scanner Types
	EC7000i
	This scanner will automatically scan both sides of a check and can scan in single or batch mode (one or more checks in a batch)

	EC9100i
	This scanner will automatically scan both sides of a check and can scan in single or batch mode (one or more checks in a batch)

	Panini MyVision X
	This scanner will automatically scan both sides of a check and can scan in single or batch mode (one or more checks in a batch)

	Panini Vision X
	This scanner will automatically scan both sides of a check and can scan in single or batch mode (one or more checks at a time)

	Panini I: Deal
	This scanner will automatically scan both sides of a check and can scan in single or batch mode (one or more checks at a time)



· The Step 3 of 4: Update the Configured OTC Endpoints page appears.

Under Available OTC Endpoints,
20. Select the OTC Endpoint (s) you want to Add by checking the box(es) under the Add column, and click Add

Under Configure OTC Endpoint,
21. Select a Default OTC Endpoint, required
1. Select the OTC Endpoint (s) you want to Delete by checking the box(es) under the Remove column, and click Remove, if applicable

When you complete configuring the OTC Endpoints, click Next (see Figure 5). 


[bookmark: _Ref467585165][bookmark: _Toc44334689][bookmark: _Toc44411267][bookmark: _Toc44498810][bookmark: _Toc57897397]Figure 5. Step 3 of 4: Update the Configured OTC Endpoints
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 5. Step 3 of 4 Update the Configured OTC Endpoints.png]
[bookmark: _Ref460488716]
Selecting a Default OTC Endpoint determines which OTC Endpoint to use when performing Check Scan actions. At least one Default OTC Endpoint is required per terminal. While a default is chosen, it does not prevent you from scanning against another configured OTC Endpoint.

· The Step 4 of 4: Review the Terminal Configuration page appears (see Figure 6). Verify the Terminal Configuration is correct and click Submit. Click Edit if you need to modify the information entered.


[bookmark: _Ref467585231][bookmark: _Toc44334690][bookmark: _Toc44411268][bookmark: _Toc44498811][bookmark: _Toc57897398]Figure 6. Step 4 of 4: Review the Terminal Configuration
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[bookmark: _Toc462396514][bookmark: _Toc467594358][bookmark: _Toc44402379][bookmark: _Toc44403519][bookmark: _Toc44411373][bookmark: _Toc44498877][image: MCj04420720000[1]]	Configure a Check Capture Terminal Online
	[image: ]Application Tip
The Check Capture Administrator (CCA) and (CCS) are authorized to configure a check capture terminal. The Card Administrator (CA) is authorized to configure a card terminal.



	[image: ]Application Tip
If you are configuring a check capture terminal, you must first start the OTCnet Local Bridge (OLB) application.
For more details, refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid.
Before starting the OLB application, ensure the following steps have been completed in this order:
22. The CCA or CA can download the OLB application
23. The OLB certificate is installed on the terminal (applicable for OLB versions 1.2.0 and older)
24. The OLB application is installed on the terminal
25. Each user has created their OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated) 
26. Each user has imported their OLB credentials to the workstation
For step-by-step instructions, refer to the Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, Create the OTCnet Local Bridge (OLB) Profile, and Import OTCnet Local Bridge (OLB) Credentials printable job aids. 



To configure a check capture terminal online, complete the following steps:

1. Click the Administration tab.

2. Select Manage Check Processing>Terminal Configuration>Modify. The Step 1 of 4: Gathering Terminal Information page may appear briefly.



	[image: ]Application Tip
If you are configuring a check capture terminal and you have not started the OTCnet Local Bridge (OLB) application, you will receive the following message: Terminal detection failed. Please ensure that the OLB application is running. Refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid for step-by-step instructions on starting the OLB application.


3. The Step 2 of 4: Update the Terminal Configuration page appears. Enter the system configuration.

Under System Configuration, 
Set LVD Usage by, optional
3. Checking or unchecking Personal Check and/or Non- Personal for Customer Present
4. Checking or unchecking Personal Check and/or Non- Personal for Customer Not Present
	[image: ]Application Tip
By default, all four checkboxes (Personal Check and Non- Personal for Customer Present and Customer Not Present) are checked for (Local Verification Database) LVD Usage. These are optional. If all of them are not checked, then the LVD verification feature is disabled. 



Set Receipt Printing by, optional
5. Checking Customer Present, optional
a. Click the Manual or Automatic radio button
i. Check with preview
6. Checking Customer Not Present, optional
a. Click the Manual or Automatic radio button
i. Check with preview

	[image: ]Application Tip
Leaving both the Customer Present and Customer Not Present fields unchecked results in the disabling of this option. If receipts are desired, click the appropriate box(es). Choosing Manual requires that the operator take additional steps to print the receipt. Choosing Automatic results in a receipt printout each time a transaction has been entered. Choosing the with preview option allows the operator to see the receipt on the screen prior to the generation of the printout. When the Customer Present and/or Customer Not Present fields are clicked, the default setting is Manual.



	[image: ]Application Tip
When printing receipts, the system will go to the Windows default printer. All receipts will print to the Windows default printer.



Under Application Configuration, 
2. Enter the Terminal ID
	[image: ]Application Tip
The Terminal ID field is available for data entry during initial setup. After the Terminal ID is assigned, it is protected and cannot be changed. 



	[image: ]Application Tip
The Host Name field is automatically generated based on your computer’s registry and cannot be changed. 


3. Select Single or Batch for Processing mode
	[image: ]Application Tip
The Single processing mode allows the user to scan only one check at a time. The Batch processing mode allows groups of checks to be scanned all at once, prior to the data entry for the items. The Batch processing mode is available for EC7000i, EC9100i, and all Panini scanners.



4. Select Settle Best Method or Truncate All Items for Cashflow
5. Check Back Office Processing Only
	[image: ]Application Tip
The Settle Best Method is the default selection, and when selected exclusively on the configuration screen, all processing methods (Customer Present, Customer Not Present, and Back Office) are allowed for either personal or non-personal items on the Entry Screen. The Back Office processing method should be used by agencies that receive payments in person, and then scan the checks at a later time in a controlled, back office environment. If Truncate All Items is selected, only non-personal items are allowed (for all processing methods) on the Entry Screen. 



6. Select Optional or Mandatory for Batch Control

	[image: ]Application Tip
If the Batch Control is set to Optional, OTCnet prompts the user to use the batch control. If the Batch Control is set to Mandatory, OTCnet prompts for batch control totals. 


7. Click Prompt on Batch Create and/or Prompt on Batch Close for Batch Control Prompts
Under Devices Configuration, 
27. Select the Scanner model, required
28. Select USB Port or Serial Port, required
a. Select the Serial Port type
	[image: ]Application Tip
USB Port: EC7000i, EC9100i, Panini MyVision, Panini VisionX, and Panini I: Deal scanners require a USB port communication channel. EC7000i scanners support USB and Serial communication channels.
Serial Port and COM dropdown: The user selects the serial port (i.e., COM port) where they have connected a serial scanner.
USB-to-Serial adapters: USB-to-serial adapters are not supported. EC7000i scanners support USB and Serial communication channels.



	[image: ]Application Tip
A “No Serial Ports are available for configuration” message displays if a Serial Port is not available for the terminal. A “No Serial Ports are available for configuration” message does not display if the terminal has a COM port enabled or if there is a COM port enabled, and there is no physical Serial Port. 


29. Check Franking Enabled, optional
	[image: ]Application Tip
The Franking Enabled option allows the scanner to automatically stamp the front of checks. Franking is available for EC7000i, EC9100i, and Panini I: Deal scanners.



4. Click Next. The Step 3 of 4: Update the Configured OTC Endpoints page appears. 


Under Available OTC Endpoints,
30. Select the OTC Endpoint (s) you want to Add by checking the box(es) under the Add column, and click Add

	[image: ]Application Tip
The OTC Endpoints are permission based and are only visible to users with the appropriate permissions.


Under Configure OTC Endpoint,
31. Select a Default OTC Endpoint, required
	[image: ]Application Tip
Selecting a Default OTC Endpoint determines which OTC Endpoint to use when performing Check Scan actions.



	[image: ]Application Tip
Multiple OTC Endpoints can be selected, but only one can be set as a Default OTC Endpoint.



32. Select the OTC Endpoint(s) you want to Delete by checking the box(es) under the Remove column, and click Remove, if applicable
	[image: ]Application Tip
At least one Default OTC Endpoint is required per terminal.


5. Click Next. The Step 4 of 4: Review the Terminal Configuration page appears. Verify the Terminal Configuration is correct and click Submit. Click Edit if you need to modify the information entered.

1. A Confirmation page appears stating that the Terminal Configuration record has been updated.
	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks: 
33. Click Cancel to return to the OTCnet Home Page. No data will be saved. 
34. Click Previous to return to the previous page.
35. Click Return Home to return to the OTCnet Home Page.



36. Select the OTC Endpoint (s) you want to Delete by checking the box(es) under the Remove column, and click Remove, if applicable.
	[image: ]Application Tip
At least one Default OTC Endpoint is required per terminal.


2. Click Next. The Step 4 of 4: Review the Terminal Configuration page appears. Verify the Terminal Configuration is correct and click Submit. Click Edit if you need to modify the information entered.

3. A Confirmation page appears stating that the Terminal Configuration record has been updated.
	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks: 
37. Click Cancel to return to the OTCnet Home Page. No data will be saved. 
38. Click Previous to return to the previous page.
39. Click Return Home to the OTCnet Home Page.





[bookmark: _Toc44402380][bookmark: _Toc44403520][bookmark: _Toc44411374][bookmark: _Toc44498878]Topic 3. View Terminal Configuration
The CCA, CCS, Check Capture Lead Operator (CCLO) and Check Capture Operator (CCO) are authorized to view check terminal configuration.
1. Click the Administration tab. From the Manage Check Processing menu, select Terminal Configuration and select View (see Figure 7 below). 
[bookmark: _Toc44334691][bookmark: _Toc44411269][bookmark: _Toc44498812][bookmark: _Toc57897399]Figure 7. Administration >Manage Check Processing>View
[image: ]
2. The View page appears (see Figure 8 below). View Terminal Configuration.
[bookmark: _Ref467585757][bookmark: _Toc44334692][bookmark: _Toc44411270][bookmark: _Toc44498813][bookmark: _Toc57897400]Figure 8. View Terminal Configuration Page
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[bookmark: _Toc462396516][bookmark: _Toc467594360][bookmark: _Toc44402381][bookmark: _Toc44403521][bookmark: _Toc44411375][bookmark: _Toc44498879]
[image: ]	View Terminal Configuration
The CCA, CCS, CCLO, CCO, CA and CO are authorized to view terminal configuration.

To view terminal configuration, complete the following steps:

1. Click the Administration tab.

2. Click Manage Check Processing>Terminal Configuration and select View. 

3. The View page appears. View Terminal Configuration.
	[image: ]Application Tip
Additional button on the page that helps you perform other tasks: 
Click Return Home to the OTCnet Home Page.





[bookmark: _Toc44402382][bookmark: _Toc44403522][bookmark: _Toc44411376][bookmark: _Toc44498880]Topic 4. Search an Audit Log
The audit log records are interactions between the user and OTCnet. They allow users to search and view audit log entries for the completed audit trail within OTCnet. The audit log is available for download to a comma separated value (CSV) report and opened in a spreadsheet program or available to print in a formatted audit log report. 

If the audit log records contain Personally Identifiable Information (PII), the data is masked in the Transaction Description. To view more details about a specific batch, including PII, access Batch Management.

The CCA, CCO, CCLO, and CCS, can search audit logs related to check processing activities. The CA and CO can search audit logs related to card processing activities. Depending on your role, you can search for and view only specific audit logs. See Table 2 for more details.
[bookmark: _Ref467590087][bookmark: _Toc485924183]Table 2. Audit Log User Permissions
	User Role
	Audit Log Access

	Check Capture Administrator (CCA)
	Partial administration-related activities and all check capture-related activities

	Check Capture Operator (CCO)
	Own check capture-related activities

	Check Capture Lead Operator (CCLO)
	Own check capture-related activities

	Check Capture Supervisor (CCS)
	Partial check capture-related activities pertaining to own actions or actions taken by their CCO or CCLO

	FS Viewer or Security Viewer
	Administration-related, check capture-related, check processing-related, and deposit processing-related activities

	Card Administrator
(CA)
	Partial administration-related activities and all card-related activities

	Card Operator
(CO)
	Partial access to user’s own card-related activities



You can search audit logs by module, user, OTC Endpoint, and other search criteria. If you run a search without specifying any criteria, then by default the search results include all activities in the system that you have access to view. If you run additional searches, the Search Results table repopulates with the results of the new search.
[bookmark: _Ref459844377]
To search an Audit Log:
1. Click the Administration tab

2. [bookmark: _Ref467590232]Click Audit (see Figure 9). 
[bookmark: _Toc44334693][bookmark: _Toc44411271][bookmark: _Toc44498814][bookmark: _Toc57897401]Figure 9. Administration >Audit
[image: ]
3. [bookmark: _Ref425600573]The Search Audit Logs page appears. Enter the search criteria for the activities you would like to view (see Figure 10).

Under Search Criteria, optional
1. Select a Module type.

Module options for check processing include Administration and Check Capture. Module drop-down options vary by user role.

Note:  Module options for card processing include Administration and Card Processing. 

2. Enter a User (login ID)
3. Select an OTC Endpoint
4. Enter the From and To Dates and Times, required
5. Select a Keyword, required
6. Select a Category Name, required

The Keyword and Category Name drop-down options vary by user role. 

7. Enter the Terminal ID
8. Enter the Batch ID
9. Select an Event Type (see Table 3)

Event types are categories of events that are recorded by the audit log.


[bookmark: _Ref467590212][bookmark: _Toc485924184]Table 3. Event Types
	Event Type
	Description

	All
	Includes all event types in the audit log 

	Error
	Error entries are created when the system is unable to complete an action

	Informational
	Information entries are general records of the activity that has happened while using OTCnet

	Warning
	Warning entries are created to inform the user when events of note have taken place. This includes cancelling an action, deleting information from the system and inactive users


10. Select an Operation Mode and click Search.
Operation Mode options include All, Online, or Offline. If you run a search without specifying any criteria, the search results include all activities in the system that you have access to view. If you run additional searches, the Search Results table repopulates with the results of the new search.

4. Click Search.
[bookmark: _Toc44334694][bookmark: _Toc44411272][bookmark: _Toc44498815][bookmark: _Toc57897402]Figure 10. Search Audit Logs Page
[image: ]
5. 
The Search Results table appears below. Click the Audit Log ID hyperlink to view additional details for an individual audit log entry (see Figure 11).
[bookmark: _Ref459877976][bookmark: _Toc44334695][bookmark: _Toc44411273][bookmark: _Toc44498816][bookmark: _Toc57897403]Figure 11. Audit Log Output
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 11. Audit Log Output.png]

Click Download to download the search results. Click Print Audit Log Records to print a formatted audit log record. 

6. The View Audit Log Details page appears (see Figure 12).
[bookmark: _Ref425600611][bookmark: _Toc44334696][bookmark: _Toc44411274][bookmark: _Toc44498817][bookmark: _Toc57897404]Figure 12. View Audit Log Details
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 12. View Audit Log Details.png]
[bookmark: _Toc462396518][bookmark: _Toc467594362][bookmark: _Toc44402383][bookmark: _Toc44403523][bookmark: _Toc44411377][bookmark: _Toc44498881]
[image: MCj04420720000[1]]	Search an Audit Log
The Check Capture Administrator (CCA), Check Capture Operator (CCO), Check Capture Lead Operator (CCLO), and Lead Operator Supervisor (CCS) can search audit logs related to check processing activities. The CA and CO can search audit logs related to card processing activities. Depending on your role, you can search for and view only specific audit logs. To search an audit log, complete the following steps:

· Click the Administration tab. 
· Click Audit. The Search Audit Logs page.
· Enter the search criteria for the activities you would like to view.
Under Search Criteria, optional
Select a Module type.
	[image: ]Application Tip
Module options include Administration, Check Capture, Check Processing, and Deposit Processing. Card Processing Module options include Administration and Card Processing. The Module drop-down options vary by user role.





11. Enter a User
12. Select an OTC Endpoint
13. Enter the From and To date and time ranges, required
	[image: ]Application Tip
The From and To Created On Date must be entered in MM/DD/YYYY format and cannot exceed 30 days.


14. Select a Keyword, required
15. Select a Category Name, required


	[image: ]Application Tip
The Keyword and Category Name drop-down options vary by user role. 


16. Enter the Terminal ID
17. Enter the Batch ID
18. Select an Event Type
	[image: ]Application Tip
Event Types are categories of events that are recorded by the audit log.
Table 4. Event Types
	Event Type
	Description

	All
	Includes all event types in the audit log 

	Error
	Error entries are created when the system is unable to complete an action.

	Informational
	Information entries are general records of the activity that has happened while using OTCnet.

	Warning
	Warning entries are created to inform the user when events of note have taken place. This includes cancelling an action, deleting information from the system and inactive users.





19. Select an Operation Mode
	[image: ]Application Tip
Operation Mode options include All, Online, or Offline.





· Click Search. The Search Results table appears below.
	[image: ]Application Tip
If you run a search without specifying any criteria, the search results 
include all activities in the system that you have access to view. If you run additional searches, the Search Results table repopulates with the results 
of the new search.



	[image: ]Application Tip
Click Download to download the search results. Click Print Audit Log Records to print a formatted audit log record. 


· Click the Audit Log ID hyperlink to view additional details for an individual audit log entry. The View Audit Log Details page appears.
	[image: ]Application Tip
If the audit log records contain Personally Identifiable Information (PII) the data is masked.



	[image: ]Application Tip
Additional buttons on the pages that help you perform other tasks: 
1. Click Previous to return to the previous page.
2. Click Return Home to the OTCnet Home Page.




[bookmark: _Toc44402384][bookmark: _Toc44403524][bookmark: _Toc44411378][bookmark: _Toc44498882]Topic 5. Download and Install Firmware
[bookmark: _Toc462396520][bookmark: _Toc44402385][bookmark: _Toc44403525][bookmark: _Toc44411379][bookmark: _Toc44498883]Download Firmware
If you are assigned the role of CCA, you can manually download check capture application firmware. The firmware “release” allows for the initial download or upgrades to the scanner software that enables a scanner to be used on a terminal. The firmware version you install also contains a series of other back-end installation files that should be used on a terminal to enable it to be used for Check Capture in OTCnet.
Prior to each firmware upgrade, the currently installed firmware must be uninstalled first. 
Additionally, firmware upgrades are operating system (Windows 10) and scanner (e.g., EC7000i, EC9100i, Panini MyVision, or Panini Vision X) specific. Therefore, downloading and executing the correct firmware upgrades helps ensure that a terminal and scanner are functioning properly. To determine firmware upgrades by firmware version, scanner, and operating system, refer to the OTCnet System Requirements and Reference Guide at: https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf. 

For offline users, this topic will also allow a user to download a “client” version of the OTCnet application to install on their terminals. Once the upgrade is downloaded to the terminal, an authorized user with terminal administrator rights must log in to the terminal and execute the upgrade. If there is more than one terminal per OTC Endpoint, the CCA must download and execute the firmware (release) for each terminal. 

To Download Firmware:
1. Click the Administration tab, click Manage Centralized Deployment, and then select Download Release (see Figure 13). 
[bookmark: _Toc57897405]Figure 13. Administration >Manage Centralized Deployment>Download Release
[image: ]

2. From the Application drop-down menu, select Firmware. By default, the Application drop-down menu is set to Firmware. Click the Next button (see Figure 14).
[bookmark: _Toc44334698][bookmark: _Toc44411276][bookmark: _Toc44498819][bookmark: _Toc57897406]Figure 14. Download Release
[image: ]

3. The Select Firmware for Download page appears. Click the Firmware hyperlink to download the firmware (see Figure 15).

[bookmark: _Ref459880323][bookmark: _Toc44334699][bookmark: _Toc44411277][bookmark: _Toc44498820][bookmark: _Toc57897407]Figure 15. Select Firmware for Download
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 15. Select Firmware for Download.png]
[bookmark: _Ref459888790]If an agency (OTC Endpoint) has multiple terminals and requires more than one firmware due to varying workstation requirements, download and execute the firmware for each terminal.

Keep in mind that firmware upgrades are operating system (e.g., Windows 10) and scanner (e.g., EC7000i, Panini MyVision X) specific. To determine firmware upgrades by firmware version, scanner, and operating system, refer to the OTCnet System Requirements and Reference Guide at: 
https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf. 

4. The Review Firmware Download page appears. Click Download (see Figure 16). 

If there is more than one terminal per OTC Endpoint, the CCA must download and execute the firmware for each terminal.
[bookmark: _Ref467591165][bookmark: _Toc44334700][bookmark: _Toc44411278][bookmark: _Toc44498821][bookmark: _Toc57897408]Figure 16. Review Firmware Download
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 16. Review Firmware Download.png]

5. The Save dialog box appears. Click Save or Cancel (see Figure 17).
[bookmark: _Ref459881081][bookmark: _Ref425600732][bookmark: _Toc44334701][bookmark: _Toc44411279][bookmark: _Toc44498822][bookmark: _Toc57897409]Figure 17. Save Dialog Box
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 17. Save Dialog Box.png]
If you click Save, choose the location where you want to save the file. If you click Cancel, you return to the OTCnet Check Capture Application Download page without saving the file.


[bookmark: _Toc462396521][bookmark: _Toc467594365][bookmark: _Toc44402386][bookmark: _Toc44403526][bookmark: _Toc44411380][bookmark: _Toc44498884][image: ]	Download Firmware
The Check Capture Administrator (CCA) is the only user authorized to download firmware. To download firmware, complete the following steps:

· Click the Administration tab.

· Click Manage Centralized Deployment and select Download Release. 

· From the Application drop-down menu, select Firmware. 
	[image: ]Application Tip 
By default, the Application drop-down menu is set to Firmware.


· Click Next. The Select Firmware for Download page appears.
	[image: ]Application Tip
Prior to each firmware upgrade, the currently installed firmware version must be uninstalled first. Firmware upgrades are operating system (e.g., Windows 10) and scanner (e.g., EC7000i, EC9100i, Panini MyVision X) specific. Each firmware version has a corresponding terminal configuration(s) that it supports (by scanner and by operating system). Determine the appropriate firmware upgrade by firmware version, scanner, and operating system before downloading.


· Click the Firmware hyperlink to download the firmware. The Review Firmware Download page appears.
	[image: ]Application Tip
If an agency (OTC Endpoint) has multiple terminals and requires more than one firmware due to varying workstation requirements, download and execute the firmware for each terminal.


· Click Download. The Save Program dialog box appears.
· Click Save or Cancel. 
	[image: ]Application Tip
If you click Save, choose the location where you want to save the file. If you click Cancel, you return to the OTCnet Check Capture Application Download page without saving the file.



	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
· Click Previous to return to the previous page.
· Click Return Home to the OTCnet Home Page.


[bookmark: _Toc397690673][bookmark: _Toc44402387][bookmark: _Toc44403527][bookmark: _Toc44411381][bookmark: _Toc44498885]
Install OTCnet Firmware
After the CCA downloads the firmware, the next step is to install the firmware (must be done for each terminal). This can be done by the CCA, CCS, CCLO, and CCO. However, before you install the firmware consider the following information:
· You will need Windows Administrator privileges to install the firmware. 
· If using OTCnet Offline, close any open batches and upload all existing batches in Batch Management, as well as stop the Offline application. 
· Ensure the scanner is not connected to the terminal as it may cause scanner connectivity issues. 
· If a previous version of firmware is installed, uninstall it before installing the new firmware version. See the Install OTCnet Firmware printable job aid for specific directions. 
· [bookmark: _Hlk536030406]Firmware versions 4.0.0 and 3.1.2 support the RDM EC7000i, RDM EC9100i, Panini MyVisionX, Panini Vision X, and Panini I: Deal scanners. Additionally, Firmware versions 4.0.0 and 3.1.2 support Windows 10 Operating Systems. 
· Firmware version 2.0.0 supports the RDM EC7000i, Panini MyVisionX, Panini Vision X, and Panini I:Deal scanners. Additionally, Firmware version 2.0.0 supports Windows 10 Operating Systems. 
For Windows 10:
· Access your Control Panel under Start > Window Systems > Control Panel
· Click Programs > Uninstall Programs
· In the Currently installed programs box, click OTCnetFirmware
· Click Remove
· Click Yes and wait while the Firmware uninstalls
Verify the OTCnetFirmware and Panini X.X.X Universal Installer automatically uninstalled
For more information about which firmware version matches the terminal settings, refer to the OTCnet System Requirements and Reference Guide at:
https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf. 

[bookmark: _Ref425600818]To Install Firmware:
3. Locate the folder where the firmware file (MSI file) resides and double-click the file to start the installation (see Figure 18).  
[bookmark: _Ref467591739][bookmark: _Toc44334702][bookmark: _Toc44411280][bookmark: _Toc44498823][bookmark: _Toc57897410]Figure 18. OTCnet Firmware.msi icon
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 18. OTCnet Firmware .msi icon.png]
4. 
The Welcome to the OTCnet Firmware Installation Wizard dialog box appears. Click Next (see Figure 19). 
[bookmark: _Ref459881351][bookmark: _Toc44334703][bookmark: _Toc44411281][bookmark: _Toc44498824][bookmark: _Toc57897411]Figure 19. Welcome to the OTCnet Firmware Installation Dialog Box
[image: ]
5. The User Information dialog box appears. Click Next (see Figure 20).
[bookmark: _Ref463351460][bookmark: _Ref463351455][bookmark: _Toc44334704][bookmark: _Toc44411282][bookmark: _Toc44498825][bookmark: _Toc57897412]Figure 20. User Information Dialog Box
[image: ]


6. The Destination Folder dialog box appears. Click Next (see Figure 21).
[bookmark: _Ref425601134][bookmark: _Toc44334705][bookmark: _Toc44411283][bookmark: _Toc44498826][bookmark: _Toc57897413]Figure 21. Destination Folder Dialog Box
[image: ]
As a best practice, it is recommended that the firmware package is installed into the default destination folder. 
7. The Select Features dialog box appears. Click Next (See Figure 22).
[bookmark: _Ref459881454][bookmark: _Ref467591813][bookmark: _Toc44334706][bookmark: _Toc44411284][bookmark: _Toc44498827][bookmark: _Toc57897414]Figure 22. Select Features Dialog Box
[image: ]

8. [bookmark: _Ref425601413]The Ready to Install the Application dialog box appears. Click Next (see Figure 23). Wait a moment while the files install.
During the installation process for OTCnet Firmware, users can continue to use their workstations. However, OTCnet and all related activities will be unavailable until the installation of the Firmware is complete. The installation time can vary from workstation to workstation. Users can expect a duration of up to 30 minutes to complete full installation. Do not close the installation window until the installation is complete.
[bookmark: _Ref467591822][bookmark: _Toc44334707][bookmark: _Toc44411285][bookmark: _Toc44498828][bookmark: _Toc57897415]Figure 23. Ready to Install the Application Dialog Box
[bookmark: _Ref459881910][image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 23. Ready to Install the Application Dialog Box.png]


9. After the OTCnet Firmware has been successfully installed message appears, click Finish (see Figure 24).
[bookmark: _Ref467591833][bookmark: _Toc44334708][bookmark: _Toc44411286][bookmark: _Toc44498829][bookmark: _Toc57897416]Figure 24. OTCnet Firmware has been successfully installed Dialog Box
[image: Q:\Training\2.3 Training Materials\2.3 UGs\Admin\adm_ug_ch7_confg_chk_proc_set_R2.3_090116_PICTURES\Figure 24. OTCnet Firmware has been successfully installed Dialog Box.png]
[bookmark: _Toc462396523][bookmark: _Toc467594367][bookmark: _Toc44402388][bookmark: _Toc44403528][bookmark: _Toc44411382][bookmark: _Toc44498886]
[image: MCj04420720000[1]]	Install OTCnet Firmware
	[image: ]Application Tip 
The CCA, CCS, CCLO, and CCO are authorized to install firmware.



	[bookmark: _Hlk536197655][image: ]Application Tip 
Before you install the OTCnet Firmware, consider the following information:
1. Prior to each firmware upgrade, the currently installed firmware version must be uninstalled first.
2. To install the Firmware, you will need Windows Administrator privileges on each computer.
3. If using OTCnet Offline, close any open batches and upload all existing batches in Batch Management, as well as stop the Offline application.
4. Ensure the scanner is not connected to the terminal when installing the firmware as it may cause scanner connectivity issues.
5. If you have a previous firmware version installed, you will need to uninstall it before installing a new Firmware version. See the directions below for uninstalling a previous version of Firmware.
For Windows 10:
1. Access your Control Panel under Start > Window Systems > Control Panel
2. Click Programs > Uninstall Programs
3. In the Currently installed programs box, click OTCnetFirmware
4. Click Remove
2. Click Yes and wait while the Firmware uninstalls
3. Verify the OTCnetFirmware and Panini X.X.X Universal Installer automatically uninstalled





	[image: ]Application Tip 
Before you install the OTCnet Firmware, consider the following information:
6. [bookmark: _Hlk520242552]Firmware versions 4.0.0 and 3.1.2 support the RDM EC7000i, RDM EC9100i, Panini MyVisionX, Panini Vision X, and Panini I: Deal scanners. Additionally, Firmware versions 4.0.0 and 3.1.2 support Windows 10 Operating Systems. 
7. Firmware version 2.0.0 supports the RDM EC7000i, Panini MyVisionX, Panini Vision X, and Panini I:Deal scanners. Additionally, Firmware version 2.0.0 supports Windows 10 Operating Systems. 
For more information about firmware upgrades by firmware version, scanner, and operating system, refer to the OTCnet System Requirements and Reference Guide at:
https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf. 


To install OTCnet firmware, complete the following steps:
1. Locate the folder where the firmware file (MSI file) resides and double-click the file to start the installation.
2. The Welcome to the OTCnet Firmware Installation Wizard dialog box appears. Click Next.
3. The User Information dialog box appears. Click Next.
4. The Destination Folder dialog box appears. Click Next.
	[image: ]Application Tip
To install the firmware to another folder destination, click Browse to select a different folder. Click Cancel to exit the setup.


5. The Ready to Install the Application dialog box appears. Click Next. Wait a moment while the files install. 
	[image: ]Application Tip
During the installation process for OTCnet Firmware, users can continue to use their workstations. However, OTCnet and all related activities will be unavailable until the installation of the Firmware is complete. The installation time can vary from workstation to workstation. Users can expect a duration of up to 30 minutes to complete full installation. Do not close the installation window until the installation is complete.


6. After the OTCnet Firmware has been successfully installed message appears, click Finish.
[bookmark: _Toc44402389][bookmark: _Toc44403529][bookmark: _Toc44411383][bookmark: _Toc44498887]Topic 6. Download and Install OTCnet Local Bridge (OLB) Application
[bookmark: _Toc44402390][bookmark: _Toc44403530][bookmark: _Toc44411384][bookmark: _Toc44498888]Download OTCnet Local Bridge (OLB) Application
[bookmark: _Hlk15223279]The CCA and CA are authorized to download the OTCnet Local Bridge (OLB). The OLB is a stand-alone application that must be installed on all user workstations performing card processing, check capture, check processing and terminal configuration operations. For more information on configuring a check processing terminal, refer to the Administration Chapter 7: Configuring Check Processing Settings user guide.

OTCnet supports Google Chrome (Chrome) and Internet Explorer (IE) browsers. When using Chrome, the CA or CCA does not need to make browser configuration changes (with the OLB prerequisites) however, the OLB must be installed. For OLB versions 1.3.0 and newer, the OLB certificate is included in the OLB installer file (EXE file). 

For OLB versions 1.2.0 and older, however, for the OLB application to function properly with OTCnet, users are required to separately install the OLB Certificate on the terminal. Review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) for additional information.

Note that the download release process was streamlined for ease and efficiency. We recommend you download the newest version of the OLB.

[bookmark: _Hlk15635646]When using IE, the CCA or CA does have to update browser configuration settings. Review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) to verify that you meet system and configuration requirements and the OLB prerequisites.  

Refer to the Download the OTCnet Local Bridge (OLB) Application printable job aid for specific directions. 

After the CCA or CA downloads the OLB application, users (CCA, CCS, CCLO, CCO, CA and CO) can complete the remaining steps in setting up the OLB application:
20. Install the OLB certificate (applicable only to OLB versions 1.2.0 and older)
21. Install the OLB application 
22. Create the OLB profile
23. Start the OLB application 
24. The OLB application is started on the terminal

Note: 
· For Check Processing workstations, the OLB application can be installed before or after the OTCnet Firmware is installed. Firmware is not required for Card Processing workstations.
· Windows Administrator privileges are required to install the OLB application on a terminal. Users may need to contact the CCA or the Agency’s IT team in order to complete this step.
· [bookmark: _Hlk39656328]Depending on your user role, you may not have access to both Manage Check Processing and Manage Card Processing functions. 

To Download the OTCnet Local Bridge (OLB) application:

1. Click the Administration tab. Click Manage Centralized Deployment and select Download Release (see Figure 25).
[bookmark: _Toc57897417]Figure 25. Administration > Manage Centralized Deployment > Download Release
[image: ]

2. The Download Release page appears. From the Application drop-down menu, select OTCnet Local Bridge, and click Next (see Figure 26). 
[bookmark: _Toc44334710][bookmark: _Toc44411288][bookmark: _Toc44498831][bookmark: _Toc57897418]Figure 26. Download Release, OLB
[image: ]
By default, the Application drop-down menu is set to Firmware, select OTCnet Local Bridge. The OLB application can be installed before or after Firmware is installed. However, both the OLB application and Firmware must be installed for check terminal configuration.


3. The Select OTCnet Local Bridge for Download page appears. Click the OTCnet Local Bridge hyperlink to download the OLB Zip file (see Figure 27).

Note: Before you install the new OLB version, you must uninstall any older OLB version(s).
[bookmark: _Toc44334711][bookmark: _Toc44411289][bookmark: _Toc44498832][bookmark: _Toc57897419]Figure 27. Select OTCnet Local Bridge for Download
[image: ]

4. The Review Application Download page appears. Click Download (see Figure 28). 
[bookmark: _Ref480471109][bookmark: _Toc44334712][bookmark: _Toc44411290][bookmark: _Toc44498833][bookmark: _Toc57897420]Figure 28. Review Application Download
[image: ]

5. A Do you want to open or save OTCnetOLBX.X.X.zip? dialog box appears. Click the Save drop-down arrow and select Save As (see Figure 29).
[bookmark: _Ref480635724][bookmark: _Toc44334713][bookmark: _Toc44411291][bookmark: _Toc44498834][bookmark: _Toc57897421]Figure 29. Review Application Download Save As
[image: ]


6. The Save As dialog box appears. Click Save or Cancel (see Figure 30).
[bookmark: _Ref489376143][bookmark: _Toc44334714][bookmark: _Toc44411292][bookmark: _Toc44498835][bookmark: _Toc57897422]Figure 30. Save As Dialog Box
[image: ]

If you click Save, choose the location where you want to save the file. If you click Cancel, you return to the OTCnet Local Bridge Application Download page without saving the file.

7. Once you save the OLB Zip file on the workstation, you must extract the files. To do this, complete the following steps: 

1. Double-click the OLB Zip file (see Figure 31), and your default Zip utility window will open.
[bookmark: _Ref486433737][bookmark: _Toc44334715][bookmark: _Toc44411293][bookmark: _Toc44498836][bookmark: _Toc57897423]Figure 31. OLB Zip file
[image: ]


2. Click Extract Files (see Figure 32). 
[bookmark: _Toc44334716][bookmark: _Toc44411294][bookmark: _Toc44498837][bookmark: _Toc57897424]Figure 32. Extract Files
[image: ]

8. Choose the location where you would like to save the files on the terminal and click Extract (see Figure 33). (If you do not choose a location, the files will be extracted to your Downloads folder by default.) 
[bookmark: _Ref486434052][bookmark: _Toc44334717][bookmark: _Toc44411295][bookmark: _Toc44498838][bookmark: _Toc57897425]Figure 33. Extract Location
[image: ]




[bookmark: _Toc44402391][bookmark: _Toc44403531][bookmark: _Toc44411385][bookmark: _Toc44498889][bookmark: _Hlk535599129][image: Title: Download Firmware]	Download OTCnet Local Bridge (OLB) Application
The Check Capture Administrator (CCA) and Card Administrator (CA) are authorized to download the OTCnet Local Bridge (OLB) application.

	[image: ]Application Tip 
The CCA and CA are authorized to download the OTCnet Local Bridge (OLB). The OLB is a stand-alone application that must be installed on all user workstations performing card processing, check capture, check processing and terminal configuration operations. For more information on configuring a check processing terminal, refer to the Administration Chapter 7: Configuring Check Processing Settings user guide.
OTCnet supports Google Chrome (Chrome) and Internet Explorer (IE) browsers. When using Chrome, the CA or CCA does not need to make browser configuration changes (with the OLB prerequisites) however, the OLB must be installed. When using IE, the CCA or CA does have to update browser configuration settings. For OLB versions 1.3.0 and newer, the OLB certificate is included in the OLB installer file (EXE file). 
For OLB versions 1.2.0 and older, however, for the OLB application to function properly with OTCnet, users are required to separately install the OLB Certificate on the terminal. Review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) for additional information.
Note that the download release process was streamlined for ease and efficiency. We recommend you download the newest version of the OLB.




	[image: ]Application Tip . 
After the CCA or CA downloads the OLB application, users (e.g., CCA, CCS, CCLO, CCO, CA and CO) can complete the remaining steps in setting up the OLB application:
25. Install the OLB certificate (applicable only to OLB versions 1.2.0 and older)
26. Install the OLB application 
27. Create the OLB profile
28. Start the OLB application





	[image: ]Application Tip 
For Check Processing workstations, the OLB application can be installed before or after the OTCnet Firmware is installed. Firmware is not required for Card Processing workstations.
Windows Administrator privileges are required to install the OLB application on a terminal. Users may need to contact their CCA, CA or IT team in order to complete this step
Depending on your user role, you may not have access to both Manage Check Processing and Manage Card Processing functions. 





To download the OTCnet Local Bridge (OLB) application, complete the following steps:

· Click the Administration tab.

· Click Manage Centralized Deployment and select Download Release. 

· The Download Release page appears. From the Application drop-down menu, select OTCnet Local Bridge. Click Next.
	[image: ]Application Tip 
By default, the Application drop-down menu is set to Firmware, select OTCnet Local Bridge. The OLB application can be installed before or after Firmware is installed. However, both the OLB application and Firmware must be installed for terminal configuration.



· The Select OTCnet Local Bridge for Download page appears. Click the OTCnet Local Bridge hyperlink to download the OLB Zip file. The Review Application Download page appears. Click Download.

	[image: ]Application Tip
Before you install the new OLB version, you must uninstall any older OLB version(s).






	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
3. Click Previous to return to the previous page.
4. Click Return Home to the OTCnet Home page.



· A Do you want to open or save OTCnetOLBX.X.X.zip? dialog box appears. Click the Save drop-down arrow, and select Save As.
	[image: ]Application Tip
If Save As is selected, a Save As dialog window will be generated so that you can save the OLB Zip file (e.g., OTCnetOLBX.X.X.zip) to your preferred location on the workstation. 
If you click Open, your default Zip utility (e.g., WinZip, PKZIP) window will open, and you can extract the files. If you click Cancel, you remain on the Review Application Download page.
When you click Save, you choose the location where you want to save the file. If you click Cancel, you return to the OTCnet Local Bridge Application Download page without saving the file.



· The Save As dialog box appears. Click Save or Cancel.

	[image: ]Application Tip
If you click Save, choose the location where you want to save the file. If you click Cancel, you return to the OTCnet Local Bridge Application Download page without saving the file.



· Double-click the OLB zip file.
· Click Extract Files.
· Choose a location to save the files on the workstation and click Extract.


[bookmark: _Toc44402392][bookmark: _Toc44403532][bookmark: _Toc44411386][bookmark: _Toc44498890]Install the OTCnet Local Bridge (OLB) Certificate
If installing OLB version 1.3.0 and newer, the file contains the OLB application installer file (EXE file) and the certificate. You do not need to separately install the certificate. 
 
For OLB version 1.2.0 and older the certificate is not included in the OLB installer file and the certificate must be separately installed on the workstation. A CCA, CCS, CCLO, CCO, CA or CO can install the OLB certificate on the workstation. The certificate must be installed on the workstation for the OLB application to function with OTCnet. The OLB application is downloaded as a zip file. 

For details on downloading the OLB refer to the Download the OTCnet Local Bridge (OLB) Application printable job aid in this User Guide. For information about all OLB system prerequisites, refer to the OTCnet System Requirements and Reference Guide at: https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf.

To install the OTCnet Local Bridge (OLB) certificate:

3. Locate the folder where the OLB certificate file (i.e., olb.otcnet.public.crt) resides, and double-click the file. Note: The older versions of the OLB package contain a certificate file with the “.cer” extension. (see Figure 34).
[bookmark: _Toc44498839][bookmark: _Toc57897426]Figure 34. OTCnet OLB Certificate .crt icon
[image: ]



4. The Certificate dialog box appears. Click Install Certificate (see Figure 35).
[bookmark: _Ref486357779][bookmark: _Toc44334719][bookmark: _Toc44411297][bookmark: _Toc44498840][bookmark: _Toc57897427]Figure 35. Install Certificate Dialog Box
[image: ]
5. The Welcome to the Certificate Import Wizard dialog box appears. Click Next (see Figure 36).
[bookmark: _Ref486357816][bookmark: _Toc44334720][bookmark: _Toc44411298][bookmark: _Toc44498841][bookmark: _Toc57897428]Figure 36. Welcome to the Certificate Import Wizard Dialog Box
[image: ]

6. The Certificate Store dialog box appears. Click the Place all certificate in the following store radio button 



7. Under Certificate Store, click Browse (see Figure 37).
[bookmark: _Ref486427716][bookmark: _Toc44334721][bookmark: _Toc44411299][bookmark: _Toc44498842][bookmark: _Toc57897429]Figure 37. Certificate Store Dialog Box
[image: ]

8. The Select Certificate Store dialog box appears. Click the Trusted Root Certification Authorities folder and click OK (see Figure 38).
[bookmark: _Ref486358551][bookmark: _Toc44334722][bookmark: _Toc44411300][bookmark: _Toc44498843][bookmark: _Toc57897430]Figure 38. Select Certificate Store Trusted Root Certification Authorities
[image: ]



9. Click Next (see Figure 39).
[bookmark: _Ref486359039][bookmark: _Toc44334723][bookmark: _Toc44411301][bookmark: _Toc44498844][bookmark: _Toc57897431]Figure 39. Certificate Store Dialog Box Next
[image: ]

10. The Completing the Certificate Import Wizard dialog box appears. Click Finish (see Figure 40).
[bookmark: _Ref486359488][bookmark: _Toc44334724][bookmark: _Toc44411302][bookmark: _Toc44498845][bookmark: _Toc57897432]Figure 40. Completing the Certificate Import Wizard Dialog Box
[image: ]



11. After The import was successful message appears, click OK (see Figure 41). 
[bookmark: _Ref486359596][bookmark: _Toc44334725][bookmark: _Toc44411303][bookmark: _Toc44498846][bookmark: _Toc57897433]Figure 41. The import was successful message
[image: ]


[bookmark: _Toc44402393][bookmark: _Toc44403533][bookmark: _Toc44411387][bookmark: _Toc44498891][image: Title: Download Firmware]	Install the OTCnet Local Bridge (OLB) Certificate
The Check Capture Administrator (CCA), Check Capture Supervisor (CCS), Check Capture Lead Operator (CCLO), Check Capture Operator (CCO), Card Administrator (CA) and Card Operator (CO) are authorized to download the OTCnet Local Bridge (OLB) certificate.

	[image: ]Application Tip 
If installing OLB version 1.3.0 and newer, the file contains the OLB application installer file (EXE file) and the certificate. You do not need to separately install the certificate. 
For OLB version 1.2.0 and older the certificate is not included in the OLB installer file and the certificate must be separately installed on the workstation. A CCA, CCS, CCLO, CCO, CA or CO can install the OLB certificate on the workstation. The certificate must be installed on the workstation for the OLB application to function with OTCnet. The OLB application is downloaded as a zip file. 
For details on downloading the OLB refer to the Download the OTCnet Local Bridge (OLB) Application printable job aid in this User Guide. For information about all OLB system prerequisites, refer to the OTCnet System Requirements and Reference Guide at: https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf.



To install the OTCnet Local Bridge (OLB) certificate, complete the following steps:

· Locate the folder where the OLB certificate file (i.e., olb.otcnet.public.crt) resides, and double-click the file. Note: The older versions of the OLB package contain a certificate file with the “.cer” extension. 

· The Certificate dialog box appears. Click Install Certificate. 

· The Welcome to the Certificate Import Wizard dialog box appears. Click Next.

	[image: ]Application Tip
Click Cancel to cancel installing the certificate.



· The Certificate Store dialog box appears. Click the Place all certificate in the following store radio button. 



	[image: ]Application Tip
Click Cancel to cancel installing the certificate. Click Back to return to the Welcome to the Certificate Import Wizard dialog box.



· Under Certificate Store, click Browse. 

· The Select Certificate Store dialog box appears. Select the Trusted Root Certification Authorities folder and click OK.

	[image: ]Application Tip
If you click Cancel, the Select Certificate Store dialog box closes. The Certificate Store dialog box remains open. Click Cancel again to cancel installing the certificate.



· Click Next.

	[image: ]Application Tip
Click Cancel to cancel installing the certificate. Click Back to return to the Welcome to the Certificate Import Wizard dialog box.



· The Completing the Certificate Import Wizard dialog box appears. Click Finish. 

	[image: ]Application Tip
Click Cancel to cancel installing the certificate. Click Back to return to the Certificate Store dialog box.



· After The import was successful message appears, click OK. 


[bookmark: _Toc44402394][bookmark: _Toc44403534][bookmark: _Toc44411388][bookmark: _Toc44498892]Install the OTCnet Local Bridge (OLB) Application
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users (i.e., CA, CO, CCA, CCS, CCLO, CCO) performing terminal configuration, card processing, check capture, and check processing operations.

The OLB application is downloaded as a zip file containing the OLB installer file (EXE file). This file includes the OLB certificate file for version 1.3.0 and newer. For OLB versions 1.2.0 and older, you must separately install the OLB certificate on the workstation for the OLB application to function with OTCnet.

After the CA or CCA downloads the OLB application and the CCA, CA, CCS, CCLO, CCO, CA and CO installs the OLB certificate (applicable for version 1.2.0 and older) the OLB is installed on the workstation. The next step is to install the OLB application. 

Before you install the OLB application, consider the following information: 
· Prior to each OLB upgrade, the currently installed OLB application version must be uninstalled first. To uninstall a previous version of the OLB, complete the following steps:
For Windows 10:
· Access your Control Panel under Start > Windows Settings > Control Panel
· Double-click Add or Remove Programs
· In the Currently installed programs box, click OTCnet OLB
· Click Remove
· Click Yes and wait while the OLB application uninstalls
To install the OLB application you will need Windows Administrator privileges on each computer.
· Verify the previous version of the OTCnet OLB is uninstalled.
· The OLB application is required for terminal detection and performing check capture and check processing operations.
· The OLB application is required if you are using the Deployable Disbursing System (DDS) Interface (DoD only), applicable to Check Processing only.
· The OLB application can be installed before or after the OTCnet Firmware is installed. Before a terminal can be configured, both the OLB application and Firmware must be installed on the terminal, applicable to Check Processing only. There is no firmware for card processing.
· Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the terminal, ensure that it is stopped before uninstalling the application. For information on installing and uninstalling the OLB application, refer to the Install the OTCnet Local Bridge (OLB) Application printable job aid. 


To install the OTCnet Local Bridge (OLB) application:
1. Locate the folder where the OTCnet Local Bridge file (EXE file) resides and double-click the file to start the installation (see Figure 42).  
[bookmark: _Ref480477066][bookmark: _Toc44334726][bookmark: _Toc44411304][bookmark: _Toc44498847][bookmark: _Toc57897434]Figure 42. OTCnet Local Bridge.EXE Icon
[image: ]

2. The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next (see Figure 43).
[bookmark: _Toc44334727][bookmark: _Toc44411305][bookmark: _Toc44498848][bookmark: _Toc57897435]Figure 43. Welcome to the OTCnet OLB Setup Dialog Box
[image: ]



3. The Destination Location dialog box appears. Click Next (see Figure 44).

As a best practice, it is recommended that the OLB application is installed into the default destination folder (i.e., C:\Program Files\OTCnet_olb).
[bookmark: _Toc44334728][bookmark: _Toc44411306][bookmark: _Toc44498849][bookmark: _Toc57897436]Figure 44. Destination Location Dialog Box
[image: ]

4. The Start Installation dialog box appears. Click Next (see Figure 45). 
[bookmark: _Toc44334729][bookmark: _Toc44411307][bookmark: _Toc44498850][bookmark: _Toc57897437]Figure 45. Start Installation Dialog Box
[image: ]



5. [bookmark: _Ref480650210]The Server Port Settings dialog box appears. Click Next (see Figure 46). Wait a moment while the files install.
[bookmark: _Toc44334730][bookmark: _Toc44411308][bookmark: _Toc44498851][bookmark: _Toc57897438]Figure 46. Server Port Settings Dialog Box
[image: ]

As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. Click Cancel to exit the setup.

6. After the OTCnet OLB has been successfully installed message appears, click Finish (see Figure 47).
[bookmark: _Toc44334731][bookmark: _Toc44411309][bookmark: _Toc44498852][bookmark: _Toc57897439]Figure 47. OTCnet OLB has been successfully installed Dialog Box
[image: ]

7. The OTCnet OLB start and stop icons will appear on the desktop of the workstation (see Figure 48).
[bookmark: _Ref43458894][bookmark: _Toc44334732][bookmark: _Toc44411310][bookmark: _Toc44498853][bookmark: _Toc57897440]Figure 48. OLB Stop and Start icons
[image: ]


[bookmark: _Toc44403535][bookmark: _Toc44411389][bookmark: _Toc44498893][bookmark: _Ref43876740][bookmark: _Toc44402395][image: MCj04420720000[1]]	Install the OTCnet Local Bridge (OLB) Application

The Check Capture Administrator (CCA), Check Capture  Supervisor (CCS), Check Capture Lead Operator (CCLO), Check Capture Operator (CCO), Card Administrator (CA) and Card Operator (CO) are authorized to install the OTCnet Local Bridge (OLB) application.

	[image: ]Application Tip
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users (i.e., CA, CO, CCA, CCS, CCLO, CCO) performing terminal configuration, card processing, check capture, and check processing operations.
The OLB application is downloaded as a zip file containing the OLB installer file (EXE file). This file includes the OLB certificate file for version 1.3.0 and newer. For OLB versions 1.2.0 and older, you must separately install the OLB certificate on the workstation for the OLB application to function with OTCnet.
After the CA or CCA downloads the OLB application and the CCA, CA, CCS, CCLO, CCO, CA and CO installs the OLB certificate (applicable for version 1.2.0 and older) the OLB is installed on the workstation. The next step is to install the OLB application. 



	[image: ]Application Tip 
Prior to each OLB upgrade, the currently installed OLB application version must be uninstalled first. To uninstall a previous version of the OLB, complete the following steps:

For Windows 10:
· Access your Control Panel under Start>Control Panel
· Double-click Add or Remove Programs
· In the Currently installed programs box, click OTCnet OLB
· Click Remove
· Click Yes and wait while the OLB application uninstalls
· Verify the OTCnet OLB automatically uninstalled






	[image: ]Application Tip
· To install the OLB application you will need Windows Administrator privileges on each computer.
· Verify the previous version of the OTCnet OLB is uninstalled.
· The OLB application is required for terminal detection and performing check capture and check processing operations.
· The OLB application is required if you are using the Deployable Disbursing System (DDS) Interface (DoD only), applicable to Check Processing only.
· The OLB application can be installed before or after the OTCnet Firmware is installed. Before a terminal can be configured, both the OLB application and Firmware must be installed on the terminal, applicable to Check Processing only. There is no firmware for Card Processing.
· Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the terminal, ensure that it is stopped before uninstalling the application. For information on installing and uninstalling the OLB application, refer to the Install the OTCnet Local Bridge (OLB) Application printable job aid. 




To install the OLB application, complete the following steps:
1. Locate the folder where the OLB application file (EXE file) resides and double-click the file to start the installation. 
2. The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next.
	[image: ]Application Tip
Click Cancel to cancel and exit the setup.


3. The Destination Location dialog box appears. Click Next.
	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed into the default destination folder (i.e., C:\Program Files\OTCnet_ olb). Click Cancel to exit the setup. Click Back to return to the previous dialog box.


4. The Start Installation dialog box appears. Click Next. 
	[image: ]Application Tip
Click Cancel to exit the setup. Click Back to return to the previous dialog box.


5. The Server Port Settings dialog box appears. Click Next. Wait a moment while the files install.
	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. If your agency has different server port settings or needs, contact customer support. Click Cancel to exit the setup.



6. After the OTCnet Local Bridge has been successfully installed message appears, click Finish. 

	[image: ]Application Tip
Click Cancel to exit the setup. Click Back to return to the previous dialog box.


The OTCnet OLB start and stop icons will appear on the desktop of the terminal. 
[image: ]		[image: ]



[bookmark: _Toc459908167][bookmark: _Toc467665442][bookmark: _Toc44402396][bookmark: _Toc44403536][bookmark: _Toc44411390][bookmark: _Toc44498894]Upgrade OTCnet Local Bridge (OLB) Application
The CCA and CA are authorized to upgrade the OLB.

As new versions of OTCnet OLB application become available, your Agency may choose to upgrade its terminals. Upgrade refers to installing an updated version of OTCnet OLB on a terminal that has a previous version of the OTCnet OLB installed.

[bookmark: _Hlk535598080]Before initiating an OTCnet OLB application upgrade, consider the following information: 
· [bookmark: _Hlk535598233]Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the terminal, ensure that it is stopped before uninstalling the application. For information on upgrading the OLB application, refer to the Upgrade the OTCnet Local Bridge (OLB) Application printable job aid. 
· You need Windows Administrator privileges to upgrade each computer.
· If you are upgrading to a newer OLB version, you must uninstall the previous OLB version and then perform a new installation.
· The OLB certificate does not need to be reinstalled during the OLB upgrade. 
1. If you previously created and imported your OLB credentials, you do not need to recreate and reimport your OLB credentials after upgrading to a newer OLB version. 
· The OLB application is required for terminal detection and performing check capture and check processing operations.
For step-by-step instructions, refer to the Create the OTCnet Local Bridge (OLB) Profile and Import OTCnet Local Bridge (OLB) Credentials printable job aids.
To upgrade the OTCnet Local Bridge (OLB) application:
a. Stop the OTCnet OLB application. From the desktop, double-click Stop OTCnet Local Bridge (see Figure 49).
[bookmark: _Ref43876248][bookmark: _Toc44334733][bookmark: _Toc44411311][bookmark: _Toc44498854][bookmark: _Toc57897441]Figure 49. Stop OTCnet Local Bridge Desktop Icon
[image: ]

b. Under Control Panel, locate the installed OTCnet OLB application and uninstall it using Add or Remove Programs, or Uninstall. 


c. After downloading and saving the latest version of OTCnet OLB application, locate the folder where the OTCnet Local Bridge file (EXE file) resides. Double-click the file to start the installation (Figure 50). 
[bookmark: _Ref43876291][bookmark: _Toc44334734][bookmark: _Toc44411312][bookmark: _Toc44498855][bookmark: _Toc57897442]Figure 50. OTCnet Local Bridge.EXE Icon
[image: ]

d. The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next (see Figure 51).
[bookmark: _Ref43876304][bookmark: _Toc44334735][bookmark: _Toc44411313][bookmark: _Toc44498856][bookmark: _Toc57897443]Figure 51. Welcome to the OTCnet OLB Setup Dialog Box
[image: ]



e. The Destination Location dialog box appears. Click Next (see Figure 52).

As a best practice, it is recommended that the OLB application is installed into the default destination folder (i.e., C:\Program Files\OTCnet_olb).
[bookmark: _Ref43876333][bookmark: _Toc44334736][bookmark: _Toc44411314][bookmark: _Toc44498857][bookmark: _Toc57897444]Figure 52. Destination Location Dialog Box
[image: ]


f. The Start Installation dialog box appears. Click Next (see Figure 53). 
[bookmark: _Ref43459914][bookmark: _Toc44334737][bookmark: _Toc44411315][bookmark: _Toc44498858][bookmark: _Toc57897445]Figure 53. Start Installation Dialog Box
[image: ]


g. The Server Port Settings dialog box appears. Click Next (see Figure 54). Wait a moment while the files install.
[bookmark: _Ref43876370][bookmark: _Toc44334738][bookmark: _Toc44411316][bookmark: _Toc44498859][bookmark: _Toc57897446]Figure 54. Server Port Settings Dialog Box
[image: ]

As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. If your agency has different server port settings or needs, contact customer support. Click Cancel to exit the setup.

h. After the OTCnet OLB has been successfully installed message appears, click Finish (see Figure 55.).
[bookmark: _Ref44487729][bookmark: _Toc44498860][bookmark: _Toc57897447]Figure 55. OTCnet OLB has been successfully installed
[image: ]



If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer, you do not need to recreate or import your OLB credentials.

The OTCnet OLB start and stop icons will appear on the desktop of the workstation (see Figure 56 and Figure 57).
[bookmark: _Ref44487942][bookmark: _Toc44498861][bookmark: _Toc57897448]Figure 56. Start OTCnet Local Bridge
[image: Start OTCnet Local Bridge icon]

[bookmark: _Ref17870436][bookmark: _Toc44411317][bookmark: _Toc44498862][bookmark: _Toc57897449]Figure 57. Stop OTCnet Local Bridge
[image: Stop OTCnet Local Bridge icon]



[bookmark: _Toc44402397][bookmark: _Toc44403537][bookmark: _Toc44411391][bookmark: _Toc44498895][image: MCj04420720000[1]]	Upgrade OTCnet Local Bridge (OLB) Application
The Check Capture Administrator (CCA) and Card Administrator (CA) are authorized to upgrade the OLB.

As new versions of OTCnet OLB application become available, your Agency may choose to upgrade its workstations. Upgrade refers to installing an updated version of OTCnet OLB on a terminal that has a previous version of the OTCnet OLB installed.

	[image: ]Application Tip
Before initiating an OTCnet OLB application upgrade, consider the following information: 
2. Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the terminal, ensure that it is stopped before uninstalling the application. For information on upgrading the OLB application, refer to the Upgrade the OTCnet Local Bridge (OLB) Application printable job aid. 
3. You need Windows Administrator privileges to upgrade each computer.
4. If you are upgrading to a newer OLB version, you must uninstall the previous OLB version and then perform a new installation.
5. The OLB certificate does not need to be reinstalled during the OLB upgrade. 
6. If you previously created and imported your OLB credentials, you do not need to recreate and reimport your OLB credentials after upgrading to a newer OLB version. 
7. The OLB application is required for terminal detection and performing check capture and check processing operations.



To upgrade the OTCnet Local Bridge (OLB) Application, complete the following steps:

· Stop the OTCnet OLB application. From the desktop, double-click Stop OTCnet Local Bridge.

· Locate the folder where the OTCnet OLB application is installed and uninstall it. 




· After downloading and saving the latest version of OTCnet OLB application, locate the folder where the OTCnet Local Bridge file (EXE file) resides. Double-click the file to start the installation. 

· The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next.

· The Destination Location dialog box appears. Click Next.

	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed into the default destination folder (i.e., C:\Program Files\OTCnet_olb). 



	[image: ]Application Tip
Click Cancel to exit the setup. Click Back to return to the previous dialog box.



· The Start Installation dialog box appears. Click Next.

· The Server Port Settings dialog box appears. Click Next. Wait a moment while the files install.

	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. If your agency has different server port settings or needs, contact customer support. Click Cancel to exit the setup.




· After the OTCnet OLB has been successfully installed message appears, click Finish.

	[image: ]Application Tip
If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer, you do not need to recreate or import your OLB credentials.





The OTCnet OLB start and stop icons will appear on the desktop of the terminal. 
[image: ]		[image: ]

[bookmark: _Toc467665449][bookmark: _Toc44402398][bookmark: _Toc44403538][bookmark: _Toc44411392][bookmark: _Toc44498896]Topic 7. Create the OTCnet Local Bridge (OLB) Profile
[bookmark: _Hlk25590937]After the CCA or CA downloads the OTCnet Local Bridge (OLB) application, the OLB certificate is installed on the terminal workstation (applicable for version 1.2.0 or older), and the OLB application is installed on the terminal, the next step is to create the OLB profile.
If you are assigned the role of CCA, CCS, CCLO, CCO, CA or CO, you are authorized to create the OLB profile. Note that the OLB profile is unique to each user role. Therefore, each of these user roles must create an OLB profile.
Before creating an OLB profile, consider the following information:
1. Creating an OLB profile applies to all card processing and check processing users, including CCA, CCS, CCLO, CCO, CA and CO.
2. The OLB application is required for check capture terminal detection, the Deployable Disbursing System (DDS) Interface (DoD and Check Processing only) and performing check processing and check capture operations, as well as performing card processing operations and card terminal detection.
To create an OLB profile:

1. Click the Administration tab, click Manage Users, and select Create Local Bridge and User Profile (see Figure 58). 
[bookmark: _Ref43876458][bookmark: _Toc44334740][bookmark: _Toc44411318][bookmark: _Toc44498863][bookmark: _Toc57897450]Figure 58. Create Local Bridge and User Profile
[image: ]

2. Select the relevant radio button for your version of the OLB or for OTCnet Offline.

Before you create your new profile, and if you downloaded and installed the newest version of the OLB, you must: 
1. Import the new OLB credentials file, required




3. Enter your Local Bridge Password, and confirm your Local Bridge Password, and click Submit (see Figure 59). 
[bookmark: _Toc57897451]Figure 59. Create Local Bridge and User Profile Radio Buttons and Password
[image: ]

Password Criteria:
75. Must be at least 12 characters long. 
76. Must contain at least one uppercase letter. 
77. Must contain at least one lowercase letter. 
78. Must contain at least one numeric character. 
79. Must not have more than two repeating characters. 
80. Must not be a word in a language, slang, dialect, or jargon. 
81. Must not be related to personal identity, history, environment, or other personal associations. 
82. Must not be shared or displayed in plain view

Note that these password criteria will be displayed on the page when you enter and confirm your Local Bridge password.

When you click Submit, the system generates the credential file based on the application version selected.

4. A Do you want to open or save [file name].ini? dialog box appears. Click the Save drop-down arrow and select Save as (see Figure 60).
[bookmark: _Ref480547370][bookmark: _Toc44334742][bookmark: _Toc44411320][bookmark: _Toc44498865][bookmark: _Toc57897452]Figure 60. Create Local Bridge and User Profile Save As
[image: ]

When you save the OLB credential file, do not rename the file as the file name must remain the same as it was generated. If the file name is changed, the OLB application will not run.

If you click Open, the file will simply open in the Microsoft Notepad application. If you click Cancel, the Do you want to open or save dialog box closes, and you remain on the Create Local Bridge and User Profile page.

5. The Save dialog box appears (see Figure 51). Choose the location where you want to save the OLB credential file. You can save the OLB credential file to any folder in which you have the ability to save a file (e.g., My Documents folder, Desktop folder). Note that the default location on the Save dialog box is the user’s My Documents folder. If you click Cancel, you return to the Create Local Bridge and User Profile page without saving the file.

6. Click Save (see Figure 61).
[bookmark: _Ref480548416][bookmark: _Toc44334743][bookmark: _Toc44411321][bookmark: _Toc44498866][bookmark: _Toc57897453]Figure 61. Create Local Bridge and User Profile Save
[image: ]

If you click Cancel, you return to the Create Local Bridge and User Profile page without saving the file.

If you forget your OLB password, or if you attempt to enter an incorrect password three times (or more), you will have to recreate an OLB credential file through the Create Local Bridge and User Profile page and save the file again. You will also have to import your OLB credentials again, which is the next step in the OLB startup process.

For information on importing OLB credentials, refer to the Import OTCnet Local Bridge (OLB) Credentials printable job aid.

OTCnet users only need to recreate OLB passwords if they forget their OLB passwords. After recreating their OLB passwords, OTCnet users need to reimport their OLB credentials. (Refer to Topic 8 of this User Guide for step-by-step instructions on importing the OLB credentials.) 
[image: Title: Download Firmware]	Create the OTCnet Local Bridge (OLB) Profile

The Check Capture Administrator (CCA), Check Capture Supervisor (CCS), Check Capture Lead Operator (CCLO), Check Capture Operator (CCO), Card Administrator (CA) and Card Operator (CO) are authorized to create a profile.

	[image: ]Application Tip
After the CCA or CA downloads the OLB application, the OLB certificate is installed on the terminal, and the OLB application is installed on the terminal, the next step is to install the OLB application create the OTCnet Local Bridge (OLB) profile.
If you are assigned the role of CCA, CCS, CCLO, CCO, CA or CO, you are authorized to create the OLB profile. Note that the OLB profile is unique to each user role. Therefore, each of these user roles must create an OLB profile.
Before creating an OLB profile, consider the following information:
1. Creating an OLB profile applies to OTCnet Online check capture, check processing and card processing users: CCA, CCS, CCLO, CCO, CA and CO.
2. The OLB application is required for terminal detection, the Deployable Disbursing System (DDS) Interface (DoD only) and performing check processing and check capture tasks.



To create an OLB profile, complete the following steps:

1. Click the Administration tab, select Manage Users, and click Create Local Bridge and User Profile. 

2. Select the relevant radio button for your version of the OLB or for OTCnet Offline.

	[image: ]Application Tip 
Before you create your new profile, and if you downloaded and installed the newest version of the OLB, you must: 
2. Import the new OLB credentials file, required




3. Enter your Local Bridge Password, and confirm your Local Bridge Password, and click Submit.


	[image: ]Application Tip
Password Criteria:
· Must be at least 12 characters long 
· Must contain at least one upper case letter
· Must contain at least one lower case letter
· Must contain at least one numeric character
· Must not have more than two repeating characters
· Must not repeat any of your last ten passwords
· Must not have been your password during the last ten days
· Must not be a word in a language, slang, dialect, or jargon
· Must not be related to personal identity, history, environment, or other personal associations
· Must not be shared or displayed in plain view
Note that these password criteria will be displayed on the page when you enter and confirm your Local Bridge password.



	[image: ]Application Tip
When you click Submit, the system generates the credential file based on the application version selected. 



	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
1. Click Clear to reset the password fields. 
2. Click Cancel to return to the OTCnet Home Page.



4. A Do you want to open or save [file name].ini? dialog box appears. Click the Save drop-down arrow and select Save as.

	[image: ]Application Tip
Note that when you save the OLB credential file, do not rename the file as the file name must remain the same as it was generated. If the file name is changed, the OLB application will not run.





	[image: ]Application Tip
If you click Open, the file will simply open in the Microsoft Notepad application. If you click Cancel, the Do you want to open or save dialog box closes, and you remain on the Create Local Bridge and User Profile page.



5. The Save dialog box appears. Click Save or Cancel.

	[image: ]Application Tip
Choose the location where you want to save the OLB credential file. You can save the OLB credential file to any folder in which you have the ability to save a file (e.g., My Documents folder, Desktop folder). Note that the default location on the Save dialog box is the user’s My Documents folder.
If you click Cancel, you return to the Create Local Bridge and User Profile page without saving the file.



	[image: ]Application Tip
If you forget your OLB password, or if you attempt to enter an incorrect password three times (or more), you will have to recreate an OLB credential file through the Create Local Bridge and User Profile page and save it again. You will also have to import your OLB credentials again, which is the next step in the OLB startup process.



	[image: ]Application Tip
For information on importing OLB credentials, refer to the Import OTCnet Local Bridge (OLB) Credentials printable job aid.




[bookmark: _Toc44402400][bookmark: _Toc44403539][bookmark: _Toc44411393][bookmark: _Toc44498898]Topic 8. Import OTCnet Local Bridge (OLB) Credentials
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users performing terminal configuration, check and card processing and check capture operations. If you are a CCA, CCS, CCLO, CCO, CA or CO you are required to import your OLB credentials to the workstation.
If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer you do not need to recreate or re-import your OLB credentials. If you are upgrading your OLB version from a version older than 2.2.0.0, you will need to recreate and re-import your OLB credentials.

You only need to recreate OLB passwords if you forget your OLB password. After recreating your OLB password, OTCnet users must reimport OLB credentials.
Importing OLB credentials is unique to each user. Therefore, if there are multiple users on a terminal, each user must import their OLB credentials.
Users are only required to import their OLB credentials once. After importing OLB credentials, users will be able to successfully start the OLB application.
Before importing your OLB credentials, ensure the following steps have been completed in this order:
3. The CCA, or CA, has downloaded the OLB application
4. The OLB certificate is installed on the terminal (applicable only for OLB versions 1.2.0 and older)
5. The OLB application is installed on the terminal
6. Each user has created their OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated). 

Import OLB credentials:
To import the OTCnet Local Bridge (OLB) credentials, complete the following steps:

· Double-click the Start OTCnet Local Bridge icon located on the terminal’s desktop (see Figure 62).
[bookmark: _Toc57897454]Figure 62. Start OTCnet Local Bridge Icon
[image: ]

Or

Click Start>Programs>Start OTCnet Local Bridge.

If the icon does not reside in either location, contact your CCA or CA. They can help complete the steps required to install the OLB application on the terminal, and install the OLB Application and the OLB certificate for the check capture terminal (applicable for OLB versions 1.2.0 and older), create your OLB profile, and import your OLB credentials.

· The OTCnet Local Bridge Startup window appears. Click the File menu, and then click Import User Profile (see Figure 63).
[bookmark: _Toc57897455]Figure 63. Start OTCnet Local Bridge Startup
[image: ]

· The Select User Profile File dialog box appears. Navigate to the location on the terminal where the OLB credential file was saved. Select the file and click Import (see
Figure 64).
[bookmark: _Toc57897456]Figure 64. Select User Profile
[image: ]

The default location on the Select User Profile File dialog box is the user’s My Documents folder.


· A Successfully imported user profile message appears. Click OK (see Figure 65).
[bookmark: _Toc57897457]Figure 65. User Profile Import
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Once you have successfully imported your OLB credentials, you can proceed with starting the OLB application on the terminal.

If you are starting the OLB application and you forget your OLB password, or if you attempt to enter an incorrect password three times (or more), you will have to recreate an OLB credential file through the Create Local Bridge and User Profile page and save the file again. You will also have to complete this step again – import OLB credentials.

For details on starting the OLB application, refer to the Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid.



[bookmark: _Toc44402401][bookmark: _Toc44403540][bookmark: _Toc44411394][bookmark: _Toc44498899][image: MCj04420720000[1]] Import OTCnet Local Bridge (OLB) Credentials

The Check Capture Administrator (CCA), Check Capture Supervisor(CCS), Check Capture Lead Operator (CCLO), Check Capture Operator (CCO), Card Administrator (CA) and Card Operator (CO) are authorized to import the OLB credentials.

	[bookmark: _Hlk497575155][image: ]Application Tip
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users performing terminal configuration, check and card processing and check capture operations. If you are a CCA, CCS, CCLO, CCO CA or CO, you are required to import your OLB credentials to the workstation.
If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer you do not need to recreate or re-import your OLB credentials. If you are upgrading your OLB version from a version older than 2.2.0.0 to 2.3.0.0, you will need to recreate and re-import your OLB credentials.
You only need to recreate OLB passwords if you forget your OLB password. After recreating your OLB password, OTCnet users must reimport OLB credentials.
Importing OLB credentials is unique to each Windows user. Therefore, if there are multiple Windows users on a terminal, each Windows user must import their own OLB credentials.
Users are only required to import their OLB credentials once. After importing OLB credentials, users will be able to successfully start the OLB application.



	[image: ]Application Tip
Before importing your OLB credentials, ensure the following steps have been completed in this order:
40. The CCA or CA downloaded the OLB application
41. The OLB certificate is installed on the terminal (applicable for versions 1.2.0 and older)
42. The OLB application is installed on the terminal
43. Each user (CCA, CCS, CCLO, CCO CA or CO) has created their OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated). 






[bookmark: _Hlk496523697]To import OTCnet Local Bridge (OLB) credentials, complete the following steps:

1. Double-click the Start OTCnet Local Bridge icon located on the terminal’s desktop.

Or

Click Start>Programs>Start OTCnet Local Bridge.

	[image: ]Application Tip
[bookmark: _Hlk15746143]If the icon does not reside in either location, contact your CCA or CA. They can help complete the steps required to install the OLB application on the terminal, and install the OLB Application and OLB certificate for the check capture terminal (applicable for OLB versions 1.2.0 and older), create your OLB profile, and import your OLB credentials.


[bookmark: _Hlk496524054]
2. [bookmark: _Hlk496524071]The OTCnet Local Bridge Startup window appears. Click the File menu, and then click Import User Profile. 

3. The Select User Profile File window appears. Navigate to the location on the terminal where the OLB credential file was saved. Select the file and click Import. 

	[image: ]Application Tip
The default location on the Select User Profile File window is the user’s My Documents folder.



4. A Successfully imported user profile message appears. Click OK. Once you have successfully imported your OLB credentials, you can proceed with starting the OLB application on the workstation.
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This chapter provided information on:
The purpose of configuring check processing settings
How to set up or modify a terminal configuration
How to view a terminal configuration
How to search an audit log
How to download and install firmware
How to download and install the OTCnet Local Bridge (OLB) Application
How to create the OTCnet Local Bridge (OLB) Profile
How to import the OTCnet Local Bridge (OLB) Credentials

Notes
____________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________
[bookmark: _Toc44402403][bookmark: _Toc44403542][bookmark: _Toc44411396][bookmark: _Toc44498901]Glossary
A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one or many agency defined accounting codes or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so) or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System. 

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.


D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. 

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).
K
Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

 Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, deposit processing, scanning checks, processing card payments and printing receipts. 

L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 

Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.

R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.

S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 

SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.
T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 
Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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[bookmark: _Toc459908162][bookmark: _Toc29548308][bookmark: _Toc140379692][bookmark: _Toc142218838][bookmark: _Toc165108686][bookmark: _Toc165110217][bookmark: _Toc165110304]Audience, Overview and Topics 
[bookmark: _Toc274479542][bookmark: _Toc274479813][bookmark: _Toc274480410][bookmark: _Toc274484320][bookmark: _Toc465762941][bookmark: _Toc467665435][bookmark: _Toc29548309]Audience
The intended audience for Setting Up and Configuring Check Capture Offline includes:
· Check Capture Administrator
· Check Capture Supervisor
· Check Capture Lead Operator
· Check Capture Operator
[bookmark: _Toc274479543][bookmark: _Toc274479814][bookmark: _Toc274480411][bookmark: _Toc274484321][bookmark: _Toc465762942][bookmark: _Toc467665436][bookmark: _Toc29548310]Overview
Welcome to Setting Up and Configuring Check Capture Offline. In this chapter, you will learn:
1. Purpose of Setting Up and Configuring Check Capture Offline
2. Download and Install OTCnet Offline Check Capture Software
3. Manage a Check Capture Administrator Profile
4. Manage OTC Endpoints
5. Manage User Profiles
6. Manage Offline Users
7. Manage a Check Capture Terminal
8. Search an Audit Log
9. Recover a Batch
[bookmark: _Toc274479544][bookmark: _Toc274479815][bookmark: _Toc274480412][bookmark: _Toc274484322][bookmark: _Toc465762943][bookmark: _Toc467665437][bookmark: _Toc29548311]Topics
This chapter is organized by the following topics:
1. Topic 1. Purpose of Setting Up and Configuring Check Capture Offline
2. Topic 2. Download and Install OTCnet Offline Check Capture Software
3. Topic 3. Manage a Check Capture Administrator Profile
4. Topic 4. Manage OTC Endpoints
5. Topic 5. Manage User Profiles
6. Topic 6. Manage Offline Users
7. Topic 7. Manage a Check Capture Terminal
8. Topic 8. Search an Audit Log
9. [bookmark: _Toc459908163]Topic 9. Recover a Batch


[bookmark: _Toc29548312]Topic 1. Purpose of Setting Up and Configuring Check Capture Offline 
OTCnet Offline allows an OTC Endpoint to scan checks and close batches without internet connectivity. Online functions (such as upload a batch, acknowledge a batch, or manage OTC Endpoints or users), however, require the appropriate permission in addition to internet connectivity. Table 1, the Offline/Online Functions, Internet Connectivity and User Matrix illustrates the functions of each user role and whether they are performed Online or Offline. 

[bookmark: _Ref425602922][bookmark: _Toc455496966][bookmark: _Toc467665575]Table 1. Offline/Online Functions, Internet Connectivity, and User Matrix
	Function
	OTCnet
Offline
	OTCnet
Online
	Requires Internet Connectivity
	User

	Download and Install* OTCnet Offline Check Capture Software
	blank
	4
	4
	CCA

	Create a CCA Offline Logon Profile**
	Blank
	4
	4
	CCA

	Retrieve a Check Capture Administrator Profile
	4
	blank
	4
	CCA

	Manage OTC Endpoints
	4
	blank
	4
	CCA, CCS, CCLO

	Manage User Profiles
	4
	blank
	blank
	CCA

	Manage Offline Users
	4
	blank
	blank
	CCA

	Manage a Check Capture Terminal
	4
	blank
	blank
	CCA, CCS

	View an Audit Log
	4
	blank
	blank
	CCA, CCS, CCLO

	Recover a Batch
	4
	blank
	blank
	CCS



CCA = Check Capture Administrator, CCS = Check Capture Supervisor, CCL/O = Check Capture Lead Operator or Check Capture Operator.
[bookmark: _Toc459908164]	
* Installation does not require the user to be logged into either OTCnet Online or Offline, and it does not require internet access. 

** The OTCnet Offline application must be installed before a CCA Offline logon profile can be created. 



[bookmark: _Toc29548313]Topic 2. Download, Install, and Upgrade OTCnet Offline Check Capture Software
If you are assigned the role of Check Capture Administrator (CCA), you can manually download, install, and upgrade the OTCnet Offline Check Capture software by logging into OTCnet Online and accessing the Administration tab, or you can request a copy of the software on CD.

The term “install” is used in this topic section to refer to a situation in which OTCnet Offline was not previously installed: this is the first time the application is being applied to a terminal. The term “upgrade” refers to a situation in which OTCnet Offline was previously installed and an updated version is being applied.

Downloading and installing OTCnet Offline software allows for capturing checks, managing batches and managing users associated with a terminal in an offline environment (no internet connectivity required). When internet connectivity is present, the OTCnet Offline software also allows users to upload and acknowledge batches.

The Offline Check Capture software must be downloaded and installed for each terminal individually and requires Windows Administrator privileges.

[bookmark: _Toc459908165][bookmark: _Toc29548314]
Download OTCnet Offline Check Capture Software
To download OTCnet Offline Check Capture software:

1. Click Administration. Click Manage Centralized Deployment and select Download Release (see Figure 1).
[bookmark: _Toc59449171]Figure 1. Download Release
Administration, Manage Centralized Deployment[image: ]
2. The Download Release page appears. From the Application drop-down menu, select OTCNET. Click Next (see Figure 2). 
By default, the Application drop-down menu is set to Firmware. 

The OTCnet application is the OTCnet Offline check capture software. Additionally, before a terminal can scan checks in OTCnet Offline you must download and install both the firmware and the OTCnet application.
[bookmark: _Toc59449172]Figure 2. Download Release, OTCnet
[image: ]





3. The Select Application for Download page appears. Click the OTCnet Application/Firmware hyperlink to download the OTCnet Offline software (see Figure 3).
[bookmark: _Toc59449173]Figure 3. Select Application for Download
[image: ]
4. The Review Application for Download page appears. Once you have verified the application name and version, click Download to continue (see Figure 4).
[bookmark: _Ref421177632][bookmark: _Toc455496891][bookmark: _Toc59449174]Figure 4. Review Application Download
[image: ]

The Save Program dialog box appears. Choose the location where you want to save the file and click Save. If you click Cancel, you will return to the OTCnet Check Capture Application Download page without saving the file (see Figure 5).



5. [bookmark: _Ref421177648][bookmark: _Toc455496892]Once the application is successfully installed, the OTCnet Offline icon appears on your terminal’s desktop and in your Start menu.
[bookmark: _Toc59449175]Figure 5. Save Dialog Box
[image: ]


[bookmark: _Toc497165403][bookmark: _Toc29548315][image: ]	Download the OTCnet Offline Check Capture Software
To download the OTCnet Offline Check Capture Software in OTCnet Online:

1. Click the Administration tab.

2. Click Manage Centralized Deployment and select Download Release. The Download Release page appears. 

3. From the Application drop-down menu, select OTCnet. 

	[image: ]Application Tip
By default, the Application drop-down menu is set to Firmware.
The OTCnet application is the OTCnet Offline check capture software.
Before a terminal can scan checks in OTCnet Offline, download and install both the Firmware and OTCnet application.



	[image: ]Application Tip
If you are upgrading OTCnet Offline, and your Agency manages verification records, you do not need to reset and download the Local Verification Database (LVD).


4. Click Next. The Select Application for Download page appears.
5. Click the OTCnet hyperlink to download the software. The Review Application 
Download page appears.

6. Click Download. The Save Program dialog box appears.

7. Click Save or Cancel. The OTCnet Offline icon appears on the terminal’s desktop 
and on your Start Menu under Programs once the application is successfully installed.

	[image: ]Application Tip
If you click Save, choose the location where you want to save the file. If you click Cancel, you return to the OTCnet Check Capture Application Download page without saving the file.





	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
5. Click Previous to return to the previous page.
6. Click Return Home to the OTCnet Home page.


[bookmark: _Toc459908166][bookmark: _Toc29548316]
Install OTCnet Offline Check Capture Software
After the OTCnet Offline Check Capture Software is downloaded, the next step is to install the software (must be done for each terminal). The Offline software was developed to provide the same functionality offered by OTCnet Online to agencies that cannot rely on a consistent online connection.

Install refers to no previous versions of OTCnet Offline installed on a terminal.

To install the OTCnet Offline Check Capture software you will need Windows Administrator privileges on each computer. Additionally, more than one version of the OTCnet Offline (Production or QA) application can be installed on a terminal. Each version of the application must be installed separately.

If installing the OTCnet Offline Check Capture Software for the first time (i.e., not upgrading from an older version), you must install the application before creating the CCA offline logon profile. You will also need to create a CCA Offline logon profile to run the OTCnet application, but it can only be created after installing the OTCnet Offline application. For more information refer to Administration User Guide: Chapter 8: Setting Up and Configuring Check Capture Offline, Topic 3. Manage a Check Capture Administrator Profile. 

To install the OTCnet Offline Check Capture software:

1. Locate the folder where the OTCnet software file (EXE file) resides and double-click the OTCnet Offline.exe icon (see Figure 6). 
[bookmark: _Ref425602924][bookmark: _Toc455496893][bookmark: _Toc59449176]Figure 6. OTCnet Offline Icon
[image: Offline 3.png]

The Welcome to the OTCnet Offline dialog box appears. Click Next to continue (see Figure 7). 

Figures 7, 8, 9, and 11 illustrate OTCnet Offline qae-future Setup; however, a user will also have the option to download and set up a production version of the software. 
[bookmark: _Ref425602929][bookmark: _Toc455496894][bookmark: _Toc59449177]Figure 7. Welcome to OTCnet Offline Setup
[image: ]
2. 
The OTCnet Offline Destination Location dialog box appears. Click Next to continue (see Figure 8). 

If you do not want the software to install the default folder destination, click Browse to select a different folder. 
[bookmark: _Toc59449178]Figure 8. OTCnet Offline Destination Location
[image: ]

3. When the OTCnet Offline Start Installation dialog box appears, click Next to continue (see Figure 9).
[bookmark: _Ref425602966][bookmark: _Toc455496896][bookmark: _Toc59449179]Figure 9. OTCnet Offline Start Installation
[image: ]
4. 
The Server Port Setting Dialog box appears. Enter the appropriate values and click Next (see Figure 10).

The Server Port Settings are pre-populated with the default values.
[bookmark: _Ref425603004][bookmark: _Toc455496897][bookmark: _Toc59449180]Figure 10. Server Port Settings dialog box
[image: ]


5. The Installing dialog box appears. Wait a moment while the files install (see Figure 11).
[bookmark: _Ref425603034][bookmark: _Toc455496898][bookmark: _Toc59449181]Figure 11. Installing dialog box
[image: ]

The OTCnet Offline Successful Installation dialog box appears. Click Finish to complete the installation (see Figure 12). 

After OTCnet Offline (Production or QA) is successfully installed an OTCnet Offline (Production or QA) icon appears on the terminal’s desktop and on your Start Menu under Programs. 
[bookmark: _Ref425603180][bookmark: _Toc455496899][bookmark: _Toc59449182]Figure 12. OTCnet Offline Successful Installation
[image: ]
[bookmark: _Toc29548317][bookmark: _Toc465762949]
[image: MCj04420720000[1]]	Install OTCnet Offline Check Capture Software
The term ‘install’ is used in this section to refer to a situation in which the OTCnet Offline application was not previously installed. The term ‘upgrade’ refers to a situation in which the OTCnet Offline application was previously installed and an updated version is being applied.

To install the OTCnet Offline Check Capture software:

	[image: ]Application Tip
Before initiating an Offline Check Capture software installation, consider the following information:
1. To install the OTCnet Offline application, you need Windows Administrator privileges on each computer.
2. More than one OTCnet Offline application environment (Production or QA) can be installed on a terminal. Each Offline application environment must be installed separately.
3. You will not be able to upgrade an existing OTCnet Offline version. You must first uninstall the previous OTCnet Offline version and perform a fresh installation. If you do not uninstall the previous version, the installation will not work properly, and you will receive an installation error message.
4. If you are installing OTCnet Offline application, you must install the application first, before creating the CCA Offline logon profile. You also need to create a CCA Offline logon profile to run the OTCnet Offline application, but it can only be created after installing the OTCnet Offline application. Refer to the Create a Check Capture Administrator Offline Logon Profile printable job aid.



1. Locate the folder where the OTCnet software file (EXE file) resides and double-click the OTCnet Offline.exe icon (see Figure 13). 
[bookmark: _Ref486004169][bookmark: _Toc59449183]Figure 13. OTCnet: Offline Icon
[image: Description: Offline 3.png]
2. 
The Welcome to the OTCnet Offline Installation Wizard dialog box appears (see Figure 14). Click Next.
[bookmark: _Ref486004844][bookmark: _Toc59449184]Figure 14. Welcome to the OTCnet Offline Installation Wizard Dialog Box
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3. The Destination Location dialog box appears (see Figure 15). Click Next. 

	[image: ]Application Tip
To install the software to another folder destination, click Browse to select a different folder. Click Cancel to exit the setup.


[bookmark: _Toc59449185]Figure 15. Destination Location Dialog Box
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4. 
The Start Installation dialog box appears (see Figure 16). Click Next.
[bookmark: _Ref486005122][bookmark: _Toc59449186]Figure 16. OTCnet Offline Installation Dialog Box
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5. The Server Port Settings dialog box appears (see Figure 17). Click OK.

	[image: ]Application Tip
The Server Port Settings are pre-populated with the default values.



	[image: ]Application Tip
If your location has specific Server Port Settings, enter the Server Start Port, Server Stop Port details, Server HTTPS Port, and Server Monitor Port details.


[bookmark: _Ref486005169][bookmark: _Toc59449187]Figure 17. Server Port Settings
[image: ]

The Installing dialog box appears (see Figure 18). Wait a moment while the files install.
[bookmark: _Ref486005238][bookmark: _Toc59449188]Figure 18. Installing Prompt
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6. After the message “OTCnet Offline has been successfully installed” appears (see Figure 19), click Finish.


	[image: ]Application Tip
After OTCnet Offline is successfully installed an OTCnet Offline icon appears on the terminal’s desktop and on your Start Menu under Programs.


[bookmark: _Ref486005304][bookmark: _Toc59449189]Figure 19. OTCnet Offline has been successfully installed
[image: ]
[bookmark: _Toc29548318]
Upgrade OTCnet Offline Check Capture Software
As new versions of OTCnet Offline Check Capture software become available, your Agency may choose to upgrade its terminals. Upgrade refers to installing an updated version of OTCnet Offline on a terminal that has a previous version of OTCnet Offline installed.

Before initiating an OTCnet Offline Application upgrade, consider the following information: 
Before you can uninstall the OTCnet Offline Application, you must first stop the OTCnet Offline Application. If the OTCnet Offline Application has been started on the terminal, ensure that it is stopped before uninstalling the application.
If you are upgrading to a newer OTCnet Offline version, you must uninstall the previous offline version and then perform a new installation. 
If you are upgrading OTCnet Offline, you must install the application first, before creating the CCA Offline logon profile. You also need to create a CCA Offline logon profile to run the OTCnet Offline application, but it can only be created after installing the OTCnet Offline application. Refer to the Create a Check Capture Administrator Offline Logon Profile printable job aid.
If you are upgrading OTCnet Offline, and your Agency manages verification records, you do not need to reset and download the Local Verification Database (LVD) for each terminal.
More than one OTCnet Offline application environment (Production or QA) can be installed and upgraded on a computer. Each Offline application environment must be upgraded separately.
You need Windows Administrator privileges for each computer you will be upgrading.


To upgrade the OTCnet Offline Check Capture software:

1. Close open batches and upload all existing batches in Batch Management.

2. Stop the Offline application. From the Windows Start Button menu, select Stop OTCnet Offline (see Figure 20).
[bookmark: _Ref486005479][bookmark: _Toc59449190][bookmark: _Toc455496900]Figure 20. Stop OTCnet Offline
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3. Locate the folder where the OTCnet software file (EXE file) resides and double-click the OTCnet Offline.exe icon (see Figure 21).
[bookmark: _Ref418240418][bookmark: _Toc455496901][bookmark: _Toc59449191]Figure 21. OTCnet Offline EXE
[image: Offline 3.png]

4. The Welcome to OTCnet Offline Setup Program dialog box appears. Click Next. (see Figure 22).
[bookmark: _Ref486005659][bookmark: _Toc59449192][bookmark: _Ref418240102][bookmark: _Toc455496902]Figure 22. Welcome to OTCnet Offline Setup Program Dialog Box
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5. The Destination Location dialog box appears. Click Next (see Figure 23).

To install the software to another folder destination, click Browse to select a different folder. Click Cancel to exit the setup.
[bookmark: _Toc59449193]Figure 23. Destination Location Dialog Box
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6. The Start Installation dialog box appears. Click Next (see Figure 24).
[bookmark: _Ref418240448][bookmark: _Toc455496904][bookmark: _Toc59449194]Figure 24. Start Installation dialog box
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7. 
The Enter CCA User ID and Offline Password dialog box appears. Enter your User ID and Offline Password in the appropriate text boxes and click Next (see Figure 25).
[bookmark: _Ref486005879][bookmark: _Toc59449195]Figure 25. Enter CCA User ID and Offline Password
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If an incorrect User ID and/or Offline Password is entered, an Installation Error dialog box message appears stating that the entered username (User ID) and/or password is invalid (see Figure 26). Click OK. The upgrade process will be cancelled. As a result, you will need to run the installer again and enter the correct credentials.
[bookmark: _Ref418240629][bookmark: _Toc455496906][bookmark: _Toc59449196]Figure 26. Installation Error dialog box
[image: Description: image002]
8. 

Wait a moment while the files install. After the OTCnet Offline has been successfully installed message appears, click Finish (see Figure 27).

After OTCnet Offline (Production or QA) is successfully installed an OTCnet Offline (Production or QA) icon appears on the terminal’s desktop and on your Start Menu under Programs.
[bookmark: _Ref418240498][bookmark: _Toc455496907][bookmark: _Toc59449197]Figure 27. OTCnet Offline has been successfully installed
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[bookmark: _Ref418238994][bookmark: _Toc29548319]
[image: MCj04420720000[1]]	Upgrade OTCnet Offline Check Capture Software
The term ‘install’ is used in this section to refer to a situation in which the OTCnet Offline application was not previously installed. The term ‘upgrade’ refers to a situation in which the OTCnet Offline application was previously installed and an updated version is being applied.

To upgrade OTCnet Offline Check Capture software:

	[image: ]Application Tip
Before initiating an Offline Check Capture software upgrade, consider the following information:
8. You need Windows Administrator privileges for each computer you will be upgrading.
9. If you are upgrading to a newer OTCnet Offline version, you must uninstall the previous offline version and then perform a new installation. 
10. If you are upgrading OTCnet Offline, you must install the application first, before creating the CCA Offline logon profile. You also need to create a CCA Offline logon profile to run the OTCnet Offline application, but it can only be created after installing the OTCnet Offline application. Refer to the Create a Check Capture Administrator Offline Logon Profile printable job aid.
11. If you are upgrading OTCnet Offline, and your Agency manages verification records, you do not need to reset and download the Local Verification Database (LVD) for each terminal.
12. More than one OTCnet Offline application environment (Production or QA) can be installed and upgraded on a computer. Each Offline application environment must be upgraded separately.



1. Close open batches and upload all existing batches in Batch Management.

2. Stop the Offline application. From the Windows Start Button menu, select Stop OTCnet Offline (see Figure 28).
[bookmark: _Ref486006216][bookmark: _Toc59449198]Figure 28. Stop OTCnet Offline
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3. Locate the folder where the OTCnet software file (EXE file) resides and double-click the OTCnet Offline.exe icon (see Figure 29). 
[bookmark: _Ref486006234][bookmark: _Toc59449199]Figure 29. OTCnet Offline.exe Icon
[image: Description: Offline 3.png]

4. The Welcome to the OTCnet Offline Installation Wizard dialog box appears (see Figure 30). Click Next.
[bookmark: _Ref486006294][bookmark: _Toc59449200]Figure 30. OTCnet Offline Installation Wizard
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5. The Destination Location dialog box appears (see Figure 31). Click Next.
	[image: ]Application Tip
To install the software to another folder destination, click Browse to select 
a different folder. Click Cancel to exit the setup.


[bookmark: _Toc59449201]Figure 31. Destination Location
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6. The Start Installation dialog box appears (see Figure 32). Click Next.
[bookmark: _Ref486006424][bookmark: _Toc59449202]Figure 32. Start Installation
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7. The CCA Offline User Credentials dialog box appears (see Figure 33). Enter your Enter ID and Offline Password in the appropriate text boxes and click Next. 
[bookmark: _Ref486006519][bookmark: _Toc59449203]Figure 33. CCA Offline User Credentials
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	[image: ]Application Tip
If an incorrect User ID and/or Offline Password is entered, an Installation Error dialog box message appears stating that the entered username (User ID) and/or password is invalid (see Figure 34). Click OK. The upgrade process will be cancelled. As a result, you will need to run the installer again and enter the correct credentials.
[bookmark: _Ref486006620][bookmark: _Toc59449204]Figure 34. Installation Error
[image: Description: Description: image002]




8. Wait while the files install. After the OTCnet Offline has been successfully installed message appears (see Figure 35), click Finish.
[bookmark: _Ref486006691][bookmark: _Toc59449205]Figure 35. OTCnet Offline has been successfully installed
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[bookmark: _Toc459908168]

[bookmark: _Toc29548320]Topic 3. Manage a Check Capture Administrator Profile
A Check Capture Administrator (CCA) Offline logon profile is necessary for upgrading the OTCnet Offline application and starting the OTCnet Offline server.

Note: The CCA Offline logon profile is also referred to as the User profile.

To create a CCA Offline logon profile, you must first log in to OTCnet Online as a CCA from each workstation where OTCnet is installed. Once logged in, you can create the CCA Offline logon profile. For more information about Downloading and Installing OTCnet Offline Check Capture Software, refer to Administration User Guide: Chapter 8: Setting Up and Configuring Check Capture Offline, Topic 2. Download, Install and Upgrade OTCnet Offline Check Capture Software. 

[bookmark: _Toc459908169][bookmark: _Toc29548321]Create a Check Capture Administrator Offline Logon Profile
The Check Capture Administrator (CCA) Offline logon profile is necessary for starting OTCnet Offline.

To create a CCA Offline logon profile, you need CCA privileges.

For the new OTCnet Offline release, any previous existing installation cannot be upgraded. You must uninstall the older Offline version and install the new version.

The CCA Offline logon profile is also referred to as the User profile. To create a CCA Offline logon profile, complete the following steps:

· Log into OTCnet Online and click the Administration tab, select Manage Users, and click Create Local Bridge and User Profile (see Figure 36). 

To create a CCA Offline logon profile, you need CCA privileges. The CCA Offline logon profile is necessary for starting OTCnet Offline.
[bookmark: _Toc59449206]Figure 36. Create Local Bridge and User Profile
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· The Create Local Bridge and User Profile page appears (see Figure 37).

Note that the first two radio buttons on this page, Online Local Bridge version XXX or newer and Online Local Bridge version XXX or older, are for OTCnet Online users.

Enter your Offline Password and confirm your Offline Password (see Figure 37).

If you forget your temporary Offline password and the OTCnet Offline server is not available, you must log in to OTCnet Online from your OTCnet Offline workstation and create a new CCA Offline logon profile. You must be logged into your OTCnet workstation as a CCA to create your CCA Offline logon profile. If you have an existing CCA account from an older version of OTCnet Offline installed, it is recommended that you set your CCA’s Offline logon profile password to the same password used for logging in to the Offline application. 

· Click Submit (see Figure 37).
[bookmark: _Toc59449207]Figure 37. Enter Local Bridge and User Profile Password
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A Do you want to open or save [file name].ini? dialog box appears. Click the Save drop-down arrow and select Save As (see Figure 38). 
[bookmark: _Ref421201069][bookmark: _Toc455496910][bookmark: _Toc59449208]Figure 38. Do you want to open or save
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Note that when you save the OLB credential file, do not rename the file as the file name must remain the same as it was generated.

[bookmark: _Hlk534641963]In addition, you must store the Offline Logon Profile credential file in the OTCnet Offline folder on the terminal. 

The Save dialog box appears (see Figure 39). To store the Offline logon profile credential file in the Offline folder on the terminal:

44. Click Local Disk (C:)
45. Double-click the OTCnetOffline folder
46. Double-click the data folder 
47. Double-click the ini folder

Click Save (see Figure 39).
[bookmark: _Ref486008486][bookmark: _Toc59449209]Figure 39. Save credential file
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If you click Save (following the guidance provided above), the Offline logon profile credential file will be saved in the appropriate folder on the terminal (C:\OTCnetOffline\data\ini\[file name].ini).
[bookmark: _Toc29548322]
[image: MCj04420720000[1]]	Create a Check Capture Administrator Offline Logon Profile
	[bookmark: _Hlk29534373][image: ]Application Tip
Before creating a Check Capture Administrator (CCA) Offline logon profile consider the following information:
To create a CCA Offline logon profile, you need CCA privileges.
For the new OTCnet Offline release, any previous existing installation cannot be upgraded. You must uninstall the older Offline version and install the new version.
The CCA Offline logon profile is also referred to as the User profile.



To create a CCA Offline logon profile, complete the following steps:

· Log into OTCnet Online from the workstation that will be using the OTCnet Offline application and click the Administration tab, select Manage Users, and click Create Local Bridge and User Profile. 

· The Create Local Bridge and User Profile page appears. Under Application, choose your OTCnet Offline version.

	[image: ]Application Tip 
Note that the first two radio buttons on this page, Online Local Bridge version XXX or newer and Online Local Bridge version XXX or older, are for OTCnet Online users.






· Enter your Offline Password and Confirm Offline Password.

	[image: ]Application Tip
Password Criteria:
· Must be at least 12 characters long 
· Must contain at least one upper case letter
· Must contain at least one lower case letter
· Must contain at least one numeric character
· Must not have more than two repeating characters
· Must not repeat any of your last ten passwords
· Must not have been your password during the last ten days
· Must not be a word in a language, slang, dialect, or jargon
· Must not be related to personal identity, history, environment, or other personal associations
· Must not be shared or displayed in plain view



	[image: ]Application Tip 
Note that these password criteria will be displayed on the page when you enter and confirm your Offline password.



	[image: ]Application Tip
If you forget your Offline password and the OTCnet Offline server is not available, you must log in to OTCnet Online from your OTCnet Offline workstation and create a new CCA Offline logon profile. You must be logged into your OTCnet workstation as a CCA to create your CCA Offline logon profile again.



	[image: ]Application Tip
If you have an existing CCA account from an older version of OTCnet Offline installed, it is recommended that you set your CCA’s Offline logon profile password to the same password used for logging in to the Offline application. 




· Click Submit.

	[image: ]Application Tip
When you click Submit, the system generates the credential file based on the application version selected. 



	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
3. Click Clear to reset the password fields. 
4. Click Cancel to return to the OTCnet Home Page.



· A Do you want to open or save [file name].ini? dialog box appears. Click the Save drop-down arrow and select Save as.

	[image: ]Application Tip
Note that when you save the Offline logon profile credential file, do not rename the file as the file name must remain the same as it was generated.
In addition, you must store the Offline logon profile credential file in the OTCnet Offline folder on the terminal.
If the file name is changed, or if the file is saved in the wrong folder location, the OTCnet application will not run.



	[image: ]Application Tip
If you click Open, the file will simply open in the Microsoft Notepad application. If you click Cancel, the Do you want to open or save dialog box closes, and you remain on the Create Local Bridge and User Profile page.



· The Save dialog box appears. To store the Offline logon profile credential file in the Offline folder on the terminal:

48. Click Local Disk (C:)
49. Double-click the OTCnetOffline folder
50. Double-click the data folder 
51. Double-click the ini folder


· Click Save.

	[image: ]Application Tip
If you click Save (following the guidance provided above), the Offline logon profile credential file will be saved in the appropriate folder on the terminal (C:\OTCnetOffline\data\ini\[file name].ini). 




[bookmark: _Toc29548323][bookmark: _Hlk29537039][bookmark: _Toc459908170]Import a Check Capture Administrator Offline Logon Profile
After creating your Check Capture Administrator Offline Logon Profile (credential file) in OTCnet Online, next you will import your Offline User Profile in OTCnet Offline. You need to import the credential file to start the Offline application.

To import the Check Capture Administrator Offline Logon Profile, complete the following steps:

· Double-click the OTCnet Offline (Production or QA) icon located on the workstation desktop (see Figure 40).
[bookmark: _Ref17710064][bookmark: _Toc25477431][bookmark: _Toc59449210]Figure 40. OTCnet Offline Icon
[image: cid:image001.png@01D5C62E.F3E034D0]
Or

[bookmark: _Hlk25662582]Click Start>Programs>OTCnet Offline (Production or QA). If the icon does not reside in either location, install OTCnet Offline. 



· The OTCnet Offline Startup window appears. Click the File menu, and then click Import User Profile (see Figure 41).
[bookmark: _Ref29533437][bookmark: _Toc59449211]Figure 41. OTCnet Offline Startup
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· [bookmark: _Hlk496527117][bookmark: _Toc25477433]The Select User Profile File dialog box appears. Navigate to the location on the workstation where the Check Capture Administrator Offline Logon Profile was saved. Select the file and click Import (see Figure 42).
[bookmark: _Ref29534073][bookmark: _Toc59449212]Figure 42. Select User Profile
[image: ]

The default location on the Select User Profile File dialog box is the user’s My Documents folder (see Figure 42).
[bookmark: _Ref29534143][bookmark: _Toc25477434][bookmark: _Toc59449213]Figure 43. User Profile Import
[image: ]

Once you have successfully imported the Check Capture Administrator Offline Logon Profile, you receive the Successfully imported user profile message (See Figure 43). You can proceed with starting OTCnet Offline on the workstation.


[bookmark: _Toc29548324][bookmark: _Hlk29565627][image: ] Import a Check Capture Administrator Offline Logon
        Profile 
	[image: ]Application Tip
After creating your Check Capture Administrator Offline Logon Profile (credential file) in OTCnet Online, next you will import your Offline User Profile in OTCnet Offline. You need to import the credential file to start the Offline application.



To import the Check Capture Administrator Offline Logon Profile, complete the following steps:

Double-click the OTCnet Offline (Production or QA) icon located on the workstation desktop.
Or

Click Start>Programs>OTCnet Offline (Production or QA).

The OTCnet Offline Startup window appears. Click the File menu, and then click Import User Profile.

The Select User Profile File dialog box appears. Navigate to the location on the workstation where the Check Capture Administrator Offline Logon Profile was saved. Select the file and click Import.

	[image: ]Application Tip
The default location on the Select User Profile File dialog box is the user’s My Documents folder.



	[image: ]Application Tip
Once you have successfully imported the Check Capture Administrator Offline Logon Profile, you receive the Successfully imported user profile message. You can proceed with starting OTCnet Offline on the workstation.






[bookmark: _Toc29548325]Retrieve a Check Capture Administrator Offline Logon Profile
After the OTCnet Offline Check Capture software is downloaded and installed, the CCA Offline logon profile is created and imported, and the Offline server is started, the next step is to retrieve (download) your Check Capture Administrator’s (CCA) Offline logon profile. 

Once the Internet Explorer or Chrome browser opens to the OTCnet Offline logon page, click the Retrieve Admin Profile hyperlink. This step is required if this is the first time that you have installed and accessed OTCnet Offline on that terminal or if you forgot your Offline password and had to create a new CCA Offline logon profile.

To download your CCA Offline logon profile, enter in your Online User ID and Password, and specify the Proxy settings for the terminal (if required). Once your credentials are confirmed, the system will connect with the OTCnet Online server, validate your credentials, and download your Administrator Profile locally. You will then be prompted to enter in a new Permanent Password for your offline account. Once completed, you will be returned to the login page to re-login to Offline OTCnet.

If you are upgrading an existing OTCnet Offline version to a newer version and you have already created a CCA Offline logon profile, you do not need to retrieve your Administrator Profile. Skip this step and proceed to logging in to the Offline application.

In the event that you forget both your online and offline passwords, contact the Customer Service Team at (866) 945-7920 to reset your online password. Then log in to OTCnet Online and re-establish a permanent password. Once your online password is reset, you will need to create another CCA Offline logon profile in OTCnet Online (see Create a Check Capture Administrator’s Offline Logon Profile) and then access OTCnet Offline (internet connectivity required) and repeat the steps for retrieving your administrator profile (see Retrieve an Administrator Profile).

Your password for offline does not need to match your online account credentials. 



To retrieve a CCA Offline logon profile:

· Double-click the OTCnet Offline icon located on the terminal’s desktop or click 
Start >Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA) (see Figure 44). 

If you have already entered your Offline logon profile credentials proceed to step 3.
[bookmark: _Ref29538156][bookmark: _Toc59449214]Figure 44. OTCnet Offline Icon
[image: cid:image001.png@01D5C62E.F3E034D0]

· The OTCnet Offline Server Startup page appears (Figure 45). Enter your User ID and Password in the appropriate text boxes, and click Log In. Wait for the application to start up and Internet Explorer to open.
[bookmark: _Ref29546779][bookmark: _Toc59449215]Figure 45. OTCnet Offline Server Startup
[image: ]

If the Offline server was not been previously started, you will need to enter your User ID and password to start up the Offline server. Refer to the Administration User Guide: Chapter 2: Accessing and Navigating OTCnet user guide, Topic 1: Logging In to OTCnet Online/Offline and Start the OTCnet Offline Server for more details.

· The OTCnet Login page appears. Click the Retrieve Admin Profile hyperlink to begin the process of downloading the Check Capture Supervisor profile (Figure 46).

Use the Retrieve Admin Profile hyperlink if this the first time you are installing any version of OTCnet Offline on your workstation or if you forgot your Offline password and had to create a new CCA Offline logon profile. 
[bookmark: _Ref421878922][bookmark: _Toc455496913][bookmark: _Toc59449216]Figure 46. OTCnet Offline Home Page
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· Enter your Online User ID and Online Password and click Retrieve Profile (see Figure 47).
[bookmark: _Ref421878526][bookmark: _Toc455496914][bookmark: _Toc59449217]Figure 47. Retrieve Admin Profile Online Credentials
[image: ]
If applicable, configure the proxy server settings. The Proxy Timeout value is the number of minutes the application waits for a connection to the server before the system times out. The maximum allowed timeout is 30 minutes
· Enter the Proxy Password
· Enter the Proxy Server
· Enter the Proxy Port
If the Use Firewall Agent option is enabled, then the Fire Agent is available for configuration and the agent name can be entered.
· Check Use Proxy
· Enter the Proxy Timeout


· Enter New Password, Re-enter New Password, and click Save (see Figure 48).
[bookmark: _Ref421878621][bookmark: _Toc455496915][bookmark: _Toc59449218]Figure 48. Retrieve Admin Profile - New Password
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Password Criteria:
4. Must be at least 12 characters long 
5. Must contain at least one upper case letter
6. Must contain at least one lower case letter
7. Must contain at least one numeric character
8. Must not have more than two repeating characters
9. Must not repeat any of your last ten passwords
10. Must not have been your password during the last ten days
11. Must not be a word in a language, slang, dialect, or jargon
12. Must not be related to personal identity, history, environment, 
or other personal associations
13. Must not be shared or displayed in plain view

When you finish entering the passwords, click Save. A Confirmation page appears, stating your new password has been set. This new password is also the permanent password for your Offline logon profile, used for starting up the Offline server and application. 

· Restart your computer to ensure that all OTCnet security features are fully enabled.
[bookmark: _Toc29548326]
[image: MCj04420720000[1]]	Retrieve a Check Capture Administrator Offline Logon Profile
To retrieve a Check Capture Administrator Offline logon profile:

Double-click the OTCnet Offline (Production or QA) icon on the computer’s desktop.
Or 
Click Start>Programs>OTCnet Offline (Production or QA)>Start OTCnet Offline (Production or QA). 

The OTCnet Offline Server Startup page appears.

	[image: ]Application Tip
If the OTCnet Offline icon is not located on the computer’s desktop or Start Menu, under Programs, download and install the OTCnet Offline Check Capture software. Refer to the Download OTCnet Offline Check Capture Software and Install OTCnet Offline Check Capture Software printable job aids. 



	[image: ]Application Tip
If the Offline server was previously started, proceed to Step 3.



Enter your User ID and Password in the appropriate text boxes and click Log In (if applicable). The OTCnet Login page appears.

Click the Retrieve Admin Profile hyperlink. The Retrieve Admin Profile page appears.

	[image: ]Application Tip
Use the Retrieve Admin Profile hyperlink if this the first time you are installing the OTCnet Offline application on your terminal or if you forgot your Offline password and had to create a new CCA Offline logon profile.



Enter your Online User ID and Online Password.

Under Proxy Server Configuration (if applicable):
Check Use Firewall Agent and enter the Firewall Agent
Check Use Proxy and enter Proxy Timeout, Proxy Password, Proxy Server and Proxy Port

	[image: ]Application Tip
If Proxy Server Configuration settings are entered, they will be saved in the system and can later be viewed and modified in Terminal Configuration. 
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If the Use Firewall Agent option is enabled, then the Firewall Agent is available for configuration and the agent name can be entered. 
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If the Use Proxy option is enabled, then Proxy Timeout, Proxy Password, Proxy Server, and Proxy Port are available for configuration.
The Proxy Timeout value is the number of minutes the application waits for a connection to the server before giving up. The maximum allowed timeout is 30 minutes.



Click Retrieve Profile.

Enter your New Password, and Re-Enter New Password.


	[image: ]Application Tip

Password Criteria:
· Must be at least 12 characters long
· Must contain at least one upper case letter
· Must contain at least one lower case letter
· Must contain at least one numeric character
· Must not have more than two repeating characters
· Must not repeat any of your last ten passwords
· Must not have been your password during the last ten days
· Must not be a word in a language, slang, dialect, or jargon
· Must not be related to personal identity, history, environment, or other personal associations
· Must not be shared or displayed in plain view



Click Save. A Confirmation page appears stating your new password has been set.  
This new password is also the permanent password for your offline logon profile, used for starting up the Offline server and application. 

	[image: ]Application Tip
After the profile is successfully downloaded and permanent password was set, you will be prompted to log in to the Offline application with your new password.



	[image: ]Application Tip
If the profile download was unsuccessful, a message appears stating that the profile download was unsuccessful and to please contact Customer Service for assistance.


Restart your computer to ensure that all OTCnet security features are fully enabled.
[bookmark: _Toc459908171]

[bookmark: _Toc29548327]Topic 4. Managing OTC Endpoints
After the Check Capture Administrator’s (CCA) profile is downloaded to the terminal, as the CCA you have the ability to manage OTC Endpoints. Managing OTC Endpoints allows for the user to select which OTC Endpoint(s) (CHK) and OTC Endpoint information will be downloaded to the OTCnet Offline Check Capture application. As a Check Capture Supervisor (CCS), you can download OTC Endpoints after the CCA selects the OTC Endpoint for download.

Before OTC Endpoints can be managed, you must access the OTCnet Offline application and enter your online User ID and password. Once connectivity is established to the Online server from OTCnet Offline the system will retrieve all OTC Endpoints (CHK) (ALC+2, Short Name, and Description) that you have access to Online. After the system has successfully retrieved all accessible OTC Endpoints (CHK), you will be redirected to the OTC Endpoint selection screen.

Once the OTC Endpoints are saved into the local offline database, perform the Download OTC Endpoints function to download the form and form data, DDS flags (Department of Defense [DoD] only), Government-Wide Accounting (GWA) flag, Summary Level Classification flag, accounting code mapping (a link will be provided to review the list of accounting codes before downloading), OTC Endpoint updates, and other information necessary for performing check scanning in offline mode. Internet connectivity is required. 

Agencies that are capturing accounting codes will have the ability to retrieve and save the accounting codes that have been setup online and mapped to that endpoint. If a CCA or CCS updates an accounting code online, the Offline application will incorporate those adjustments when internet connectivity has been established.


[bookmark: _Toc459908172][bookmark: _Toc29548328]Select OTC Endpoints
To select OTC Endpoints:

Click the Administration tab, select Manage OTC Endpoints and then click Select OTC Endpoints (see Figure 49).
[bookmark: _Toc59449219]Figure 49. Select OTC Endpoints
[image: ]

The Select OTC Endpoints function allows you to select which OTC Endpoint(s) will be retrieved from the hierarchy. You must first select the OTC Endpoints you want to retrieve from the hierarchy before you can download to the OTCnet Endpoints. 

Once the Online User ID and Online Password dialog box appears, enter your Online Password and click Login (see Figure 50).
[bookmark: _Ref425603508][bookmark: _Toc455496917][bookmark: _Toc59449220]Figure 50. Online Password
[image: ]

When the Select OTC Endpoints Download dialog box appears, the system retrieves the Short Name, Description, and ALC+2 for all OTC Endpoints that you have access to in OTCnet Online. Upon Task completed successfully, click Close (see Figure 51).
[bookmark: _Ref425603530][bookmark: _Toc455496918][bookmark: _Toc59449221]Figure 51. Agency Download
[image: ]

When the Step 1 of 2: Select OTC Endpoint(s) page appears, select OTC Endpoint(s) that you want to download to the OTCnet Offline Check Capture application by checking the box(es) in the Select column and click Next (see Figure 52).
[bookmark: _Ref425603561][bookmark: _Toc455496919][bookmark: _Toc59449222]Figure 52. Select OTC Endpoints
[image: ]


The Step 2 of 2: Review OTC Endpoint(s) page appears. Verify the OTC Endpoints that will be downloaded and click Submit (see Figure 53).
[bookmark: _Ref425603584][bookmark: _Toc455496920][bookmark: _Toc59449223]Figure 53. Review OTC Endpoints
[image: ]
A Confirmation page appears showing the OTC Endpoints that have been successfully saved into the local offline database (see Figure 54).
[bookmark: _Ref425603605][bookmark: _Toc455496921][bookmark: _Toc59449224]Figure 54. OTC Endpoint Confirmation
[image: figure 32]


[bookmark: _Toc29548329][image: MCj04420720000[1]]  Select OTC Endpoints
To select OTC Endpoints:

Click the Administration tab.

Select Manage OTC Endpoints and click Select OTC Endpoints. The Online User ID and Online Password dialog box appears.

	[image: ]Application Tip
The Select OTC Endpoints function allows you to select which OTC Endpoint(s) will be retrieved from the hierarchy. You must first select the OTC Endpoints you want to retrieve from the hierarchy before you can download to the OTCnet Endpoints.   



Enter your Online Password and click Login. The Select OTC Endpoint Downloads dialog box appears. 

	[image: ]Application Tip
Enter your password that you use to access OTCnet Online. If your OTCnet Online credentials (Log In and Password) are expired or do not exist an error message appears. Ensure your OTCnet Offline credentials correspond to an existing OTCnet Online account. 



	[image: ]Application Tip
The system retrieves the Short Name, Description and ALC+2 for all OTC Endpoints that you have access to in OTCnet Online.



Click Close. The Step 1 of 2 Select OTCnet Endpoint(s) page appears with Select OTC 
Endpoint message. 

	[image: ]Application Tip
It is highly recommended that the Cancel button is not clicked. Instead, wait for the Close button to ensure the OTC Endpoints (CHK) display on the Select OTC Endpoints page.





	[image: ]Application Tip
When the Select OTC Endpoints Task dialog box appears, the system downloads the OTC Endpoint information (CHK) (Short Name, ALC+2, and Description).



Select the OTC Endpoint(s) that you want to download to the OTCnet Offline Check Capture application by checking the check box(es) under the Select column. 

	[image: ]Application Tip
Only active OTC Endpoints (CHK) to which a user has access will be listed. OTC Endpoints (TGA) will not be displayed.



Click Next. The Step of 2 of 2 Review OTC Endpoint(s) page appears. 

Verify that the following OTC Endpoints should be saved to the database and click Submit. 

A Confirmation page appears showing the OTC Endpoints have been successfully saved into the local offline database.

	[image: ]Application Tip
Additional button on the page that help you perform other tasks:
5. Click Return Home to the OTCnet Home Page


[bookmark: _Toc459908173]

[bookmark: _Toc29548330]Download OTC Endpoints
To download OTC Endpoints:
Click the Administration tab
Select Manage OTC Endpoints and then click Download OTC Endpoints (see
Figure 55).
[bookmark: _Toc59449225]Figure 55. Download OTC Endpoints
[image: ]

The Download OTC Endpoints function allows you to download OTC Endpoint information such as the form and form data; Deployable Disbursing System (DDS) flag configurations (Department of Defense (DoD) only); GWA Reporter flag configurations; accounting codes that are mapped explicitly to the OTC Endpoints or inherited from a higher level OTC Endpoint or highest level organization (HLO); and other information necessary to perform check scanning in Offline mode.  Only OTC Endpoints that have been retrieved using the Select OTC Endpoints function are available for download using the Download OTC Endpoints function.

When the Task Download OTC Endpoint Started… message appears the system downloads the check capture forms and form data, DDS flag configurations, accounting code information, and organization hierarchy details for all OTC Endpoint (CHK) for all OTC Endpoints present on the local application.

Once the Download OTC Endpoints page appears, click Download (see Figure 56).
[bookmark: _Ref415830375][bookmark: _Toc455496923][bookmark: _Toc59449226]Figure 56. Download OTC Endpoints Review
[image: ]

To view the accounting codes associated with the OTC Endpoint before downloading the OTC Endpoints, click View on the Download OTC Endpoints page. After viewing the accounting codes, click Previous to return to the Download OTC Endpoints page.


Once the OTC Endpoint and Form Update task is complete, click Close to continue (see Figure 57).
[bookmark: _Ref415830323][bookmark: _Toc455496924][bookmark: _Toc59449227]Figure 57. OTC Endpoint Form Update
[image: ]

It is highly recommended that the Cancel button is not clicked instead wait for the Close button to ensure the OTC Endpoints (CHK) and forms are downloaded on the Download OTC Endpoints page.

Only active OTC Endpoints (CHK) that a user has access will be listed. OTC Endpoints (TGA) will not display. CHK denotes check capture and TGA denotes deposit processing.

A Confirmation page appears showing the OTC Endpoints have been successfully downloaded (Figure 58).
[bookmark: _Ref415830398][bookmark: _Toc455496925][bookmark: _Toc59449228]Figure 58. PTC Endpoint Download Confirmation
[image: ]
[bookmark: _Toc29548331]
[image: MCj04420720000[1]]  Download OTC Endpoints
To download OTC Endpoints:

Click the Administration tab.

Select Manage OTC Endpoints and click Download OTC Endpoints. The Download 
OTC Endpoint message appears.

	[image: ]Application Tip
The Download OTC Endpoints function allows you to download OTC Endpoint information such as the form and form data; Deployable Disbursing System (DDS) flag configurations (Department of Defense (DoD) only); GWA Reporter flag configurations; accounting codes that are mapped explicitly to the OTC Endpoints or inherited from a higher level OTC Endpoint or highest level organization (HLO); and other information necessary to perform check scanning in Offline mode.  Only OTC Endpoints that have been retrieved using the Select OTC Endpoints function are available for download using the Download OTC Endpoints function. 



The Download OTC Endpoints page appears. Click Download. The OTC Endpoint and Form Update dialog box appears.

	[image: ]Application Tip
When the Task Download OTC Endpoint Started… message appears the system downloads the check capture forms and form data, DDS flag configurations, accounting code information, and organization hierarchy details for all OTC Endpoint (CHK) for all OTC Endpoints present on the local application. 



	[image: ]Application Tip
To view the accounting codes associated with the OTC Endpoint before downloading the OTC Endpoints, click View on the Download OTC Endpoints page. After viewing the accounting codes, click Previous to return to the Download OTC Endpoints page.




Click Close.
 
	[image: ]Application Tip
It is highly recommended that the Cancel button is not clicked instead wait for the Close button to ensure the OTC Endpoints (CHK) and forms are downloaded on the Download OTC Endpoints page.



	[image: ]Application Tip
Only active OTC Endpoints (CHK) that a user has access will be listed. OTC Endpoints (TGA) will not display. CHK denotes check capture and TGA denotes deposit processing.



A Confirmation page appears showing the OTC Endpoints have been successfully downloaded.

	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
6. Click Return Home to return the OTCnet Home Page.


[bookmark: _Toc459908174]

[bookmark: _Toc29548332]Topic 5. Managing User Profiles
If you are assigned the role of Check Capture Administrator (CCA), you are the only authorized user that can download and update user profiles.

Downloading user profiles allows for a user to perform the check capture function using the OTCnet Offline. The user can only perform this function within the OTC Endpoints that he/she is provisioned to in OTCnet Online (via ISIM). After the user profiles are downloaded to the appropriate OTC Endpoints temporary passwords are displayed. Communicate the User ID and temporary password details to the appropriate users. 

Updating user profiles allows for updating the account status, personal information, as well as provisioning. If an inactive user profile is downloaded and can be activated in OTCnet Offline. Updating user profiles in OTCnet Offline does not change the user’s profile in OTCnet Online.

[bookmark: _Toc459908175][bookmark: _Toc29548333]Download User Profiles
In order to manage user profiles, one must first download user profiles to the OTCnet Offline application. This ensures the most up to date information is being used. 

To download user profiles:

Click the Administration tab, select User Administration, and then click Download Users (Figure 59).
[bookmark: _Ref486010290][bookmark: _Toc59449229]Figure 59. Download Users
[image: ]
Once the Step 1 of 3: Selecting OTC Endpoint(s) page appears, select the OTC Endpoints(s) for which you want to download the user profile(s), and then click Download User Profile (Figure 60).
[bookmark: _Ref425603690][bookmark: _Toc455496927][bookmark: _Toc59449230]Figure 60. Step 1 of 3: Select OTC Endpoint(s)
[image: ]

Once the download user profiles action has been successfully completed message appears in the Download Users dialog box, click Close to continue (see Figure 61).
[bookmark: _Ref425603714][bookmark: _Toc455496928][bookmark: _Toc59449231]Figure 61. Download Users
[image: ]

After the Step 2 of 3: Select Users dialog box appears, select the user profile(s) that you want to download to the OTCnet Offline Check Capture application and then click Next (see Figure 62).
[bookmark: _Ref425603744][bookmark: _Toc455496929][bookmark: _Toc59449232]Figure 62. Step 2 of 3: Select Users
[image: ]

The Step 3 of 3: Review Users dialog box appears. Verify the users selected to download and click Submit (see Figure 63).
[bookmark: _Ref425603775][bookmark: _Toc455496930][bookmark: _Toc59449233]Figure 63. Step 3 of 3: Review Users
[image: ]

The Download Users Confirmation page appears, showing the user profiles for the OTC Endpoints that have successfully been downloaded to the local Offline database (see Figure 64).
[bookmark: _Ref425603800][bookmark: _Toc455496931][bookmark: _Toc59449234]Figure 64. Download Users Confirmation
[image: ]
[bookmark: _Toc29548334]
[image: MCj04420720000[1]]	Download User Profiles
To download user profiles:

6. Click the Administration tab.

7. Select User Administration and click Download Users. The Step 1 of 3: Select OTCnet Endpoint(s) page appears.

8. Select the OTC Endpoint(s) that you want to download the user profile(s) to the OTCnet Offline Check Capture application. 

9. Click Next. The Download Users dialog box appears.

10. Click Close. The Step 2 of 3: Select User(s) page appears. 

11. Select the user profile(s) that you want to download to the OTCnet Offline Check Capture application.

12. Click Next. The Step 3 of 3: Review Users page appears.

13. Verify the following user profiles for the selected OTC Endpoints should be downloaded to the local offline database and click Submit. 

14. A Confirmation page appears showing the user profiles for the OTC Endpoints that have been successfully downloaded to the local offline database along with the users’ temporary passwords to access OTCnet Offline.

	[image: ]Application Tip
Communicate the User IDs and temporary passwords to the appropriate users. The user’s ID is the same User ID used to access OTCnet Online. If the CCA forgets to record the temporary password, he/she may reset the user profile’s password for another temporary password.



	[image: ]Application Tip
Additional button on the page that help you perform other tasks:
7. Click Return Home to the OTCnet Home Page.


[bookmark: _Toc459908176]

[bookmark: _Toc29548335]Topic 6. Managing Offline Users
If you are assigned the role of Check Capture Administrator (CCA), you are the only authorized user in OTCnet Offline that can manage Offline users. Upon downloading the user profiles to a local terminal, the user accounts must be managed locally. Once you download the OTCnet Offline software and configure each terminal, you have the ability to activate/deactivate a user, unlock a user account, reset a user’s password, and print the system users list.

Before a user can access OTCnet Offline, the Primary/Local Security Administrator (P/LSA) must not only create the OTC Online user identity, but this user identity must also be successfully provisioned, approved, and provided a password using the online IBM Security Identity Manager (ISIM). For more details and step-by-step instructions refer to User Guide Chapter 5.5 pg. 2 Managing User Accounts. 

[bookmark: _Toc459908177][bookmark: _Toc29548336]Activating/Deactivating a User
It is strongly recommended that the user’s account be deactivated if the user is not going to access OTCnet Offline for an extended period (e.g., vacation or leave). Temporarily deactivating a user’s account disables the user’s account, disallowing the capture of checks and/or managing or uploading batches. Activating a user’s account allows the user to capture checks and/or managing or uploading batches.

To activate or deactivate a user:

Click the Administration tab, select User Administration, and then Manage Users (see Figure 65).
[bookmark: _Toc59449235]Figure 65. Manage Users
[image: ]
Once the Step 1 of 2: Select a User page appears, select the radio button next to the user profile that you want to activate/deactivate and click Activate/Deactivate (see Figure 66).
[bookmark: _Ref425603866][bookmark: _Toc455496933][bookmark: _Toc59449236]Figure 66: Activate/Deactivate User Profile
[image: ]

[bookmark: _Toc316399639]When the Step 2 of 2: Review User Profile for Activation/Deactivation page appears, verify the following user should be Activated/Deactivated and click Submit (see
Figure 67).
[bookmark: _Ref425603899][bookmark: _Toc455496934][bookmark: _Toc59449237]Figure 67. Step 2 of 2: Review User Profile for Activation/Deactivation
[image: ]

A Confirmation page appears showing the user profile has been activate/deactivated (see Figure 68).
[bookmark: _Ref425603926][bookmark: _Toc455496935][bookmark: _Toc59449238]Figure 68. Activating/Deactivating Confirmation
[image: ]
[bookmark: _Toc29548337]
[image: MCj04420720000[1]]	Activate/Deactivate a User
To activate/deactivate a user:

Click the Administration tab.

Select User Administration and click Manage Users. The Step 1 of 2: Select a User page appears. 

Select the user profile’s radio button that you want to activate/deactivate. 

	[image: ]Application Tip
You can only activate/deactivate one user’s profile at a time. 



Click Activate/Deactivate. The Step 2 of 2: Review User Profile for Activation/Deactivation page appears. 

Verify the following user profile should be activated/deactivated and click Submit. A 
confirmation page appears showing the user profile has been activated/deactivated.

	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
8. Click Return to View User Profile List to return to the View User Profile List for that terminal.
9. Click Return Home to the OTCnet Home Page.


[bookmark: _Toc459908178][bookmark: _Toc29548338]
Unlocking a User Account
Unlocking a user’s account allows the user to log on to OTCnet Offline using his/her original password. For example, if a user locks his/her account after three failed log on attempts and remembers his/her password, you can unlock the user’s account without resetting the user’s password. 

To unlock a user account:

Click the Administration tab, select User Administration, and then click Manage Users (see Figure 69).
[bookmark: _Toc59449239]Figure 69. Manage Users
[image: ]

Once the Step 1 of 2: Select User Profiles page appears, select the User Profiles radio button that you want to unlock and click Unlock Account (see Figure 70).
[bookmark: _Ref425603964][bookmark: _Toc455496937][bookmark: _Toc59449240]Figure 70. Step 1 of 2: Select User Profiles
[image: ]

After the Step 2 of 2: Review User Profile to be Unlocked page appears, verify the following user profile should be unlocked and click Submit (see Figure 71).
[bookmark: _Ref425603993][bookmark: _Toc455496938][bookmark: _Toc59449241]Figure 71. Step 2 of 2: Review User Profile to be Unlocked
[image: ]

A Confirmation page appears showing the profile has been unlocked (see Figure 72).
[bookmark: _Ref425604014][bookmark: _Toc455496939][bookmark: _Toc59449242]Figure 72. User Profile Unlock Confirmation
[image: ]
[bookmark: _Toc29548339]
[image: MCj04420720000[1]]	Unlock a User’s Profile
To unlock a user’s profile:

Click the Administration tab.

Select User Administration and click Manage Users. The Step 1 of 2 Select a User page appears. 

Select the user profile’s radio button that you want to unlock. 

	[image: ]Application Tip
You can only unlock one user’s profile at a time. 



Click Unlock Account. The Step 2 of 2: Review User Profile To Be Unlocked page appears. 

	[image: ]Application Tip
Unlocking a user’s profile will allow the user to log on to OTCnet Offline using his/her original password.



Verify the following user profile should be unlocked and click Submit. A Confirmation page appears showing that the user profile has been unlocked.

	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
Click Return to View User Profile List to return to the View User Profile List for that terminal.
Click Return Home to the OTCnet Home Page.


[bookmark: _Toc459908179]

[bookmark: _Toc29548340]Resetting a User’s Password
Resetting a user’s password allows the user to receive a new temporary password to access OTCnet Offline. For example, if a user locks his/her account after three failed log in attempts and does not remember his/her password, or if a user forgets his/her password, you can reset the user’s password to a temporary password. After the password is reset, communicate the temporary password to the appropriate user. 

To reset a user’s password:

Click the Administration tab, select User Administration, and then click Manage Users (see Figure 73).
[bookmark: _Toc59449243]Figure 73. Manage Users
[image: ]

When the Step 1 of 2: Select User Profile page appears, select the User Profiles radio button for the user whose password should be reset and click Reset Password (see Figure 74).
[bookmark: _Ref425604146][bookmark: _Toc455496941][bookmark: _Toc59449244]Figure 74. Step 1 of 2: Select User Profile
[image: ]

Once the Step 2 of 2: Review User Profile for Password Reset page appears, verify the User profile to reset password and click Submit (see Figure 75).
[bookmark: _Ref425604166][bookmark: _Toc455496942][bookmark: _Toc59449245]Figure 75. Step 2 of 2: Review User Password Reset
[image: ]

A Confirmation page appears showing the user’s password has been reset (see
Figure 76).
[bookmark: _Ref425604194][bookmark: _Toc455496943][bookmark: _Toc59449246]Figure 76. Reset User Password Confirmation
[image: ]
[bookmark: _Toc29548341]
[image: MCj04420720000[1]]	Reset a User’s Password
To reset a user’s password:

Click the Administration tab.

Select User Administration and click Manage Users. The Step 1 of 2 Select a User page appears. 

Select the user profile radio button for which you want to reset the password. 

	[image: ]Application Tip
You can only reset one user’s password at a time. 



Click Reset Password. The Step 2 of 2 Review User Profile for Password Reset page appears. 

Verify the following user profile’s password should be reset and click Submit. A Confirmation page appears showing the user profile’s temporary password.

	[image: ]Application Tip
Communicate the User’s ID and temporary password and provide it to the appropriate user. The User’s ID is the same User ID used to access OTC Online.



	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
Click Return to View User Profile List to return to the View User Profile List for that terminal.
Click Return Home to the OTCnet Home Page.


[bookmark: _Toc459908180]

[bookmark: _Toc29548342]Printing a User’s List
After the users’ profiles are managed, you can export and print out a detailed user list in the following formats: Word, Excel, RTF, or PDF. The User List report provides details such as OTC Endpoint, ALC+2, User ID, User Name, Create Date, Last Access Time, Download Time, and Role Name.

To print a user’s list:

Click the Administration tab, select User Administration, and then click Manage Users (see Figure 77).
[bookmark: _Toc59449247]Figure 77. Manage Users
[image: ]
Click Print User List (see Figure 78).
[bookmark: _Ref425604228][bookmark: _Toc455496945][bookmark: _Toc59449248]Figure 78. Step 1 of 2: Select User Profile
[image: ]
Selecting a radio button is not required. If no radio button is selected the user list will print all users.


The Print User List preview page appears (see Figure 79).

Under Export as,
Select PDF, Word or Excel 
Click Download
Or
Click Print PDF Report.
[bookmark: _Ref425604243][bookmark: _Toc455496946][bookmark: _Toc59449249]Figure 79. Print User List
[image: ]
[bookmark: _Toc29548343]
[image: MCj04420720000[1]]	Print User List
To print a user list:

Click the Administration tab.

Select User Administration and click Manage Users. The Step 1 of 2 Select a User page appears. 

Click Print User List. The Print User List preview page appears. 

Under Export as, 
Select PDF, Word or Excel 
Click Download

Or

Click Print PDF Report.

	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
Click Previous to return to the View User Profile List for that terminal.


[bookmark: _Toc459908181]

[bookmark: _Toc29548344]Topic 7. Manage a Check Capture Terminal Offline
If you are assigned the role of Check Capture Administrator (CCA) or Check Capture Supervisor (CCS), you are the only authorized users who can configure the OTCnet Offline check capture settings for your agency’s terminal(s). To meet your location’s check capture needs, each OTCnet terminal must have configuration settings individually applied. 

You can add or update the following:
System Configuration: Used to ensure Task Execution on Start Up or Batch Close, LVD usage, and receipt printing.
Application Configuration: Used to define a Terminal ID, processing mode, specify a cashflow method, as well as specify batch control and batch control prompts.
Devices Configuration: Used to specify the scanner type and communication channel and enable franking.
Standalone Configuration: Used to define a secondary storage, specify if supervisor approval is required to upload a batch, specify retention periods for batches and audit logs, as well as specify secure batch transmission details and proxy server configuration details (if applicable).
Available OTC Endpoints: Used to add available OTC Endpoints for check capture. 
Configured OTC Endpoints: Used to set a default OTC Endpoint, review already-configured OTC Endpoints or remove unused OTC Endpoints from the terminal.
[bookmark: _Toc459908182][bookmark: _Toc29548345]
Configure a Check Capture Terminal
To configure a check capture terminal Offline:

Click the Administration tab.

Select Manage Check Processing, then select Terminal Configuration and click Modify (see Figure 80).
[bookmark: _Toc59449250]Figure 80. Modify Terminal
[image: ]

The Step 1 of 4: Gathering Terminal Information page may appear briefly (see
Figure 81).
[bookmark: _Ref425604277][bookmark: _Toc455496948][bookmark: _Toc59449251]Figure 81. Step 1 of 4: Gathering Terminal Information
[image: ]

The Step 2 of 4: Update Terminal Configuration page appears. Under System Configuration (see Figure 82).
Set Task Execution
Set LVD Usage (optional)
Set Receipt Printing (optional)
By default, all tasks execute on Start Up and Close Batch. Unless you want the tasks to execute on Start Up and Batch Close every time, customize your options appropriately. If none of the tasks are checked, then none of the tasks will be executed.
[bookmark: _Ref425604353][bookmark: _Toc455496949][bookmark: _Toc59449252]Figure 82. Step 2 of 4: Update Terminal Configuration
[image: ]

Under Application Configuration: (see Figure 83).
Enter Terminal ID (this is a onetime setting per Terminal)
Select Single or Batch for Processing Mode
Select Settle Best Method or Truncate All 
Select Optional or Mandatory for Batch Control
Click Prompt on Batch Create and/or Prompt on Batch Close 
For more details, refer to the Configure a Check Capture Terminal Offline printable job aid below.
[bookmark: _Ref425604395][bookmark: _Toc455496950][bookmark: _Toc59449253]Figure 83. Application Configuration
[image: figure 61]

Under Device Configuration (see Figure 84):
Select the Scanner Model (required)
Select USB Port or Serial Port (required)
Select the Serial Port Type

A “No Serial Ports are available for configuration” message displays if a Serial Port is not available for a terminal. A “No Serial Ports are available for configuration” message does not display if the terminal has a COM port enabled or if there a COM port enabled and there is no physical Serial Port. 

Check Franking Enabled (optional) 

The Franking Enabled option allows the scanner to automatically stamp the front of checks. Franking is available for EC7000i, EC9100i, and Panini I: Deal scanners.
For more details, refer to the Configure a Check Capture Terminal Offline printable job aid below.
[bookmark: _Ref425604459][bookmark: _Toc455496951][bookmark: _Toc59449254]Figure 84. Device Configuration
[image: ug8_setup_Config_CC_off_64]

Under Standalone Configuration (see Figure 85):
Set Secondary Storage (required)
As a best practice, it is recommended that you use an external secondary storage folder location, for example a shared or network drive (e.g., E:\OTCnet\SecondaryStorage). If you do not specify an external folder location and attempt to use a folder on your local workstation, you will receive a warning message. You can use Windows Explorer to specify (and enter) the preferred folder location for Secondary Storage on the terminal. You can either manually enter the preferred folder location. Or, you can copy the path from the Windows Explorer path field and paste it into the Secondary Storage field.
Set Supervisor Approval (optional)
Set Retention Periods (required)
By default, the Batch Retention Period is set to 30 days. 
By default, the Audit Log Retention Period is set to 365 days. 
Set Secure Batch Transmissions
Set Proxy Server Configuration
For more details, refer to the Configure a Check Capture Terminal Offline printable job aid below.
Once the terminal configuration settings have been entered, click Next.
[bookmark: _Ref425604507][bookmark: _Toc455496952][bookmark: _Toc59449255]Figure 85. Standalone Configuration
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The Step 3 of 4: Update the Configured OTC Endpoints page appears. Select the OTC Endpoint(s) that you want to Add by checking the box(es) under the Add column and click Add (see Figure 86).
[bookmark: _Ref425604535][bookmark: _Toc455496953][bookmark: _Toc59449256]Figure 86. Step 3 of 4: Update the Configured OTC Endpoints
[image: ]

Under Configure OTC Endpoint(s) (see Figure 87):
Select a Default OTC Endpoints (required)
Select the OTC Endpoints that you want to Delete by checking the box(es) under the Remove column, and click Remove (if applicable)
Once the Endpoints have been selected for updates, click Next
[bookmark: _Ref425604564][bookmark: _Toc455496954][bookmark: _Toc59449257]Figure 87. Configure OTC Endpoints
[image: ]

The Step 4 or 4: Review the Terminal Configuration page appears. Verify the Terminal Configuration is correct and click Submit. Click Edit if you need to modify the information entered (see Figure 88).
[bookmark: _Ref425604591][bookmark: _Toc455496955][bookmark: _Toc59449258]Figure 88. Step 4 of 4: Review the Terminal Configuration
[image: ]

A Confirmation page appears stating that the Terminal Configuration record has been updated (see Figure 89).
[bookmark: _Ref425604847][bookmark: _Toc455496956][bookmark: _Toc59449259]Figure 89. Terminal Configuration Confirmation
[image: ]
[bookmark: _Toc29548346]
[image: MCj04420720000[1]]	Configure a Check Capture Terminal Offline
	[image: ]Application Tip
The Check Capture Administrator and Check Capture Supervisor are authorized to configure the check capture settings on a terminal.



To configure a check terminal offline, complete the following steps:

Click the Administration tab.

Select Manage Check Processing>Terminal Configuration and click Modify. The Step 1 of 4: Gathering Terminal Information page may appear briefly.

	[image: ]Application Tip
When the Automated terminal detection in progress message appears, the system reads the desktop settings and displays the appropriate information on the next page. 



The Step 2 of 4: Update the Terminal Configuration page appears. Enter the system configuration.

Under System Configuration, 
Set Task Execution by,
Checking or unchecking Start Up and/or Close Batch for 
Download OTC Endpoint
LVD Download
Acknowledge Batch
Upload Batch

	[image: ]Application Tip
By default, all tasks execute on Start Up and Close Batch. Unless you want the tasks to execute on Start Up and Batch Close every time, customize your options appropriately. Note, if none of the tasks are checked, then none of the tasks will be executed.




	[image: ]Application Tip
Download OTC Endpoint: If enabled, the offline application automatically downloads updated forms, organization information, DDS flags, and the endpoint status from the OTCnet Online servers.
LVD Download: If enabled and there is no previous LVD located on the terminal, the full LVD downloads. Subsequent LVD Downloads:
Update existing records (if necessary)
Download new records

Acknowledge Batch: If enabled, the offline application automatically acknowledges any uploaded batches that have successfully been processed by the OTCnet Online application.

Upload Batch: If enabled, OTCnet Offline automatically uploads any approved batches. If the supervisor approval flag is unchecked in terminal configuration, the Upload Batch task uploads Closed batches. The local activity log also uploads during the Upload Batch task. Additionally, the terminal configuration information uploads for use by Customer Service in Terminal Query.



Set LVD Usage by, optional
Checking or unchecking Personal Check and/or Non Personal for 
Customer Present
Checking or unchecking Personal Check and/or Non Personal for 
Customer Not Present
Entering the number of days an LVD Download override is required after

	[image: ]Application Tip
By default, all four checkboxes (Personal and/or Non Personal checks and Customer Present and/or Customer Not Present) for (Local Verification Database) LVD Usage are checked and they are optional. If all of them are not checked, then the LVD verification feature is disabled. 



	[image: ]Application Tip
If any of the LVD Usage check boxes are checked, the number of days an LVD Download override is required after is required. The LVD Download override is required after field specifies the number of days that can pass before the LVD is considered stale and requires a Check Capture Supervisor to approve scanning checks against the stale LVD; otherwise, the operator is required to download the latest LVD. 




Set Receipt Printing by, optional
Checking Person Present, optional
Click the Manual or Automatic radio button
Check with preview
Checking Person Not Present, optional
Click the Manual or Automatic radio button
Check with preview

	[image: ]Application Tip
Leaving both the Person Present and Person Not Present fields unchecked results in the disabling of this option. If receipts are desired, click the appropriate box(es). Choosing Manual requires that the operator take additional steps to print the receipt. Choosing Automatic results in a receipt printout each time a transaction has been entered. Choosing the with preview option allows the operator to see the receipt on the screen prior to the generation of the printout. When the Person Present and/or Person Not Present fields are clicked, the default setting is Manual.



	[image: ]Application Tip
When printing receipts, the system will go to the Windows default printer. All receipts will print to the Windows default printer.



Under Application Configuration, 
Enter the Terminal ID

	[image: ]Application Tip
The Terminal ID field is available for data entry during initial setup. After the Terminal ID is assigned it is protected and cannot be changed. 



	[image: ]Application Tip
The Host Name field is automatically generated based on your computer’s registry and cannot be changed. 




Select Single or Batch for Processing mode

	[image: ]Application Tip
Single processing mode allows the user to scan only one check at a time. Batch processing mode allows groups of checks to be scanned all at once, prior to the data entry for the items. The Batch processing mode is available for EC7000i, EC9100i, and all Panini scanners.



Select Settle Best Method or Truncate All Items for Cashflow
Check Back Office Processing Only

	[image: ]Application Tip
The Settle Best Method is the default selection and when selected exclusively on the configuration screen, all processing methods (Customer Present, Customer Not Present, and Back Office) are allowed for either personal or non-personal items on the Entry Screen. The Back Office Processing method should be used by agencies that receive payments in person, and then scan the checks at a later time in a controlled, back office environment. Truncate All Items represents only non-personal items are allowed (for all processing methods) on the Entry Screen. 



Select Optional or Mandatory for Batch Control

	[image: ]Application Tip
If the Batch Control is set to Optional, OTCnet prompts the user to use the batch control and enter the batch control totals. If the Batch Control is set to Mandatory, OTCnet prompts for batch control totals. 



Click Prompt on Batch Create and/or Prompt on Batch Close for Batch 
Control Prompts


Under Devices Configuration,
Select the Scanner model, required
Select USB Port or Serial Port, required
Select the Serial Port type

	[image: ]Application Tip
USB Port: EC7000i, EC9100i, Panini MyVision, Panini VisionX, and Panini I: Deal scanners require a USB port communication channel. EC7000i scanners support USB and Serial communication channels.
Serial Port and COM dropdown: The user selects the serial port (i.e., COM port) where they have connected a serial scanner.
USB-to-serial adapters: USB-to-serial adapters are not supported. EC7000i scanners support USB and Serial communication channels.


[bookmark: _Hlk494714092]
	[image: ]Application Tip
A “No Serial Ports are available for configuration” message displays if a Serial Port is not available for the terminal. A “No Serial Ports are available for configuration” message does not display if the terminal has a COM port enabled or if there a COM port enabled and there is no physical Serial Port. 



Check Franking Enabled, optional

	[image: ]Application Tip
The Franking Enabled option allows the scanner to automatically stamp the front of checks. Franking is available for EC7000i, EC9100i, and Panini I: Deal scanners.




Under Standalone Configuration, 
Set Secondary Storage by, required
Specifying the preferred Secondary Storage folder location in the Secondary Storage location

	[image: ]Application Tip
As a best practice, it is recommended that you use an external secondary storage folder location, for example a shared or network drive (e.g., E:\OTCnet\SecondaryStorage). If you do not specify an external folder location and attempt to use a folder on your local workstation, you will receive a warning message. You can use Windows Explorer to specify (and enter) the preferred folder location for Secondary Storage on the terminal. You can either manually enter the preferred folder location. Or, you can copy the path from the Windows Explorer path field and paste it into the Secondary Storage field.



Set Supervisor Approval by, optional
Checking or unchecking Supervisor Approval Required for Upload Batch

	[image: ]Application Tip
By default, the Supervisor Approval Required for Upload Batch is unchecked. Checking Supervisor Approval Required for Upload Batch indicates that a Check Capture Supervisor’s (CCS), or a check capture user with the Batch Approver permission, approval is required to upload a batch to the OTCnet server when there is internet connectivity. Additionally, the CCS needs to approve the batch from the terminal where the checks were captured. If unchecked, batches that are Closed but not Approved may be uploaded but must be approved once the batch is available in Online OTCnet.



Set Retention Periods by,
Entering the number of days for Batch Retention Period
Entering the number of days for Audit Log Retention Period

	[image: ]Application Tip
The Batch Retention Period refers to the period of time that a batch is available in both primary storage and secondary storage. After the Batch Retention Period passes for a batch, the batch is removed from Primary and Secondary Storage. This only applies to Acknowledged and Deactivated batches. All other batches remain in Primary and Secondary storage indefinitely.



	[image: ]Application Tip
By default, the Batch Retention Period is set to 30 days. By default, the Audit Log Retention Period is set to 365 days. 



Under Secure Batch Transmission,
Set the WSDL URL by, 
Selecting the Number of Re-Tries
Entering the number of milliseconds for Re-Try Interval

	[image: ]Application Tip
By default, the WSDL URL Number of Retries is set to 3. The Number of Re-Tries is the number of attempts the OTCnet Offline application will make to connect with the OTCnet Online server.  The Re-Try Interval allows for specifying the number of milliseconds before the OTCnet Offline attempts another connection to the OTCnet Online server (to maximum of 100,000 ms) in order to transmit the batch. 



Under Proxy Server Configuration, if applicable
Check Use Firewall Agent
Enter the Firewall Agent
Check User Proxy
Enter the Proxy Timeout
Enter the Proxy User
Enter the Proxy Password
Enter the Proxy Server
Enter the Proxy Port

	[image: ]Application Tip
If Proxy Server Configuration settings are entered when the Check Capture Administrator’s profile was retrieved, then the Proxy Server Configuration settings are saved in the system, are displayed here, and can be modified. 



	[image: ]Application Tip
If the Use Firewall Agent option is enabled, then the Fire Agency is available for configuration and the agent name can be entered. 



	[image: ]Application Tip
If the Use Proxy option is enabled, then Proxy Timeout, Proxy User, Proxy Password, Proxy Server, and Proxy Port are available for configuration. 



Click Next. The Step 3 of 4: Update the Configured OTC Endpoints page appears. 

Under Available OTC Endpoints,
Select the OTC Endpoint(s) you want to Add by checking the box(es) under the Add column, and click Add

	[image: ]Application Tip
The OTC Endpoints are permission based and are only visible to users with the appropriate permissions.



Under Configure OTC Endpoint,
Select a Default OTC Endpoint, required

	[image: ]Application Tip
Selecting a Default OTC Endpoint determines which OTC Endpoint to use when performing Scan Checks actions.



	[image: ]Application Tip
Multiple OTC Endpoints can be selected but only one can be set as a Default OTC Endpoint.


Select the OTC Endpoint(s) you want to Delete by checking the box(es) under the Remove column, and click Remove, if applicable

	[image: ]Application Tip
At least one Default OTC Endpoint is required per terminal.



Click Next. The Step 4 of 4: Review the Terminal Configuration page appears. Verify the Terminal Configuration is correct and click Submit. Click Edit if you need to modify the information entered.

A Confirmation page appears stating that the Terminal Configuration record has been updated.

	[image: ]Application Tip
Additional button on the page that help you perform other tasks:
Click Return Home to the OTCnet Home Page.


[bookmark: _Toc459908183]


[bookmark: _Toc29548347]View a Check Capture Terminal’s Configuration
To view a Check Capture Terminal’s Configuration:

Click the Administration tab. 

Click Manage Check Processing. Next, go to Terminal Configuration and click View. The View page appears (see Figure 90 and Figure 91). 
[bookmark: _Toc59449260]Figure 90. View Terminal Configuration
[image: ]
[bookmark: _Ref486011492][bookmark: _Toc59449261]Figure 91. View Terminal Configuration Page
[image: ]
[bookmark: _Toc29548348]
[image: MCj04420720000[1]]	View a Check Capture Terminal’s Offline Configuration Settings
To view check capture terminal configuration settings:

Click the Administration tab.

Select Manage Check Processing>Terminal Configuration and click View. The View page appears.

	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
Click Return Home to the OTCnet Home Page.


[bookmark: _Toc459908184]

[bookmark: _Toc29548349]Topic 8. Search an Audit Log
The audit log records all interactions between the user and OTCnet and allows users to search and view Audit Log entries for the completed audit trail within OTCnet. The Audit Log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report. 

If the audit log records contain Personally Identifiable Information (PII), the data is masked in the Transaction Description. To view more details about a specific batch, including PII, access Batch Management.

Each user role can view specific audit logs. For example, if you are assigned the role of Check Capture Administrator (CCA), you can view partial administration-related activities and all check capture-related activities. If you are assigned the role of Check Capture Supervisor (CCS), however, you can view partial check capture-related activities pertaining to your actions or actions taken by Check Capture Lead Operators (CCLO) or Check Capture Operators (CCO). If you are assigned the role CCLO or CCO, you can only view your own check capture-related activities.

You can search audit logs by module, user, OTC Endpoint, as well as other search criteria. If you run additional searches, the Search Results table repopulates with the results of the new search. Before you can view an audit log, you must access OTCnet Offline and enter your online User ID and offline password. 
[bookmark: _Toc459908185][bookmark: _Toc465762969][bookmark: _Toc29548350]
Search an Audit Log
To search an Audit Log:

Click the Administration tab.

Click Audit (see Figure 92).
[bookmark: _Toc59449262]Figure 92. Audit Log
[image: ]

The Search Audit Log page appears. Enter the search criteria for the activities you would like to view and click Search.

Under Search Criteria: (see Figure 93).
Select Module Type, required

Module options include Administration, Check Capture, and Check Processing. Additionally, the Module drop-down options vary by user role.

Enter a User
Select and OTC Endpoint
Enter the From and To Dates and Times, required 

The From and To Dates must be entered in MM/DD/YYYY format and cannot exceed 30 days

Select a Keyword, required
Select a Category Name
Enter the Terminal ID
Enter the Batch ID
Select an Event Type
Select an Operation Mode
[bookmark: _Ref425604967][bookmark: _Toc455496960]

[bookmark: _Toc59449263]Figure 93. Search Audit Logs
[image: ]

Event types are categories of events that are recorded by the audit log (see Table 2).
[bookmark: _Ref425605001][bookmark: _Toc455496967][bookmark: _Toc467665576]Table 2. Event Types
	Event Type
	Description

	All
	Includes all event types in the audit log 

	Error
	Error entries are created when the system is unable to complete an action

	Informational
	Information entries are general records of the activity that has happened while using OTCnet

	Warning
	Warning entries are created to inform the user when events of note have taken place. This includes cancelling an action, deleting information from the system and inactive users



To view additional details for an individual audit log entry, click the Audit Log ID hyperlink (see Figure 94).

Click Download to download the search results. Click Print Audit Log Records to print a formatted audit log record. 
[bookmark: _Ref425605035][bookmark: _Ref425605026][bookmark: _Toc455496961][bookmark: _Toc59449264]Figure 94. Audit Log ID
[image: ]


[bookmark: _Toc29548351][image: MCj04420720000[1]]	Search an Audit Log
To search an audit log using OTCnet Offline:

Click the Administration tab.

Click Audit. The Search Audit Logs page appears.

Enter the search criteria for the activities you would like to view.

Under Search Conditions, optional
Select a Module type.

	[image: ]Application Tip
Module options include Administration, Check Capture, and Check Processing. 



	[image: ]Application Tip
The Module drop-down options vary by user role. 



Enter a User
Select an OTC Endpoint

	[image: ]Application Tip
If you do not know the full name of OTC Endpoint, you can enter a partial name search (as few as one letter) in the Starts with text box and click the Select From List icon (magnifying glass).



Enter the From and To date and time ranges, required

	[image: ]Application Tip
The From and To Created On Date must be entered in MM/DD/YYYY format and cannot exceed 30 days.



Select a Keyword, required
Select a Category Name, required

	[image: ]Application Tip
The Keyword and Category Name drop-down options vary by user role. 



Enter the Terminal ID
Enter the Batch ID
Select an Event Type

	[image: ]Application Tip
Event Types are categories of events that are recorded by the audit log.
[bookmark: _Toc467665577]	Table 3. Event Types
	Event Type
	Description

	All
	Includes all event types in the audit log 

	Error
	Error entries are created when the system is unable to complete an action.

	Informational
	Information entries are general records of the activity that has happened while using OTCnet.

	Warning
	Warning entries are created to inform the user when events of note have taken place. This includes cancelling an action, deleting information from the system and inactive users.






Select an Operation Mode

	[image: ]Application Tip
Operation Mode option includes Offline.



Click Search. The Search Results table appears below.

	[image: ]Application Tip
If you run a search without specifying any criteria, the search results include all activities in the system that you have access to view. If you run additional searches, the Search Results table repopulates with the results of the new search.




	[image: ]Application Tip
Click Download to download the search results. Click Print Audit Log Records to print a formatted audit log record. 



Click the Audit Log ID hyperlink to view additional details for an individual audit log entry. The View Audit Log Details page appears.

	[image: ]Application Tip
If the audit log records contain Personally Identifiable Information (PII) in the Transaction Description, the data is masked. To view more details about a specific batch including PII access Batch Management.



	[image: ]Application Tip
Additional buttons on the pages that help you perform other tasks:
Click Cancel to return to the OTCnet Home Page. No data will be saved. 
Click Clear to clear all data fields and reset to the default selections.
Click Previous to return to the previous page.
Click Return Home to the OTCnet Home Page.




[bookmark: _Toc459908186][bookmark: _Toc29548352]Topic 9. Recover a Batch
If you are assigned the role of Check Capture Supervisor (CCS), you can recover a batch from a non-functioning terminal and restore items to a backup terminal. Batch Recovery would occur when a Check Capture terminal unexpectedly fails any time prior to batches being uploaded Online. If the backup or contingency terminal is being used to process batches, all batches must be closed and transmitted before using the terminal for batch recovery. The primary terminal and the contingency terminal must both have the same secondary storage or a compatible secondary storage for the batch recovery to work. Additionally, the full name of the user on the new system must match the name of the user that created the batch. Also, the Agency Location Code (ALC) and Terminal ID must match that of the batch to be recovered.

For the Batch Recovery function to work:
•	The backup or contingency terminal being used to process batches must be closed and transmitted before using the terminal for batch recovery
•	The primary terminal and the contingency terminal must both have the same storage or a compatible secondary storage
•	The full name of the user on the new terminal must match the name of the user that created the batch
•	The Agency Location Code (ALC) and Terminal ID must match that of the batch to be recovered

The Recover Batch function supports the recovery of batches that contain transactions with associated accounting codes from secondary storage.


[bookmark: _Toc459908187]

[bookmark: _Toc465762971][bookmark: _Toc29548353]Recover a Batch
To recover a batch:
Click the Administration tab.

Select Utilities. Next, select Batch Utilities and then click Batch Recovery (see
Figure 95).
[bookmark: _Ref415845155][bookmark: _Toc455496962][bookmark: _Toc59449265]Figure 95. Batch Recovery
[image: ]
The Review Recovery page appears. Click Submit (see Figure 96).
[bookmark: _Ref415845091][bookmark: _Toc455496963][bookmark: _Toc59449266]Figure 96. Batch Recovery Review
[image: ]

The Percentage Complete dialog box appears (see Figure 97). Click Close.
[bookmark: _Ref415845114][bookmark: _Toc455496964][bookmark: _Toc59449267]Figure 97. Batch Recovery Percentage Complete
[image: ]
Wait until the display percent completion reaches 100% before clicking Close. If the Cancel button is clicked before the batch recovery is complete, a dialog box appears asking if you want to cancel the batch recovery. Click Yes to cancel the batch recovery or click No to continue 
recovering the batch.

A Review page shows the total number of batches that have been successfully recovered from the secondary storage (see Figure 98).
[bookmark: _Ref425605084][bookmark: _Toc455496965][bookmark: _Toc59449268]Figure 98. Successfully Recovered Batches
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[bookmark: _Toc29548354][image: MCj04420720000[1]]	Recover a Batch
To recover a batch:

Click the Administration tab.

Select Utilities>Batch Utilities and click Batch Recovery. The Review Recovery page appears.

	[image: ]Application Tip
For the Batch Recovery function to work:
The backup or contingency terminal being used to process batches must be closed and transmitted before using the terminal for batch recovery
The primary terminal and the contingency terminal must both have the same storage or a compatible secondary storage
The full name of the user on the new terminal must match the name of the user that created the batch
The Agency Location Code (ALC) and Terminal ID must match that of the batch to be recovered



	[image: ]Application Tip
The Recover Batch function supports the recovery of batches that contain transactions with associated accounting codes from secondary storage.



Click Submit. The Percentage Complete dialog box appears.

Click Close. The Review page shows the total number of batches that have been successfully recovered from the secondary storage.

	[image: ]Application Tip
Wait until the display percent completion reaches 100% before clicking Close. If the Cancel button is clicked before the batch recovery is complete, a dialog box appears asking if you want to cancel the batch recovery. Click Yes to cancel the batch recovery or click No to continue recovering the batch.




A Review page shows the total number of batches that have been successfully recovered from the secondary storage.

	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
Click Return Home to return to the OTCnet Home Page.


[bookmark: _Toc459908188]

[bookmark: _Toc29548355]Summary
This chapter provided information on: 
The purpose of Setting Up and Configuring Check Capture Offline
Downloading and Installing OTCnet Offline Check Capture Software
Retrieving a Check Capture Administrator Profile
Managing OTC Endpoints
Managing User Profiles
Managing Offline Users
Managing a Check Capture Terminal Offline
Searching an Audit Log
Recovering a Batch
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[bookmark: _Toc29548357]Glossary
A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one, or many agency-defined accounting codes, or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or Check Capture Operator.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.

B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a Check Capture Lead Operator or Check Capture Operator roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so) or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a Check Capture Supervisor present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System. 

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

Check Capture Administrator – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

Check Capture Lead Operator – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

Check Capture Operator – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

Check Capture Supervisor – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.



D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. 

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).
K
Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

 Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, deposit processing, scanning checks, processing card payments and printing receipts. 
L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 

Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.

R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.
S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 
SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.
T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 
Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 
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[bookmark: _Toc17614191]Audience, Overview, and Topics
[bookmark: _Toc17614192]Audience
The intended audience for the Configuring Card Processing Settings Participant User Guide includes:
View / Modify Configuration Functions
· Card Administrator
· Check Capture Administrator
· Check Capture Supervisor
View Configuration Only
· Card Operator 
· Check Capture Lead Operator
· Check Capture Operator
[bookmark: _Toc17614193]Overview
Welcome to Configuring Card Processing Settings. In this chapter, you will learn:
· The purpose of configuring card processing settings
· How to set up or modify a card terminal configuration
· How to view a card terminal configuration
· How to search an audit log
· How to download and install the OTCnet Local Bridge (OLB) application
· How to create the OTCnet Local Bridge (OLB) profile
[bookmark: _Toc17614194]Topics
This chapter is organized by the following topics:
9. Purpose of Configuring Card Processing Settings
10. Set Up or Modify a Card Terminal Configuration
11. Unregister a Card Terminal
12. View a Card Terminal Configuration
13. Search an Audit Log
14. Download and Install the OTCnet Local Bridge (OLB) Application
15. Create the OTCnet Local Bridge (OLB) Profile
16. Import OTCnet Local Bridge (OLB) Credentials
17. Select the 80mm Card Receipt Printer
18. 

[bookmark: _Toc17614195]Topic 1. Purpose of Configuring Card Processing Settings 
If assigned the role of Card Administrator (CA), you are authorized to configure the card processing settings for your Agency’s card terminal. Additionally, as a CA, you can manually download or upgrade application software (e.g., the OTCnet Local Bridge Application) which is used to communicate between OTCnet and a card terminal. You need to register your card terminal.
*Note a Check Capture Administrator (CCA) can also download or upgrade the OLB.
To meet your agency’s card transaction needs, each card terminal must have configuration settings individually applied. The card terminal must be paired with OTCnet before the card terminal can be used for processing payments in OTCnet Online. The following is a list of data elements needed to pair the card terminal to OTCnet:
· [bookmark: _Hlk15285520]Card Terminal Internet Protocol (IP) address—Internet Protocol Address is a unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet).
· OTC Endpoint Credit-Debit-Card (CDC)—The endpoint (location) setup in OTCnet for CDC processing
· OTCnet Generated Eight-Character Pairing Pin— A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. During card terminal setup, the card terminal will prompt the user for the pairing pin.  



[bookmark: _Toc17614196][bookmark: _Hlk16778040]Topic 2. Set Up or Modify a Card Terminal Configuration
If you are a CA or CCA, you are authorized to register/configure a terminal. To configure a card terminal, the CA must first start the OTCnet Local Bridge (OLB) application. If the OLB is not started, you will not be able to pair the card terminal with OTCnet. For more details about starting the OLB, refer to the Administration Chapter 2: Accessing and Navigating OTCnet user guide.

Note: The CCA and Check Capture Supervisor (CCS) are authorized to register/configure a check capture terminal.  

Before starting the OLB application, ensure the following steps have been completed in this order. 

· The OLB application is downloaded (by a CA or CCA)
· The OLB certificate is installed on the workstation (for OLB versions 1.2.0 and older)
· The OLB application is installed on the workstation
· Each user has created an OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated) 
· Each user has imported their OLB credentials to the workstation

After the OLB is started, ensure the following:
· The card terminal must be ethernet connected to the Internet/network and ready for pairing with the OTCnet server
· The CA or CCA must use either a Static (Fixed Internet Protocol Address [IP]) or Dynamic Host Configuration Protocol (DHCP) when configuring the card terminal. A static IP Address is recommended as it will not change

For step-by-step instructions, refer to Topic 6: Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, Topic 7: Create the OTCnet Local Bridge (OLB) Profile, and Topic 8: Import OTCnet Local Bridge (OLB) Credentials, in this user guide.



To register/configure a card terminal online, complete the following steps:

· Click the Administration tab. 
· Select Manage Card Processing>Terminal Configuration and click Modify (see Figure 1). 
[bookmark: _Toc59449614]Figure 1. Administration >Manage Card Processing>Card Terminal Configuration>Modify
[image: ]
[bookmark: _Hlk16596160][bookmark: _Hlk17103819]If you are configuring a card terminal and the OLB application has not been started, the following message appears: “Card terminal detection failed. Ensure that the OLB application is running.” Refer to the Chapter Two: Accessing and Navigating OTCnet Topic 1: Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid in for step-by-step instructions on starting the OLB application.

· The Step 1 of 3: Select OTC Endpoint page appears. Select an OTC Endpoint (see Figure 2) and click Add. The Endpoint appears under Configured OTC Endpoint. (see Figure 3). Click Next.
[bookmark: _Toc59449615]Figure 2. Step 1 of 3: Select OTC Endpoint
[image: ]
[bookmark: _Ref32261591][bookmark: _Toc59449616]Figure 3. Step 1 of 3: Review OTC Endpoint
[image: ]

· [bookmark: _Hlk17618994]The Step 2 of 3: Terminal Registration page appears. Enter the Card Terminal IP Address (see Figure 4) and click Register. OTCnet searches for the Pairing Pin (see Figure 5). A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. Note: It may take 15-20 seconds to receive a Pairing Pin.
[bookmark: _Ref18660569][bookmark: _Toc59449617]Figure 4. Step 2of 3: Terminal registration, Enter Card Terminal IP Address
[image: ]
[bookmark: _Ref18401708][bookmark: _Toc59449618]Figure 5. Step 2 of 3: Card Terminal Registration, Getting Pairing Pin
[image: ]



· Enter the Pairing Pin, that appears in OTCnet into the card terminal (see Figure 6). Press the green button. The green button indicates OK.
[bookmark: _Ref19273226][bookmark: _Toc59449619]Figure 6. Step 2 of 3: Card Terminal Registration, Pairing Pin and enter the Pairing Pin in the card terminal
[image: ]



· The system compares Merchant IDs (see Figure 7.). A Merchant ID is a unique designator assigned by Worldpay to reflect the processing location. Each agency has several Merchant IDs under a single Chain Code, to distinguish which agency location processed card transactions. 
[bookmark: _Ref32261613][bookmark: _Toc59449620]Figure 7. Step 2 of 3: Terminal Registration, Comparing Merchant IDs message
[image: ]

· [bookmark: _Hlk18550066]The “Registration Successful!” message appears (see Figure 8). Click Next.
[bookmark: _Ref18659662][bookmark: _Toc59449621]Figure 8. Step 2 of 3: Card Terminal Registration, Registration Successful! message
[image: ]
[bookmark: _Hlk17618913]
· The “Connection successful!” message appears. (see Figure 9). Click Next.
[bookmark: _Ref19273537][bookmark: _Toc59449622]Figure 9. Step 2 of 3: Card Terminal Registration, Connection Successful! message
[image: ]

· [bookmark: _Hlk17628398]The Step 3 of 3: Review the Terminal Configuration page appears (see Figure 10). Verify the card terminal configurations. The Card Terminal Serial Number, Host Name, and IP Address are automatically populated after card terminal registration is complete. Click Submit. Card Terminal Serial Number refers to the workstation serial number.

Click the Edit hyperlink if you need to modify the information entered.   
[bookmark: _Ref19273586][bookmark: _Toc59449623]Figure 10. Step 3 of 3: Review the Card Terminal Configuration
[image: ]

· The Confirmation page appears. View the card terminal configuration attributes defined and any final changes. Click Return Home to return to the Home Page (see Figure 11). 
[bookmark: _Ref19273607][bookmark: _Toc59449624]Figure 11. Confirmation page
[image: ]
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[bookmark: _Toc17614197][bookmark: _Hlk17638235][image: MCj04420720000[1]]	Register a Card Terminal 
	[bookmark: _Hlk14870537][image: ]Application Tip
The Card Administrator (CA) is authorized to configure a card terminal. The Check Capture Administrator (CCA) and Check Capture Supervisor (CCS) are authorized to register/configure a check capture terminal.  



	[image: ]Application Tip
            Before registering/configuring the card terminal, start the OLB application and ensure  the following steps have been completed in this order. 
The OLB application is downloaded and installed on the workstation, by the CA or the CCA
The OLB certificate is installed on the workstation (for OLB versions 1.2.0 and older)
Each user has created an OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated)
Each user imported his/her OLB credentials to the workstation 
If the OLB is not started, you will not be able to pair the card terminal with OTCnet. For more details, refer to the Administration Chapter 2: Accessing and Navigating OTCnet user guide for more information.
After the OLB is started, ensure the following:
The card terminal must be ethernet connected to the Internet/network and ready for pairing with the OTCnet server
The CA use either a “Static” (Fixed IP) or “DHCP” on the card terminal screen
For step-by-step instructions, refer to Topic 6: Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, Topic 7: Create the OTCnet Local Bridge (OLB) Profile, and Topic 8: Import OTCnet Local Bridge (OLB) Credentials, in this user guide.



To register/configure a card terminal, complete the following steps:

Click the Administration tab.
Select Manage Card Processing>Card Terminal Configuration and select Modify. 



	[image: ]Application Tip
If you are configuring a card terminal and you have not started the OTCnet Local Bridge (OLB) application, you receive the following message: “Card terminal detection failed. Ensure that the OLB application is running.” 

Refer to the Administration Chapter 2: Accessing and Navigating OTCnet User Guide, Start and Stop the OTCnet Local Bridge (OLB) Application printable job aid for step-by-step instructions on starting the OLB application.



The Step 1 of 3: Select OTC Endpoint page appears. Select the OTC Endpoint. Click Add. The Endpoint appears under Configured OTC Endpoint. Click Next.
The Step 2 of 3: Card Terminal Registration page appears. Enter Card Terminal Internet Protocol (IP) Address. 

	[image: ]Application Tip
Internet Protocol (IP) Address is a unique number or address that computing devices (e.g., laptops, tablets, mobile phones, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet).



Click Register. The system searches for the pairing pin. A pairing pin displays.

	[image: ]Application Tip
A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. Note: It may take 15-20 seconds to receive a pairing pin. The number is entered the card terminal. 




Enter the Pairing Pin on the card terminal. Press the green button. The green button indicates “OK” on the card terminal. The system compares Merchant IDs. 




	[image: ]Application Tip
A Merchant ID is a unique designator assigned by Worldpay to reflect the processing location. Each agency has several Merchant IDs under a single Chain Code, to distinguish which agency location processed card transactions. The Merchant ID is entered at the lower-level endpoint in OTCnet.



The “Registration Successful!” message appears. Click Next. 
The “Connection successful!” message appears. Click Next.
The Step 3 of 3: Review the Terminal Configuration page appears. Click Submit.

	[image: ]Application Tip
The page loads and the system verifies the OLB connection. Once the OLB connection is established, the system verifies configuration. When the configuration is retrieved, view the current information; Card Terminal Serial Number, Host Name, and IP Address of the configured card terminal. Card Terminal Serial Number is automatically populated in OTCnet, from the card terminal, after the card terminal registration is complete.



	[bookmark: _Hlk14870677][image: ]Application Tip
Click the Edit hyperlink if you need to modify the information entered. Click the Unregister hyperlink if you want to unregister the terminal.




The Confirmation page appears. View the card terminal configurations, which are automatically populated.
 
	[image: ]Application Tip
Additional button on the page that helps you perform other tasks:
· Click Return Home to return to the OTCnet Home Page.



[bookmark: _Toc17614198]Topic 3. Unregister a Card Terminal 
The CA is authorized to unregister a card terminal after it has been paired with OTCnet, as needed. At times, you may need to unregister a terminal (i.e., you may want to add a different card terminal to an OTCnet terminal, or, you may mistakenly register a terminal and then wish to unregister it). First, you must begin the steps to re-register a card terminal before you can unregister it.

To unregister a card terminal after it’s been paired with OTCnet, there are two options:

Option 1: Unregister from the Terminal Registration page. 
Option 2: Unregister from the Review (Step 3 of 3: Review Terminal 
Configuration) page. 

 For Option 1, complete the following steps:

Click the Administration tab. 
Click Manage Card Processing>Terminal Configuration and select Modify (see Figure 12). 
[bookmark: _Toc59449625]Figure 12. Administration >Manage Card Processing>Card Terminal Configuration>Modify
[image: ]

The Step 1 of 3: Select OTC Endpoint page appears. Select an OTC Endpoint. Click Add. Select Next (see Figure 13) below.
[bookmark: _Ref18661451][bookmark: _Toc59449626]Figure 13. Step 1 of 3: Select an OTC Endpoint
[image: ]
[bookmark: _Hlk17114202]
The Step 2 of 3: Terminal Configuration page appears. Enter the Card Terminal IP Address for the card terminal you wish to register. Click Register (see Figure 14).
[bookmark: _Toc59449627][bookmark: _Hlk17114253]Figure 14. Card Terminal Registration, Enter IP Address
[image: ]



OTCnet searches for the pairing pin (see Figure 15). The pairing pin number, that appears in OTCnet is entered in the card terminal (see Figure 16). Note: It may take 15-20 seconds to receive a pairing pin. Press the green button. The green button indicates “OK” on the card terminal.
[bookmark: _Ref32258038][bookmark: _Toc59449628]Figure 15. Step 2 of 3: Card Terminal Registration, Getting Pairing Pin
[image: ]
[bookmark: _Ref19274587][bookmark: _Toc59449629]Figure 16. Step 2 of 3: Card Terminal Registration, Pairing Pin and enter the Pairing Pin in the card terminal
[image: ]



The “Registration Successful!” message appears (see Figure 17). Click Unregister. The “Terminal unregistered” message appears (see Figure 18).
[bookmark: _Ref18661709][bookmark: _Toc59449630]Figure 17. Step 2 of 3: Terminal Registration page, Test Connection and Unregister buttons activated
[image: ]

[bookmark: _Ref18577433][bookmark: _Toc59449631][bookmark: _Hlk18661815]Figure 18. Step 2 of 3: Terminal Registration page, Terminal unregistered
[image: ]

Option 2:
To unregister a card terminal after it’s been paired with OTCnet, complete the following steps:

Click the Administration tab. 
Click Manage Card Processing>Terminal Configuration and select Modify (see Figure 19). 
[bookmark: _Toc59449632]Figure 19. Administration >Manage Card Processing>Card Terminal Configuration>Modify
[image: ]



The Step 1 of 3: Select OTC Endpoint page appears. Select an OTC Endpoint. Click Add (see Figure 20) below. Click Next (see Figure 21).
[bookmark: _Ref18586879][bookmark: _Toc59449633]Figure 20. Step 1 of 3: Select an OTC Endpoint
[image: ]
[bookmark: _Ref19275245][bookmark: _Toc59449634]Figure 21. Step 1 of 3: Review OTC Endpoint
[image: ]



The Step 2 of 3: Terminal Configuration page appears. Enter the Card Terminal IP Address for the card terminal you wish to register. Click Register (see Figure 22.). OTCnet searches for the pairing pin (see Figure 23.). 
[bookmark: _Ref32261630][bookmark: _Toc59449635]Figure 22. Card Terminal Registration, Enter IP Address
[image: ]
[bookmark: _Ref32261647][bookmark: _Toc59449636]Figure 23. Step 2 of 3: Card Terminal Registration, Getting Pairing Pin
[image: ]
[bookmark: _Ref18587301]

Enter the pairing pin number, that appears in OTCnet into the card terminal (see Figure 24). Note: It may take 15-20 seconds to receive a pairing pin. Press the green button. The green indicates “OK” on the card terminal.
[bookmark: _Ref19275464][bookmark: _Toc59449637]Figure 24. Step 2 of 3: Card Terminal Registration, Pairing Pin and enter the Pairing Pin in the card terminal
[image: ]

The “Registration Successful!” message appears (see Figure 25). Click Next.
[bookmark: _Ref18597662][bookmark: _Toc59449638]Figure 25. Registration Successful!
[image: ]



The Step 3 of 3: Review the Terminal Configuration page appears. Click Unregister (see Figure 26). The “Registration Successful!” message appears (see Figure 27.). Click Unregister and then click Next. The “Terminal unregistered” message appears (see Figure 28).
[bookmark: _Ref32261870][bookmark: _Toc59449639]Figure 26. Step 3 of 3: Review the Terminal Configuration
[image: ]
[bookmark: _Ref32261900][bookmark: _Toc59449640]Figure 27. Step 2 of 3: Terminal Registration
[image: ]
[bookmark: _Ref18597967][bookmark: _Toc59449641]Figure 28. Terminal unregistered
[image: ]

[bookmark: _Toc17614199][image: MCj04420720000[1]]	Unregister a Card Terminal 
	[bookmark: _Hlk18659921][image: ]Application Tip
The CA is authorized to unregister a card terminal.




	[image: ]Application Tip
At times, users may need to unregister a terminal (i.e., a user may want to add a different card terminal to an OTCnet terminal or users may mistakenly register a terminal and then wish to unregister it). You must first begin the steps to re-register a card terminal before you can unregister it.



To unregister a card terminal after it’s been paired with OTCnet, there are two options:

Option 1: Unregister from the Registration Successful! page. 
Option 2: Unregister from the Review (Step 3 of 3: Review Terminal 
Configuration) page. 

 For Option 1, complete the following steps:
Click the Administration tab.
Click Manage Card Processing>Card Terminal Configuration and select Modify. 
The Step 1 of 3: Select OTC Endpoint page appears. Select an OTC Endpoint. Click Add. Select Next.
The Step 2 of 3: Terminal Configuration page appears. Enter the card terminal’s Internet Protocol (IP) Address in to the Enter Card Terminal IP Address text box for the card terminal you wish to register. Click Register.
OTCnet searches for the pairing pin. Once the pairing pin appears in OTCnet, enter it in to the card terminal and press the green button. The green button indicates “OK” on the card terminal. 
	[image: ]Application Tip
It may take 15-20 seconds to receive a pairing pin. 



The “Registration Successful!” message appears. Click Unregister. Click Next.
The “Terminal unregistered” message appears.
 
	[image: ]Application Tip
Additional buttons on the page help you perform other tasks: 
Click Test Connection to test the pairing connection between the card terminal and OTCnet.
Click Unregister to unregister the card terminal.
Click Cancel to terminal registration. A "Registration cancelled" 
will appear and the terminal registration
will stop.
Click Previous to return to the previous page. 
Click Return Home to return to the OTCnet Home Page. 




Option 2:
To unregister a card terminal after it’s been paired with OTCnet, complete the following steps:

Click the Administration tab. 
Click Manage Card Processing>Terminal Configuration and select Modify. 

The Step 1 of 3: Select OTC Endpoint page appears. Select an OTC Endpoint. Click Add. Click Next.

The Step 2 of 3: Terminal Configuration page appears. Enter the Card Terminal IP
      Address for the card terminal you wish to register. Click Register. OTCnet searches for
      the pairing pin. 

Enter the pairing pin number, that appears in OTCnet, in to the card terminal. Press the green button. The green button indicates “OK” on the card terminal.

	[image: ]Application Tip
It may take 15-20 seconds to receive a pairing pin. 





The “Registration Successful!” message appears. Click Next.

The Step 3 of 3: Review the Terminal Configuration page appears. Select Unregister. 

The “Registration Successful!” Page appears. Click Unregister. Click Next. The “Terminal unregistered” message appears.



	[image: ]Application Tip
Additional buttons on the page help you perform other tasks: 
Click Edit to navigate to the Step 1 of 3: Select OTC Endpoint page to remove an OTC endpoint or add another available OTC endpoint.
Click Unregister to unregister the card terminal.
Click Cancel to terminal registration. A "Registration cancelled" 
will appear and the terminal registration
will stop.
Click Previous to return to the previous page. 
Click Return Home to return to the OTCnet Home Page. 




[bookmark: _Toc17614200]Topic 4. View Card Terminal Configuration
The CA and CO can view a card terminal configuration.

To view a card terminal’s configuration, complete the following steps: 

3. Click the Administration tab. From the Manage Card Processing menu, select Terminal Configuration and select View (see Figure 29). 
[bookmark: _Toc59449642]Figure 29. Administration >Manage Card Processing>View
[image: ]
4. The View Card Terminal Configuration page appears and OTCnet verifies the OLB connection (see Figure 30). Next, OTCnet verifies the card terminal configuration (see Figure 31). This typically takes about 10-15 seconds. Finally, the card terminal(s) that has been configured appears. View the details and click Return Home when you are finished reviewing (see Figure 32).
[bookmark: _Ref17140432][bookmark: _Toc59449643]Figure 30. OTCnet verifies the OLB connection
[image: ]
[bookmark: _Ref17707340][bookmark: _Toc59449644]Figure 31. OTCnet verifies card terminal configuration
[image: ]
[bookmark: _Ref18403673][bookmark: _Toc59449645]Figure 32. View Terminal Configuration
[image: ]
[bookmark: _Toc17614201]
[image: ]View Card Terminal Configuration
The CA and CO can view a card terminal configuration by completing the following steps:

4. Click the Administration tab.

5. Click Manage Card Processing>Terminal Configuration and select View. 

6. The View Card Terminal Configuration page appears. 
	[image: ]Application Tip
The additional button on the page that helps you perform other tasks: Click Return Home to return to the OTCnet Home Page.





[bookmark: _Toc17614202][bookmark: _Hlk16955663]Topic 5. Search an Audit Log
The audit log records are interactions between the user and OTCnet. They allow users to search and view audit log entries for the completed audit trail within OTCnet. The audit log is available for download to a comma separated value (CSV) report. It opens in a spreadsheet program or can be printed in a formatted audit log report. 

If the audit log records contain Personally Identifiable Information (PII), the data is masked in the Transaction Description. 

The CA and CO can search audit logs related to card processing activities. Depending on your role, you can search for and view only specific audit logs (see Table 1) for details.	
[bookmark: _Ref19176868][bookmark: _Toc19180800]Table 1. Audit Log User Permissions
	User Role
	Audit Log Access

	Check Capture Administrator (CCA)
	Partial administration-related activities and all check capture-related activities

	Check Capture Operator (CCO)
	Own check capture-related activities

	Check Capture Lead Operator (CCLO)
	Own check capture-related activities

	Check Capture Supervisor (CCS)
	Partial check capture-related activities pertaining to own actions or actions taken by their CCO or CCLO

	FS Viewer or Security Viewer
	Administration-related, check capture-related, check processing-related, and deposit processing-related activities

	Card Administrator (CA)
	Partial administration-related activities and all card-related activities

	Card Operator (CO)
	Partial access to user’s own card-related activities



You can search audit logs by module, user, OTC Endpoint, and other search criteria. If you run a search without specifying any criteria, by default, the search results include all activities in the system that you have access to view. If you run additional searches, the Search Results table repopulates with the results of the new search.


To search an audit log for card processing activities, complete the following steps:
7. Click the Administration tab.

8. Click Audit (see Figure 33). 
[bookmark: _Toc59449646]Figure 33. Save Dialog Box
[image: ]
9. The Search Audit Logs page appears. Enter the search criteria for the activities you want to view (see Figure 34).

Under Search Criteria, select Module. Select from Administration or Card Processing. The Module drop-down options vary by user role.

Note: Module options for check processing include Administration and Check Capture. 

29. Select a User (login ID)
30. Select an OTC Endpoint
31. Enter the From and To Dates and Times, required
32. Select a Keyword, required
33. Select a Category Name, required

The Keyword and Category Name drop-down options vary by user role. 

34. Enter the Terminal ID, for the workstation
35. Enter the Batch ID, specific to Check Processing
36. Select an Event Type (see Table 2)



Event types are categories of events that are recorded by the audit log (see Table 2).
[bookmark: _Toc19180801]Table 2. Event Types
	Event Type
	Description

	All
	Includes all event types in the audit log 

	Error
	Error entries are created when the system is unable to complete an action

	Informational
	Information entries are general records of the activity that has happened while using OTCnet

	Warning
	Warning entries are created to inform the user when events of note have taken place. This includes cancelling an action, deleting information from the system and inactive users


37. Select an Operation Mode and click Search.
Operation Mode options include All, Online, or Offline*. 
* Offline applies to OTCnet Check Capture Processing only.
If you run a search without specifying any criteria, the search results include all activities in the system that you have access to view. If you run additional searches, the Search Results table repopulates with the results of the new search.



10. Click Search (see Figure 34). 
[bookmark: _Toc59449647]Figure 34. Search Audit Logs page
[image: ]

11. The Search Results table appears. Click the Audit Log ID hyperlink to view additional details for an individual audit log entry (see Figure 35). Click Download to download the search results. Click Print Audit Log Records to print a formatted audit log record. 
[bookmark: _Ref18663272][bookmark: _Toc59449648]Figure 35. Audit Log Input
[image: ]



12. The View Audit Log Details page appears (see Figure 36).
[bookmark: _Ref32261965][bookmark: _Toc59449649]Figure 36. View Audit Log Details
[image: ]

[bookmark: _Toc17614203]
[image: MCj04420720000[1]]	Search an Audit Log
The Check Card Administrator (CA) and Card Operator (CO) can search audit logs related to card processing activities. The CCA, Check Card Operator (CCO), Check Card Lead Operator (CCLO), and Check Card Supervisor (CCS) can search audit logs related to check processing activities. Depending on your role, you can search for and view only specific audit logs. To search an audit log, complete the following steps:
· Click the Administration tab. 
· Click Audit. The Search Audit Logs page appears.
· Enter the search criteria for the activities you would like to view.
Under Search Criteria, optional
Select a Module type.
	[image: ]Application Tip
The CA and CO can search an audit log. 



	[bookmark: _Hlk18555893][image: ]Application Tip
Card Processing Module options include Administration and Card Processing. Check processing Module options include Administration, Check Capture, Check Processing, and Deposit Processing. The Module drop-down options vary by user role.





38. Enter a User (login ID)
39. Select an OTC Endpoint
40. Enter the From and To date and time ranges, required
	[image: ]Application Tip
The From and To Create On Date must be entered in MM/DD/YYYY format and cannot exceed 30 days.



41. Select a Keyword, required
42. Select a Category Name, required

	[image: ]Application Tip
The Keyword and Category Name drop-down options vary by user role. 



43. Enter the Card Terminal ID, for the workstation
44. Enter the Batch ID

	[image: ]Application Tip
The Batch ID is specific to Check Processing.




45. Select an Event Type (see Table 4).
	[image: ]Application Tip
Event Types are categories of events that are recorded by the audit log.
Table 4. Event Types
	Event Type
	Description

	All
	Includes all event types in the audit log 

	Error
	Error entries are created when the system is unable to complete an action.

	Informational
	Informational entries are general records of the activity that has happened while using OTCnet.

	Warning
	Warning entries are created to inform the user when events of note have taken place. This includes cancelling an action, deleting information from the system and inactive users.





46. Select an Operation Mode
	[image: ]Application Tip
Operation Mode options include All, Online, or Offline*. 
* Offline applies to OTCnet Check Capture Processing only.





· Click Search. The Search Results table appears below.
	[image: ]Application Tip
If you run a search without specifying any criteria, the search results 
include all activities in the system that you have access to view. If you run additional searches, the Search Results table repopulates with the results 
of the new search.



	[image: ]Application Tip
Click Download to download the search results. Click Print Audit Log Records to print a formatted audit log record. 


· Click the Audit Log ID hyperlink to view additional details for an individual audit log entry. The View Audit Log Details page appears.
	[image: ]Application Tip
If the Audit Log records contain Personally Identifiable Information (PII) the data is masked.





[bookmark: _Toc17614204][bookmark: _Hlk17868145][bookmark: _Hlk15274290][bookmark: _Hlk17658081][bookmark: _Hlk17007419]Topic 6. Download and Install OTCnet Local Bridge 
[bookmark: _Toc17614205]Download OTCnet Local Bridge (OLB) Application
The CCA and CA are authorized to download the OTCnet Local Bridge (OLB). The OLB is a stand-alone application that must be installed on all user workstations performing card processing, check capture, check processing and terminal configuration operations. For more information on configuring a check processing terminal, refer to the Administration Chapter 7: Configuring Check Processing Settings user guide.

OTCnet supports Google Chrome (Chrome) and Internet Explorer (IE) browsers. When using Chrome, the CA or CCA does not need to make browser configuration changes (with the OLB prerequisites) however, the OLB must be installed. For OLB versions 1.3.0 and newer, the OLB certificate is included in the OLB installer file (EXE file). 

For OLB versions 1.2.0 and older, however, for the OLB application to function properly with OTCnet, users are required to separately install the OLB Certificate on the terminal. Review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) for additional information.

Note that the download release process was streamlined for ease and efficiency. We recommend you download the newest version of the OLB.

When using IE, the CA or CCA does have to update browser configuration settings. Review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) to verify that you meet system and configuration requirements and the OLB prerequisites.  

Refer to the Download the OTCnet Local Bridge (OLB) Application printable job aid for specific directions. 

After the CA or CCA downloads the OLB application, users (CO, CCS, CCLO, CCO and the CA or CCA) can complete the remaining steps in setting up the OLB application:
47. Install the OLB certificate (applicable only to OLB versions 1.2.0 and older)
48. Install the OLB application 
49. Create the OLB profile
50. Start the OLB application 

[bookmark: _Hlk17802745]Note: 
For Check Processing workstations, the OLB application can be installed before or after the OTCnet Firmware is installed. Firmware is not required for Card Processing workstations.
After you download the OLB application, complete the remaining steps in setting up the OLB application on the workstation. Windows Administrator privileges are required to install the OLB application. Users may need to contact the CA or the Agency’s IT team in order to complete this step.
The OLB is available for download within the OTCnet application under the Administration tab. Click Manage Centralized Deployment>Download Release.
Depending on your user role, you may not have access to both Manage Check Processing and Manage Card Processing functions. 

To download the OLB application, complete the following steps:

Click the Administration tab. Click Manage Centralized Deployment and select Download Release. 
[bookmark: _Toc59449650]Figure 37. Administration>Manage Centralized Deployment>Download Release
[image: ]

The Download Release page appears. From the Application drop-down menu, select OTCnet Local Bridge hyperlink (see Figure 38) and click Next.
[bookmark: _Toc59449651]Figure 38. Download Release page
[image: ]
By default, the Application drop-down menu is set to Firmware, select OTCnet Local Bridge.


The Select OTCnet Local Bridge for Download page appears. Click the OTCnet Local Bridge hyperlink to download the OLB Zip file (see Figure 39). 

Note: Before you install the new OLB version, you must uninstall the old OLB version.
[bookmark: _Toc59449652]Figure 39. Select OTCnet Local Bridge hyperlink
[image: ]
[bookmark: _Ref18664947]The Review Application Download page appears. Click Download (see Figure 40). 
[bookmark: _Toc59449653]Figure 40. Click Download
[image: ]

Select Save As from the Save drop-down. Click Save (see Figure 41).
[bookmark: _Ref18665186][bookmark: _Toc59449654]Figure 41. Save OLB Zip File
[image: ]
When you click Save, you choose the location where you want to save the file (see Figure 42). If you click Cancel, you return to the OTCnet Local Bridge Application Download page without saving the file.
[bookmark: _Ref18665217][bookmark: _Toc59449655]Figure 42. Choose File Location
[image: ]
Once you save the OLB Zip file on the workstation, you must extract the files. To do this, complete the following steps: 

Double-click the OLB zip file (see Figure 43).
[bookmark: _Ref18665080][bookmark: _Toc59449656]Figure 43. OLB Zip File
[image: ]


Click Extract Files (see Figure 44).
[bookmark: _Ref19179714][bookmark: _Toc59449657]Figure 44. Extract Files
[image: ]

Choose a location to save the files on the workstation and click Extract (see Figure 45).
[bookmark: _Ref19179738][bookmark: _Toc59449658]Figure 45. Extract
[image: ]


[bookmark: _Toc17614206][image: ]Download OTCnet Local Bridge (OLB) Application
The Check Capture Administrator (CCA) and Card Administrator (CA) are authorized to download the OTCnet Local Bridge (OLB) application.
[bookmark: _Toc17614207][bookmark: _Hlk17010220]
	[image: ]Application Tip
The CCA and CA are authorized to download the OTCnet Local Bridge (OLB). The OLB is a stand-alone application that must be installed on all user workstations performing card processing, check capture, check processing and terminal configuration operations. For more information on configuring a check processing terminal, refer to the Administration Chapter 7: Configuring Check Processing Settings user guide.
OTCnet supports Google Chrome (Chrome) and Internet Explorer (IE) browsers. When using Chrome, the CA or CCA does not need to make browser configuration changes (with the OLB prerequisites) however, the OLB must be installed. When using IE, the CCA or CA does have to update browser configuration settings. For OLB versions 1.3.0 and newer, the OLB certificate is included in the OLB installer file (EXE file). 
For OLB versions 1.2.0 and older, however, for the OLB application to function properly with OTCnet, users are required to separately install the OLB Certificate on the terminal. Review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) for additional information.
Note that the download release process was streamlined for ease and efficiency. We recommend you download the newest version of the OLB.



	[image: ]Application Tip
After the CA or CCA downloads the OLB application, users (e.g., CO, CCS, CCLO, CCO and the CA or CCA) can complete the remaining steps in setting up the OLB application:
Install the OLB certificate (applicable only to OLB versions 1.2.0 and older)
Install the OLB application 
Create the OLB profile
Start the OLB application 





	[image: ]Application Tip
For Check Processing workstations, the OLB application can be installed before or after the OTCnet Firmware is installed. Firmware is not required for Card Processing workstations.
Windows Administrator privileges are required to install the OLB application on a terminal. Users may need to contact their CCA, CA or IT team in order to complete this step
Depending on your user role, you may not have access to both Manage Check Processing and Manage Card Processing functions.



To download the OLB, complete the following steps:
Click Administration tab.
Click Manage Centralized Deployment and select Download Release. 
The Download Release page appears. From the Application drop-down menu, select OTCnet Local Bridge hyperlink. Click Next. 

	[image: ]Application Tip 
By default, the Application drop-down menu is set to Firmware, select OTCnet Local Bridge. 



The Select OTCnet Local Bridge for Download page appears. Click the OTCnet Local Bridge hyperlink to download the OLB Zip file. The Review Application Download page appears. Click Download.
	[image: ]Application Tip
Before you install the new OLB version, you must uninstall the old OLB version.



	[image: ]Application Tip
Additional buttons on the page that help you perform other tasks:
7. Click Previous to return to the previous page.
8. Click Return Home to the OTCnet Home page.




A Do you want to open or save OTCnetOLBX.X.X.zip? dialog box appears. From the Save drop-down, select Save As. 
Click Save.
	[bookmark: _Hlk18559583][image: ]Application Tip
Save As is selected, a Save As dialog window will be generated so that you can save the OLB zip file (e.g. OTCnetOLBXXX.zip) to your preferred location on the workstation. 
If you click Open, your default Zip utility (e.g. WinZip, PKZIP) window will open, and you can extract the files. If you click Cancel, you remain on the Review Application Download page. 
When you click Save, you choose the location where you want to save the file. If you click Cancel, you return to the OTCnet Local Bridge Application Download page without saving the file.



Double-click the OLB zip file.
Click Extract Files.
Choose a location to save the files on the workstation and click Extract.



[bookmark: _Hlk25644513]Install the OTCnet Local Bridge (OLB) Certificate
If installing OLB version 1.3.0 and newer, the file contains the OLB application installer file (EXE file) and the certificate. You do not need to separately install the certificate. 
 
For OLB version 1.2.0 and older the certificate is not included in the OLB installer file and the certificate must be separately installed on the workstation. A CCA, CCS, CCLO, CCO, CA or CO can install the OLB certificate on the workstation. The certificate must be installed on the workstation for the OLB application to function with OTCnet. The OLB application is downloaded as a zip file. 

For details on downloading the OLB refer to the Download the OTCnet Local Bridge (OLB) Application printable job aid in this User Guide. For information about all OLB system prerequisites, refer to the OTCnet System Requirements and Reference Guide at: https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf.

[bookmark: _Hlk17286948]To install the OTCnet Local Bridge (OLB) certificate:

12. [bookmark: _Hlk17279781][bookmark: _Hlk17287746]Locate the folder where the OLB certificate file (i.e., olb.otcnet.public.crt) resides, and double-click the file to start the installation (see Figure 46). Note: The older versions of the OLB package contain a certificate file with the “.cer” extension.  
[bookmark: _Ref17140604][bookmark: _Toc59449659]Figure 46. OTCnet OLB Certificate.crt Icon
[image: ]



13. The Certificate dialog box appears. Click Install Certificate (see Figure 47).
[bookmark: _Ref17709257][bookmark: _Toc59449660]Figure 47. Install Certificate Dialog Box
[image: ]
14. The Welcome to the Certificate Import Wizard dialog box appears. Click Next (see Figure 48).
[bookmark: _Ref17709314][bookmark: _Toc59449661]Figure 48. Welcome to the Certificate Import Wizard Dialog Box
[image: ]

15. The Certificate Store dialog box appears. Click the Place all certificate in the following store radio button.



16. Under Certificate Store, click Browse (see Figure 49).
[bookmark: _Ref18405921][bookmark: _Toc59449662]Figure 49. Certificate Store Dialog Box
[image: ]

17. The Select Certificate Store dialog box appears. Click the Trusted Root Certification Authorities folder and click OK (see Figure 50).
[bookmark: _Ref17709428][bookmark: _Toc59449663]Figure 50. Select Certificate Store Trusted Root Certification Authorities
[image: ]



18. Click Next (see Figure 51).
[bookmark: _Ref18405963][bookmark: _Toc59449664]Figure 51. Certificate Store Dialog Box Next
[image: ]


19. The Completing the Certificate Import Wizard dialog box appears. Click Finish (see Figure 52).
[bookmark: _Ref17709492][bookmark: _Toc59449665]Figure 52. Completing the Certificate Import Wizard dialog box
[image: ]



20. After The import was successful message appears, click OK (see Figure 53). 
[bookmark: _Ref18406010][bookmark: _Toc59449666]Figure 53. The import was successful message
[image: ]


[bookmark: _Toc17614208][image: ] Install the OTCnet Local Bridge (OLB) Certificate
The Check Capture Administrator (CCA), Check Capture Supervisor (CCS), Check Capture Lead Operator (CCLO), Check Capture Operator (CCO), Card Administrator (CA) and Card Operator (CO) are authorized to download the OTCnet Local Bridge (OLB) certificate.

	[image: ]Application Tip 
If installing OLB version 1.3.0 or newer, the file contains the OLB application installer file (EXE file) and the certificate. You do not need to separately install the certificate. 
For OLB version 1.2.0 and older the certificate is not included in the OLB installer file. You must separately install the OLB Certificate on the workstation. A CCA, CCS, CCLO, CCO, CA and CO can install the OLB Certificate on the workstation. The certificate must be installed on the workstation for the OLB application to function with OTCnet. The OLB application is downloaded as a zip file. 
For details on downloading the OLB refer to the Download the OTCnet Local Bridge (OLB) Application printable job aid in this User Guide. For information about all OLB system prerequisites, refer to the OTCnet System Requirements and Reference Guide at: https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf



To install the OTCnet Local Bridge (OLB) certificate, complete the following steps:

Locate the folder where the OLB certificate file (i.e., olb.otcnet.public.crt) resides, and double-click the file. Note: The older versions of the OLB package contain a certificate file with the “.cer” extension. 

The Certificate dialog box appears. Click Install Certificate. 

The Welcome to the Certificate Import Wizard dialog box appears. Click Next.

	[image: ]Application Tip
Click Cancel to cancel installing the certificate.



The Certificate Store dialog box appears. Click the Place all certificate in the following store radio button. 



	[image: ]Application Tip
Click Cancel to cancel installing the certificate. Click Back to return to the Welcome to the Certificate Import Wizard dialog box.



Under Certificate Store, click Browse. 
The Select Certificate Store dialog box appears. Select the Trusted Root Certification Authorities folder and click OK. 

	[image: ]Application Tip
If you click Cancel, the Select Certificate Store dialog box closes. The Certificate Store dialog box remains open. Click Cancel again to cancel installing the certificate.



Click Next.

	[image: ]Application Tip
Click Cancel to cancel installing the certificate. Click Back to return to the Welcome to the Certificate Import Wizard dialog box.



The Completing the Certificate Import Wizard dialog box appears. Click Finish. 

	[image: ]Application Tip
Click Cancel to cancel installing the certificate. Click Back to return to the Certificate Store dialog box.



After The import was successful message appears, click OK. 
[bookmark: _Toc17614209]

Install the OTCnet Local Bridge (OLB) Application
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users (i.e., CA, CO, CCA, CCS, CCLO, CCO) performing terminal configuration, card processing, check capture, and check processing operations.

The OLB application is downloaded as a zip file containing the OLB installer file (EXE file). This file includes the OLB certificate file for version 1.3.0 and newer. For OLB versions 1.2.0 and older, you must separately install the OLB certificate on the workstation for the OLB application to function with OTCnet.

After the CA or CCA downloads the OLB application and the CCA, CA, CCS, CCLO, CCO, CA and CO installs the OLB certificate (for version 1.2.0 and older) the next step is to install the OLB application. 

Before you install the OLB application, consider the following information: 
· Prior to each OLB upgrade, the currently installed OLB application version must be uninstalled first.
· To uninstall a previous version of the OLB, complete the following steps:
For Windows 10:
· Access your Control Panel under Start > Windows Settings > Control Panel
· Double-click Add or Remove Programs
· In the Currently installed programs box, click OTCnet OLB
· Click Remove
· Click Yes and wait while the OLB application uninstalls
To install the new version of the OLB application you will need Windows Administrator privileges on each computer.
· Verify the previous version of the OTCnet OLB is uninstalled.
· The OLB application is required for terminal detection and performing check capture and check processing operations.
· The OLB application is required if you are using the Deployable Disbursing System (DDS) Interface (DoD only), applicable to Check Processing only.
· The OLB application can be installed before or after the OTCnet Firmware is installed. Before a terminal can be configured, both the OLB application and Firmware must be installed on the terminal, applicable to Check Processing only. There is no firmware for card processing.
· Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the workstation, ensure that it is stopped before uninstalling the application. For information on installing and uninstalling the OLB application, refer to the Install the OTCnet Local Bridge (OLB) Application printable job aid. 



To install the OTCnet Local Bridge (OLB) application:
8. Locate the folder where the OTCnet Local Bridge file (EXE file) resides and double-click the file to start the installation (see Figure 54).  
[bookmark: _Ref17709554][bookmark: _Toc59449667]Figure 54. OTCnet Local Bridge.EXE Icon
[image: ]

9. The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next (see Figure 55).
[bookmark: _Toc59449668]Figure 55. Welcome to the OTCnet OLB Setup Dialog Box
[image: ]



10. The Destination Location dialog box appears. Click Next (see Figure 56).

As a best practice, it is recommended that the OLB application is installed into the default destination folder (i.e., C:\Program Files\OTCnet_olb
[bookmark: _Toc59449669]Figure 56. Destination Location Dialog Box
[image: ]


11. The Start Installation dialog box appears. Click Next (Figure 57). 
[bookmark: _Toc59449670]Figure 57.  Start Installation dialog box
[image: ]



12. The Server Port Settings dialog box appears. Click Next (see Figure 58). Wait a moment while the files install.
[bookmark: _Toc59449671]Figure 58. Server Port Settings Dialog Box
[image: ]

As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. Click Cancel to exit the setup.

13. After the OTCnet OLB has been successfully installed message appears, click Finish (see Figure 59). 
[bookmark: _Toc59449672]Figure 59. OTCnet OLB has been successfully installed Dialog Box
[image: ]


The OTCnet OLB start and stop icons will appear on the desktop of the workstation (see Figure 60).
[bookmark: _Ref18566404][bookmark: _Toc59449673]Figure 60. OLB Stop and Start icons
[image: ]





[bookmark: _Toc17614210][image: ] Install the OTCnet Local Bridge (OLB) Application

The Check Capture Administrator (CCA), Check Capture Supervisor (CCS), Check Capture Lead Operator (CCLO), Check Capture Operator (CCO), Card Administrator (CA) and Card Operator (CO) are authorized to install the OTCnet Local Bridge (OLB)application.
	[image: ]Application Tip
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users (i.e., CA, CO, CCA, CCS, CCLO, CCO) performing terminal configuration, card processing, check capture, and check processing operations.
The OLB application is downloaded as a zip file containing the OLB installer file (EXE file). This file includes the OLB certificate file for version 1.3.0 and newer. For OLB versions 1.2.0 and older, you must separately install the OLB certificate on the workstation for the OLB application to function with OTCnet.
After the CA or CCA downloads the OLB application and the CCA, CA, CCS, CCLO, CCO, CA and CO installs the OLB certificate (for version 1.2.0 and older) the OLB is installed on the workstation. The next step is to install the OLB application. 



	[image: ]Application Tip 
Prior to each OLB upgrade, the currently installed OLB application version must be uninstalled first. To uninstall a previous version of the OLB, complete the following steps:
For Windows 10:
1. Access your Control Panel under Start>Control Panel
2. Double-click Add or Remove Programs
3. In the Currently installed programs box, click OTCnet OLB
4. Click Remove
5. Click Yes and wait while the OLB application uninstalls







	[image: ]Application Tip 
Verify the previous version of the OTCnet OLB is uninstalled.
To install the OLB application you will need Windows Administrator privileges on each computer. Verify that the previous version of the OTCnet OLB is uninstalled.

The OLB application is required for terminal detection and performing check capture and check processing operations.
The OLB application is required if you are using the Deployable Disbursing System (DDS) Interface (DoD only), applicable to Check Processing only.
The OLB application can be installed before or after the OTCnet Firmware is installed. Before a terminal can be configured, both the OLB application and Firmware must be installed on the terminal, applicable to Check Processing only.
Before you can uninstall the OLB application, you must first stop the OLB application. If the OLB application has been started on the terminal, ensure that it is stopped before uninstalling the application. For information on installing and uninstalling the OLB application, refer to the Install the OTCnet Local Bridge (OLB) Application printable job aid. 



To install the OLB application, complete the following steps:
7. Locate the folder where the OLB application file (EXE file) resides and double-click the file to start the installation. 
8. The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next.
	[image: ]Application Tip
Click Cancel to cancel and exit the setup.


9. The Destination Location dialog box appears. Click Next.
	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed into the default destination folder
(i.e., C:\Program Files\OTCnet_olb). Click Cancel to exit the setup. Click Back to return to the previous dialog box.


10. The Start Installation dialog box appears. Click Next. 
	[image: ]Application Tip
Click Cancel to exit the setup. Click Back to return to the previous dialog box.


11. The Server Port Settings dialog box appears. Click Next. Wait a moment while the files install.
	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. If your agency has different server port settings or needs, contact customer support. Click Cancel to exit the setup.



12. After the OTCnet Local Bridge has been successfully installed message appears, click Finish. 

	[image: ]Application Tip
Click Cancel to exit the setup. Click Back to return to the previous dialog box.


The OTCnet OLB Start and Stop icons appear on the desktop of the workstation. 
[image: ]		[image: ]


[bookmark: _Toc17614211]Upgrade OTCnet Local Bridge (OLB) Application
The CCA and CA are authorized to upgrade the OLB.

As new versions of the OTCnet OLB application become available, your Agency may choose to upgrade its workstations. Upgrade refers to installing a revised version of OTCnet OLB on a workstation that has a previous version of the OTCnet OLB installed.

Before initiating an OTCnet OLB application upgrade, consider the following: 
3. The OLB application must be stopped if it is running. If the OLB application has been started on the workstation, stop it before uninstalling the current version of the application. For information on upgrading the OLB application, refer to the Upgrade the OTCnet Local Bridge (OLB) Application printable job aid in this User Guide. 
4. Windows Administrator privileges are required to upgrade each workstation.
5. The current OLB version must be uninstalled before upgrading to an updated OLB version. You must uninstall and then perform a new installation.
6. The OLB certificate does not need to be reinstalled during the OLB upgrade.
7. For OLB credentials previously created and imported, you do not need to recreate and reimport your OLB credentials after upgrading your OLB version. 
8. The OLB application is required for card terminal detection and performing card processing operations.
For step-by-step instructions, refer to Topic 7: Create the OTCnet Local Bridge (OLB) Profile and Topic 8: Import OTCnet Local Bridge (OLB) Credentials printable job aids in this User Guide. 
To upgrade the OTCnet Local Bridge (OLB) application:
i. Stop the OTCnet OLB application. From the desktop, double-click Stop OTCnet Local Bridge (Figure 61).
[bookmark: _Ref18406679][bookmark: _Toc59449674]Figure 61. Stop OTCnet Local Bridge Desktop Icon
[image: ]

j. Under Control Panel, locate the installed OTCnet OLB application and uninstall it using Add or Remove Programs, or Uninstall. 



k. [bookmark: _Hlk19276942]After downloading and saving the latest version of OTCnet OLB application, locate the folder where the OTCnet Local Bridge file (EXE file) resides. Double-click the file to start the installation (see Figure 62). 
[bookmark: _Ref18406777][bookmark: _Toc59449675]Figure 62. OTCnet Local Bridge.EXE Icon
[image: ]

l. The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next (see Figure 63).
[bookmark: _Toc59449676]Figure 63. Welcome to the OTCnet OLB Setup Dialog Box
[image: ]



m. The Destination Location dialog box appears. Click Next (see Figure 64).

As a best practice, it is recommended that the OLB application is installed into the default destination folder (i.e., C:\Program Files\OTCnet_olb).
[bookmark: _Toc59449677]Figure 64. Destination Location Dialog Box
[image: ]

n. The Start Installation dialog box appears. Click Next (see Figure 65). 
[bookmark: _Toc59449678]Figure 65. Start Installation dialog box
[image: ]



o. The Server Port Settings dialog box appears. Click Next (see Figure 66). Wait a moment while the files install.
[bookmark: _Toc59449679]Figure 66. Server Port Settings Dialog Box
[image: ]

As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. If your agency has different server port settings or needs, contact customer support. Click Cancel to exit the setup.

p. After the OTCnet OLB has been successfully installed message appears, click Finish (Figure 67). 
[bookmark: _Toc59449680]Figure 67. OTCnet OLB has been successfully installed Dialog Box
[image: ]

If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer, you do not need to recreate or import your OLB credentials.

The OTCnet OLB start and stop icons will appear on the desktop of the workstation (see Figure 68 and Figure 69).
[bookmark: _Ref17870420][bookmark: _Toc59449681]Figure 68. Start OTCnet Local Bridge
[image: Start OTCnet Local Bridge icon]

[bookmark: _Toc59449682]Figure 69. Stop OTCnet Local Bridge
[image: Stop OTCnet Local Bridge icon]



[bookmark: _Toc17614212][image: MCj04420720000[1]]	Upgrade the OTCnet Local Bridge (OLB) Application
The Check Capture Administrator (CCA) and Card Administrator (CA) are authorized to upgrade the OLB.

As new versions of the OTCnet OLB application become available, your Agency may choose to upgrade its workstations. Upgrade refers to installing a revised version of OTCnet OLB on a workstation that has a previous version of the OTCnet OLB installed.

	[image: ]Application Tip
Before initiating an OTCnet OLB application upgrade, remember: 
9. The OLB application must be stopped if it is running. If the OLB application has been started on the workstation, stop it before uninstalling the current version of the application. For information on upgrading the OLB application, refer to the Upgrade the OTCnet Local Bridge (OLB) Application printable job aid in this User Guide. 
10. Windows Administrator privileges are required to upgrade each workstation.
11. The current OLB version must be uninstalled before upgrading to an updated OLB version. You must uninstall and then perform a new installation.
12. The OLB certificate does not need to be reinstalled during the OLB upgrade. 
13. For OLB credentials previously created and imported, you do not need to recreate and reimport your OLB credentials after upgrading your OLB version. 
14. The OLB application is required for card terminal detection and performing card processing operations.
For step-by-step instructions, refer to the Create the OTCnet Local Bridge (OLB) Profile and Import OTCnet Local Bridge (OLB) Credentials printable job aids in this User Guide.




To upgrade the OTCnet Local Bridge (OLB) Application, complete the following steps:

· Stop the OTCnet OLB application. From the desktop, double-click Stop OTCnet Local Bridge.

· Locate the folder where the OTCnet OLB application is installed and uninstall it. 



· After downloading and saving the latest version of OTCnet OLB application, locate the folder where the OTCnet Local Bridge file (EXE file) resides. Double-click the file to start the installation. 

· The Welcome to the OTCnet OLB Setup program dialog box appears. Click Next.

· The Destination Location dialog box appears. Click Next.

	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed into the default destination fold (i.e., C:\Program Files\OTCnet_olb). 



	[image: ]Application Tip
Click Cancel to exit the setup. Click Back to return to the previous dialog box.



· The Start Installation dialog box appears. Click Next.

· The Server Port Settings dialog box appears. Click Next. Wait a moment while the files install.

	[image: ]Application Tip
As a best practice, it is recommended that the OLB application is installed with the default list of fixed ports. If your agency has different server port settings or needs, contact customer support. Click Cancel to exit the setup.




· After the OTCnet OLB has been successfully installed message appears, click Finish.

	[image: ]Application Tip
If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer, you do not need to recreate or import your OLB credentials.


The OTCnet OLB start and stop icons will appear on the desktop of the terminal. 
[image: ]		[image: ]
[bookmark: _Toc17614213]Topic 7. Create the OTCnet Local Bridge (OLB) Profile
After the CA or CCA downloads the OTCnet Local Bridge (OLB) application, the OLB certificate and the OLB application is installed on the workstation. The next step is to create the OLB profile.
If you are assigned the role of CA, CO, CCA, CCS, CCLO, or CCO you are authorized to create the OLB profile. Note that the OLB profile is unique to each user role. Therefore, each of these user roles must create an OLB profile.
Before creating an OLB profile, consider the following information:
7. Creating an OLB profile applies to all card processing and check processing users, including CAs, COs, CCAs, CCSs, CCLOs, and CCOs. 
8. The OLB application is required for performing card processing operations and card terminal detection as well as check capture terminal detection, the Deployable Disbursing System (DDS) Interface (DoD and Check Processing only) and performing check processing and check capture operations.
To create an OLB profile:

7. Click the Administration tab, click Manage Users, and select Create Local Bridge and User Profile (see Figure 70).
[bookmark: _Ref44357328][bookmark: _Toc59449683]Figure 70. Create Local Bridge and User Profile
[image: ]

8. Select the relevant radio button for your version of the OLB or for OTCnet Offline.

Before you create your new profile, and if you downloaded and installed the newest version of the OLB, you must: 
3. Import the new OLB credentials file, required


9. Enter your Local Bridge Password and confirm your Local Bridge Password, and click Submit (see Figure 71). 

[bookmark: _Toc59449684]Figure 71. Create Local Bridge and User Profile Radio Buttons and Password
[image: ]

Password Criteria:
83. Must be at least 12 characters long. 
84. Must contain at least one uppercase letter. 
85. Must contain at least one lowercase letter. 
86. Must contain at least one numeric character. 
87. Must not have more than two repeating characters. 
88. Must not be a word in a language, slang, dialect, or jargon. 
89. Must not be related to personal identity, history, environment, or other personal associations. 
90. Must not be shared or displayed in plain view

Note that the password criteria is displayed on the page when you enter and confirm your Local Bridge password.

When you click Submit, the system generates the credential file based on the application version selected.

10. A Do you want to open or save [file name].ini? dialog box appears. Click the Save drop-down arrow and select Save as (see Figure 72).
[bookmark: _Ref17709984][bookmark: _Toc59449685]Figure 72. Create Local Bridge and User Profile Save As
[image: ]

When you save the OLB credential file, do not rename the file as the file name must remain the same as it was generated. If the file name is changed, the OLB application will not run.

If you click Open, the file opens in the Microsoft Notepad application. If you click Cancel, the Do you want to open or save dialog box closes, and you remain on the Create Local Bridge and User Profile page.

11. The Save dialog box appears (see Figure 73). Choose the location where you want to save the OLB credential file. Save the OLB credential file to any folder in which can save a file (e.g., My Documents folder, Desktop folder). Note that the default location on the Save dialog box is the user’s My Documents folder. If you click Cancel, you return to the Create Local Bridge and User Profile page without saving the file. 

12. Click Save (see Figure 73).
[bookmark: _Ref17710019][bookmark: _Toc59449686]Figure 73. Create Local Bridge and User Profile Save
[image: ]

If you click Cancel, you return to the Create Local Bridge and User Profile page without saving the file.

If you forget your OLB password, or if you attempt to enter an incorrect password three times (or more), you must recreate an OLB credential file through the Create Local Bridge and User Profile page and save the file again. You must to import your OLB credentials again, which is the next step in the OLB startup process.

For information on importing OLB credentials, refer to Topic 8: Import OTCnet Local Bridge (OLB) Credentials printable job in this User Guide.

OTCnet users only need to recreate OLB passwords if they forget their OLB passwords. After recreating their OLB passwords, OTCnet users need to reimport their OLB credentials. (Refer to Topic 8 of this User Guide for step-by-step instructions on importing the OLB credentials.) 

[image: MCj04420720000[1]]	Create the OTCnet Local Bridge (OLB) Profile
The Check Capture Administrator (CCA), Check Capture Supervisor (CCS), Check Capture Lead Operator (CCLO), Check Capture Operator (CCO), Card Administrator (CA) and Card Operator (CO) are authorized to create an OLB profile.

	[image: ]Application Tip
After the CA or CCA downloads the OTCnet Local Bridge (OLB) application, the OLB certificate and the OLB application is installed on the workstation. The next step is to create the OLB profile.
The OLB profile is unique to each user role. Therefore, each of these user roles must create an OLB profile.
Before creating an OLB profile, consider the following information:
Creating an OLB profile applies to all card processing and check processing users, including CAs, COs, CCAs, CCSs, CCLOs, and CCOs. 
The OLB application is required for performing card processing operations and card terminal detection as well as check capture terminal detection, the Deployable Disbursing System (DDS) Interface (DoD and Check Processing only) and performing check processing and check capture operations.



To create an OLB profile, complete the following steps:

15. Click the Administration tab, click Manage Users, and click Create Local Bridge and User Profile. 

16. Select the relevant radio button for your version of the OLB or for OTCnet Offline.

	[image: ]Application Tip 
Before you create your new profile, and if you downloaded and installed the newest version of the OLB, you must: 
4. Import the new OLB credentials file, required




17. Enter your Local Bridge Password, and confirm your Local Bridge Password, and click Submit.



	[image: ]Application Tip
Password Criteria:
· Must be at least 12 characters long 
· Must contain at least one upper case letter
· Must contain at least one lower case letter
· Must contain at least one numeric character
· Must not have more than two repeating characters
· Must not repeat any of your last ten passwords
· Must not have been your password during the last ten days
· Must not be a word in a language, slang, dialect, or jargon
· Must not be related to personal identity, history, environment, or other personal associations
· Must not be shared or displayed in plain view
Note that these password criteria are displayed on the page when you enter and confirm your Local Bridge password.



	[image: ]Application Tip
When you click Submit, the system generates the credential file based on the application version selected. 




18. A Do you want to open or save [file name].ini? dialog box appears. Click the Save drop-down arrow and select Save as.

	[image: ]Application Tip
When you save the OLB credential file, do not rename the file as the file name must remain the same as it was generated. If the file name is changed, the OLB application will not run.



	[image: ]Application Tip
If you click Open, the file will simply open in the Microsoft Notepad application. If you click Cancel, the Do you want to open or save dialog box closes, and you remain on the Create Local Bridge and User Profile page.



19. The Save dialog box appears. Click Save or Cancel.

	[image: ]Application Tip
Choose the location where you want to save the OLB credential file. Save the OLB credential file to any folder in which you have the ability to save a file (e.g., My Documents folder, Desktop folder). Note that the default location on the Save dialog box is the user’s My Documents folder.
If you click Cancel, you return to the Create Local Bridge and User Profile page without saving the file.



	[image: ]Application Tip
If you forget your OLB password, or if you attempt to enter an incorrect password three times (or more), you will have to recreate an OLB credential file through the Create Local Bridge and User Profile page and save it again. You will also have to import your OLB credentials again, which is the next step in the OLB startup process.



	[image: ]Application Tip
For information on importing OLB credentials, refer to Topic 8: Import OTCnet Local Bridge (OLB) Credentials printable job aid in this user guide.



	[image: ]Application Tip
OTCnet users only need to recreate OLB passwords if they forget their OLB passwords. After recreating their OLB passwords, OTCnet users need to reimport their OLB credentials. (Refer to Topic 8 of this User Guide for step-by-step instructions on importing the OLB credentials.) 




[bookmark: _Toc17614215][bookmark: _Hlk15280214]Topic 8. Import OTCnet Local Bridge (OLB) Credentials
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users performing card terminal configuration and card processing. If you are a CA, CO, CCA, CCS, CCLO, or CCO you are required to import your OLB credentials to the workstation.
If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer you do not need to recreate or re-import your OLB credentials. If you are upgrading your OLB version from a version older than 2.2.0.0, you will need to recreate and re-import your OLB credentials.
You only need to recreate OLB passwords if you forget your OLB password. After recreating your OLB password, OTCnet users must reimport OLB credentials.
Importing OLB credentials is unique to each user. Therefore, if there are multiple users on a workstation, each user must import their OLB credentials.
Users are only required to import their OLB credentials once. After importing OLB credentials, users can successfully start the OLB application.
Before importing your OLB credentials, ensure the following steps have been completed in this order:
9. The CA or CCA has downloaded the OLB application
10. The OLB certificate is installed on the workstation (for OLB versions 1.2.0 and older)
11. The OLB application is installed on the workstation
12. Each user has created an OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated). 

For step-by-step instructions, refer to the Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, and Create the OTCnet Local Bridge (OLB) Profile printable job aids.




To import the OTCnet Local Bridge (OLB) credentials, complete the following steps:

· Double-click the Start OTCnet Local Bridge icon located on the workstation desktop (see Figure 74).
[bookmark: _Toc59449687]Figure 74. Start OTCnet Local Bridge Icon
[image: ]

Or

Click Start>Programs>Start OTCnet Local Bridge.

If the icon does not reside in either location, contact your CA or CCA. They can help complete the steps required to install the OLB application on the card terminal and install the OLB Application and the OLB certificate (for OLB versions 1.2.0 and older) for the check capture terminal, create your OLB profile, and import your OLB credentials.

· The OTCnet Local Bridge Startup window appears. Click the File menu, and then click Import User Profile (see Figure 75).
[bookmark: _Toc59449688]Figure 75. Start OTCnet Local Bridge Startup
[image: ]


· The Select User Profile File dialog box appears. Navigate to the location on the workstation where the OLB credential file was saved. Select the file and click Import (see Figure 76).
[bookmark: _Ref32262006][bookmark: _Toc59449689]Figure 76. Select User Profile
[image: ]

The default location on the Select User Profile File dialog box is the user’s My Documents folder (see Figure 77.).
[bookmark: _Ref32262018][bookmark: _Toc59449690]Figure 77. User Profile Import
[image: ]

Once you have successfully imported your OLB credentials, you can proceed with starting the OLB application on the workstation.



[image: MCj04420720000[1]]	Import OTCnet Local Bridge (OLB) Credentials

	[image: ]Application Tip
The OTCnet Local Bridge (OLB) application is required for OTCnet Online users performing terminal configuration, check processing, and check capture operations. If you are a CCA, CCS, CCLO, CCO CA or CO, you are required to import your OLB credentials to the workstation.
If you are upgrading your OLB version from 2.2.0.0 to 2.3.0.0 or newer you do not need to recreate or re-import your OLB credentials. If you are upgrading your OLB version from a version older than 2.2.0.0 to 2.3.0.0, you will need to recreate and re-import your OLB credentials.
You only need to recreate OLB passwords if you forget your OLB password. After recreating your OLB password, OTCnet users must reimport OLB credentials.
Importing OLB credentials is unique to each Windows user. Therefore, if there are multiple Windows users on a terminal, each Windows user must import their own OLB credentials.
Users are only required to import their OLB credentials once, upon their first attempt to start the OLB application. After importing OLB credentials, users will be able to successfully start the OLB application.



	[image: ]Application Tip
Before importing your OLB credentials, ensure the following steps have been completed in this order:
52. The CA or CCA downloaded the OLB application
53. The OLB certificate is installed on the workstation (for versions 1.2.0 and older)
54. The OLB application is installed on the workstation 
55. Each user (CCA, CCS, CCLO, CCO CA or CO) has created an OLB profile, ensuring that the OLB credential file was not renamed (the file name remained the same as it was generated). 
For step-by-step instructions, refer to the Download the OTCnet Local Bridge (OLB) Application, Install the OTCnet Local Bridge (OLB) Certificate, Install the OTCnet Local Bridge (OLB) Application, and Create the OTCnet Local Bridge (OLB) Profile printable job aids.



To import OTCnet Local Bridge (OLB) credentials, complete the following steps:

5. Double-click the Start OTCnet Local Bridge icon located on the card terminal’s desktop.

Or

Click Start>Programs>Start OTCnet Local Bridge.

	[image: ]Application Tip
If the icon does not reside in either location, contact your CA or CCA. They can help complete the steps required to install the OLB application on the card terminal and install the OLB Application and OLB certificate for the check capture terminal (for OLB versions 1.2.0 and older), create your OLB profile, and import your OLB credentials.



6. The OTCnet Local Bridge Startup window appears. Click the File menu, and then click Import User Profile. 

7. The Select User Profile File window appears. Navigate to the location on the card terminal where the OLB credential file was saved. Select the file and click Import. 

	[image: ]Application Tip
The default location on the Select User Profile File window is the user’s My Documents folder.



8. A Successfully imported user profile message appears. Click OK.

Once you have successfully imported your OLB credentials, you can proceed with starting the OLB application on the workstation.


Topic 9. Select 80mm Card Receipt Printer 
If you are a Card Operator (CO), you have the option to choose Select 80mm Card Receipt Printer. OTCnet offers the option to select an 80mm Card Receipt Printer for card processing receipts, they will be printed on 80mm (3.125 inch) paper. 

Before you can select your 80mm printer, ensure:
Your printer must be installed on your workstation or network. If you do not install the 80mm printer, card receipts will be sent to your default Windows printer. 

The OLB is not started. If it is started, you receive a message that the OLB is running and you will not be able to access the OLB menu until you stop the OLB. 

You must have the latest OLB version to select the 80mm printer.

Your agency uses check processing and/or deposit processing, check or deposit items will print to the Windows default printer, not the 80mm printer. 

For the 80mm printer driver installation process, review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) for additional information.

Select 80mm Card Receipt Printer:
To select the 80mm card receipt printer, complete the following steps:

· Double-click the Start OTCnet Local Bridge icon located on the terminal’s desktop (see Figure 78).
[bookmark: _Ref57099841][bookmark: _Toc59449691]Figure 78. Start OTCnet Local Bridge Icon
[image: ]

Or

Click Start>Programs>Start OTCnet Local Bridge.



· The OTCnet Local Bridge Startup window appears. Click the File menu, and then select Select 80mm Card Receipt Printer (see Figure 79). 

[bookmark: _Toc59449692]Figure 79. Start OTCnet Local Bridge Startup
[image: ]

1. The Select 80mm Card Receipt Printer window appears. Select a printer and click Confirm (see Figure 80).
[bookmark: _Toc59449693]Figure 80. Confirm the 80mm Printer
[image: ]



Note: If you want to cancel your selection (Select 80mm Card Receipt Printer), click Clear Selection & Close to cancel and close the window. A “The Windows default printer, ‘Microsoft Print to PDF,’ will be used as your card receipt printer” message appears (see Figure 81). You will be returned to the OLB Login page. Card receipts will be sent to the default Windows printer. Click OK.
[bookmark: _Ref58524822][bookmark: _Toc59449694]Figure 81. Card Printer Selection Complete
[image: ]

2. The “You have successfully chosen XXX Printer as your 80mm card receipt printer” message appears (see Figure 82). Click OK to return to the OLB Login page. 
[bookmark: _Ref58524514][bookmark: _Toc59449695]Figure 82. 80mm Card Receipt Printer Selection Complete
[image: ]



[bookmark: _GoBack]Note: In the event that your 80mm printer is no longer available (if your printer drivers are removed from the Window’s list of managed printers), the “Your previously selected 80mm card receipt printer, ‘XXX Printer’, is no longer available. Card Receipt printing will 
revert back to using the Windows default printer. Please select an 80mm printer again to 
enable 80mm card receipt printing” message appears (see Figure 83) on the OLB login
page. Click OK. 
[bookmark: _Toc59449696]Figure 83. Printer Selection Error
[image: ]


[image: MCj04420720000[1]] Select 80mm Card Receipt Printer 
The Card Operator (CO) is authorized to install/select the 80mm Card Receipt Printer.

	[bookmark: _Hlk58567728][image: ]Application Tip
If you are a Card Operator (CO), you have the option to choose Select 80mm Card Receipt Printer. OTCnet offers the option to install an 80mm Card Receipt Printer for card processing receipts, they will be printed on 80mm (3.125 inch) paper. 

Before you can select your 80mm printer, ensure:
56. Your printer must be installed on your workstation or network. If you do not install the 80mm printer, card receipts will be sent to your default Windows printer. 
57. The OLB is not started. If it is started, you receive a message that the OLB is running and you will not be able to access the OLB menu until you stop the OLB. 
58. You must have the latest OLB version to select the 80mm printer.

If your agency uses check processing and/or deposit processing, check or deposit items will print to the Windows default printer, not the 80mm printer. 



	[image: ]Application Tip
For the 80mm printer driver installation process, review the system requirements document (https://www.fiscal.treasury.gov/files/otcnet/OTCnet-SysReq.pdf) for additional information.




To select the 80mm Card Receipt Printer, complete the following steps:

· Double-click the Start OTCnet Local Bridge icon located on the terminal’s desktop.

Or

Click Start>Programs>Start OTCnet Local Bridge.

· The OTCnet Local Bridge Startup window appears. Click the File menu, and then select Select 80mm Card Receipt Printer.

· The Select 80mm Card Receipt Printer window appears. Select a printer and click Confirm. 


	[image: ]Application Tip
If you want to cancel your selection (Select 80mm Card Receipt Printer), click Clear Selection & Close to cancel and close the window. A “The Windows default printer, ‘Microsoft Print to PDF,’ will be used as your card receipt printer” message appears. You will be returned to the OLB Login page. Card receipts will be sent to the default Windows printer. Click OK.






[bookmark: _Toc17614217]The “You have successfully chosen XXX Printer as your 80mm card receipt printer” message appears. Click OK to return to the OLB Login page. 

	[image: ]Application Tip
In the event that your 80mm printer is no longer available (if your printer drivers are removed from the Window’s list of managed printers), the “Your previously selected 80mm card receipt printer, ‘XXX Printer’, is no longer available. Card Receipt printing will revert back to using the Windows default printer. Please select an 80mm printer again to 
enable 80mm card receipt printing” message appears on the OLB login page. Click OK. 






Summary
This chapter provided information on:
The purpose of configuring card processing settings
How to set up or modify a card terminal configuration
How to unregister a card terminal
How to view a card terminal configuration
How to search an audit log
How to download and install the OTCnet Local Bridge (OLB) Application
How to create the OTCnet Local Bridge (OLB) Profile
How to import OTCnet Local Bridge (OLB) Credentials
How to select the 80mm Card Receipt Printer

Notes
____________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________________

[bookmark: _Toc17614218]Glossary
A

Accounting Code – A unique agency classification code assigned to a transaction, which identifies the FRB Account Key that is used within the Federal Reserve. In check capture, it is a method of grouping individual check transactions into certain classifications. In deposit reporting, the classification is being done at a voucher level, where a voucher is being classified with one, or many agency-defined accounting codes, or TAS.

Accounting Code Description – A brief explanation that provides further detail about an accounting code.

Accounting Code Name – The title of the accounting code.

Accounting Key – The account number assigned to a deposit when it is submitted to FRB CA$HLINK. The FRB Account Key is used by FRB CASHLINK in combination with the RTN to determine the appropriate CAN. The FRB Account Key is similar to the CAN, which is only used for FRB financial activity.

Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their agency. This role will establish and maintain the organizational foundation, accounting data and accounting relationships at the highest level of the agency in OTCnet. This role can also establish, maintain, and view processing options that one or more lower level endpoints will use in OTCnet.

Acknowledged Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Acknowledged Error Batch Status – Indicates the acknowledge batch process experienced system errors and the acknowledgment was unsuccessful, or a user selected to cancel the batch acknowledgment which resulted in a batch being updated to Acknowledgment Error.

ACR Activity Report – A check processing business report that allows you to view detailed information about transactions that were adjusted, corrected, or reversed/rescinded. Users can generate a report that covers a maximum period of 45 calendar days.

Activity Type – The parameter indicates if a User Defined Field (UDF) is used for capturing custom agency information for a deposit or during classifying the deposit with accounting codes. OTCnet allows for the creation of three UDFs for the deposit activity, and two UDFs for the deposit accounting subtotals activity.

Adjustment Activity (FI) Report – A business report that allows you to view adjustments made by your financial institution (FI).

Adjustment Historical Report – A deposit processing report that allows you to view historical deposit adjustment and returned item adjustment transaction data.

Adjustments by OTC Endpoints Report – A business report that allows you to view adjustments made by Agency Location Code (ALC) and Adjustment Types (Credit, Debit or Return Item Adjustments). An adjustment was created when a deposit ticket has been received by a financial institution and the amount of the deposit does not match the deposit amount reported on the deposit ticket.
 
Agency CIRA Report – A check processing business report that allows you to view the batch level transaction activity for a specified OTC Endpoint. A user can filter the report by Received Date, Capture Date, Batch ID, or CCO.

Agency Contact – A person designated by an agency as the primary contact regarding deposit-related matters.

Agency Information – The optional comments or instructions, receipt processing dates, alternate agency contact, and internal control number for your deposit.

Agency Location Code (ALC) – A numeric symbol identifying the agency accounting and/or reporting office. 

Agency Location Code plus 2 (ALC+2) – The agency location code plus a unique two-digit number that is used in OTCnet to identify a cashflow at a location within an ALC. This plus two digits accommodates the fact that one ALC can represent many locations and allows the agency to identify those locations specifically.

Agency Manager – A user that has authorization to view and download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

Alternate Agency Contact – A person designated by an agency as the secondary contact regarding deposit-related matters.

American Bankers Association (ABA) – (also known as Bank Routing Number) A routing transit number (RTN), routing number, or ABA number is a nine-digit bank code, used in the United States, which appears on the bottom of negotiable instruments such as checks identifying the financial institution on which it was drawn.

Approved Batch Status – Indicates that the batch is ready for settlement (online only). Indicates that the batch is ready for upload and settlement (offline only).

Audit Log – A table that records all interactions between the user and OTCnet Deposit Reporting, Check Capture, Check Processing, administrative actions and other processes that take place in the application. Some entries also contain before and after values for actions completed. The audit log is available for download to a comma separated value report (CSV) and opened in a spreadsheet program or available to print in a formatted audit log report.

Automated Clearing House – A computerized network used by member financial institutions to process payment orders in machine readable form. ACH processes both credit and debit transactions between financial institutions in batches. ACH items are settled electronically and do not require an image.

Awaiting Approval (AWAP) – A deposit that is waiting for deposit confirmation by a Deposit Approver.
B

Back Office Processing Method – Indicates that a customer presented a check in person, but the check is being scanned in a controlled back-office environment away from the customer.

Batch – A file containing the transaction information and tiff images (collection of scanned checks) of one or more checks, which will be sent for settlement.

Batch Approver – An agency user that has the authorization to approve a batch either prior to batch upload from OTCnet Offline or when a batch is uploaded/submitted to OTCnet Online but not yet approved. The Batch Approver permission must be applied to either a CCLO or CCO roles and allows the operators to approve batches that they have created. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a CCS present.

Batch Control/Batch Balancing – An optional feature (which can be configured to be 
mandatory) that agencies can use as a batch balancing tool to perform checks and balances on the number of checks that have been scanned, and ensure their respective dollar amounts and check number totals have been accurately entered. The functionality is available for both single item mode and batch mode.

Batch ID – The unique number assigned to a batch by OTCnet.

Batch List Report – A report that contains transaction information for each batch item, including the Individual Reference Number (IRN), Item Type, ABA Number, Account Number, Check Number, and Amount.

Batch Status – Reflects the current state of a batch during processing, transmission, and settlement. The batch states for OTCnet Online are Open, Closed, Approved, and Forwarded. The batch states for OTCnet Offline are Open, Closed, Approved, Sending, Sent, Acknowledged, Send Error, and Acknowledgment Error (offline only). 

Batch Uploader – An agency user that has the authorization to upload a batch from OTCnet Offline to the online database. The Batch Uploader permission must be applied to either a CCLO or CCO roles and allows the operators to auto-upload the batch upon close (if terminal is configured to do so) or upload approved batches. This role should be granted in limited cases at sites where there is a need for the operator to perform this function without a CCS present.

Blocked – A customer may no longer present checks for a specific ABA number and account number due to manual entry by authorized persons into the MVD rather than the result of a failed transaction. If desired, an authorized user can edit the transactional record to a clear status.

Bureau of the Fiscal Service (FS) – (formerly FMS) The bureau of the United States Department of Treasury that provides central payment services to federal agencies, operates the federal government’s collections and deposit systems, provides government wide accounting and reporting services, and manages the collection of delinquent debt owed to the government.

Business Event Type Code (BETC) – A code used in the CARS system to indicate the type of activity being reported, such as payments, collections, borrowings, etc. This code must accompany the Treasury Account Symbol (TAS).

C

CA$HLINK II – An electronic cash concentration, financial information, and data warehouse system used to manage the collection of U.S. government funds and to provide deposit information to Federal agencies.

CA$HLINK II Account Number (CAN) – The account number assigned to a deposit when it is submitted to CA$HLINK II.

Capture Date – The calendar date and time the payment is processed by the agency.

Card Acquiring Service (CAS) – (formerly Plastic Card Network) A Bureau of the Fiscal Service federal program that provides federal agencies with payment card (credit, debit, electronic benefit transfer (EBT) and store-value (gift cards) cards) acceptance capabilities. 

Card Administrator – An agency user that has the authorization to manage endpoints for card processing, set up and view terminal configuration and read and view audit log information.

Card Invoice ID –The unique Invoice ID for a processed card transaction. The default on terminals is set to 10 characters, a max of 40 characters can be configured for MX terminals. It can be used to track transactions in OTCnet. 

Card Operator – An agency user that has the authorization to start card processing, query, void, and refund any card transaction, as well as reboot and check terminal connection status.

Card Processing: A functionality available in OTCnet that allows agencies to provide customers with an option to make payments with a credit, debit or Visa/Mastercard gift card. The card transactions are directly sent to WorldPay. WorldPay sends all approved OTCnet transactions via a Card Acquiring Service (CAS) flat file to Collections Information Repository (CIR) for deposit reporting.
(80mm) Card Receipt Printer– A printer that can be selected by a Card Operator or Kiosk Operator; the 80mm printer provides the ability to print standard-sized card receipts on 3.125in (80mm) paper. 

Card Uploader: A full vendor kiosk server system role that is authorized to transmit card data from an external kiosk system to OTCnet. This role requests acknowledgement of the data transmitted; the system account with this role has no other permissions. 
Cashier ID – The ID of the user that created the transaction.

Central Accounting Reporting System (CARS) – The system that addresses the central accounting and reporting functions and processes associated with budget execution, accountability, and cash/other asset management. This includes the collection and dissemination of financial management and accounting information from and to federal program agencies. 

Central Image and Research Archive (CIRA) – The Central Image Research Archive (CIRA) is an image archive of all items processed in the OTCnet System. 

Central Image and Research Archive (CIRA) Query – An online query function that allows users to search for all check transactions (includes mobile check transactions) processed in the OTCnet application that have been settled less than18 months ago.

Chain Code aka Chain Number: An alphanumeric designator (e.g. 0F123B) assigned by acquirer to reflect a unique channel of processing. The chain code is assigned at lower level endpoints and an agency may have multiple chain codes. 

Characteristics – The properties of a user, organization, deposit, or financial institution.

Check 21 – Provides the legal framework for the creation of substitute checks which can be used in place of the original paper document, without an agreement in place with other financial institutions. A substitute check is a paper reproduction of the original check. Check 21 items require an image before they can settle. Check 21 is also referred to as check truncation. 

Check Amount – The dollar amount of the check.

Check Capture – The component of OTCnet used to process scan images of checks and money orders through OTCnet for the electronic deposit of checks and money orders at financial institutions. Check capture can be done online through the internet, or offline through the user’s desktop.

CCA – An agency user that has the authorization to define and modify the check capture sites; to manage accounting codes; to modify endpoint mappings; to configure Check Capture functions and perform upgrades of the application; to create and download user profiles; as well as download software or firmware to the terminal using the Download Check Capture application permission. Furthermore, this user can view checks at the item level or a batch at the summary level classified with multiple accounting codes, view/download CIRA CSV reports and ACR Activity reports, run CIRA queries and view other general reports such as the SF215 Deposit Ticket and 5515 Debit Voucher reports, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Lastly, this user has the ability to create the CCA offline user logon profile using OTCnet online.

CCLO – An agency user that has the authorization to in scan checks into a batch, view and classify checks at the item level or batch at the summary level with multiple accounting codes, close a batch, edit a batch, balance check amounts, and enter batch control values during batch closing. Additionally, the user is authorized to accept checks with poor quality, make MICR line corrections, and accept duplicate checks. This user is not authorized; however, to use an out-of-date LVD. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments.

Check Capture Offline – A web-based functionality in the offline Check Capture application that resides in the user’s desktop for capturing check images for the electronic deposit of checks and money orders. The check transactions are stored within a local database, and the check information will need to be uploaded to OTCnet server when there is internet connectivity before they can be deposited for settlement. 

Check Capture Online – A web-based functionality within OTCnet to allow agencies users to process scanned images of checks and money orders for the electronic deposit of checks and money orders at financial institutions. The check transactions are directly saved to the OTCnet online database, and no upload of batches of checks are needed.

CCO – An agency user that has the authorization to perform only very minimal Check Capture activities. This user has authorization to scan checks into a batch view and classify checks at the item level or a batch at the summary level with multiple accounting codes, close a batch, balance check amounts and enter batch control values during batch closing. The agency user can also view is an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. Additionally, the user can enter/apply the Accounting Code at the time of scanning checks is established. This user does not have authorization to accept duplicates, make MICR corrections, authorize the use of out-of-date LVD, or accept checks with poor quality. 

CCS – An agency user that has the authorization to perform almost all the functions on the Check Capture including view and classify checks at the item level or a batch at the summary level with multiple accounting codes, accept duplicates (not recommended), make MICR corrections, authorize the use of out-of-date LVD, and accept checks with poor quality as well as view, modify, import, and modify endpoint mappings. This role can also establish, maintain, and view processing options for an endpoint pertaining to summary level classification and agency comments. 

Check Image Report – A check processing business report that allows you to view the front and back images of a check for an Individual Reference Number (IRN) that you request.

Check Number – The printed number of the check writer’s check.

CIRA CSV Historical Report – A check processing business report that allows you to query check records that are associated with batches that have been forwarded for settlement more than 18 months ago. The exported comma separated value report (CSV) data can be used to import the data into other applications within an agency. The report has been enhanced to provide users the option to solely retrieve mobile check transactions.

CIRA CSV Report – A check processing business report that allows users to search for all transactions in the system (including mobile check transactions) and allows users to export the results to a comma separated value report (CSV) file.

CIRA Viewer – A user that has authorization to view CIRA records and download CSV files. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

Classification Key (C-Key) – A unique agency accounting code assigned to a transaction. Agencies establish C-Keys in SAM for collection transactions that will be used to derive the appropriate values of TAS-BETC(s).

Clear – Indicates that a customer may present checks for a specific ABA Number and Account Number, because the prior restrictions on the individual's check payments have been removed. Note: Manually cleared items are permanently cleared. If a transaction is cleared in error, manual suspend, block or deny records need to be created in its place to prevent transactions.

Client ID/GCI Number – An ID used by the deposit end point when requesting a currency conversion for foreign check to the US dollar Equivalent (USE) with the foreign currency exchange gateway for foreign check items or currency conversion service for foreign currency cash.
	
Client Order ID – A unique ID assigned by OTCnet to maintain uniqueness while requesting/accepting a foreign currency conversion quote for foreign checks the foreign currency exchange gateway.

Closed Batch Status – Indicates the batch is closed and no new checks may be scanned into that batch.

Collections Information Repository (CIR) – (formerly TRS) A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.

Comma Separated Values (CSV) – A computer data file used for storage of data structured in a table form. Each line in the CSV file corresponds to a row in the table. Within a line, fields are separated by commas, each field belonging to one table column.

Confirmed – A deposit that has been reviewed and then confirmed by a financial institution or FRB.

Cost Center Work Unit (CCWU) – A Federal Reserve cost center work unit that processing the FRB deposits and adjustments. It is normally abbreviated as CCWU and provided only on non-commercial (FRB settled) transactions. Debits and credits processed by FRB Cleveland will be noted with the CCWU number 9910 on the daily accounting statement agencies receive from the Federal Reserve Bank. 

Credentials – Evidence of authority, status, rights, or entitlement to privileges. Credentials are typically in written form (e.g., OLB credentials such as a login or password). 

Custom Label – Text defined by OTCnet that describes a level in the organization hierarchy, the internal control number, or agency accounting code.

Customer Not Present Processing Method – The processing method selected in OTCnet when processing a check that has been presented by a check writer who is not present at the agency location i.e., mail.

Customer Present Processing Method – The processing method used in the OTCnet when the check writer is presenting the check in person.

D

Daily Voucher Report – A business report that allows you to view the daily voucher extract. 

Data Type – The type of data that should be entered for a user defined field.

Date of Deposit – The date, prior to established cut off times, the user transmits a batch of checks and money orders through check capture, or the date the agency sends the physical negotiable instruments to the financial institution.

Debit Gateway – The financial settlement program that is responsible for the presenting and settling of payment transactions acquired through the OTCnet application. The Debit Gateway receives a transaction file from OTCnet and determines the proper path for settlement of each item. Items are either converted to ACH for direct automated clearing house debit, or are included in an image cash letter, which is sent to the Check 21 system for presentment to paying banks. Once the file is processed, the Debit Gateway sends a Response Processing File (RPF) to OTCnet with the status of each of the items. 

Demand Deposit Account (DDA) – The account at a financial institution where an organization deposits collections.

Denied – Indicates that OTCnet system permanently denies an individual from cashing a check through OTCnet based on the combination of ABA number, account number, and User Defined Field 1. 

Deny Date – Indicates when the verification record (MVD/LVD) expires, and OTCnet can start accepting checks that will be presented by a check writer that has previously presented a bad check. The Deny Date is calculated based on suspension periods configured in the Check Cashing policy of an OTC Endpoint.

Deposit – A collection of over-the-counter receipts deposited to a United States Department of Treasury General Account for credit.

Deposit Activity (FI) Report – A business report that allows the financial institution to view deposits submitted to its location. 

Deposit Approver – A user who has authorization to review and submit deposits to a financial institution.

Deposit Confirmer – A user at a financial institution that has authorization to verify the accuracy of deposits received from an agency.

Deposit History by Status Report – A business report that allows you to view deposits by status. 

Deposit Information – The attributes that define a deposit: deposit status, voucher number, deposit endpoint, ALC, voucher date, deposit total, check/money order subtotal, currency subtotal, and subtotals by accounting code.

Deposit Preparer – A user that has authorization to prepare and save deposits for approval to a Deposit Approver.

Deposit Total – The total amount of over-the-counter receipts included in the deposit.

Deposit Historical Report – A deposit processing report that allows you to view historical deposit transaction data.

Deposits by Accounting Code Report – A business report that allows you to view deposits by accounting code. 

Deposits by OTC Endpoint Report – A business report that allows you to view deposits by OTC Endpoint.

Display Order Number – The order in which user defined fields (UDFs) should be displayed.
Draft – A deposit that is saved for modification at a later date by a Deposit Preparer.

Division Number: A three-digit (e.g. 001) value assigned at lower level endpoints under the chain code to designate unique lines of accounting. 

E

Exchange Rate – The decimal value used to convert foreign currency to the US dollar Equivalent (USE).

F

Failed – The item was unable to be processed and/or settled by United States Department of Treasury/Bureau of the Fiscal Service (BFS). These are item that could not be collected such as foreign items or possible duplicate items. These items are not included on your 215 Report.

Federal Program Agency – A permanent or semi-permanent organization of government that is responsible for the oversight and administration of specific functions. 

Federal Reserve Bank (FRB) – A Federal Reserve Bank is one of twelve regulatory bodies throughout the United States that make up the Federal Reserve System. Each Bank is given power over commercial and savings banks in its area and is charged with making sure that those banks comply with any and all rules and regulations.

Federal Reserve Bank-Cleveland (FRB-C) – FRB-C serves as the conduit for settlement of transactions originating from the OTCnet application. FRB-C is responsible for receiving the transaction data from OTCnet via forward file and performing check clearing/transaction settlement as the ‘debit gateway’.

Federal Reserve System's Automated Clearing House (ACH) System – Enables debits and credits to be sent electronically between depository financial institutions.

Financial Institution (FI) – A bank, designated by the United States Department of Treasury and a Treasury General Account (TGA) of International Treasury General Account (ITGA), which collects funds to be deposited in the Treasury General Account. These banks also include the Federal Reserve Bank (FRB).

Financial Institution Information – The name, address, routing transit number, and the demand deposit account number of a financial institution.

Firmware – A release used for initial download or upgrades to the scanner software that allows a scanner to be used on a terminal. The firmware versions also contain a series of other back-end installation files that should be installed on a terminal to enable it to be used for Check Capture in OTCnet.

Fiscal Year – A 12-month period for which an organization plans the use of its funds.

Forwarded Batch Status – Indicates the batch has been sent to Debit Gateway to initiate the settlement process.

Forwarded File – A term that is assigned to a file that contains the check transactions that is send from channel applications, such as OTCnet or ECP, to Debit Gateway for settlement purposes.

Franker – An internal stamp unit that stamps a check with “Electronically Processed” after the check is processed and scanned. Franker availability is based on the model of your scanner.

Franking – The process of stamping a check processed through Check Capture. The stamp indicates that the check was electronically processed.

H

Highest Level Organization – The primary level of the organization hierarchy.

I

IBM Security Identity Manager (ISIM) – Refers to Fiscal Service’s Enterprise provisioning tool for user account and identity management.

Individual Reference Number (IRN) – The auto-generated unique number used in OTCnet to identify Check Capture transactions. 

Input Length Maximum – The maximum number of characters that may be entered in a user defined field.

Input Length Minimum – The minimum number of characters that may be entered in a user defined field.

Internal Control Number – A customizable field for agency use to further describe a deposit.

Internet Protocol (IP) address – A unique number or address that computing devices, (e.g., computers, laptops, tablets, etc.) connected to a computer network, use to identify themselves and communicate with other devices in an IP-based network (e.g., the Internet). 

Item Detail Report – A report that contains the information about an individual item (check) associated with a batch. The report print-out will contain MICR information, data entered about the check, and an image of the check obtained during scanning. 

Item Type – Indicates whether the check presented is a personal or business check. This determines whether the check is handled through Check 21 (non-personal) or FedACH (personal).

K
Kiosk Lockdown Software – Lockdown software is intended to restrict access to sensitive Windows functions and to prevent public users from tampering with the system. Lockdown software ensures that the Kiosk Tablet is used as intended and it prevents malicious, unauthorized and inadvertent system changes (e.g., software installations and virus infections). The lockdown software only needs to be implemented once, as part of the initial workstation configuration. Locking down the tablet ensures that users cannot access any outside information or applications from the OTC Kiosk Tablet (e.g., checking email or accessing other websites).

 Kiosk Operator User Role – A user with the following permissions for the OTC Kiosk Tablet: logging into the OTCnet Kiosk application, processing deposits, scanning checks, processing card payments and printing receipts. 
L

Local Accounting Specialist – A user who is an expert on the organizational structure, reporting needs and accounting rules for their depositing endpoint and its lower level OTC Endpoints. This role will establish, maintain, and view the organizational structure, accounting code mappings to individual endpoints, and the processing options that one or more lower level OTC Endpoints will use in OTCnet.

Local Security Administrator (LSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Local Verification Database (LVD) – A database (specific to the endpoint using OTCnet) that is downloaded from OTCnet and stored locally on the agencies network, which replicates the information found in the Master Verification Database (MVD).

Lower Level Organization – Any organization created below the highest level organization.

LVD Contents Report – A check processing business report that allows you to view the contents of a Local Verification Database (LVD) for a given OTC Endpoint.

M

Magnetic Ink Character Recognition (MICR) – Digital characters on the bottom edge of a paper check containing the issuing bank's ABA number and account number. The check number may also be included. 

Manual Card Entry – An option available in OTCnet for card processing, it allows agency users to manually enter a card number on behalf of the card holder so a card payment can be processed. It is only to be used as a contingency if all other payment methods fail.  

Master Verification Database (MVD) – It is an online database specific to the agency that maintains the agency hierarchy check cashing policy, information on bad check writers, and manually entered blocked items based on an agency’s policy. Bad check information is accumulated in the MVD as agencies process checks through Check Capture. The MVD provides downloads of dishonored check information and blocked items via the Local Verification Database (LVD) on a daily basis. 

Merchant Identification Number (MID): A unique designator (e.g. 44450XXXXXXXXX) assigned by the acquirer to reflect the card processing location and may contain up to 13 characters. An ALC can be associated with multiple Merchant IDs; however, each Merchant ID must be unique for each lower level endpoint.

Mobile Check Capture – A functionality in OTCnet; it allows the processing of mobile check transactions from the FedRevCollect mobile application (Mobile Server).  

MVD Editor – A user that has the authorization to view, edit, and download CIRA records, view verification records, and read blocked records containing only ABA permissions, view other general reports such as the SF215 Deposit Ticket report,5515 Debit Voucher report, the ACR Activity report as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint. 

MVD Viewer – A user that has the authorization to view and download CIRA records, view verification records, and read blocked records containing only ABA permissions. This role also has the permission to download CSV formatted reports, view other general reports such as the 215 Deposit Ticket report, 5515 Debit Voucher report, the ACR Activity report, as well as view and download Historical Reports. The agency user can view if an endpoint is designated for summary level classification, and the agency comments associated to an endpoint.

N

Non-Personal Item Type – Indicates that the name on check is an organization, or the check is a money order, traveler’s check, or third-party check.

Non-Reporting OTC Endpoints Report – A business report that allows you to view OTC Endpoints that have not reported a deposit. 

O

Open Batch Status – Indicates the batch is open and accepting new checks.

Organization – The location or level within a Federal Program agency.

Organization Hierarchy – The structure of a Federal Program agency as defined in OTCnet.

Organization Hierarchy Report – A check processing business report that allows you to view the target OTC Endpoint within the context of the current OTC Endpoint. 

OTC Collections – Receipts that contain cash, checks, and/or money orders that are collected over-the-counter by organization endpoints in exchange for goods or services.

OTC Endpoint – The endpoint (location) that collects over-the-counter (OTC) receipts and deposits them to the United States Department of Treasury General Account.

OTC Endpoint Credit-Debit-Card (CDC) – The endpoint (location) setup in OTCnet for use in card processing.

OTC Endpoint Check (CHK) – The endpoint (location) setup in OTCnet for use in check capture.

OTC Endpoint Treasury General Account (TGA) – The endpoint (location) setup in OTCnet for use in deposit reporting. 

OTC Endpoint Mapping – The assignment of accounting codes to an agency’s OTC Endpoint, for which a deposit amount can be allocated. 

OTCnet Generated Eight-Character Pairing Pin – A pairing pin is a unique eight-character OTCnet-generated number used to pair OTCnet and the card terminal. The number is entered the card terminal. 

OTC Kiosk Tablet – A lightweight collections mobile tablet terminal that features OTCnet Check Processing and Card Processing with receipt printing functionalities. It allows agency customers to make check (personal only) and card payments (credit, debit and gift) independent of an agency representative.

OTCnet Local Bridge (OLB) Application – Refers to an application installed on a workstation, used to facilitate communication between the browser and the operating system/workstation.

OTCnet Offline – Refers to the over the counter application that provides Check Capture functionality to end users with limited internet connectivity and provides the capability to upload offline-captured batches to the Online OTCnet application for processing. 

OTCnet Online – Refers to the web-based over the counter application that provides Check Capture, Check Processing, Deposit Processing, and Card Processing functions to end users (that have constant internet connectivity). 

Over the Counter Channel Application (OTCnet) – Refers to the over the counter application that provide Check Capture and Deposit Reporting to end users.

P

Personal Item Type – Indicates that the name on check is an individual’s name, not acting as a business.

Personally Identifiable Information (PII) – It is any piece of information which can potentially be used to uniquely identify, contact, or locate a single person or can be used with other sources to uniquely identify a single individual. Examples of PII include but are not limited to social security numbers, dates and places of birth, mothers’ maiden names, biometric records.

Primary Local Security Administrator (PLSA) – An agency or financial institution/federal reserve bank user who has authorization to maintain user access to an organization, including assigning/removing user roles and assigning/removing organization hierarchy access. This user is also able to request and create users for the organization.

Processing Options – User-defined parameters for the deposit and adjustment processes.

Processing Options by OTC Endpoints Report – A business report that allows you to view processing options defined for endpoints within the organization. 

Q

Queue Interface – Used by military agencies that utilize the Deployable Disbursing System (DDS) database bridge. It provides a single transaction input point, prevents data entry errors, and discrepancy between both systems.
R

Received – The agency has sent this transaction through OTCnet. No settlement has been performed for this transaction yet.

Received Date – The date the check was received by web-based OTCnet. 

Rejected – A deposit that is returned by a financial institution or FRB to the Deposit Preparer to create a new deposit.
Represented – This transaction was returned with a reason code that allows for another collection attempt to be made (see Appendix Chapter of the Participant User Guides for Reason Codes). Depending on an agency’s policy, the item is reprocessed in an attempt to collect the funds from the check writer. Items with this status are in-process of collection.

Retired – This transaction was unable to be collected. The agency receives an SF5515 Debit Voucher Report with a debit processed to Debit Gateway, the effective date and debit voucher number. The offset to the agency’s debit is an ACH return or a paper return (Check 21) received from the check writer’s financial institution. This transaction cannot be processed again through OTCnet.

Return Reason Codes – Represent the numeric codes used in the ACH and paper return processing, which specify the reason for the return of the transaction and Check 21 codes. 

Return Settlement Date – The effective date of settlement of the returned check item.

Returned Item – A check that was originally part of an OTCnet deposit but returned to the financial institution for non-sufficient funds, closed account, etc.

Routing Transit Number (RTN) – (also known as American Bankers Association (ABA) 
Number or Bank Routing Number) – The nine-digit number used to identify a financial institution.

S

Save as Draft – An option that allows a Deposit Preparer to save a deposit for modification at a later date.

Save for Approval – An option that allows a Deposit Preparer to save a deposit for a Deposit Approver to submit to a financial institution.

Send Error Batch Status – Indicates the batch was transmitted and fully processed by the OTCnet server without error.

Sent Batch Status – Indicates the batch was uploaded online without error.

Separation of Duties – A concept used to ensure there are typically separate personnel with authority to authorize a transaction, process the transaction, and review the transaction.

Settle Best Method – The option that allows OTCnet to decide the best settlement method for personal and non-personal checks.

Settled – This transaction is complete, and the funds have been credited to the agency’s United States Department of Treasury General Account. The effective date of the deposit and the SF215 Deposit Ticket Report deposit ticket number are provided.

Settlement Date – The payment date of a check item, which is when the deposit is debited from the check writer’s account. 

SF215 Deposit Ticket Report – The report presented to a financial institution by a U.S. government agency with checks and other payment instruments to make a manual deposit. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable for a duration of up to 45 days.

SF5515 Debit Voucher Report – The report used to debit the United States Department of Treasury General Account (TGA) to decrease the amount of a deposit made to that account. This report is manually generated for Deposit Reporting and auto-generated for Check capture. The report is searchable in for a duration of up to 45 days.

Share Accounting Module (SAM) – The application that facilitates the process of validating or deriving United States Department of Treasury Account Symbol (TAS) and Business Event Type Code (BETC) combinations to assist CARS in classifying financial transactions as they occur.

Short Name/Code – The user-defined text describing an organization. Short Names/Codes must be unique within an organization hierarchy.

Statistical Report – A check processing administration report that allows you to view statistical details for an OTC Endpoint. The report includes statistical information regarding the total transactions, overall success rate, total returns sent back to the agency, and total returns received. The report is searchable for a duration of up to 15 days.

Submit – An option that allows a Deposit Approver to submit a deposit to a financial institution.

Submitted – A deposit that is submitted and waiting deposit confirmation by a Deposit Confirmer.

Suspend – Indicates that an individual's record is set to a predetermined suspension period. During this time, OTCnet prevents an individual from processing a check through OTCnet. The individual's database record has a Trade Status of Suspend and the expiration date is set until a specific date.

T

Terminal ID – The unique number assigned to the workstation where a user performs functions in OTCnet.

Trade Status – Represents the status of the verification records. There are four 4 possible trade statuses in the system: Blocked, Denied, Suspended, and Cleared. The Trade Status D-Suspended or D-Denied is assigned to auto generated Dynamic records.

Transaction History – Defines the time range that a Deposit Confirmer can view the historical deposit transactions for his or her financial institutions. For example, if the transaction history is set at 45 days, the Deposit Confirmer can view all the deposits that he or she has confirmed for the past 45 days.

Transaction Reporting System (TRS) – A collections reporting tool, supplying the latest information on deposits and detail of collections transactions to federal agencies. The system will allow financial transaction information from all collections systems and settlement mechanisms to be exchanged in a single system.
Treasury Account Symbol (TAS) – The receipt, expenditure, appropriation, and other fund account symbols and titles as assigned by Treasury.

U

Universal Serial Bus (USB) – A connection port on a computer that is universally compatible with many types of devices, such as printers, speakers, mouse, flash drives, etc. 

US Dollar Equivalent (USE) – The deposit amount, in United States currency, which is equal to the foreign currency for which it is being exchanged.

US Treasury – The executive department and the United States Department of Treasury of the United States federal government.

User Defined Field (UDF) – A user-defined text that describes deposit activity or deposit accounting activity.

User Information Report – A security report allows that you to view a user’s contact information.

Users by Access Group (FI) Report – A security report that allows you to view users by financial institution. 

Users by Access Group (FPA) Report – A security report that allows you to view users by OTC Endpoint.

Users by Role (FI) Report – A security report that allows you to view users by role for your financial institution. 

Users by Role (FPA) Report – A security report that allows you to view users by role for your OTC Endpoint.

V

View CIR File Status Report – An administration report allows you to view the status of CIR files that have been processed by Collections Information Repository (CIR) or are ready for CIR to process. 

View CIR Transmission Status for Check Processing – A check processing administration report that allows you to view the status of CIR files that have been processed by CIR or are ready for CIR processing.

View Vouchers Completed Report – An administration report allows you to view the status of deposit and adjustment vouchers that have completed processing through the FI System To System Interface in the past 36 hours. 

View Vouchers in Progress Report – An administration report allows you to view the status of deposit and adjustment vouchers in progress. 
Viewer – A user who has authorization to view OTCnet information and produce reports from it.

Voucher Date – The day that Debit Gateway receives transactions from OTCnet. 

Voucher Number – The number assigned to a deposit by OTCnet.

W

WorldPay: (formerly Vantiv) A credit card, debit card and gift card merchant processor who is responsible for the creation of card acquiring service (CAS) accounts including chain codes and merchant IDs. 


Release 2.5/August 2017	Administration	1
14		Administration
Administration		13
image55.png
New External Identity

e
16ty Organization = =]
=
Primary Location ==
[Gwa supervisar?
Csaarch |
sponsaring Application * =]
stotus Actve

© Scheduleforton
© Schedule for Later 10/16/2013

| Submit | [Cancel |

Time: 0000 ~





image56.png
Search:

Where  |fmsorgname Contains v treas

{Treasury Web Application Infrastructure





image57.png
New External Identity

— I B =
1dentty Organization * || Treasury Web Application nfiastucture: =
[Som)
rimary Location =
[wa supervisors
o
Sponsoring Agpiicaton = =]
totue Active
© schedule for Now
© schedule for Later 10/1672013 Time: 0000 ~

{subemit | cancel |





image58.png
Search: Sponsoring Application

foats

/390

S TCnet (550)

IPacer

AM (550)

fir (sso)

fom security

fses

srar





image59.png
New External Identity

email - QaeTrain+47@gmailcom
bile phone
orice phone - 5555555555

Pager Number

orfice Fax.

ofice room Number

[Offce Strest Addrese
O e 123 Training St

[office Streat aciress 2

civy - McLean

office state Virginia

office zip/postal code * [ 22101

orice Country = UNITED STATES|

Schedule for Later 10/16/2013 Time; 0000 +





image60.emf
 


image61.png




image62.png
Request anagement

Search Person

select

Extemal

Person

Account

where

Full Name.

Contains

DanG Dprep





image63.png
T stotes

T

Organization

[Canc Oorep

[Gastransaroomatcom

[acive





image64.png
Manage User: DanG Dprep

o Manage Personal Info

[¢ Manage Accounts

* Manage Passwords





image65.png
Manage Accounts: DanG Dprep

Select

User ID

Service

Status

¥

ddprep07

single Sign On (FSLDAP)

Active

Tew ] Suspend | Restore || De-Provison | Cocel





image66.png
Create Account for: DanG Dprep

Choose Account Type

"OTCret (External Future)
OTCret (FT-FUTURE2)
OTCnet (internal)
OTCret (1nternal Future)
OTCnet (Qa)

OTCnet (QAe-FUTURE2)
OTCret (QAFUTURE2)
OTCnet (WAL FT)
OTChet (TWAI FT-Future)
OTCnet (WA IT)

Single Sign On (FSLDAP)
Single Sign On (TWAI FT)
Single Sign On (TWAI IT)

e





image67.png
Edit Account: OTCnet (External)

[Ssouin - [Goprepor

Managed Organizations

csion permission Click to vodif
Created oy
Created Date

Lost Updsted 8y

Lost Updated Date

[account status

© Schedulefor Now
Schedule for Later 10/17/2013

(bt | [Caneat

Time: 0000 +





image68.png
Search: Managed Organizations

o e T

=]

9] 3|rreasury web Application Infrastructure





image69.png
Edit Account: OTCnet (External)

SSouio -

[Gaorese”

anaged Organizatons

Treasury Web Application Infastucture

[ron rermsson_[imemmaant ]|
ooy
Created e
ot Updorea 67
ot Upared o
P heve
© schedle fortow
Schedule orLter 0172013 ime: 0000 -

e





image70.png
OTCnet Module Role Access Group

This form calls the AGM Web Service after changing each of the items below.
The screen will refresh with the new data once it is available.

Existing values:

Choose a Role -Select- -
Acccunhng Sgeclahs( F
[subait ]| [{Agency
Agency Manager
Agency Onboarding & Support (AOS)





image71.png
OTCnet Module Role Access Group

“This form call the AGM Web Service after changing each of the tems below.
“The sereen will refresh with the new data once it s available.

« There are no more sub-groups.

Existing values:

todulelRole  Access Grouo]

Choose a Role_DepositPreparer -
Level 1 ‘AllFederal Agencies ~

Level 2 TTH -

Level 3 E2 -

=





image72.png
Edit Account: OTCnet (External)

Treasury Web Application nfiastuciure

anaged Organizations

[scign permission sk o oty

Crested 5y

Crested Oste

Lost Updoted By

Last Updated Date

[accoun statue Actve

‘Schedle for Later 10/17/2013

[z





image73.jpeg
Request Management - Your Pending Requests

Select

View Details

Request 1D

Time Submitted

Process Type

Requestee

Subject

Status

Details

5101857541947746626

oct 17, 2013 10:24 AM DT

Create Account

DanG Dprep

ddprepo7

In Process





image74.png
Request Management Organization

Search Person

elect Extemal |

where Full Name.

Contains  ~

DanG Dprep





image1.png
@UTCneL

DEPOSITS MADE SIMPLE

BUREAU OF THE FISCAL SERVICE





image75.png
T stotes

T

Organization

[Canc Oorep

[Gastransaroomatcom

[acive





image76.png
Manage User: DanG Dprep

o Manage Personal Info
o Manage Accounts

'+ Manage Password:





image77.png
Personal Info - Reset Passwords

Select

Service

Login

Status

[

single Sign On (FSLDAP)

adprep07

[active





image78.png
Personal Info - Reset Passwords

Request submitted

Select Service Login Status

[single sign on (FsLoAP) ddprepo7 [active





image79.png
Search Person

select

Where

External

Full Name

Contains

DanG Dprep

=)





image80.png
E-mail

Status.

Organization

anG Dprep

QaeTrain+&7@gmailcom

Adive





image81.png
Manage User: DanG Dprep

* Manage Accounts
® Manage Passwords





image82.png
Personal Information: DanG Dprep

Eremre Tedbreor

Lega prefix

Legal Name DanG Dprep

LegalFirst vame = | DanG

Legal piddle Name

Legl Last Name * Dprep

(Generstion
Ldentiver/Sufix

organizational roes

[
[





image83.png
Request Management Organization

Request Management - Your To-Do List

[ioea ] Aty T Time bus T Reauestes | subject ]|
a T[ses o1, 2010 o330 pm eoT [5rea Shaw T





image84.png
Approve / Reject the Request

[Descrption _[Access request for DanG Dprep's sccount ddprep07 on OTCret (Extermal) requires your sporoval
Request 1D [5101873505291330896
Requestor [otenet tengeniAST
Requestee [banG Dorep
Subject ddprep07
[Time Submitted [oct 17, 2015 10724 AN EOT
Time oue 8242013 10:2¢ An EOT
[View Request Dot

expianation





image85.png
Search Person

Organizaton

Account

select

Extemal

Where

Full Name

Contains

DanG Dprep

[as]





image86.png
E-mail

Status.

Organization

e

[DanG Doren

QoeTroin+47Gomail.com

[Acive





image87.png
Manage User: DanG Dprep

e Manage Personal Info
e Manage Accounts|
e Manage Passwords





image88.png
Manage Accounts: DanG Dprep

Select

User 10

Service

Status

ddorec0r

[Single Sign on (FsLDAR)

[active

Jorcnet (external)

[active





image89.png
Manage Accounts: DanG Dprep

© Schedule for Now

Schedule for Later 10/17/2013

Confirm suspend of the following accounts:

User 1D [Service Status
ddprep07 Single Sign On (FSLDAP) Active





image90.png
Request Management

Organazaton

Search | Reports

Request Management - Your To-Do List

Tocked

Activity

Time bue

Requestee

Subject

o Aporoval

[pet 22, 2015 10:23 AM EOT

[DanG Dprep

[Gdprepo7.





image91.png
Approve / Reject the Request

[Description [ Acoess request for DanG Dprep's account ddprep07 on OTCnet (External) requires your approval.
RequestID___[5101873505291330896

Requestor __[otcnet tenqeHLAS1

Requestee __|DanG Dprep

Subject ddprep07

[Time Submitted [Oct 17, 2013 10:24 AM EDT

[Time Due [Oct 24, 2013 10:24 AM EDT

View Request Data

Explanation

Approve Reject Cancel





image92.png
=181]

i 2] o a8

Ele Edt View Favories Toos Help

Request Management - Your Pending Requests

.. @ Sungestedstes = ] iebSice Glery +

Select| View Details

Request 1D

Time Submitted

Process Type

Requestee

[Subject

Status

™ |petails

[7613500040730785753

|oct 26, 2010 01:50 P DT

|change User Data

|sandy saunders

Not Started

T T T @menet G- [®w00% -




image93.png
Deposit Proces:

Check Processing Card Processing

Organizations + o [—_— - Check Processing +_Manage Card P

orgnizsion ey ) | crewe |

[ |

coomtatns [ ouee |

Processing Options b | view ] A
semen A

User Defined Fields )





image94.png
Location: Home>>Administration> >Manage Organizations > >Organization Hierarchy>>Modify
Modify Organization
Step 1 of 3: Select OTC Endpoint

Select the OTC Endpoint you would like to modify.

CHK denotes check capture  TGA denotes deposit processing  CDC denotes card processing

Organization Hierarchy:High Level Organizations

Expand All/Contract All

1 [TTL- Training Taam Top Level 00002089

M denotes mapped accounting code(s)





image95.png
Modify Organization

Step 2 of 3: Update OTC Endpoint Information

Update the OTC Endpoint information.

Organization Hierarchy TTTL - Training Team Top Level -00002099
OTC Endpoint: TTTL - Training Team Top Level -00002099
* Denotes required fields.

General
‘Short Name* Max 10 alpha-numeric characters
A
Description*

[Training Team Top Le|

» ClAllow OTC Endpoint to create deposits for over-the-counter collections.

»  ICheck Cashing Policies

» MEnable Check Capture

‘ » ¥Data Privacy ‘

+  [Enable Card Processing

~ [VIAdd lower levels to this OTC Endpoint

‘Short Name* Description*

(L1 ] [ Lower Level 1 |
(L2 ] [ Lower Level 2 ]
(13 ] [ Lower Level 3 J

Add More

[+ Advanced dinicsion \

[ svciDasignaon \





image96.png
Modify Organization

[P —

Orgoizaion rachy:TTTL . Troning Teom Tep Lovel 006209
O Endpomt TTTL Teamng Toam Top Lovel S00709
B
onerst
= ™
Do Traing Team Top Leve 0000209
C "
Check Cashin P
Acsgnad Return Reson Code ters oukie.
o1t s B
10-Cumamar v ot A 0
Aaeocy Assned uspemsions
oo ocrence ot
» ' "
@ 2 "
» 3 "
Agency Verticaton o
e e ok Oy e
e e -

Lowerteve

r—r——

E

E

ETa—




image97.png
Modify Organization

[T ———

Organizadon ioarchy:TTTL . Tusining T Top Lovel 000209
OTC Endpane TTTL - Trainag Toam Top Level 8042099

Conerst
St ™
Team Top el
OrCtngont "
Chock Cashing P
Assoed Return Reason Coe iters. ookt
o1t s B
et Goms -
Aaency Assgned Suspensions
oays ocaumence ookt
» ' "o
@ B "
Agency Vertiation pokcies
e fred rch Oy e
e pred -
Data Privacy - Agency Avabl Atrbutes
pre— ke
Swtvame =
o Rt aer ~
o tnad a1
Lower toves
Shorthame  Descrption
w Lome e 1
w otz
Spectt Desgation
Assoced AC WA Reporter
wee2om




image98.png




image99.PNG
Check Processing Card Processing

anageoranzaions  ranage 1 . Wanage Users  Managemnt . Wanage Chack Processing _Manag Cr

Organization Hierarchy b | Create

Accounting Codes ) | wodity

Custom Labels S| W

Processing Options b | yiew
UserDefined Fields b | searcn A





image100.png
Modify Organization

Select the OTC Endpoint you would like to mofy.

GHK denotes check capture  TGA denotes deposit processing ~ CDC denotes card processing 1 denotes mapped accour

g code(s)
Organization Hierarchy:High Level Organizations

Expand AllContract All
E TTL - Training Team Top Level -00002099
ELL1- LowerLevel 1-0000209901 CHK TGA CDG M
BILL1A- Lowe
EILL1B- Lower Level 18

Level 1A





image101.png
Modify Organization

Step 2 of 3: Update OTC Endpoint Information

Update the OTC Endpoint information.

Organization Hierarchy TTTL - Training Team Top Level -00002099
OTC Endpoint: TTTL - Training Team Top Level -00002099
* Denotes required fields.

General

Short Name® Max 10 alpha-numeric characters

[wic

Description”
[LowerLevel1c |

» ClAllow OTC Endpoint to create deposits for over-the-counter collections.

» [Data Privacy

‘ »  ICheck Cashing Policies

» [JEnable Check Capture

+  [Enable Card Processing

Short Name* Description*

[LL1ct ] Lower Level 1C1 |

( ) [ )
( ) ( )
( ] ( ]
( ) ( )

Add More

es.

‘ » Advanced Administration

~ Add lower levels to this OTC Endpoint

‘ » Special Designation





image102.png
‘Modify Organization

DoE

Venty the o fermaton s correct and chckSubant t oy th OTC Endpon.

Organization Hirarchy TTTL - Training Team Top Lovl 0000209
OTC Endpoin LLIC - Lower Love 1C

Genera i tean)
Shortrame wic
Descen LowsrLevel 1C
OTCendpons ( 74 ) o
oTC Endpomt (0 ) "o
OTCendpans ( o) "o
Check Cashing olicies
Agency Assgned suspensions
ouys Occarrence. Deete
f o o

Agency Vefiction olices
Inchude Reprsartd and Rtred ChckYes.
nche Expeed Yo
e oo o

Aoy Verbcston Polcs--Oeite Mo

ata Prvacy - Agency Avadlable Atrbutes
trbute Home.

sccount
Swrtrame
Note
Bk Routing tomber
e Ootoed i 1
MaskPil.

HHEHEH

wa Lover tevl 11




image103.png
Step 1 of 3: Select OTC Endpoint
Select the OTC Endpoint you would like to mofy.

GHK denotes check capture  TGA denotes deposit processing

M denotes mapped accounting code(s)

Organization Hierarchy:High Level Organizations

Expand All/Contract All
(=] TTL - Training Team Top Level -00002099
[ LL1- LowerLevel 1-0000209901 CHK TGA CDC M

CDC denotes card processing





image104.png
ation

Step 2 of 3: Update OTC Endpoint Information

Update the OTC Endpoint information.

Organization Hierarchy: TTL - Training Team Top Level -00002099
OTC Endpoint: LL1 - Lower Level 1 - 0000209901

“ Denotes required fields.
General

‘Short Name*

w

Descriptio
[ Lower Level 1

» ClAllow OTC Endpoint to create deposits for over-the-counter collections.

»  ICheck Cashing Policies

» ¥Data Privacy

» MEnable Check Capture

» VIAdd lower levels to this OTC Endpoint

» Special Designation

‘ + CEnable Card Processing ‘




image105.png
~ ¥Allow OTC Endpoint to create deposits for o

Agency Location Code
ALCt

Address
Address Line 1*

( )

Address Line 2

( )

City*

( )

State / Province”

J
Postal Code’

Country® o
United States of America V] |us |

Phone Number
( )
Financial Institution Relationship(s)
Financial Institution
[Select.
DDA
( )
Retype DDA
( ]

[ Add >> |

RTN

Financial Institution RTN DDA

Delete

Bank of America 011900445 234567

[ICheck Cashing Policies.

VData Privacy

[Enable Card Processing

»
»
» VEnable Check Capture
»
»

[VAdd lower levels to this OTC Endpoint

» Advanced Administration

o e oo





image106.png
Modify Organization

Step 2 of

Update OTC Endpoint Inform:

Update the OTC Endpoint information.

Organization Hierarchy:TTTL - Training Team Top Level 00002099
OTC Endpoint: LL1 - Lower Level 1 - 0000209901

* Denotes required fields.
General

‘Short Name*
[t ]

Description®
(Lower Level 1 ]

» Allow OTC Endpoint to create deposits for over-the-counter collections.

~ [Check Cashing Policies

Default Reason Codes

[Select

03-No Account / Unable to Locate A
04-Invalid Account Number

05-Reserved

06-Retumed per ODFI Request

07-Auth Revoked by Customer

05-Payment Stopped

09-Uncollected Funds

1-Does not conform with ANS X9.100-181 - 2007 Specification for TIFF Image Format v
11-Check Truncation Entry Returm

Assigned Return Reason Code

T Delete

01-Insufficient Funds
02--Account Closed

10-Customer Advises Not Authed

Days Occurrence  Delete

]

Agency Verification Policies

o

Include Represented and Retired Check
®

Include Retired Check Only

Include Expired u]

» [¥Data Privacy

[Enable Card Processing

»
» [VAdd lower levels to this OTC Endpoint

\ |
‘ »  WEnable Check Capture ‘
\ |
\ |
\ |

» Advanced Administration





image107.png
Modify Organization

[ ——
Orgatton Werachy: TITL-Trsing Team To Leve 40002088

Do

Al OTC Endpoint et depost o v e <oue coiecions

+ Ccmeck casingPokcion

- owsprscy

Data Prvacy - Agey Avadble Atres
rE——

<f

St o
ote

Bk g et

ek 1

B




image108.png
Modify Organization

Step 2 of 3: Update OTC Endpoint Information

Update the OTC Endpoint information.

Organization Hierarchy: TTTL - Training Team Top Level -00002099
OTC Endpoint: LL1 - Lower Level - 0000209901
“ Denotes required fields.
General
‘Short Name*
L ]

Description®
(Lower Level 1 ]

‘ » ClAllow OTC Endpoint to create deposits for over-the-counter collections. ‘

‘ »  ICheck Cashing Policies ‘

‘ » ¥Data Privacy ‘

~ MEnable Check Capture
ALC+2*

Queue Interface

Short Name(Starting With)
L1 ]

| Clear | search |
OTC Verification Group

Current Agency Site
NASA Headquarters

short Name: Description ALC+2  Delete

1K) Lower Level 1 0000209001  [J

[Enable Card Processing

»
»

» Advanced Administration

» Special Designation

V/Add lower levels to this OTC Endpoint ‘





image109.png
~ Enable Card Processing

Chain Code* Division® ALC Merchant ID*

( ) ( ) 00002089 | |

Address
Address Line 1°

)

Address Line 2

State / Province”™
O
Postal Code™
]
Country”
vs )

Phone Number

)

\ + Add lower levels to this OTC Endpoint




image110.png
Signature Capture
Selact the checkbox f you wish to add a customer signature to your agency's transaction recelpts.
1 selacted, thefollowing will appear on your agency's sale fecelpts: | AGREE TO PAY THE ABOVE TOTAL AMOUNT IN ACCORDANCE WITH THE CARD ISSUER'S AGREEMENT™

and the following will ppear on your agency's refund receipts: ‘| AGREE THAT | HAVE RECEIVED A REFUND FOR THE AMOUNT STATED ABOVE™

Rotum Policy
Please select one ofthe ollowing below to indicate the card transaction retun policy for your organization

NO REFUND, ALL SALES FINAL - For any agency that does not ccept merchandise in retum or exchang and does o issue refunds o cardholders.
EXCHANGE ONLY - For any agency that only accepts metchandise inimmediate exchange fo simiar merchandise o 2 price equal o the amount of the origna ransaction

IN.STORE CREDIT ONLY - For any agency that accepis merchandise i rturn and delvers 1 the cardhokder an n-sore credt equal 10 the value ofthe merchanis retumed that may be used only i the agency’s place(s) of business.
REFUNDS ONLY AVAILABLE WITHIN 30 DAY OF SERVICE OR PURCHASE - For any agency that issues refunds o the crginalcre6itor it card within 30 days ofthe date of purchase orservce

Other




image111.png
Modify Organization

Step 20l

Update OTC Endpoint nfor

Update the OTC Endpaint information.

Organization Hierarchy: TTTL - Training Team Top Level 00002099
OTC Endpoint: LL1 - Lower Lovel 1 - 0000209901

* Denotes required fields.

General

Short Name
w x

Max 10 aphanumerc haracters

Descrition”
Lower Level 1

+ CAllow OTC Endpoint to create deposits or overtho-counter collectons
+ ECheck Cashing Polices

+ ¥Data Privacy

+ ZEnable Check Capture

+ VEnable Card Processing

~ Add lower levels to this OTC Endpoint

‘Short Name* Description”
Ty Lower Lovel 1A
s Lower Level 18
Lic Lower Level 1C.

Add More Lines
+ Advanced Administration

» Special Designation





image112.png
Please remember to submit your Agency Site Profiles (ASPs) for
all check capture endpoints. Failure to do so will prevent your
transaction from processing.





image113.png
~ Advanced Adi

Debit Gateway
® O

Yes No

Forms Rendered Solution

® O

HTML ActiveX

[CReport Only Summary Level Data to CIR

[CJsummary Level Classification

Batch List Report Print/Export Required During Note: Users can choose to printiexport the batch list
¥iciose Batch  WlApprove Batch report regardiess of whether they are required to

print/export it at close or approval

Specify Agency Comments:




image114.png
Modify Organization

Step 2 of 3: Update OTC Endpoint Information

Update the OTC Endpoint information.

Organization Hierarchy:TTTL - T Team Top Level 00002099
OTC Endpoint:LL1 - Lower Level 1 - 0000209901

* Denotes required fields.

General
Short Name®

L ]

Description®

Lower Level 1 ]

» ClAllow OTC Endpoint to create deposits for over-the-counter collections.

»  [ICheck Cashing Poli

» ¥Data Privacy

» MEnable Check Capture

+  [Enable Card Processing

» VIAdd lower levels to this OTC Endpoint

~ Advanced Administration

Debit Gateway

Yes No

Félms Rendered Solution
HTML ActiveX

[Report Only Summary Level Data to CIR

[lsummary Level Classification

Batch List Report PrintExport Required During: Note: Users can choose to printlexport the batch list report
Close Batch  ¥lapprove Batch regardless of whether they are required to prinvexport it at
close or approval

Specify Agency Comments:

» Special Designation





image115.png
Modify Organization

e r—

Updatethe OTC Endpint informaton.

‘Organizaton Hierarchy-TTTL - Trsiing Team Top Level 00002095
OTC EndpointLL1 - Lower Level 1 - 0000203501

~ Dencles required felcs.
General

Short Name+
[

Desorpton”
[Lomer Levei 7

~ Allow OTC Endpoint {0 create depositsfor ovr-the-counter colectons.

‘Agency Location Code.

e
= ]

Address
At Ui 1

Adtress e 2

Financial Insttution Relationshipts)

Finsncil Insttuton
e v

[Add>>]

[Financil Tostuion £

+ ZCheck Cashing Policies
+ 2ata Privacy
+ Enable Check Capture

+ /Add lower levels toths OTC Endpoint
+ Advanced Administration
« Special Designation

WA Reporter ALC. o
Nor-appropriated Funds ALC ™

\
\
\
[+ ot cort rcesion
\
\





image116.png
‘View Organization

[P ——

B ——
O Erapame - evar ot S

Genarat
D Lower vl 1
ne o0coz0s
orC et (764 e
ot o ) e
onc et ( ) e
Addoss
o e
ar e
St o w
o 0
Fianca nsttton Reltionshiots)
At il It Reoonsup(s)
Fisncal astation w
Check st Polcien
s Return oo Code Fers Dl
o1t s o
10-Gntme v ek o
s —
oo ocarrence

ey Vrtcaton pokies
e Rtred Crockomy. e
Eesedons e
Aoy Vet o Dekte o

Data privacy - Agency Avaiabe Atributes.

Ntrbute Name Blocked
Sortane e
e e
wkrt e
an Routng Numasr £
ets e
Check Copure
Qe e B
01 vertication Groon
Caren gy She.
Towertowl 1
Shottome  Desarpton N
u Lomer e 1 aconnion
Candprocessiog
Lo Lol
Short e Oecrpion
use [y
Jror—
Dt Gty -
Feme et St [
et Ony Sumrory Lol D9 0 C o

B st gt o e Y

o st gt o R s
oo
Sty Ay Commers

Spec Desination
O Reprer AC 5

o apreced s MC -





image117.png
Modify Organization

Step 3 of 3: Review OTC Endpoint

Verify the following is correct and click Submit to modify the OTC endpoint

Organization Hierarchy: TTL - Training Team Top Level 00002099
OTC Endpoint:LL1 - Lower Level 1 -0000209901

General

Short Name i
Description Lower Level 1
ALC 00002099
OTC Endpoint ( 7G4 ) Yes

OTC Endpoint ( cHk ) Yes

OTC Endpoint ( cpC ) Yes
Address

Address Line 1 111 Train St
Address Line 2

City: McLean
State / Province VA

Country us

Postal Code 22102

Phone Number

Financial Institution Relationship(s)
Active Financial Institution Relationship(s)
Financial Insti RTN
Bank of America 011900445

Check Cashing Pol

Assigned Return Reason Code Filters Delete
01-Insufficient Funds No
02-Account Closed No
10--Customer Advises Not Authed No
Agency Assigned Suspensions
Days Occurrence

30 1

60 2

90 3

Agency Verification Policies

Include Retired Check Only Yes
Include Expired Yes
Expired Days 999999
Agency Verification Policies—Delete No

Check Capture
ALC+2 8000000101
Queue Interface No

OTC Verification Group
Current Agency Site
Lower Level 1

Short Name Description ALC+2
L1 Lower Level 1 8000000101
Card Processing
Chain Code OF1234
Division 001
Merchant ID ap123123123123123123

Lower Levels

Short Name Description
LL1A Lower Level 1A
LL1B Lower Level 1B
LLiC Lower Level 1C
Debit Gateway Yes

Forms Rendered Solution HTML

Report Only Summary Level Datato CR ~ No
Summary Level Classification No

Batch List Report Print/Export Required at ~ Yes
Close Batch

Batch List Report Print/Export Required at ~ Yes
Approve Batch

Specify Agency Comments

Special Designation
GWA Reporter ALC Yes

Non-appropriated Funds ALC No

Delete

No





image118.PNG
Deposit Proces:

Check Processing Card Processing

I P ————————r
T ]

ol

e T— b

Dl

User Defined Fields )

=N

== ==





image119.png
Delete Organization

Select the OTC Endpoint(s) you would like to delete.
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Select OTC Endpoint
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Step 1 of 3: Select OTC Endpoint
Select the top level OTC Endpoint to modify accounting codes.
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Organization Hierarchy: TTTL - Training Team Top Level -00002099
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Select OTC Endpoint

Select the top level OTC Endpoint to view accounting codes.
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Step 1 of 4: Select OTC Endpoi
Select the OTC Endpoint to view and modify accounting code Endpoint mappings.
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Review the list below and select the Assign Mappings to add accounting code mappings.
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Review the list below and select the accounting codes you would like to remove.
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Review the list below and verify the accounting codes you would like to assign.
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Endpoint

Verify the following information is correct and click Submit to assign the accounting code to the OTC Endpoint.
Organization Hierarchy: TTTL - Training Team Top Level 00002099
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‘The following accounting codes have been assigned to the OTC Endpoint.
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Select the OTC Endpoint to modify processing options.

CHK denotes check capture TGA denotes deposit processing CDC denotes card processing

M denotes mapped accounting code(s)
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Modify processing options and dlick Next
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Modify processing options and click Next
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Step 2 of 3: Define processing options

Modify processing options and dlick Next
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